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INTRODUCTION 

How to use this documentation 

READ THE NEXT TWO PAGES, 
EVEN IF YOU DON'T READ ANYTHING ELSE. 

Installation 

How to start 

Training 

User interface 

Modes of 
Operation 

REFERENCE GUIDE 

Many people read their user's manual only as a last resort. If you are 
one of those, the next two pages tell you where to find information 
when you need it. 

To learn how to install Xerox Ventura Publisher, read the Setup and 
Installation chapter. If you previously installed an earlier version of 
Xerox Ventura Publisher, see Appendix A, Installation Instructions. If 
you want to install without reading the manual, insert the Application 
Disk in the A drive, type A: VPPREP and then press the Enter key. 

To run Ventura Publisher, type VP and then press the Enter key. To 
quit, select the Quit option in the File menu. 

This is a Reference Guide. It provides a complete description of each 
feature, and assumes you already understand concepts unique to Xerox 
Ventura Publisher, such as Style Sheets and Chapters. To learn how 
to use the basic features, read the Xerox Ventura Publisher Training 
Guide. 

Read the User Interface chapter to learn about the components of the 
screen dialog boxes, using the mouse, and about keyboard shortcuts. 

Read the Modes of Operation chapter to learn about Xerox Ventura 
Publisher's four separate functions (Frame, Paragraph, Text, and 
Graphic.) 
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INTRODUCTION 

Menu 
commands 

Putting it 
together 

Examples 

Problems 

Advanced 
operation 

Cautions 

Read the Menu Commands chapter to obtain a complete description 
of each menu operation. 

Read Putting it Together to see how you combine the user interface, 
functions, and menu commands to create your documents. 

To learn by looking at examples, use the Open Chapter command in 
the File menu to see the example chapters contained in the TYPESET 
subdirectory. The style sheets associated with each of these chapters 
are described in Appendix L. 

If you have a problem, read through the Common Problems appendix 
(Appendix C.) You should also consult the Problem heading in the 
index. 

Other useful information about printers, word processors, and ad
vanced operation is contained in the various appendices. 

Do not use the DOS COpy command to copy chapters. Use Xerox 
Ventura Publisher's Multi-Chapter Copy All command instead (see 
the Multi-Chapter section in the Menu Commands chapter). 

Background utilities should not be installed when running Xerox 
Ventura Publisher because they reduce the available memory and may 
interfere with operation. 

One final suggestion: don't lose your work due to a power outage or 
compu~er malfunction. Save your work often! 

Technical Support 

1-2 

See the Customer Support booklet for details about telephone support, 
training classes, the Xerox Ventura Publisher newsletter and more. 
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Contents of package INTRODUCTION 

Contents of package 
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Xerox Ventura Publisher includes: 

• Sixteen 51/4" or eight 31/2" disks: 

- Application Disks 

- Examples Disk-Contains sample style sheets and example 
documents. 

Utilities Disk-Contains font and picture conversion 
utilities. The Utilities Disk is combined with the Examples 
Disk in the 31/2" version. 

- Device Driver Disks--Contain configuration software for 
various printers and displays, plus fonts for each printer and 
display. 

• Reference Guide 

• Training Guide 

• Publication Planning Workbook 

• Quick Reference 

• Customer Support Guide (includes registration card) 

• License Agreement 
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Features 
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Features 

Xerox Ventura Publisher is a professional page layout and document 
composition system that lets you create typeset documents by auto
matically combining text from word processors with pictures from 
popular graphics software programs. Images created by a graphics 
artist can be digitized with a scanner, converted to GEM, PC 
Paintbrush, or TIFF file format, and then displayed, scaled, cropped, 
and moved on the computer screen. You can also create simple draw
ings directly in Xerox Ventura Publisher. 

The resulting pages are formatted automatically by Style Sheets. A 
Style Sheet is a computer file which contains typographic attributes 
(e.g., fonts, ruling lines, inter-line spacing.) These attributes are 
grouped together into Tags which can then be applied to each para
graph in your document. By applying a tag to a paragraph, you change 
the typographic attributes for that paragraph. The same Style Sheet can 
be used for many documents, resulting in consistent typography from 
one document to the next. Also, a style sheet designed by a typographic 
professional can be used by an amateur to produce sophisticated 
documents. 

Xerox Ventura Publisher makes a unified Chapter of each document 
by creating a unique Chapter file for it. The chapter file binds together 
all the separate text, graphics, and style sheet files associated with a 
particular document and tells the computer where to look for them and 
how to place them on the page. 

Depending on the number of pictures, number of paragraphs and 
version of DOS, each chapter can contain up to SOaK bytes of text in 
a 640K system, although actual document size may be smaller depend
ing on the number of paragraphs and other factors. Up to 128 chapters 
can be combined together into a Publication. Thus, you can develop 
and print documents which are thousands of pages in length. 

The Professional Extension to Xerox Ventura Publisher allows you to 
create much larger documents by utilizing EMS memory. Contact 
Xerox for more information. 

Appendix J contains a complete list of features. 
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Typographical conventions INTRODUCTION 

Typographical conventions 
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In this manual, the ~ callout emphasizes important points. 

When a specialized term is used for the first time, it appears in 
boldface. Chapter names mentioned in the text also appear in bold, as 
do the names of menu, mode, and keyboard commands when they 
refer to actions which you should perform. Names of computer files 
and directories appear in upper case boldface. 

Throughout this manual, when you see Enter you should press the 
Enter key (sometimes called the Return key.) 

The term Mouse Cursor refers to the cursor that moves when you 
move the mouse. The shape of this cursor depends on the function 
selected, (see Figure 3-2) and on the nature of the action being 
performed. 

The term Text Cursor refers to the vertical line cursor that indicates 
the location where text is currently being added or deleted. The text 
cursor is always placed between characters, and is active only when 
you are operating in Text mode. 

Throughout this manual, the phrase Select the ... is used. This means 
you should move the mouse cursor to the middle of the item that you 
are going to select, and then press the left mouse button once. 

Except when explicitly stated otherwise, the computer hard disk is 
always assumed to be C. The term Floppy Disk refers to either 5V4" 
or 3Vi' diskettes. 
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SETUP AND INSTALLATION 

System requirements 

REFERENCE GUIDE 

Xerox Ventura Publisher requires an IBM PC, XT, AT, PS/2, or a 
compatible computer which runs the same software as these machines. 
Your computer must also contain the following or equivalent: 

• 640K bytes of RAM. 

• A hard disk drive with I-3M bytes available space to hold 
software and fonts (space required depends on printers installed
see the Software Installation section which follows.) At least 
2-3M bytes should still be available after installation. This space is 
needed to hold your document files and any additional fonts you 
may choose to install later. 

• A graphics board: 

- AT&T 6300 (640 X 400) or Xerox 6065. 

- Hercules Graphics Card, or equivalent 

- IBM Color Card and compatible color monitor 

- IBM Enhanced Graphics Adapter (EGA) or compatible 

- IBM VGA or compatible 

- Micro Display Systems Genius display 

- Wyse 700 

- Other 

• A mouse: 

- Microsoft Mouse (serial or bus mouse) 

- IBM PS/2 mouse. 

- Mouse Systems PC Mouse, or equivalent. 

- Any mouse compatible with these standards 

2-1 



SETUP AND INSTALLATION 

• MS-DOS or PC-DOS version 2.10 or higher. 

• You must also have one of the following printers in order to print 
what you see on the screen: 

- Any PostScript-compatible printer or typesetter (e.g., Apple 
LaserWriter or IBM 4216 PostScript printer) 

- Epson MX/FX/RX series dot matrix printers 

- Epson LQ series dot matrix printers 

- Hewlett-Packard LaserJet Plus or LaserJet II 

- HP LaserJet with 92286F font cartridge 

- IBM Proprinter 

- NEC P-series dot matrix printer 

- Tall Tree Systems JLaser printer card and compatible printer 

- Toshiba P351 SX 

- Xerox 4020 Color Ink Jet Printer 

- Xerox 4045 Laser Printer 

Other (see Appendix J for a complete list of printers sup
ported) 

Additional display and printer drivers are available from other com
panies although they are not supported directly by Xerox. 

~ To run this software, your computer must contain hardware from 
the options listed above and on the previous page-including a 
mouse and a graphics board. 
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Software installation SETUP AND INSTALLATION 

Software installation 

~ If you previously installed Version 1.0 of Xerox Ventura Publisher, 
please consult the section Updating From Version 1.0 in Appendix 
A. If you previously installed version 1.1, answer Y when asked by the 
installation program "Are you installing for the first time?" 

This section provides installation instructions intended for use by a 
person who has basic familiarity with the IBM PC (or compatible) and 
DOS. Additional installation information is provided in Appendix A. 

Note that Xerox Ventura Publisher will not operate when shared 
among multiple computers, nor is it licensed for sharing from a file 
server among multiple computer workstations on a communications 
network. However, a network version of Xerox Ventura Publisher is 
available. Contact Xerox for price and availability. 

Preparing for installation 

REFERENCE GUIDE 

You need to know the following about your computer hardware: 

• The type of graphics board installed in your computer. 

• The printer port u~d by your printer, e.g., serial, parallel or special 
printer interface. 

• The serial port or special board used by your mouse. 

You should make backup copies of your distribution disks to guard 
against accidental damage. Read the Software License and Warranty 
Agreement included with this product to understand the legal restric
tions governing copying and installation. 

You need 1.5-3.5M bytes of space on your computer's hard disk to 
hold all printer fonts, screen fonts, system software, application 
software, and examples. In addition, it is recommended that you have 
several megabytes of disk space available after Xerox Ventura Pub
lisher has been installed, to make room for your document files, as well 
as any fonts you may choose to install later. 
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SETUP AND INSTALLATION Software installation 
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Disk space required for the initial installation depends on the printer 
installed. Approximate total space requirements for some typical 
printers are as follows. These examples assume only one printer is 
installed, and includes the space needed for the example files. 

• HP LaserJet Plus, Xerox 4045-3.5M bytes 

• PostScript-l.5M bytes 

• JLaser, Dot Matrix, Xerox 4020-2.5M bytes 

Consult Appendix A for exact space requirements. 

If you will be using any bus mouse (e.g., Microsoft Bus Mouse, IBM 
PS/2 mouse, Xerox optical mouse, or AT&T 6300 mouse), locate the 
disk that contains the MOUSE.COM file. You must copy this file to 
your computer's hard disk when you are finished with installation. 

Installation 

During installation, the program will ask you to insert different disket
tes. The point during installation at which these diskettes are requested 
varies from one installation to the next, so no mention of diskette 
changes is made in these instructions. Also, the same diskette may be 
requested more than once during installation. This is normal. 

If you type the wrong letter or number in response to a question, 
simply type the correct response before you press Enter. You do not 
need to press the backspace key. If you make a mistake which you 
discover after you press Enter, the installation process can be aoorted 
at any time by pressing and holding the Ctrl key and then pressing the 
Break key. 

1) Make sure that MS-DOS or PC-DOS version 2.10 or above has 
been booted. 

2) Insert the Application Disk into the A drive. Close the drive door, 

type A : VPPREP and then press the Enter key. 

3) If you install from any drive other than A, type n : VPPREP n: 
where n is replaced with the letter of the floppy disk drive. The 
system responds with: 

REFERENCE GUIDE 



Software installation SETUP AND INSTALLATION 

II Is your hard disk drive C? Y II 

4) To install Xerox Ventura Publisher on drive C, press Enter. If your 
computer uses a different letter, or you have more than one hard 

disk drive and want to install on another disk drive, type N and then 

press the Enter key. If you answer N, the computer prompts you 
with: 

Type your hard~disk drive letter ( A-Z )? 

Respond by typing the appropriate letter. For instance, to install for 

the D drive, type D and then press the Enter key. 

After you enter the drive letter, the computer asks: 

Are you installing this version for the first time? Y. 

5) Respond by pressing Enter. 

~ If you have already installed Xerox Ventura Publisher version 2.0, you 
can change part of the installation or add a printer without going 
through the entire installation process by typing N and then pressing 
the Enter key in response to this question. 

Xerox Ventura Publisher then creates new directories, copies applica
tion files and instructs you to insert additional disks. 

After these operations have been completed, the following prompt 
appears on the screen: 

Do you wish to install the example files? Y 

REFERENCE GUIDE 

6) Press Enter if you want sample style sheets and formatted chapters 
to be available on screen as you operate Xerox Ventura Publisher. 
Otherwise, type N and press Enter to continue. 
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SETUP AND INSTALLATION Software installation 

2-6 

7) You are next asked what type of graphics board, display, mouse, 
and printer you wish to install. You are given a series of choices for 
each hardware option. Type the letter of the option you want to 
install, and then press Enter. If you make a mistake and type the 
wrong letter, merely type the new letter. If you press Enter after 
typing the wrong letter, either abort (Ctrl + Break) and start over, 
or continue until you are asked to confirm your choices, and then 
tell the system that your choices are not all correct. 

8) When the computer asks 

Do You Want To Install Another Printer? N 

answer Y if you plan to print to more than one printer. You can 
install up to five printer drivers. 

9) Once you have selected all your hardware options, the screen 
displays your choices and asks you to confirm them. If you have 

made any errors, type N at the prompt. You will be guided through 
the choices again. If all the choices are correct, simply press Enter. 

After you have confirmed your choices, you are asked to insert one or 
more of the Xerox Ventura Publisher disks, depending on which 
display, mouse, and printers you are using. Don't be surprised if you 
never use certain disks. This is normal. The installation process takes 
five to thirty minutes depending on the printers installed and speed of 

your computer. The message Expanding Font Files stays 
on the screen for fi ve to ten minutes, for each printer installed, towards 
the end of installation. For additional installation information, con
sult Appendix A. 

Post installation 

To assure best performance, use the ASCII text function of your word 
processor to modify the file in your computer called CONFIG.SYS to 
contain the lines: 

BUFFERS=20 
FILES=20 

REFERENCE GUIDE 
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Any number greater than 20 also works but reduces the amount of 
memory available for Xerox Ventura Publisher. 

~ Failure to add the BUFFERS statement to your CONFIG.SYS file and 
specify at least BUFFERS=20 results in slower performance. Failure 
to add the FILES statement and specify at least FILES=20 will cause 
the Multi-Chapter operations to malfunction and reduce the number of 
bit images which may be printed on certain printers. 

REFERENCE GUIDE 

If CONFIG.SYS does not exist, you can create it by typing the 
following directly from the DOS prompt (this example assumes that 
the computer boots from hard disk C): 

COpy CON: C:\CONFIG.SYS Enter 
BUFFERS=20 Enter 
FILES=20 Enter 
<Ctrl Z> Enter 

where <Ctrl Z> means "hold down the Ctrl key while typing a Z." 

If you installed a bus mouse (option C in the mouse menu), copy the 
MOUSE.COM file from your mouse distribution disk to the root 
directory of your computer. Then use the ASCII text function in your 
word processor to add the word MOUSE to the AUTOEXEC.BAT 
file. If your system does not have an AUTOEXEC.BAT file, you can 
create one, and place the MOUSE command in it by typing the 
following: 

COPY CON: C: \AUTOEXEC . BAT Enter 
MOUSE Enter 
<Ctrl Z> Enter 

where <Ctrl Z> means "hold down the Ctrl key while typing a Z." 
Some mice use the CONFIG.SYS file to load the mouse driver. In this 
case, you must copy the file called MOUSE.SYS to the root directory 
of your hard disk, and add the statement 

DEVICE=MOUSE.SYS 

to the CONFIG.SYS file. Consult your mouse manual for more infor
mation. 
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SETUP AND INSTALLATION Starting the program 

Starting the program 

Improve 
performance 
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To run Xerox Ventura Publisher, make sure that you have logged-on to 
your computer's hard disk drive, and that you have changed to the root 
directory. To log onto your computer's hard disk drive (assuming it is 
drive C), and change to the root directory, type the following: 

C: Enter 
CD \ Enter 

Make sure you type \ not I. 

To run Xerox Ventura Publisher, type 

VP Enter. 

Depending on your computer, Xerox Ventura Publisher takes 
anywhere from five to forty-five seconds to load. If loading time seems 
excessively long (more than 45 seconds), make sure that the 
CONFIG.SYS file contains the statement BUFFERS=20, as described 
under Post Installation. 

You can specify the chapter you want to open when you start the 

program by typing the file name on the same line with VP. For 
example, to automatically open SCOOP.CHP in the TYPESET direc
tory, type: 

VP C: \ TYPESET\SCOOP . CHP Enter 

If your computer contains more than 640K RAM, you can improve 
performance when creating long documents. To do this, follow these 
steps: 

1) Use the software supplied with your memory card to create a RAM 
disk using the RAM above 640K. 

2) Use the ASCII function in your word processor to add /O=n: to 
the last line of the VP.BAT file, where n is the letter of your RAM 
disk drive. For instance, to use a RAM disk configured as drive D, 
the last line of the VP.BAT file should read: 
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Starting the program SETUP AND INSTALLATION 

DRVRMRGR VP %1 /S=SD_X6655.EGA/M=32/0=D: 

The IS and 1M options may differ depending on the screen and mouse 
installed. 

Running From Microsoft Windows 

You can run Xerox Ventura Publisher from the Microsoft Windows 
Executive. To do this, Windows requires information about Xerox 
Ventura Publisher. This information is provided in the Program Infor
mation File (PIP) contained on the Xerox Ventura Publisher Utilities 
Disk. 

~ It is recommended that you run Xerox Ventura Publisher from the 
Windows Executive only if you have installed the Microsoft bus 
mouse. Windows does not re-initialize the serial port after a non-Win
dows application terminates. Therefore, if you quit Xerox Ventura 
Publisher from within Windows, and are using a serial mouse, the 
mouse may no longer function, or may behave erratically. 
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To run Xerox Ventura Publisher from the Microsoft Windows MS
DOS Executive: 

1) Copy the VP.PIF file from the Utilities Disk to the -
WINDOWS\PIF directory by typing the following: 

'COPY A: \vp .PIF C: \WINDOWS\PIF 

2) The root directory of the drive containing the VP.BAT file must be 
included in the DOS PATH command. You can accomplish this as 
follows: 

PATH C:\ 

3) Start the MS-DOS Executive (see the Microsoft Windows manual). 

4) Run Xerox Ventura Publisher by double-clicking on the VP.PIF file 
name in the WINDOWS\PIF directory. 
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Quitting from Xerox Ventura Publisher 

To quit from Xerox Ventura Publisher, select the Quit option in the 
File menu. 
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Main screen 

USER INTERFACE 

This chapter will familiarize you with the operation of the main screen, 
sidebar, and subsidiary displays. It will also describe the use of the 
mouse and the operation of keyboard keys that perform special func
tions. 

Mode Selector __ Title Bar Full Box 

Addition Button __ 

Assignment List ----II---+---+ 

Current Selection 

Page Number __ 

Figure 3-1 

Scroll Up One Line 

Vertical Scroll Bar -----Jor:::::::::l 

Horizontal Scroll Controls 

Scroll Down One Line ~ 

SizeBox~ 

Xerox Ventura Publisher Main Screen 

Figure 3-1 shows the Xerox Ventura Publisher screen with the Para
graph mode enabled. The operation of each mode shown in this figure 
is described below. The modes are explained, in clockwise order, 
starting at the top of the screen. 
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Menus 

Title bar 

Full box 

Scroll up one 
line 

Vertical scroll 
bar 

3-2 

When the mouse cursor points to the menu names at the top of the 
screen, menus drop down. The Set Prefuences option in the Options 
menu allows you to change operation to pull-down menus. Pull-down 
menus appear only when yeu press the mouse button while the mouse 
cursor is positioned at the top of the screen. 

To clear a menu that has dropped down, move the mouse cursor 
outside the menu and press the left mouse button once. If you select 
Pull-Down in the Set Preferences menu, the menus disappear as soon 
as you release the mouse button. 

As you move the mouse cursor down through the menu, each menu 
option, initially shown as black on white, reverses to white on black. 
This highlighting indicates that the item is available for selection. 

To select a highlighted item, press the left mouse button once. 

Some items in a menu appear in gray rather than black and cannot be 
highlignted. This indicates that the option is not available as long as 
the current mode (i.e., Frame, Paragraph, Text, Graphic) is selected. 

The Title Bar shows the current chapter and style sheet file names. 

Xerox Ventura Publisher pages appear within a window on the screen. 
If you have used the Size Box to make the window smaller, the Full 
Box returns the window to full screen size. The Full Box has no 
pertinent application in the current version. 

The Scroll Up One Line feature moves the screen up over the page in 
increments of approximately one line. 

To operate, move the mouse cursor to the scroll up box and press the 
mouse button once. To continue scrolling, press and hold the mouse 
button until the display is where you want it, then release the mouse 
button. For large movements, use the Vertical Scroll Bar instead. 

The Vertical Scroll Bar moves the screen up or down over the page 
by an amount that depends on how far you move the scroll bar. 

To operate, move the mouse cursor to the scroll bar, press and hold the 
mouse button, and "drag" the scroll bar up or down, depending on 
which direction you want the screen to move over the page. When the 
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Scroll down one 
line 

Size box 

Horizontal 
scrolling 
controls 
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USER INTERFACE 

scroll bar shows you the area of the screen that you want, release the 
mouse button. 

The gray area above and below the scroll bar indicates how much of 
the page is not displayed. For instance, if the gray area is three times 
as long as the scroll bar, then three times more page length is not shown 
compared to what is shown. 

To move up or down approximately one screen length, move the 
mouse cursor to the gray area above or below the scroll bar and press 
the mouse button once. 

This works identically to Scroll Up One Line, described previously, 
except that it moves the screen in the opposite direction. 

The Size Box is used to change the size of the Xerox Ventura Publisher 
window. It has no pertinent application in this version. 

These controls work like the Vertical Scroll controls, except that they 
move the screen horizontally. 
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Side-bar 

Mode selector 

Addition button 

Assignment list 

3-4 

Side-bar 

+- Mode Selector 

+- Addition Button 

+- Assignment List 

ta-"1I4 r Current Selection 

+- Page Number 

Figure 3-2 Side Bar. 

The left side of the screen, called the Side-Bar (Figure 3-2), consists 
of five features: the Mode Selector, the Addition Button, the Assign
ment List, the Current Selection indicator, and the Page Number 
indicator. 

The Mode Selector consists of four icons (pictures) in the upper left 
corner of the screen. These icons show which of the four major modes 
is currently enabled. The operation of the four major modes is 
described in the next chapter. 

Immediately below the Mode Selector is the Addition Button, which 
allows you to add a frame, tag, or text attribute, depending on which 
mode is currently enabled. You can activate the Addition Button by 
either selecting with the mouse, or holding the Ctrl key and then 
pressing 2. 

The Assignment List, located beneath the Addition Button, shows the 
items which can be assigned to whatever you have currently selected 
in the main screen area. The Assignment List displays, in alphabetical 
order, the choices available for each Xerox Ventura Publisher mode. 
Use the Assignment List to transfer a file, tag, attribute, or graphic 
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object from the Assignment List to the frame, paragraph, or text you 
have selected. 

~ If nothing happens when you point to the item in the Assignment List, 
you probably forgot to first select a frame, paragraph, or text. 

Current 
selection 
indicator 

Page number 
indicator 
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The operation of the scroll bars in the Assignment list is identical to 
that of the main screen scroll bars. 

The Current Selection indicator shows which item from the Assign
ment List is currently assigned to the frame, paragraph, text or graphic 
you have selected. 

The Page Number indicator shows which page is currently displayed 
and whether the page is a left or right page. When you change a tag, 
renumber sections, or go to another page, the page number indicator 
shows which page is currently being reformatted. 
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Mouse 
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Mouse 

The Mouse has two separate functions within Xerox Ventura 
Publisher: 

• Use it to move the Mouse Cursor to items on the screen that you 
want to select. 

• Use it to draw frames and graphics. 

Select items by placing the mouse cursor anywhere inside the item and 
then pressing the left mouse button once. Exact placement of the 
cursor is not critical as long as the cursor lies within the item you are 
selecting. 

Xerox Ventura Publisher uses only the left mouse button. 

When selecting file names, pressing the mouse button twice in a row, 
very quickly, is equivalent to selecting an item and then selecting OK. 

The mouse cursor changes shape depending on the mode selected, as 
shown in Figure 3-3. 
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Frame Mode + 
Add New Frame Ifi 

Re-size Frame ~ 
Pan Image ~ 

Move Frame + 
Paragraph Mode ~ 

Text Mode I 
Graphic Mode ~ 

Box Text ITe 
Line Drawing , 

Ellipse Drawing ffi 
Rectangle Drawing r 

Rounded Rectangle Drawing r 
Figure 3-3 Mouse Cursor Shapes 
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Keyboard keys 

Cursor keys 

Home 

End 

Pg Up 

Pg On 

Del 

Ins 

Backspace 

Esc 

Shift keys 

Keyboard keys 

Various keys on the keyboard perform special functions: 

Control the movement of the Text Cursor. 

Go to the first page of the document. 

Go to the last page of the document. 

Go to the previous page. 

Go to the next page. 

1. Deletes the character to the right of the text cursor when in the Text 
mode. 

2. Equivalent to selecting the Cut option in the Edit menu when a 
block of text, frame, or graphic is selected. 

3. Equivalent to selecting the Copy option in the Edit menu when you 
press the Shift key simultaneously with the Del key. 

Equivalent to selecting the Paste option in the Edit menu. 

Deletes the character to the left of the text cursor. 

1. Halts the print operation for the current chapter when printing. 

2. The Esc key can also halt a "go to page" operation. 

3. In a dialog box, the Esc key deletes all characters on the line that 
contains the text cursor. 

4. At all other times, the Esc key reformats the current page. 

1. When used in conjunction with the mouse, Shift Keys select 
multiple paragraphs, frames, or graphics. Press and hold down either 
shift key while selecting in order to select several items. 
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Tab key 

Special 
Function Keys 

Ctrl key 

USER INTERFACE 

2. In text mode, use the Shift keys to extend or diminish the range of 
text selected. Press and hold down either Shift key and then press the 
mouse button. The text selected will extend to the current text cursor 
location. 

3. Press the Shift key while adding frames or graphics to keep the Add 
New Frame or graphic tool enabled. 

4. Pressing the right Shift key and the Ctrl key simultaneously causes 
the keyboard cursor keys to toggle between controlling the text cursor 
(normal operation) and controlling the mouse cursor. 

1. Inserts horizontal tab characters. 

2. Within a dialog box, the Tab key moves the text cursor forward to 
the next line or, if the Shift key is pressed simultaneously, back to the 
previous line. 

Used to tag paragraphs, if the style sheet has assigned tags to these 
keys. See Assign Function Keys in the Menu Commands chapter. 

1. Use with the Enter key to insert a line break. 

2. Use with the Hyphen key to insert a discretionary hyphen. 

3. Press and hold the Ctrl key while selecting graphics or frames with 
the mouse to select graphics which are "hidden" beneath other 
graphics. 

4. Press the Ctrl and right Shift keys simultaneously to toggle the 
keyboard cursor keys between control of the mouse and text cursors. 

5. Press and hold the Ctrl key and then type X to recall the last dialog 
box. Within a dialog box, Ctrl X is equivalent to selecting Cancel. 

~ Ctrl X is equivalent to Cancel within the dialog box. At all other 
times, it recalls the last dialog box. 

Alt key 1. Use with the mouse to move cropped pictures within frames. Press 
and hold down the Alt key, move the mouse cursor to the center of the 
image to be moved, press and hold the mouse button, and then move 
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Keys for special 
characters 

Keyboard keys 

the image. Release both the Alt key and the mouse button when 
finished. 

2. Constrain graphics. Press and hold the Alt key while drawing 
graphics in the Graphic mode. The graphic will be constrained to 
perfect proportions (e.g., a circle instead of an ellipse). 

3. Add characters that are not on the keyboard. Press and hold down 
the Alt key, and type the numeric equivalent on the keypad for the 
character you wish to enter; then release the Alt key. Appendix E 
shows the numbers for each character. See the Text mode section in 
the Functions chapter for more information. 

Xerox Ventura Publisher provides the keyboard shortcuts shown 
below for commonly used typographic characters. These shortcuts can 
be used instead of typing a number with the Alt key pressed. Also 
shown are the keyboard combinations for various types of typographic 

spaces. The + sign indicates that you should press several keys simul
taneously. For instance, to create a copyright mark, press and hold both 
the Ctrl and Shift keys and then type C. 

Function 

Copyright mark © 
Discretionary hyphen 
Em dash-
Em space 
En space . 
En dash-
Figure space 
Non-breaking space 
Quote, open" . . . 
Quote, closed" 
Registered trademark ® 
Thin space 
Trademark ™ . . . . 

Key 

Ctrl + Shift + C 
Ctrl + -
Ctrl + 
Ctrl + Shift + M 
Ctrl + Shift + N 
Ctrl + [ 
Ctrl + Shift + F 
Ctrl + space 
Ctrl + Shift + [ 
Ctrl + Shift + ] 
Ctrl + Shift + R 
Ctrl + Shift + T 
Ctrl + Shift + 2 

Keyboard shortcuts 

3-10 

You can control many of Xerox Ventura Publisher's functions directly 
from the keyboard, as shown in the following table. 
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Keyboard keys 

Function 

Addition button 
Bring to Front . 
Cancel (from dialog box) 
Copy ... . 
Cut .... . 
Edit Special Item 
Enlarged View 
Fill Attributes . 
Frame Mode 
Go to First Page 
Go to Last Page 
Go to Next Page 
Go to Page .. 
Go to Previous Page 
Graphic Mode 
Insert Special Item 
Line Attributes 
Normal View 
Paragraph Mode 
Paste .. .. 
Recall Last Dialog Box (or Cancel) 
Redraw Screen 
Reduced View 
Renumber Chapter 
Save ..... 
Select All (graphics) 
Send to Back 
Show /Hide Tabs & Returns 
Show /Hide Side-Bar 
Text mode 
Update Tag List . . 

Key 

Ctrl + 2 
Ctrl + A 
Ctrl + X 
Shift + Del 
Del 
Ctrl + D 
Ctrl + E 
Ctrl + F 
Ctrl + U 
Home 
End 
PgDn 
Ctrl + G 
PgUp 
Ctrl + P 
Ctrl + C 
Ctrl + L 
Ctrl + N 
Ctrl + I 
Ins 
Ctrl + X 
Esc 
Ctrl + R 
Ctrl + B 
Ctrl + S 
Ctrl + Q 
Ctrl + Z 
Ctrl + T 
Ctrl + W 
Ctrl + 0 
Ctrl + K 

USER INTERFACE 

Cursor keys 
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While in a Dialog Box or Item Selector, or when operating in Text 
mode, you can move the text cursor to another location on the screen 
by moving the mouse cursor to the desired new position and pressing 
the mouse button once. Once you have positioned the text cursor, you 
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can use the keyboard cursor keys to move it back and forth one 
character at a time, as well as up and down one line at a time. 

Operation without a mouse 

During normal operation of Xerox Ventura Publisher, the keyboard 
cursor keys control the movement of the text cursor. You can however, 
choose to use the cursor keys to control the mouse cursor instead. 

~ Press the Ctrl and right Shift keys simultaneously to enable the cursor 
keys to control the mouse cursor. 

Your computer should emit a beep signal to indicate that the switch in 
cursor key functions has occurred. 

When the cursor keys control the mouse cursor instead of the text 
cursor, some of the cursor keys assume special functions: 

• Pressing the Home key once is equivalent to pressing and releasing 
the mouse button. 

• Pressing the End key is equivalent to pressing and holding the 
mouse button. To release the mouse button, press the Home key. 

• Press and hold either Shift key to reduce the amount the mouse 
cursor travels each time the cursor direction keys are presses. When 
you release the Shift key, the mouse will again travel a greater 
distance. 

To resume normal cursor keyboard control over the text cursor, press 
the Ctrl and right Shift keys again. You should again hear a beep to 
signal that the switch has occurred. 

If the keyboard keys affect neither the mouse nor the text cursor, press 
the Num Lock key once and try again. On many computers, Num 
Lock must be off for the keyboard cursor keys to work. 
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Dialog box 

Button 
controls 

Pop-up menus. Point to name of feature, press 
and hold mouse button. Make selection. Release 
mouse button. 

SIZING & SCALING 

I I I 

Upper Left X: 
Fral1le Width: 

Hariz. Padding: 

Picture Scaling: 

Upper Left Y 
Fral11e Height 

Vert. Padding 

B~ Scale Factors 

Aspect Ratio: limn;"",,' I Distorted I 

Help menu. Point to question mark, press 
and hold mouse button. Make selection. 
Release mouse button. 

B1.78 a8 
B1.17 
BB. BB inches _----t+- Point to the 

measurement units 
with the mouse 
cursor, and press 

X Crop Offset: BB.BB a 8 Y Crop Offset: BB.BB a 8 
Scale Width: B1.15 Scale Height: 01, 15 

the mouse button 
to change the 
measurement units 

DO I Cancel I 

Figure 3-4 Typical dialog box showing (clockwise from upper left corner) a pop-up menu, help 
button, measurement units control, and button controls. 
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Some of the menu options within Xerox Ventura Publisher function as 
simple commands which are executed as soon as you select them. 
Show Rulers, Copy, Cut, and Paste are examples of this type of 
option. 

Many menu options, however, contain features that require you to 
specify additional information. Whenever you select a menu option of 
this type (indicated by three periods after the option name in the 
menu), a Dialog Box appears on the screen. Dialog boxes control most 
of Xerox Ventura Publisher's features. 

A typical dialog box (see Figure 3-4) contains several types of controls 
as well as help information, including: 

• Button Controls. These controls operate much like the radio but
tons in a car radio. You can select from any of a series of rectangular 
boxes. When you make a selection, the previous selection is dis
abled. 
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• Pop-Up Menus. These appear whenever you select a dialog box 
option which is followed by the t symbol. Pop-Up Menus show all 
the available options for the feature you wish to change. You can 
select anyone option from this list. 

• Entering Text and Numbers. Many of the features let you specify 
text and number. These are typed using the keyboard or, in some 
dialog boxes, are set by selecting the arrow on a scroll bar. 

• Measurement Controls. The measurement system for dialog box 
settings can be changed within each dialog box. 

• Help Menus and associated Help Screens that give you on-line 
assistance concerning the function and operation of each feature. 
Help is accessed by selecting the ? in the upper right comer of the 
dialog box. 

Button controls and pop-up menus 

3-14 

If the option you want to change is shown inside a rectangular button: 

1) Point to the setting you wish to choose. 

2) Press the mouse button once. The background in the button just 
selected changes from white to black. For example, in Figure 3-4, 
By Scale Factors is selected. 

If the button you select is a Command or Insert, the background will 
not change to black permanently, but the command you requested will 
be executed. 

If the pop-up symbol is shown next to a selection, the options for that 
selection are available in a pop-up menu. The current setting for that 
option is shown after the colon. To access the pop-up menu and change 
the selection: 

1) Move the mouse cursor anywhere to the left of the pop-up symbol, 
and press and hold the mouse button. A pop-up menu appears (e.g., 
Flow Text Around in Figure 3-4). 

2) While still holding the mouse button, move the mouse cursor to the 
selection you want. Release the mouse button. 
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Entering text 

Accept or 
cancel settings 

USER INTERFACE 

If the text within the item you want to select is shown in gray instead 
of black type, this means that the item is not available for selection 
given the current dialog box settings. 

To type information into a dialog box, first place the text cursor on the 
line whose value you want to change. This is done either by moving 
the mouse cursor to the line whose value you want to change and then 
pressing the mouse button once, or by moving the text cursor from its 
current location using either the keyboard cursor keys, or tab and 
back-tab (Le., shift plus tab). The vertical text cursor then appears on 
the chosen line. 

• Use the Backspace key or Del key to erase some of the line 

• Use the Esc key to erase the entire line, or 

• Use the keyboard cursor keys to move the text cursor without 
erasing information. 

When the text cursor is positioned correctly, type the desired value. 

To accept the new settings in a dialog box, move the mouse cursor to 
the box labeled OK and press the mouse button. 

If you decide not to make any changes, move the mouse cursor to the 
box labeled Cancel and press the mouse button once. None of the 
changes will take effect. 

~ Pressing the Enter key on the keyboard is equivalent to selecting OK 
with the mouse button. Pressing the Ctrl key and then typing X is 
equivalent to Cancel. 

Measurement controls 
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Numerical settings in each dialog box may be set in inches, cen
timeters, picas & points, or fractional points. The measure used can be 
changed at any time. To change a measure, simply point to the unit of 
measurement (e.g., the word Inches), and press the mouse button once 
(Figure 3-4.) The unit of measure changes and the value for that 
setting is recalculated. Each press of the mouse button changes to the 
next unit of measure, until you return to the original measure. Fraction
al Points provides the greatest precision. 
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Dialog box 

When setting measurements in picas, the numbers to the left of the 
comma are picas, and to the right of the comma the numbers are points. 
Thus, to set three picas, two points, you should type 3,02. 

Since there are twelve points in a pica, 3,12 is equivalent to 4,00. 

For those not familiar with typesetter measures, seventy-two points 
and six picas both equal one inch. 

When changing between measurement units, the tilde ( .... ) character 
may appear. This indicates that the setting is too large to be displayed 
in that measurement unit. For instance, if you set the top margin to 2.00 
inches and then change to Fractional Points, you will see the tilde 
character because two inches is larger than 99.99 points, the largest 
setting allowed in that measurement unit. If the tilde is displayed, the 
original setting is not lost. Simply select a different unit of measure and 
make the desired changes in that different measurement system. 
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Item selector 

Description 

Application 

Directory Line 

Backup Button 

Directory Name 

FileName -- Scroll Bar 

Figure 3-5 Item Selector. Directory names are preceded by the • charac
ter. The backup button moves up one directory level. 

The display shown in Figure 3-5 is called an Item Selector. The Item 
Selector is used for saving and retrieving files and appears when you 
select any of the options in the File menu that are followed by three 
periods ( ... ). 

The Item Selector allows you to save and retrieve files by pointing to 
the file name, or by typing the file name. 

The Item Selector also provides a simple way to move between various 
DOS subdirectories. 

The Item Selector automatically "filters" the files displayed so that 
you need only search for files which match specified criteria (see 
Figure 3-5). When you are loading or saving chapters, for instance, 
only chapter files (which are stored with a file extension CHP) are 
displayed. The method for filtering files follows standard DOS con
ventions, including wildcard characters (e. g., * and?) You can change 
these filters by positioning the text cursor on the Directory line and 
typing a new filter name. Figure 3-5 shows the filter set to display all 
chapter (CHP) files that are contained in the subdirectory called 
LETTERS. 
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Operation To save or retrieve a file using the Item Selector, select the file name 
with the mouse and then select OK. 

3-18 

Until you press the mouse button while pointing to OK, you can 
change your mind and select some other file name. If you decide not 
to make any selections, point to Cancel and press the mouse button, 
or press and hold the Ctrl key and then press X. 

If the file name you are looking for is not shown, use the Scroll Bar to 
move up and down through the list of files. 

~ Pointing to the desired file name, holding the mouse stationary, and 
pressing the mouse button twice in rapid succession, is equivalent to 
selecting the file name and then selecting OK. 

When you wish to save a file for which a name does not exist, or if you 
prefer to use the keyboard, position the text cursor on the Selection 
line, type the new file name, and then select OK. 

~ If the computer beeps when the Item Selector is displayed, more than 
100 files match the file filter in the current subdirectory. The last files 
modified are not shown. Either change the file filter to restrict the 
number of files shown, or delete some files using the DOS File 
Operations option in the File menu. 

Changing directories 

To change directories or disk drives when saving or retrieving a file: 

1) Select the Backup Button (see Figure 3-5) to "back up" to the 
previous directory. This is equivalent to the DOS CD .. command. 
If you select the Backup Button while in the root directory, the 
currently available disk drives are shown. You can then select a new 
disk drive. 

2) To change to a new directory, select the directory name. As shown 
in Figure 3-5, directory names are always preceded by the diamond 
• character. 

Alternatively, you can change directories or disk drives by placing the 
text cursor on the Directory line and typing disk drive and directory 
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path. If the disk drive is not initially shown, move the text cursor to the 
beginning of the Directory line, erase the current drive letter, and type 
the new drive letter. 

Consult Appendix A for information on how to make other drive letters 
always appear within the Item Selector at the level above the root 
directory. 

When using the Item Selector, please note the following two cautions: 

~ If you have only one disk drive, and you select the B drive, DOS 
attempts to print a message on the screen telling you to insert a disk in 
the B drive. On some displays, you may not be able to read the 
message, and will see several jagged horizontal lines through the 
display. Ignore these lines, place a disk in the drive, and press Enter. 
The horizontal lines disappear as you continue working on your 
chapter. 

~ Be careful when reading files directly from a floppy disk. If you create 
a chapter with files from a floppy disk and then Save the chapter on 
your computer's hard disk, Xerox Ventura Publisher expects those 
same files to be available in the floppy disk drive when that chapter is 
next opened. 

File name conventions 
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The default file name extensions are shown below and on the next 
page. Changes to these default extensions remain in effect until next 
changed, even if you Quit and then return to Xerox Ventura Publisher. 

Program Extension 

ASCII TXT 
AutoCAD SLD 
CGM CGM 
DCA RFT 
GEM Line Art GEM 
GEM Image IMG 
HPGL HPG 
Lotus 1-2-3 PIC 
Macintosh Paint PNT 
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Program Extension 

Macintosh PICT PCT 
Mentor Graphics p* 

MS Word DOC 
Multimate DOC 
PC Paintbrush PCX 
PostScript Encapsulated EPS 
TIFF files TIF 
Video Show files PIC 
Windows WMF 
Wordperfect (4.2 and 5.0) WP 
Wordstar WS 
WordstarUK TXT 
Xerox Writer XWP 
Xywrite TXT 

Ventura Publisher File Extension 

Captions CAP 
Chapters CHP 
Chapter Information CIF 
Generated text GEN 
Fonts FNT 
Graphics VGR 
Hyphenation algorithms HY1, HY2 
Hyphenation dictionaries DIC 
Printer information file CNF 
Print files COO 
Publications PUB 
Style sheets STY 
Width tables WID 

~ If you can't find a file name, check to make sure that you are looking 
in the correct subdirectory, on the proper disk drive, or are using a file 
filter that matches the type of file you are retrieving (e.g., CHP or STY 
files.) 
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Xerox Ventura Publisher is designed to provide What You See (on the 
screen) Is What You Get printed (WYSIWYG.) This means that the 
computer display should match as closely as possible, at all times, 
what you will see on the final printed page. Of course, the difference 
between the technology used to display a page on a computer screen 
and the technologies used to print a page on a laser printer or typesetter 
do create some unavoidable differences. In particular, because a com
puter screen cannot produce anywhere near the same resolution as a 
printer or typesetter, and because what is displayed is shown in a 
different aspect ratio (height to width ratio), the space between words 
and between lines will appear larger or smaller on the computer screen 
than on the printed page. 

Color displays 

In order to see your document in color on the screen, you must use a 
VGA, Enhanced Graphics Adapter (EGA), or Display Enhancement 
Board (DEB) and compatible color monitor. However, even if a 
monochrome monitor is used, the text prints in the color chosen if a 
color printer is used. The user interface (menus, side-bar, etc.) still 
displays in monochrome even on a color monitor. 

Printer limitations 

REFERENCE GUIDE 

Most laser printers do not print to the edge of the page. Therefore, if 
you place pictures, graphics, or text near the edge of the page, these 
will show correctly on the screen, but will not print. Consult Appendix 
F for information on the blank space left at the edge of the page by 
your printer. Better still, print the CAPABILI.CHP chapter contained 
in the TYPESET directory. This will show you exactly what your 
printer can-and cannot- do. 
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Frame Paragraph Text Graphic 

Figure 4-1 Mode Selector. The Frame mode is enabled. 

This chapter provides a task-oriented summary of Xerox Ventura 
Publisher's page layout operations, organizing them according to the 
functions they perform. 

Modes of operation 

REFERENCE GUIDE 

The concept of modes of operation is central to the logic of creating 
documents with Xerox Ventura Publisher. Each of the following four 
major modes controls a different group of operations. 

• The Frame Mode allows you to place pictures on the page or in 
frames, and allows you to create, cut, copy, and paste frames. 

• The Paragraph Mode allows you to apply typographical and page 
layout attributes to an entire paragraph (or group of paragraphs). It 
also allows you to create style sheets which contain these attributes. 

• The Text Mode is a built-in word processor that allows you to add 
and delete text, and also to change the font (e.g., typeface and size) 
and attributes (e.g., underline) of any selected text on the page. 

• The Graphic Mode is a built-in drawing program which allows 
you to annotate any frame that you draw, produce forms, create 
additional ruling lines, and much more. Many of the Frame Mode 
functions are also available in Graphic Mode. 
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Menu 
commands 
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To enable a mode, move the mouse cursor to the appropriate box in the 
Mode Selector and press the mouse button once. The background of 
the selected icon changes from white to black, and the contents of the 
Assignment List immediately change to show the attributes available 
in that mode. The menu options available to you in that mode appear 
in black, those not available appear in gray. In Figure 4-1, the Frame 
mode is selected. 

The Menu Commands chapter (the chapter after this one) describes 
the operation of each menu at the top of the screen. For the most part, 
Frame mode options are found in the Frame menu, Paragraph mode 
options in the Paragraph menu, Text mode options in the Edit menu, 
and Graphic mode options in the Graphic and Frame menus. 

You can access options in the File, Chapter, and Options menu regard
less of the mode you have selected. 

The following pages describe how to use each mode. 
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Frame mode 

Frame definition 

A frame is a rectangular area of the page which can contain text, line 
art, or images. You draw frames using the Add New Frame function 
described later in this section. In addition, the page itselfis aframe. 

Although frames which you draw are similar in most ways to the page 
itself, you will find some differences: 

• Frames which you draw can be cut, copied, re-sized, or moved; the 
page cannot. 

• When text fills a frame that you've drawn, you must draw a new 
frame to hold it. However, when text fills the page, Xerox Ventura 
Publisher creates a new page automatically. 

For newsletter and magazine layout, place text in manually drawn 
frames. For books and technical manuals, place text directly onto the 
page. See the Putting It Together chapter for more information on 
when to place text in manually drawn frames and when to place it in 
the page itself. 

Frame mode application 
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The Frame mode allows you to: 

• Create new frames 

• Place files from the Assignment List into frames 

• Select, move, re-size, copy, and delete frames 

• Remove files from selected frames, or from the Assignment List 

• Change frame attributes such as column balance, margins and 
columns, ruling lines, captions, and background pattern 

• Cause frames to repeat on every page. 
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Add new frame 

The Addition Button (see Figures 3-1 in the previous chapter) dis
plays the words Add New Frame when the Frame or Graphic mode 
is enabled. Add New Frame has three primary purposes: 

• Add new frames to an existing layout. This allows you to place text 
and pictures wherever you want. 

• Block text from flowing into unwanted areas of the page. This is 
particularly useful for constructing runarounds, where text is made 
to flow around an irregularly shaped object. 

• Add additional space between lines or paragraphs. 

To add a new frame, follow these steps: 

1) Select the Frame mode (Figure 4-1) and then select the Add New 
Frame button (or hold the Ctrl key and then press 2). 

2) Move the mouse cursor to the point on the page where you want to 
start the upper left comer of the frame. 

3) Press and hold the mouse button. 

4) Drag the lower right comer of the frame to the desired location 
(Figure 4-2) and release the mouse button. Text already on the page 
flows around the frame (Figure 4-3). 

The Adventure Begins 

T his trip really began in Sep- Western Pacific, we 
tember last year when Gerry and 42 minutes out 

won first prize in a raffle at the geles with about 2 rno 
fashion show which Rush-Pres- ............. g.~ .... ~.<:>. .... I~.~y~.: ... , We were 
byterian-St. Luke's lMea'i'car"C'en~ hour and ten i minutes I 
ter holds every yee!.r. The prize Los Angeles. : 
was two round trip tijckets to Hong 11 : 03 P. M~ Chic a 
Kong on United Ai~ines, and ten 39,000 feet s9mewhe 
nights in the Hong Kong Hyatt Western Paci~ic, we 
Hotel. Analyzing ~ur good for- and 42 minu~es out 
tune, we conclu~ed that we geles with abiout 2 mo 
~anted to do ~ore tha~"'s'p'e'rl'(f~e'n' ·············~·o·· .. to····To·~yo:···~e wer~ .. 

Figure 4-2 Adding new frame. Mouse button still pressed down. 
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The Ad venture Begins 

T his trip really began in Sep-
tember last year when Gerry videotape. 

won first prize in a raffle at the 11 :03 P.M. Chic 
fashion show which Rush-Pres-
byterian-St. Luke'sf' ........ ·· .........•. 

Medical C enterl 
holds every year.! 
The prize was two~ 
round trip tickets to! 
Hong Kong onl 
United Airlines, and..................... • ................................ ... 
ten nights in the Hong Kong Hyatt and ten 

Figure 4-3 Adding new frame. Mouse button released. Textflows aroundframe automatically, and 
addition button is no longer highlighted. 

~ Text containing horizontal tabs will not flow around frames if the tab 
stops and the frame occupy the same position on the page. 

Add multiple 
frames 

Once the mouse button is released, Xerox Ventura Publisher automat
ically de-selects the Add New Frame button, and the frame just created 
is selected. This allows you to move or re-size the frame just created, 
or to place a file from the Assignment List into the Frame immediately. 

To prevent Xerox Ventura Publisher from automatically de-selecting 
the Add New Frame button, press and hold either Shift key on the 
keyboard prior to drawing a frame. As long as you hold the Shift key, 
Xerox Ventura Publisher allows you to draw another frame without 
first selecting the Add New Frame button. 

When you draw multiple frames that occupy the same location on the 
page, the last frame drawn on a page is placed on top of all other 
frames. Text placed in lower frames flows around frames on top. To 
place an existing frame on top, cut that frame and then immediately 
paste it back to the page. 

~ If text from a file is placed into more than one frame on a page, it 
always flows first into the frame which you drew first. 
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Placing files into frames 

To place files in frames, follow these steps: 

1) Select the Frame mode (i.e., the left box in the Mode Selector). 

2) Use the Load Text/Picture option (Figure 4-4) to build up a list of 
text, image, and line art files in the Assignment List. See the Load 
Text/Picture option in the Menu Commands chapter. 

LOAD TEXT /P ICTURE 

T~pe of File: lliilllmlD ~ 
Line·Art Forlllat: crno tMlilijiA'II' I Lotus .PIC I I Mentor Gr I 

I UideoShow I IJ!EJ1ill I PostScript I 
cmo ~ I MS Windows I 

~ of Files: liD I Several I 

Figure 4-4 Load Text/Picture dialog box set to load AutoCAD file. 

3) Select the frame and then select the file from the Assignment List 
(Figure 4-5). If a file is already in the frame, the new file takes its 
place. The old file remains in the Assignment List, and its contents 
are not affected. 

The Current Selection Indicator in the side-bar shows the name of the 
file that is currently placed in the selected frame (Figure 4-6). 

When a text file is placed directly on the page, any text that does not 
fit on the page automatically flows to succeeding pages. However, 
when placing text in a frame you have drawn, you must first manually 
select the next frame in which you want the text to continue, and then 
select the file name in the Assignment List. The remaining text will 
then flow into that frame. 

~ You must always select a frame or the page before selecting a file to 
place in the frame or page. If no frame is selected, nothing happens. 
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Figure 4-5 Select the frame first, then select the file you want to occupy that frame. 

.-_ .. _---_._---_. __ ... _---------_ ... _---_._--_ ...... _----_ ..... -----

I Chapter 

1 The Adventure Begins 
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Figure 4-6 After the mouse button is pressed, the picture is placed in the selectedframe. 
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You can place the same line art or image file into more than one frame 
in a chapter and scale that picture differently in each frame. A text file, 
however, can only be used once in a chapter even if it fits entirely into 
one frame. An exception is Repeating Frames which allow the same 
text to appear on every page. See Repeating Frames in the Frame 
section of the Menu Commands chapter. 

Removing files from frames 

REMOVE FI lE rn 
File Narqe: GRAPH2 • PIcl 

Figure 4-7 Remove File dialog box. GRAPH2.PIC will be removed both 
from the list offiles in Assignment List andfrom the frame. 

You can remove a file from a frame either by placing another file in 
the frame, or by selecting the frame and then selecting the Remove 
File option in the Edit menu (Figure 4-7). Within this option, select 
From Frame in the pop-up menu to remove the file from the frame 
only. See Remove TextlFile in the Edit section of the Menu Com
mands chapter. 

Types of files in frames 

Xerox Ventura Publisher can place text or picture· files into frames 
(Figure 4-8). Text files can originate in another word processor or be 
entered using the built-in word processor. Pictures, on the other hand, 
are always created and edited in another program. Pictures can be 
either Line Art or Images. 

Line Art refers to pictures stored as vectors and objects (mathematical 
expressions), whereas Images refers to pictures stored as simple bits 
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frame in the page. All frames 
drawn after this frame will be 
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this frame. Text 
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Modes of Operation 

Line 
Art 

Figure 4-8 Text, line art, and images can all be placed inframes. 

(1 's and O's). Because the mathematical expressions can be re-com
puted to achieve the resolution required by any output device (printer 
or typesetter), line art always prints at the maximum resolution that the 
output device can produce. By contrast, images can never be printed 
with more resolution than when they were first created. For instance, 
an image created with a 300 dot per inch scanner and printed on a 1200 
dot per inch typesetter provides only 300 dots per inch quality. On the 
other hand, line art created on the computer screen (which is relatively 
low resolution), still prints with 1200 dots per inch resolution. 

Moving frames 
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To move a frame and its contents to another position on the page: 

1) Select the frame. 

2) Place the mouse cursor within the frame, and press and hold the 
mouse button. The mouse cursor changes to a picture of a cross with 
arrows on each end. 

3) Move the frame to the desired new location, then release the mouse 
button (Figures 4-9, 4-10). If Turn Column Snap On is selected 
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from the Options menu, the frame aligns with the nearest column 
guide when placed near that guide while you are drawing. 

Re-sizing frames To increase or decrease the size of a frame: 

Change size of 
picture only 

Move, 
copy, 
delete 

Select multiple 
frames 

4-10 

1) Select the frame. 

2) Place the mouse cursor inside one of the eight sizing buttons found 
around the perimeter of each selected frame (Figure 4-10). 

3) Press and hold the mouse button. The mouse cursor changes to a 
picture of a finger. 

4) Continue holding the mouse button and move the selected corner 
or edge to the desired new location. When you are satisfied with the 
placement, release the button. 

If the mouse cursor changes to a picture of a cross with arrows on each 
end instead of a picture of a finger, you have not placed the cursor 
inside the sizing buttons. 

To change the placement of a picture within a given frame size, first 
select the frame, then select the Margins & Columns option in the 
Frame menu. To reduce the area occupied by a picture, select larger 
margins, to increase the area occupied by a picture, decrease the 
margin size. To place the picture to the right side of the frame, increase 
the left margin; to place the picture at the bottom of the frame, increase 
the top margin, and so on. 

To copy or move a frame to another page, or to delete a frame, follow 
the instructions given under Cut, Copy, and Paste, described in the 
Edit menu section of the Menu Commands chapter. 

You can select more than one frame simultaneously and then move, 
cut, copy, or paste the entire group. 

1) Press and hold down either Shift key on the keyboard. 

2) Select each frame with the mouse. 

The Current Selection Indicator displays the word Multiple to indicate 
that more than one frame has been selected. To deselect a single frame 
in a group, first point to the frame while holding down the Shift key, 
then press the mouse button once. 
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Figure 4-9 Place mouse cursor inside the frame. Press and hold the mouse button. Move the frame 
to the new location. Release the mouse button. 

MAGL 1FT _ TXT 

NEWSLOGO. TXT 

:"Ch~Pt~~"1""''''''''''''''''''''''''''''''''''''''''''''': 

: The Adventure Begins : 

i This trip really began in Septemberi 
ilast year when Gerry won first prize! 
iin a raffle at the fashion show whichi 
!Rush-Presbyterian-St. Luke's Medi-i -, / 

Sizing buttons 

• 
.. • 

:cal Center holds 
ievery year. The 
:prize was two 
iround trip tickets 
~o Hong Kong on 
iUnited Airlines, 
iand ten nights in 
~he Hong Kong 
Hyatt Hotel. 
!Analyzing our 
igood fortune, we concluded that we: 
!wanted to do more than spend teni 
~ • •• • .,. • I.. ..: 

Figure 4-10 Frame moved to new location. 
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on bottom 

Frame mode 

When one frame is underneath another frame, it sometimes seems 
impossible to select the frame on the bottom. To select a frame which 
is covered by several other frames: 

1) Select the Frame mode. 

2) Press and hold the Ctrl key and then select the first frame. 

3) While holding the Ctrl key, press the mouse button again to select 
the next frame down from the top. 

4) Continue pressing the mouse button, while holding the Ctrl key, 
until you select the desired frame. 

Runarounds 

4-12 

Normally, text that is already on a page flows around a newly created 
frame. However, text can be made to flow behind a selected frame by 
turning Text Flow Around Off in the Sizing and Scaling option 
(found in the Frame menu.) You can use this feature to make text 
follow the outline of an irregular object (a runaround) as follows: 

1) Create a frame. 

2) With this frame selected, turn Text Flow Around: Off in the Sizing 
and Scaling option. 

3) Place a picture in the frame. You should now have an image which 
overlaps text, as shown in Figure 4-11. 

4) Select the Add New Frame button and place boxes over each 
portion of the picture that you want to be free of text. To keep the 
Add New Frame button selected, hold down either Shift key while 
placing these frames. See Figures 4-11, 4-12 and 4--13. 

Adding space between lines 

You can add space between paragraphs using narrow frames. Tum 
Column Snap and Line Snap (Options menu) On to assure that these 
frames reach the exact edges of the columns and to force each frame 
to be exactly 1,2,3, etc. lines high (See Figure 4--14.) 
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Figure 4-11 Flow text around turned off. 

Figure 4-12 Multiple Frames added to create runaround. 

REFERENCE GUIDE 

Modes of Operation 

4-13 



Modes of Operation Paragraph mode 

Analyzing our good fortune, 
ncluded that we wanted to do 
than spend ten days in Hong 
and return, but at the same 

United, having just gotten its 
and equipment from 
erican, had not yet 

d authority to fly to 
de stinations 

rity, and , 
ruary 11th Debbie began put-i 

ur trip together. We left oni 
DmI •••••• fh 2nd and returned on March: 
IiII We entered seven countries, i 

over 25,000 miles on fouri 
ade over 500i 

ouds over a rough 
many fishing boats an 

:vessels all headed into To 
iapproach into the Narita 
ivolved a long, slow de 
iafter passing the shoreline 
ily reminiscent of the West 
!Lake Michigan although 
isandy beaches), gave us 
~unity to see many small 
icultivated ground. Tiny 
ieven small factories. 

Figure 4-13 Completed run around. 
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Figure 4-14 Adding aframe to make columns balance. 
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Enabling the 
paragraph mode 

Tagging with 
function keys 

REFERENCE GUIDE 

Figure 4-15 Paragraph mode 

The Paragraph mode is used to assign style sheet tags from the 
Assignment List to selected paragraphs. Tag attributes are changed 
through the options in the Paragraph menu. A paragraph is defined as 
any group of words or numbers followed by a carriage return. 

The Paragraph mode allows you to format the chapter without having 
to specify point size, typeface, spacing, ruling lines, etc. for each 
paragraph. 

To enable the Paragraph mode, select the second box from the left in 
the Mode Selector. (See Figure 4--15.) The tags available within a style 
sheet appear in the Assignment List. Each time you select a paragraph, 
the tag currently assigned to that paragraph appears in the Current 
Selection Indicator. 

Once the Paragraph mode is enabled, you first select a paragraph with 
the mouse and then select a tag from the Assignment List (Figures 
4-16 and 4-17). If multiple paragraphs are selected (see next page) the 
same tag is assigned to all of the paragraphs. The paragraph selected 
is highlighted in reverse video (white text on black background.) To 
de-select a paragraph, either select another paragraph, or move the 
mouse cursor to a part of the page which contains no text and press the 
mouse button once. 

Up to ten tags from the Assignment List can be assigned to your 
keyboard's function keys (see Update Tag List in the Menu Com
mands chapter). You can then assign a tag to a paragraph simply by 
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Figure 4-16 Selecting and tagging a paragraph. The tag Chapter Title will be assigned. 
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Figure 4-17 After the mouse button is pressed, the paragraph is changed. Note how the tag has 
changed not only the font, but the space between paragraphs as well. 
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pressing the appropriate function key. You can also use the function 
keys to tag text while you are in Text mode. 

You can assign one tag to several paragraphs simultaneously by 
following these steps: 

1) Hold down either Shift key on the keyboard. 

2) Select each paragraph with the mouse. The Current Selection 
Indicator displays the word Multiple to indicate that more than one 
paragraph has been selected. 

3) To de-select any paragraph in a Multiple group, select the para
graph while still holding the Shift key. 

4) Select the tag name in the Assignment List or press the appropriate 
special function key. The tag is applied to all selected paragraphs. 

Text in headers, footers, section numbers, captions, table of contents, 
and indices are automatically tagged with Generated Tags. Generated 
Tags are created by Xerox Ventura Publisher, and always have names 
which begin with Z_. Generated Tags are assigned Body Text at
tributes when first created. You can change Generated Tags as you 
would any other tag. 

When you tag a header or footer, the entire header or footer is selected. 

Add new tag 
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The Add New Tag features allows you to create new paragraph tags. 
(See the Putting It Together chapter for more details on how to use 
these feature to create new sty Ie sheets.) 

The words Add New Tag appear in the Addition Button when the 
Paragraph mode is enabled. 

To add a new tag, select the Add New Tag button or hold the Ctrl key 
and then press 2. The Add New Tag dialog box shown in Figure 4-18 
appears. Enter the name of the new tag. If you want to copy the settings 
from a tag other than the one selected, enter that tag's name on the Tag 
Name to Copy From line. Select OK when finished. The new tag 
name immediately appears in the alphabetized Assignment List. 
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ADD NEW TAG [1] 
Enter new tag name 

Tag Nane to Add: on this line 

OK I Cancel I 

Figure 4-18 Add New Tag dialog box. 

New tag's initial 
attributes are copied 
from this tag. 

If a paragraph is already selected when you select the Add New Tag 
button, the Tag Name to Copy From line is automatically set to that 
paragraph's tag name. If you don't want to use that tag as a starting 
point, use the keyboard cursor keys to erase that name and enter a 
different tag name. 

When you select OK, the currently selected paragraph is tagged with 
this new tag. 

If you wish to remove the currently selected tag from the Assignment 
List, select the Update Tag option from the Paragraph menu, then 
select Remove Selected Tag from the dialog box. The Update Tag 
List section of the Menu Commands chapter provides more detailed 
guidance on this option. 

To modify a given tag: 

1) Select a paragraph already formatted with the tag you wish to 
modify. 

2) Select any of the options in the Paragraph menu and make the 
changes you desire. 

Note that as soon as you select OK, every paragraph in the entire 
chapter already formatted with this tag will be changed. If you then 
save the chapter or style sheet, the change to this tag will be per
manently saved in the style sheet. 

See the chapter Putting It Together for a complete explanation of how 
to create new style sheets. 
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Text mode 

-----------------------._--

Figure 4-19 Text mode enabled. 

The Text mode is a word processor which can be used to: 

• Change text attributes (bold, italic, subscript, point size, etc.) 

• Interactively kern and track text 

• Add, delete, copy, or move text 

• Insert index references, frame anchors, and footnotes 

• Compose a new document directly in Xerox Ventura Publisher. 

Changing text attributes 
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Using the Text mode, you can make font and attribute changes to 
single characters and blocks of text. By contrast, the Paragraph mode 
changes all attributes, including line spacing, for the entire paragraph. 

Text attributes include: 

• Bold 

• Italic 

• Overscore 

• Small caps 

• Subscript 

• Superscript 

• Underline and Double Underline 
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Figure 4-20 Selecting text to change attributes in Text mode. 

To change text attributes: 

Select the Text mode (Figure 4-19.) The cursor changes to an 
"I -Beam" and the Assignment List displays the list of text attributes 
available. 

• Next, move the mouse cursor directly in front of the first letter to 
be selected. 

• Press and hold the mouse button. 

• While holding the mouse button, drag the mouse cursor to the end 
of the last character in the text you want to select. 

• Release the mouse button. 

The selected text (Figure 4-20) is shown in reverse video (white text 
on black background.) If the wrong text is selected, repeat the selection 
process. 

You can also select text by the following steps: 

1) Move the mouse cursor to the beginning of the text you want to 
select. 

2) Press and then release the mouse button. 

3) Move the mouse cursor to the last character III the text to be 
selected. 

4) Press and hold the Shift key, then press the mouse button once. 
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Set Font 

~ You can extend or shorten an existing selection by using this Shift key 
and mouse combination. Note, however, that text cannot be selected 
across page or frame boundaries. 

Once text is selected, you can assign as many of the attributes in the 
Assignment List as you desire. For instance, to change the selected text 
to boldface and underline, select the Bold attribute in the Assignment 
List, then select Underline. 

Selecting Normal clears all attributes within the selected text and 
returns text to the attributes set by the paragraph tag. 

~ Selecting Normal returns text to the font set by the paragraph tag. If 
the paragraph tag is set at bold, italic, etc. and you want to set the 
selected text's font to Normal style, use the Set Font option described 
in the next section. 

The Capitalize attribute converts selected text to initial capital letters. 
Upper Case changes every letter to upper case. 

Normal restores text to the attributes specified in the paragraph tag. It 
does not, however, undo case conversions (e.g., upper case to lower 
case.) 

Text and font attributes that you set using the Text mode take 
precedence over font attributes applied with a paragraph tag. They will 
always override the attributes of the paragraph tag. 

To change the font of selected text: 

1) Select the Text mode. 

2) Select the text whose font you wish to change. 

3) Select the Set Font option in the Addition Button. The Font Setting 
For Selected Text dialog box appears (Figure 4-21). 

4) Select the Face, Size, Style, and Color you desire and then select 
OK. 

Interactive font 
selection 

If you have selected a width table which allows you to select Custom 
Size in the font menus, you have access to an additional feature: 
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Interactive Font Selection. This feature allows you to increase and 
decrease the font of selected text one point at a time simply by pressing 
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Text mode 

Shift plus the up or down cursor arrows on your keyboard. To use this 
feature: 

1) Select the range of text you want to change. 

2) Press and hold either Shift key and press the up or down arrows on 
the keyboard. The font will get increase of decrease by one point 
each time you press the up or down arrow. 

Because the font size increases or decreases by one point each time 
you press the up or down arrow, Interactive font selection works best 
when using a printer or typesetter for which Custom Size is enabled 
in the Paragraph font menu (e.g., a PostScript printer). For other 
printers, you must press the up or down arrow several times to go from 
one font selection to the next. For example, if your printer has 14 and 
18 point sizes available for a particular typeface, then you must press 
the up arrow four times to change from 14 to 18 point. 

Kerning is the process of moving letters closer together, and is usually 
used in headlines where certain letter combinations, such as a capital 
V followed by a capital A, appear to be too far apart when spaced with 
normal proportional spacing. For example, the A in the word VALUE 
is kerned in the second line on the next page. 

Un-kerned text: V AL UE 

Kerned text: VALUE 
Tracking is the process of moving every letter in a word or sentence 
either further apart or closer together. 

Interactive kerning/tracking can be used in several ways to: 

• Make text fit a give space. 

• Improve the appearance of large headlines. 

• Locally adjust typography without creating a new paragraph tag. 

This feature is particularly useful in creating headlines and titles, since 
you can instantaneously see the effect of your changes on the overall 
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FONT SETTING FOR SELECTED TEXT 

Courier 
S9Abol 
Avant Garde Gothic Book/DeAi 
IT( BookAan Light/DeAi 
Helvetica Narrol! 
Palatino 

CUStOA Size: 912. ~ points 

Overscore: Off I Shift: Up 9.999 inches 
Strike' Thru: Off I Kern: Looser 9.99 EMS 

Underline: Off t 
Double Under line: Off t 

Figure 4-21 Font Setting dialog box. Typeface selection shown is for Post
Script printers. 
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Figure 4-22 Selected text font change using Set Font option. 
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Text mode 

layout. This feature can also be used to manually kern (move to the left 
or right) individual characters. 

To use the interactive kerning/tracking feature, follow these steps: 

1) Select the Text mode. 

2) Select a range of characters. 

3) Press and hold either Shift key and press the left or right arrow on 
the keyboard. 

Each time you press an arrow key, every letter in the selected text is 
moved closer together (left arrow) or further apart (right arrow). 

Alternatively, after selecting the characters, select the Set Font option 
which occupies the Addition Button when you are working in Text 
mode. The Font Setting For Selected Text dialog box appears (Figure 
4-21). Then: 

1) Select Kern: Looser to move the characters apart and Kern: 
Tighter to move the characters together. 

2) Immediately to the right of this selection, enter the amount of space 
to add (looser) or subtract (tighter) between each character. 

The amount you enter is measured in Ems, where one Em equals the 
width of the @ character in the currently selected font. You will 
quickly discover that adding one full Em between each character 
makes a dramatic difference. Most kerning changes are made in small 
fractions of an Em. 

To move an individual letter to the left or right 

1) Select only a single letter. 

2) Press and hold the Shift key. 

3) Press either the right or left keyboard cursor key. The text/allowing 
the selected letter will move in the direction of the arrow. 
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You can shift selected text up or down. In the Font Settings dialog box 
(Figure 4-21), select Shift: Up to move the text up, or Shift: Down to 
move the text down. Then enter the amount by which you wish to shift 
the text. 

Add, delete, copy, and move text 

Foreign 
language and 
special 
characters 
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The Text mode allows you to add and delete text. When adding and 
deleting text, use the Show Tabs & Returns option in the Options 
menu in order to see hidden formatting characters. 

To add or delete existing text: 

1) Move the mouse cursor to the point directly after the character to 
be edited and press the mouse button. A vertical cursor appears, 
indicating that you can begin typing. 

2) Use the Backspace key to delete text directly to the left of the 
cursor, and use the Del key to delete text directly to the right of the 
cursor. 

3) Press any character key on the keyboard to add text. 

You can also add many characters not on the keyboard including: 

• Foreign language and special typographic characters 

• Math and greek characters 

• Line Breaks 

• Special spaces 

• Discretionary hyphens 

The fonts included with Xerox Ventura Publisher include foreign 
language and other special characters. These are useful for several 
tasks: 

• Adding foreign words. 

• Adding real typographic characters such as: 
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Text mode 

- Em dashes (- instead of --) 

- True typographic quotes (" " instead of ") 

- Trademark and copyright symbols (®, ©). 

• Creating simple mathematical equations. 

To add characters not on your keyboard: 

1) Locate the desired character and its numeric decimal equivalent in 
Appendix E. 

2) Hold down the Alt key on the keyboard. 

3) Enter the decimal number using the numeric keypad. 

4) After the number is entered, release the Alt key. The character 
appears on the screen. 

For instance, to enter the registered trademark symbol ®, press the Alt 
key and type 190. 

You can delete foreign language and special characters and change 
their attributes changed just like any other keyboard character. 

If a special or foreign character entered does not print, this character 
may not be available for the printer you have currently selected. Print 
the CHAR SET chapter located in the TYPESET directory to see the 
character set for your printer. 

Xerox Ventura Publisher provides a mathematical and Greek character 
set. Unlike the additional characters described in the previous section, 
these characters are selected by changing to the Symbol typeface. 
When you tag a paragraph with a symbol font tag, every character in 
the paragraph is converted to a symbol character. For instance, an 
upper case F (decimal code 70) displays as <1>. 

To change all characters in a paragraph to symbols, select the Para
graph mode, then create a new tag and change its typeface to Symbol. 

To create occasional symbols within a paragraph: 

1) Select the range of text you wish to change. 

2) Use the Set Font button to change this range of text to Symbol 
characters. 
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Although not designed specifically to generate complex mathematical 
equations (e.g., large integrals, complex fractions, matrices, etc.), 
Xerox Ventura Publisher can easily generate simple formulas using the 
symbol character set. For instance, to put a 1t in the formula 

1) Type pr2 

2) Select the letter p. 

3) Use the Set Font button to change this one letter to Symbol 
typeface. 

Use superscript, subscript, or the Set Font Shift option to create 
powers and subscripts. 

~ The Professional Extension to Xerox Ventura Publisher contains a 
sophisticated equation program. Contact Xerox for more information. 

When creating headlines and tables, you may want to end a line within 
a paragraph without breaking the text into two paragraphs. This is done 
with a Line Break. Line breaks are created by holding down the Ctrl 
key while you press the Enter key. Line breaks add the normal 
inter-line spacing, but no inter-paragraph, above, below, or ruling line 
space. 

Line breaks 
Line Break Example 

This is a paragraph +--4 --------/-11 
which is broken +-4----------" 

into three lines using a line break 

This is a second paragraph 

This is a third paragraph 

Spaces Xerox Ventura Publisher can create several types of spaces that you 
can insert into your documents when working in Text mode. Typical 
examples of situations in which you might use such spaces include: 
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Text mode 

• Inserting a fixed width space when you don't want the space 
between two words to change, or when you want to add space 
between two numbers in a table without causing the table to mis
align. 

• Inserting a non-breaking space when you want to keep two words 
together on the same line. 

The fixed width spaces - Em, En, Thin, and Figure spaces -
neither increase nor decrease in size during justification. When work
ing with text rather than with numbers, choose from among the Em, 
En, and Thin spaces. The Em space is the width of the M character in 
any font (Xerox Ventura Publisher actually uses the @ character which 
provides better typographic results); the En space is the width of the 
lower case n; and the Thin space is the width of a period. 

When you want to add space in tables of numbers that must remain 
aligned, choose the Figure space, which is the width of a number. All 
numbers are the same width, even in proportionally spaced fonts. 

The Non-breaking space, on the other hand, changes in width as space 
is added or subtracted to make a line justify. Use the Non-breaking 
space to keep two words together on one line. 

The following list summarizes the keyboard combinations used to 
create these special types of spaces: 

Em space 
En space 
Figure space 
Thin space . 
Non-breaking space 

Ctrl + Shift + M 
Ctrl + Shift + N 
Ctrl + Shift + F 
Ctrl + Shift + T 
Ctrl + Space 

Use discretionary hyphens to tighten a loose line. A loose line is a 
line of text which contains too much space between words because the 
first word of the next line could not be hyphenated during the justifica
tion process. You can manually hyphenate this word by inserting a 
discretionary hyphen. Unlike a normal hyphen, a discretionary hyphen 
only appears if the word is at the end of a line. The example on the next 
page shows how a discretionary hyphen can tighten a loose line. 

Placing a discretionary hyphen at the beginning of a word suppresses 
hyphenation for that occurrence of the word. If you place a discretion-
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This line is too loose because the word overextended has 
not been hyphenated. 

This line is not loose because the word overextended has 
been hyphenated with a discretionary hyphen. 

ary hyphen at the beginning of a compound word such as Alsace-Lor
raine, then that word will not be broken, even at the normal hyphen. 

To add a discretionary hyphen to any word: 

1) Place the text cursor at the point in the word where you wish a 
hyphen to be inserted 

2) Press and hold down the Ctrl key 

3) Press the - key Gust above the P key on most keyboards.) This 
hyphen is neither displayed on the screen nor printed unless the 
word needs to be hyphenated. If Show Tabs and Returns is turned 
on, a small hyphen is displayed at each discretionary hyphen point, 
although this hyphen is not printed. 

As you move the text cursor across a word containing a discretionary 
hyphen, the discretionary hyphen's presence is displayed in the Cur
rent Selection Indicator box. Once you have displayed the discretion
ary hyphen, you can remove it by pressing the Del key. 

Start a new document 
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You can use Xerox Ventura Publisher to just like any word processor 
to create new text files. The reSUlting files can be saved in any file 
format available (e.g., Wordstar, Wordperfect, DCA.) 

• To create a new text file, select the Text mode and place the text 
cursor anywhere on the page. Begin typing. The text will begin at 
the upper left comer of the page. 

• To place text at a specific location, select the Graphic mode and 
then use box text (described in the Graphic mode section) to place 
the text at the location you desire. 
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• To save a text file, select the Save As option in the File menu and 
save a new Chapter. A text file will be created with the same file 
name as the chapter, but with the file extension for the word 
processor that you most recently selected through Load Text/Pic
ture in the Edit menu. If no other text files have been loaded, Xerox 
Ventura Publisher will save the new file in ASCII format. 

To change the file extension or wordprocessor format: 

1) Select the Frame mode. 

2) Select the page. 

3) Select the File Type/Rename option in the Edit menu. 

4) Change the default extension on the New Name line. 

5) Change the word processor file format by selecting the appropriate 
Text Format. 

Text editing hints 

4-30 

As you add or delete text, the page automatically reformats as you 
type, so you can always see the effect on the page layout. When editing 
across page boundaries, press the Page Down key to go to the next 
page, and place the cursor at the point where you wish to resume 
editing. When the cursor reaches the edge of the screen, use the scroll 
bars to move the screen and then resume editing. 

As you add or delete text, you may occasionally see some extra "ink" 
around certain characters and ruling lines. Press the ESC key to 
re-draw the page and eliminate this ink. 

Text may suddenly disappear when you are editing near the end of a 
page or column. This is caused by the Widow & Orphan and Keep 
With Next controls automatically placing text in the appropriate page 
or column. Scroll to a different part of the page, or press the Page Up 
or Page Down keys as necess3IY; and continue editing. 

As you move the text cursor with the keyboard cursor keys, the 
Current Selection Indicator displays the presence of text attributes, 
index references, footnotes, frame anchors, paragraph marks, horizon
tal tabs, line breaks, discretionary hyphens, and non-breaking spaces. 
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Press the Del key to delete these attributes. These attributes or refer
ences are cut to the clipboard and can be pasted elsewhere by placing 
the text cursor at another location in the document and then pressing 
the Ins key. 

To move, copy, or delete blocks of text, index references, footnotes, 
and anchors, refer to the Cut, Copy, and Paste commands found in the 
Edit menu section of the Menu Commands chapter. 

~ You can undo any cut to the clipboard by immediately selecting Paste. 

Xerox Ventura Publisher places attribute settings (bold, italic, super
script, etc.) at both the beginning and the end of a block of text that is 
set to that attribute. Although the attribute settings do not appear on the 
screen, the Current Selection Indicator flags their presence when the 
text cursor passes over the point at which they are located. If you 
accidentally delete the attribute at the end of a block of text, the 
remaining text in the paragraph suddenly appears with that same 
attribute. Press the Ins key immediately to correct this problem or 
re-size the desired attribute if necessary. To avoid this problem, look 
for the word Attribute in the Current Selection Indicator before you 
delete text. 

Attributes are terminated at the end of each paragraph, even if the "end 
attribute" character has been deleted. 

Use the keyboard cursor keys to move the text cursor a short distance. 
Use the mouse to move the text cursor to remote portions of the page. 

Consult Appendix D for important information on how text is trans
ferred between your favorite word processor and Xerox Ventura Pub
lisher. 

Tagging using the text mode 

REFERENCE GUIDE 

Whenever you press the Enter key, you automatically create a new 
paragraph which has the same tag as the last paragraph. Since you may 
want to change the tag of this new paragraph, and since it takes time 
to change to the Paragraph mode, Xerox Ventura Publisher provides 
an easy shortcut. You can assign frequently used tags to the special 
function keys on your computer's keyboard. (See the Assign Function 
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Text mode 

Keys option in the Paragraph menu.) Once a tag is assigned to a 
function key, pressing that function key while using the Text mode 
immediately tags the entire paragraph in which you are typing. 

You can very easily tag several consecutive paragraphs while in the 
Text mode. 

1) Select text spanning several paragraphs. 

2) Press one of the function keys to assign a tag to all paragraphs 
included in the selection. 

To create page breaks, you should follow these steps: 

1) Use the Add New Tag option available in the Addition Button 
while using the Paragraph mode to create a new tag. Copy this tag's 
initial settings from Body Text. 

2) Set Page Break for this tag to After using the Paragraph menu's 
Break option. 

3) Assign this tag to the special function key of your choice. 

After you have created this tag, you can create a page break from 
within any paragraph tagged as Body Text, while in Text mode or 
Paragraph mode, by pressing this function key. The page break will 
take place at the end of the paragraph. If you want to create a page 
break after a paragraph tagged with some tag other than Body Text, or 
if you want to create a page break within a paragraph press Enter and 
then press the function key. 
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Graphic mode 

Add new frame __ 

Graphic selection __ __ Box text 

Description 
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Line __ __ Ellipse 

Rectangle __ __ Rounded rectangle 

Figure 4-23 Graphic mode 

The Graphic mode (Figure 4--23) allows you to draw lines, ellipses, 
circles, square-edged rectangles and squares, and rounded-edge rec
tangles and squares. You can also place text in a box and move this box 
anywhere on a page. Once you have drawn these objects, you can 
assign different line and fill attributes to each of them .. You create 
drawings either on the current page or attached to a selected frame. 

You can also create new frames or select any existing frame while 
using the Graphic mode. You can move or re-size frames, or assign 
attributes from the Frame menu to your drawings. However, to cut, 
copy, or paste frames, or to place files from the Assignment List into 
a frame, use the Frame mode. 

The graphics drawn in Xerox Ventura Publisher will print with the 
maximum resolution your printer is capable of producing. These 
graphics are not "screen snapshots." 
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Application The Graphic mode is designed to let you: 

Attach graphics 
to frames 

Drawing 
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• Draw call-outs for pictures which you have loaded into frames from 
other drawing programs. 

• Create forms and tables. 

• Place additional ruling lines anywhere on the page. 

• Create unstructured, free-form pages for advertising and brochures. 

Graphics are attached either to the current page or to a specific frame. 
If you attach a graphic to a frame, the graphic will be moved with the 
frame when that frame is moved, cut, or copied. The ability to tie 
graphics to frames is useful for creating callouts or adding typo
graphical sophisticated text to pictures and graphs. Also, since frames 
can be anchored to the text, tying graphics to frames allows you to 
anchor graphics to a specific point in the text. This feature is useful 
when you want to keep illustrations and the text that refers to them on 
the same page. 

To attach a graphic to a frame, select the frame while in Graphic mode 
or select any graphic already attached to the frame immediately prior 
to drawing a graphic. The selected frame is shown by a gray (instead 
of black) selection box. 

To attach a graphic to the page instead of a specific frame, first select 
the page and then draw the graphic. 

1) Select the Graphic mode. The Assignment List is replaced with six 
icons (pictures) which represent the drawing tools available. Figure 
4-23 shows these icons and their function. 

2) Select one of these tools. 

3) To draw, place the mouse cursor where you want the drawing to 
begin. Press and hold the mouse button. 

4) Move the mouse to create the desired size and shape of the object. 

5) Release the mouse button when the desired size and shape has been 
obtained. 

As soon as you have drawn the graphic, the tool is disabled and the 
Graphic Selection icon (Figure 4-23) appears in reverse video once 
more. 
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Once a graphic is drawn, you can move it, re-size it, or change its 
attributes as follows: 

1) Select the Graphic Selection tool (see Figure 4-23). 

2) Select the graphic object. 

3) To move, place the mouse cursor in the middle of the object, press 
and hold the mouse button and drag the object to its new location. 
Release the mouse button. 

4) To change the object's size or shape, place the mouse cursor inside 
one of the little black selection buttons around the edge of the 
object. Press and hold the mouse button and drag the object into its 
new size and shape. Release the mouse button. 

s) To change attributes, select the Line Attributes or Fill Attributes 
options in the Graphic menu and make the appropriate selections. 
(See the Fill Attributes and Line Attributes section in the Menu 
Commands chapter for more infonnation.) 

The Current Selection Indicator shows the type of graphic currently 
selected (Le., ellipse, line, rectangle, box text.) 

Multiple graphic objects can be selected by pressing and holding either 
Shift key and then selecting each individual graphic. These graphics 
can then be cut, copied, pasted, or moved. Attributes can be applied 
simultaneously to all selected graphics if they are of the same type 
(e.g., all rectangles). 

Multiple graphic objects can also be re-sized as a group: re-size one 
graphic in a group, and all graphics in that group will change size 
proportionally. 

Nonnally, graphics tied to the current page will show on that page 
only. They can, however, be made to repeat on every page as follows: 

1) Select the graphic. 

2) Select Show On All Pages in the Graphic mode. 

To prevent a graphic from repeating on all pages: 

1) Select the graphic. 

2) Select Show On This Page in the Graphic mode. 
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Grid settings 

Graphic mode 

All graphics associated with a frame can be selected by selecting the 
Frame and then choosing Select All from the Graphic mode or press
ing Ctrl Q. 

If you press and hold the Alt key while you draw or re-size a graphic, 
the graphic will be constrained to perfect proportions. This means that 
you get: 

• A perfect circle instead of an ellipse 

• A square instead of a rectangle 

• Horizontal, vertical, or 45° lines. 

After each graphic is drawn, Xerox Ventura Publisher automatically 
changes to the Graphic Selection mode so you can move or re-size the 
graphic just drawn. If, however, you want to draw several graphics of 
the same kind, you can retain the drawing tool currently selected, by 
depressing and holding either Shift key while drawing each graphic. 
As long as you depress the Shift key while drawing the graphic, the 
drawing tool remains available. 

Graphics can be snapped to an invisible grid which is defined in the 
Grid Settings option in the Graphic menu (Figure 4-24). The grid 
setting can be different for each frame or for each inserted page in the 
chapter. 

GRID SETTINGS 

Grid Snap: On t 

Horizontal Spacing: 12.0~ fractional pts 

Vertical Spacing: 12.00 

OK I Cancel I 

Figure 4-24 Grid Settings dialog box. 
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The Grid Setting helps you align different graphic objects with one 
another. You can use it, in conjunction with Box Text, to construct 
complex tables or forms. See the Grid Settings option in the Menu 
Commands chapter for more details. 

If graphics are placed on top of one another, the last graphic drawn is 
always placed on top. To change this order, first select the graphic you 
wish to move, then select either the Send to Back or Bring to Front 
option in the Graphic menu. The selected graphic is then placed either 
on the bottom of all graphics associated with this frame (Send to 
Back), or on the top (Bring to Front.) 

Figure 4-25 shows a line behind a rectangle. Figure 4-26 shows the 
result of selecting the line and then choosing the Bring to Front 
option. 

Selecting graphic on bottom 

When one graphic is completely covered by another graphic, it some
times seems impossible to select the graphic on the bottom. To select 
a graphic which is covered by several other graphics: 

1) Select the Graphic mode. 

2) Press and hold the Ctrl key and then select the first graphic. 

3) While holding the Ctrl key, press the mouse button again to select 
the next graphic down from the top. 

4) Continue pressing the mouse button, while holding the Ctrl key, 
until you select the desired graphic. 

Figure 4-25 Line behind a rectangle. Figure 4-26 Line brought to front of 
rectangle. 
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Box text 

Graphic mode 

The Box Text feature allows you to place text anywhere on the page. 
Unlike text in frames, which is formatted in columns and causes text 
in other frames to move aside, box text is formatted in a single column, 
and overlaps all text and pictures on the page. Think of box text as a 
Post-It® (self-adhesive yellow note paper) that can be placed 
anywhere on the page. 

To create box text: 

1) Select a frame (or the page) to which the box text will be attached. 

2) Select the Box Text icon. 

3) Draw a box in the same manner as you would draw a frame. 

You can then move this box anywhere on the page, and increase or 
decrease its size. 

Notice that the end of file marker (a small square) appears within the 
box. This shows you where to place the text cursor to begin typing. If 
necessary, select the Graphic mode and make the box larger or smaller, 
to hold more or less text. Select the Text mode and enter text into this 
box. 

The text entered into this box is stored in the chapter's caption (CAP) 
file. 

Box text callouts Use the box text feature to place callouts outside, but attached to, a 
frame that contains a picture. Follow these steps: 
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1) Select the desired frame. 

2) Draw a box text figure. 

3) If you don't want a line around the box, select Line Attributes from 
the Graphic menu and set Thickness to None (select Save To before 
selecting OK to use these new attributes when you draw the next 
box text). 

4) Place the box at the position inside or outside the frame where you 
want the callout to appear. 
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Graphic mode 

Box text tables 
and forms 
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Modes of Operation 

5) When the box is placed correctly, select the line drawing tool and 
draw a line from the box to the item in the frame you wish to 
annotate. 

6) With the line selected, select the Line Attributes menu to change the 
line's thickness and add arrows. 

7) If you want to move the line and box together, select both, using the 
Shift key and the mouse as described earlier in this chapter, and 
move them both. 

8) When the box and the line are positioned correctly, select the Text 
mode, place the text cursor in the box, and type the callout. 

Since the graphics you have just created are attached to the frame that 
contain the picture, moving the picture will cause the entire set of 
graphics to move as a single unit. 

Simple tables can be created using tabs and paragraph ruling lines. 
However, many tables are more easily done with box text. The process 
for creating tables is described in the Tables section of the Putting It 
Together chapter. 

The Professional Extension contains a powerful and sophisticated 
tables feature. Contact Xerox for more information. 
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MENU COMMANDS 

This chapter describes the options you control through the menus at 
the top of the screen. These options are presented in the order in which 
they appear on the screen, from left to right. Use the index on the next 
page for an alphabetical reference to these menus. 

Many of the menu features combine to produce the typographic effects 
you want. The next chapter, Putting It Together, shows how to achieve 
common typographic formats. In addition, the style sheets in the 
TYPESET directory, which are documented in Appendix L, provide 
even more complete examples of how to use the menu features to 
produce your documents. 

Menu conventions 

REFERENCE GUIDE 

When a menu option appears in gray rather than in black, you cannot 
highlight it because you are not operating in the proper mode. Note 
also that some menu options are followed by an ellipsis ( ... ) while 
others are not. Options which appear without an ellipsis are executed 
as soon as you select them. When you select an option followed by an 
ellipses, however, you must specify further information. Your choices 
will appear on the screen within a dialog box or item selector. 
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Menu commands index 

Abandon ..... 
Add/remove fonts 
Alignment .... 
Anchors & caption settings 
Attribute overrides 
Auto-numbering 
Box character 
Breaks ..... 
Bring to front 
CHAPTER MENU 
Chapter typography 
Cut/copy/paste 
Define colors 
DESKMENU 
DOS file operations 
Edit special item 
EDITMENU 
FILE MENU 
File type/rename 
Fill attributes 
Font ..... . 
Footnote setting 
Footnote .... 
FRAMEMENU 
Frame background 
Frame typography . 
Go to page ..... 
GRAPHIC MENU 
Grid settings . . . 
Headers & footers 
Image settings . . . 
Insert page/remove page 
Insert cross reference 
Insert special item 
Insert fraction .. 
Insert/edit anchor 
Insert/edit index 
Line attributes . . 
Load different style 
Load text/picture 
Margins & columns 
Menu commands index 
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· 5-12 Multi-chapter 
.5-203 New ..... 
.5-133 Open chapter . 
.5-110 OPTIONS MENU 
· 5-154 Page size & layout . 
· 5-74 Paragraph typography 

5-39 PARAGRAPH MENU 
.5-145 Quit ...... . 
· 5-181 Re-anchor frames 

5-61 Remove text/file 
· 5-65 Renumber chapter 
· 5-32 Repeating frame 
· 5-166 Ruling lines 

· 5-3 Ruling lines 
5-26 Save as . . . 
5-38 Save .... 
5-30 Save as new style 
· 5--4 Select all . . . 
5-56 Send to back 

· 5-185 Set printer info 
· 5-131 Set ruler .,. 

5-89 Set preferences 
5--40 Show on all pages 

· 5-97 Show /hide loose lines 
· 5-122 Show /hide tabs & returns 
.5-108 Show /hide pictures 
· 5-95 Show/hide column guides 
.5-176 Show/hide rulers .. 
.5-189 Show/hide side-bar 
· 5-83 Sizing & scaling 
.5-124 Spacing 

5-93 Special effects 
5-52 Tab settings 
5-37 To print . . . . 
5--47 Tum line snap on/off 
5--49 Tum column snap on/off 
5--42 Tum header/footer off (on) 

.5-183 Update tag list 
5-19 Update counters 
5-13 Vertical rules . . 
5-98 VIEW MENU . 
· 5-2 Views and mode changes 
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· .5-6 
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· 5-62 
5-156 
5-129 
5-28 
5-82 
5-54 
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5-198 
5-196 
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5-177 
5-212 
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5-208 
5-207 
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5-102 
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5-214 
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5-171 
· 5-71 
.5-118 
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DESK MENU 

Figure 5-1 Desk Menu 

Description 
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The Publisher Info option in Desk menu provides the product name, 
version number, and serial number for your copy of Xerox Ventura 
Publisher. Be prepared to give this information to your Xerox Techni
cal Representative when you call technical support. 

To operate, select Publisher Info. When finished, select OK. 
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FILE MENU 

New 
Open Chapter ... 

Save AS 
Save As .. . 
Abandon .. . 

Load Text/Picture .. . 
Load Diff. St~le .. . 
Save As New St~le .. . 

To Print ... 
DOS F He Ops ... 
uit 

Figure 5-2 File Menu 

Description 

The File menu controls the flow of information into and out of Xerox 
Ventura Publisher. 

The File menu provides six basic functions: 

• You can Open or Save the entire chapter. 

• You can Load individual text, line art, or image files into the 
chapter. 

• You can use a different style sheet than the one currently in use, or 
JP 

save a newly created style sheet. 

• You can print the chapter. 

• You can execute a limited subset of DOS file commands. 

• You can finish using (Quit) Xerox Ventura Publisher. 
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New 

Description 

Selecting New removes the current chapter from memory and 
provides a blank screen. The last version saved is still available on 
disk. 

Application 

Start composing a brand new chapter. 

Operation 

Select New from the File menu. If any changes have been made to the 
chapter since it was last saved, a warning appears reminding you to 
save the chapter. Also, if any changes have been made to the style sheet 
since the chapter or style sheet was last saved, a second warning 
appears. In both cases, select Save to save all changes made, or select 
Abandon if you choose not to save the changes. If you Abandon, any 
changes to style sheet settings remain in effect. If you want to use the 
original style sheet settings, selection the Load Different Style option 
in the File menu and re-Ioad the current sty Ie sheet. 
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FILE MENU, Open chapter 

Open chapter 
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Description 

The Open Chapter option retrieves a previously stored chapter and 
its related style sheet, text, and picture files. 

Application 

Resume editing a previously saved chapter. 

Operation 

Select the Open Chapter option in the File menu. If another chapter is 
currently being edited, you are prompted to save the existing chapter. 
Select Save to save, or select Abandon to throwaway all changes. 

The Item Selector then appears. Using the conventions described 
under Item Selector in the User Interface chapter, select the chapter 
to open. 

~ If the file name is not shown, you may have saved the chapter with an 
extension different than the CHP default used by Xerox Ventura 
Publisher, or the file may be saved in a different subdirectory from the 
one currently shown in the Item Selector. Either change the default 
extension on the Directory line in the Item Selector, or change the 
subdirectory. 

As the chapter is loading, different messages appear on the screen. 
When text files are loading, the message Loading & Hyphenating 
Text File: appears. Xerox Ventura Publisher places all possible 
hyphenation points in the text in order to increase re-formatting speed 
each time you add a frame or change a text attribute. For a large text 
file, this takes several minutes, depending on the speed of your com
puter and size of the chapter. If you install a hyphenation algorithm 
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other than the US English algorithm (see Appendix B), the text loading 
time may increase. The hyphenation time is different for each lan
guage. 

~ Use Open Chapter to retrieve an entire chapter and all associated text, 
picture, and style sheet files. To add another text or picture file to an 
existing chapter, use Load TextlPicture instead. 
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Description 

The Save option stores the chapter under the name shown in the Title 
Bar. The style sheet and each text file are also saved if they have been 
changed. 

Application 

• Save changes under an existing file name. 

• Protect against accidental erasure due to power failures. 

Operation 

Select the Save option in the File menu, or press and hold the Ctrl key 
and then press S. The chapter file is saved under the file name shown 
in the Title Bar. If no name is shown in the Title Bar, the chapter is 
given the same file name as the text file placed on the page, but with 
the extension CHP. 

~ The style sheet shown in the Title Bar, and all text files shown in the 
Assignment List, are also saved, if they have been changed. If you 
don't want to change the current style sheet, use the Save As New Style 
option to save the style sheet under a new name prior to saving the 
chapter. 

Captions, graphics generated within Xerox Ventura Publisher, and 
chapter summary information are automatically saved in files which 
have the same name as the chapter, but which have the extensions 
CAP, VGR, and CIF respectively. The CIF file provides information 
to external document management programs (available from other 
companies). This information includes original creation date, date last 
saved, and date last archived. 
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If selected in the Set Preferences option in the Option menu, backup 
files (e.g., $HP) are automatically made for chapter, style sheet, and 
text files. 
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FILE MENU, Save as 

Save as 
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Description 

The Save As option saves the chapter under a new name. The style 
sheet and each text file are also saved-under their original names-if 
they have been changed. 

Application 

Save the same chapter under a name different than shown in the Title 
Bar. 

Operation 

Select the Save As option in the File menu, then use the Item Selector 
(see the User Interface chapter) to specify the new file name. If the 
extension is not specified, Xerox Ventura Publisher automatically adds 
CUP. 

If you don't want to change the current style sheet, use the Save as new 
style option to save the style sheet under a new name prior to saving 
the chapter. 

All captions, graphics, and information for a chapter are automatically 
saved in files which have the same name as the chapter, but which have 
the extensions CAP, VGR, and CIF respectively. The elF file pro
vides information to programs from other companies. 

Backup files (e.g., $HP) are automatically made for chapter, style 
sheet, and text files, if you have set the Keep Backup Files option (see 
Set Preferences under the Options menu). The first letter of the backup 
file extension is changed to a dollar sign. 
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If you want to save files on a drive other than the one containing Xerox 
Ventura Publisher, consult Appendix A for information on how to 
make additional drive letters appear within the Item Selector. 
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Abandon 

Description 

Abandon replaces the chapter currently in memory with the last 
version saved. 

Application 

Recover from major mistakes. 

Operation 

Select the Abandon option in the File menu. The following Alert Box 
appears: 

Abandon changes to this chapter and revert to the 
previously saved version? 

5-12 

Select Abandon to throwaway all changes and automatically open the 
last version saved. All changes made since the last time the chapter 
was saved are lost. Select Save to stop the Abandon operation and 
resume working with the existing chapter. 

If the chapter has been saved, but you want to get rid of the changes 
and start with a blank page, select New instead. 
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Load text/picture 

lOOD TEXT /P I (TURE rn 
T9pe of File: mil IUne-Art I D!illJ 
Text Forllat: I Generated 1.1mII I WOrdStar 3 I I ~S 4.915.9 I 
~ I WordPerfect I ~ la-Bit ASCII I 
I Writer I IltiltiHate I OOJ I WordPerfect 5 I 

~ of Files: I!D I Several I 
Destination: Imljlnrtj I TeKt Clipboard I I TeKt (ursDr I 

rn I (ancell 

Figure 5-3 Load Text/Picture dialog box. 

Description 

The Load Text/Picture option places either text, line art, or image 
files in the Assignment List prior to placing them on the page or in a 
frame. 

Application 

• Build a list of all files in the chapter. 

• Combine text from several files into one file. 

Operation 
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1) Select the Load Text/Picture option in the File menu. The Load 
Text/picture dialog box shown in Figure 5-3 appears. 
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2) Select the type of file you want to add e.g., text, line art, or image. 

3) Select the file format under which this file was saved, such as GEM, 
or Lotus 1-2-3. (Select Text and Generated to load a table of 
contents, index file, or style sheet printout generated by Xerox 
Ventura Publisher.) 

4) If you want to load several files of the same type (e.g., four Lotus 
1-2-3 pictures) select Several. 

5) If you selected Text, select Destination: List of Files. 

6) Select OK when you are ready to select files. 

7) Xerox Ventura Publisher then displays the Item Selector, with the 
appropriate subdirectory and file filter already chosen. If the sub
directory and filter are not initially correct, change them as 
described in the Item Selector section. 

8) Finally, select the file name and then select OK. 

For instance, if you are loading a Wordstar file, first select Text and 
then select Wordstar. Or, if you are loading Lotus 1-2-3 graphics, first 
select line art and then select Lotus .PIC. 

~ Don't load files directly from floppy disk. Xerox Ventura Publisher 
creates additional files during the loading process, and the floppy disk 
may not contain sufficient space. Also, your computer cannot load 
files as quickly from floppy disk. 

When loading text files, you will notice a delay-up to several minutes 
for large files-as Xerox Ventura Publisher converts text and inserts 
hyphens. If loading seems excessively long, check the CONFIG.SYS 
file to make sure you have included a BUFFERS=20 statement (see 
the Post Installation section of the Setup and Installation chapter). 

If you selected Multiple, the Item Selector reappears after each file is 
selected. To finish selecting mUltiple files, either select OK without 
first selecting another file name, or choose Cancel. 

~ Use Load Text/picture to add another text or picture file to an existing 
chapter. To retrieve an entire chapter and all associated text, picture, 
and style sheet files, use Open Chapter instead. 

Destination If you select Text, Xerox Ventura Publisher provides the following 
three selections: 
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Text changes 
made during 
load 
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• List of Files 

• Text Clipboard 

• Text Cursor 

1) Select List of Files to place the text file into the Assignment List. 
You can then place the contents of this file into a frame or page as 
described in the preceding paragraphs. 

2) Select Text Clipboard to place a copy of the entire file on the text 
clipboard. Any information on the Text Mode clipboard will be 
erased. You can then use the Text Mode Paste option (Edit menu) 
to paste a copy of this text anywhere in the chapter. 

3) Select Text Cursor to place a copy of the entire file at the current 
location of the text cursor. You must select the Text Mode prior to 
selecting the Load Text/picture option in order to use the Text 
Cursor feature. 

Files brought into the chapter using the Text Clipboard or Text Cursor 
feature are combined with file into which they are placed. The original 
text file will not be modified in any way. 

The following is a list of all changes that Xerox Ventura Publisher 
makes to text during the Load Text/picture operation: 

• Multiple spaces are converted to a single space plus non-breaking 
spaces. 

• All possible hyphen points are temporarily inserted into the text. 
(They are not saved back into the text file.) 

• Information not used by Xerox Ventura Publisher, such as center
ing, indents, and printing commands, is eliminated. 

• Two hyphens (--) are converted to a single em dash (-), and inch 
marks (") are converted to open and closed quotes (" ") if you have 
selected these adjustments through the Set Preferences option 
(Auto-Adjustments) in the Options menu prior to loading text. 

Double carriage returns 

Most typists press Enter twice in a row to create blank lines between 
paragraphs. However, when preparing a text file that will be used with 
Xerox Ventura Publisher, it is advisable to press Enter only once to 
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signal the end of a paragraph. This is because Xerox Ventura Publisher 
treats each carriage return in the word processor file as a new para
graph and adds above, below, and inter-paragraph spacing. As a result, 
text prepared with the double carriage return convention will appear 
to have too much space between paragraphs and unwanted spaces at 
the top of columns after it is loaded into Xerox Ventura Publisher. 
Also, many of the powerful formatting controls found in the Paragraph 
Breaks and Spacing options will not work correctly when a blank 
paragraph is inserted between each real paragraph. 

To eliminate all double carriage returns entered in your word proces
sor, type the following-from within your word processor--on the 
first line of the text file: 

@PARAFILTR ON 

This command causes Xerox Ventura Publisher to remove all para
graphs which contain no text. Note, however, that when you save the 
chapter, the blank paragraphs are permanently eliminated. 

If you want to retain two carriage returns in some places, put a space 
in front of the second carriage return when working on the document 
from within your word processor. 

Double spaces 

Most typists type two spaces after a period or colon. This, however, is 
not considered correct when a page is typeset. Therefore, you should 
use the search and replace feature in your word processor to eliminate 
all double spaces after a period. 

Pictures stored in other than GEM format (e.g., a Lotus 1-2-3 PIC file), 
are automatically converted to Xerox Ventura Publisher's file format 
and saved in new files which have the same name as the original file, 
but with the extension GEM (line art) or IMG (image.) The original 
files remain unchanged. Your disk must have enough available room 
to hold both the original and the converted files. Otherwise an error 
message is produced and the load operation halted. 

Xerox Ventura Publisher converts several industry standard graphics 
formats into its own file format, as described above. These formats 
include: 
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PostScript files 

• GEM 

• CGM 

• DXF 

• HPGL 

• Lotus 1-2-3 (PIC) 

• Macintosh PICT 

• Macintosh Paint 

• PC Paintbrush (PCX) 

• PostScript 

• TIFF 

• Video Show 

• Windows 

Because of the tremendous range of capabilities of programs which 
produce these file formats, graphics saved in these fonnats may not 
display and print from Xerox Ventura Publisher with absolute fidelity 
to the original. Consult Appendix G for a list of the specific limitations 
of each graphic format. 

Use PC Paintbrush, PostScript, or TIFF formats to load files created 
by a scanner. 

PostScript files must be in encapsulated format (EPSF), or an error 
message will result. If your graphics program produces PostScript 
files, check with the software manufacturer to make sure these are 
stored in encapsulated format. 

You can only print PostScript files to PostScript printers. 

~ Many PostScript files will not display on the screen. Instead the frame 
is filled with a large X, and the name of the file is displayed in the 
Current Selection Indicator. If the file does display, this means it 
contains a screen-resolution TIFF image or Windows metafile em
bedded within the PostScript file to let you see a representation of the 
PostScript file on you computer screen. If you print the page contain
ing this file to a non-PostScript printer, the TIFF image or Windows 
metafile is printed. 
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Xerox Ventura Publisher PostScript pages 

Note: If you print single page to a disk file using the PostScript printer 
driver, you can load that page back into a frame by selecting Line-Art: 
PostScript in the Load TextlPicture option. Using this method, you 
can load a page into a frame and then expand or shrink it. Note, 
however, that the file created by Xerox Ventura Publisher is not a true 
EPSF file and therefore cannot be read by another program. Also, 
landscape PostScript pages printed by Xerox Ventura Publisher cannot 
be loaded into a document formatted as Portrait (see the Page Size & 
Layout option in the Chapters menu). 
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Load different style 

Description 

Load Different Style applies a different style sheet to the chapter 
currently on the screen. If the chapter is then saved, the reference to 
the old style sheet is replaced with a reference to the new style sheet. 

Application 

Retrieve an existing style sheet. 

Operation 
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Select Load Different Style in the File menu. The Item Selector 
appears. Select the desired style sheet. The new style sheet name 
appears in the Title Bar at the top of the screen. 

The Open Chapter function automatically loads the style sheet for 
that chapter. 

If you used a special set of fonts when you last used this style sheet, 
the width table for these fonts is automatically loaded when you load 
the style sheet. 

See the Set Printer Info and Add/Remove Fonts sections (in the 
Options menu) for more information on width tables. 
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Save as new style 
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Description 

Save As New Style creates a new style sheet file or modifies an 
existing style sheet. 

Application 

Create new style sheets. 

Operation 

Select the Save As New Style option in the File menu. When the Item 
Selector appears, type the name of the new style sheet on the Selection 
line, and then select OK. If you do not specify the extension, Xerox 
Ventura Publisher automatically appends the extension STY to the file 
name. 

~ Saving the chapter after modifying a style sheet, or saving a modified 
style sheet under its :Jfiginal name, changes the look of other chapters 
that use that same style sheet. Always save modifications to existing 
style sheets under a new name unless you want those modifications to 
affect other chapters. 

If you have loaded a new width table in order to gain access to a 
different set of fonts, the reference to this width table will be stored 
with the style sheet. See the Set Printer Info and AddlRemove Fonts 
sections in the Menu Commands chapter for more information on 
width tables. 
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To print 

Description 

Application 

Operation 

Printer 
configuration 
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PRINT INFORMATION (POSTSCRIPT· Uitilllate) ill 
Which Pages: Selected 

Frolll Page: 8823 
Through Page: Ogi4 

NUlllber of Copies: 021 

Collated Copies: Off I 
Printing Order: 1st to Last I 

Paper Trail: Default I 
Crop Marks: On I 

Spot Color OlJerlalls: On I 
Mul ti' [1m. Print Files: Conbined 1 

DelJice Nar.e: POSTSCRIPT 
Output To: LPT1: 

Figure 5-4 To Print dialog box. 

To Print begins the printing process. 

• Generate printed copies of the currently opened chapter. 

• Print to a file. This file can then be copied to a remote printer or sent 
to a typesetter. 

To print a chapter, select the To Print option in the File menu. The 
Print Information dialog box shown in Figure 5-4 appears. If you 
want to print just one copy of the entire chapter, select OK. 

Always select the printer you desire before selecting To Print. Use Set 
Printer Into in the Options menu to choose the printing device and 
port. To stop a print operation in progress, press Esc. Printing stops 
after the current page is printed. 

Xerox Ventura Publisher allows you to create documents using the 
character widths for printers other than the one currently connected to 
your computer. Using this capability, you can produce draft copies on 
your local printer with the knowledge that the line endings and page 
breaks will not change when the document is printed on the final, 
ultimate device (such as a typesetting machine). The name of the 
ultimate printer appears at the top of the dialog box next to the words 
PRINT INFORMATION. The Device Name line shows which 
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printer is currently selected. The Output To line shows which printer 
port is in use. 

If character widths (detennined by the width table loaded in the Set 
Printer Info option) match the selected printer, the word Ultimate is 
displayed at the top of the dialog box. If the width table is for a printer 
other than the one connected to your computer, the word Draft is 
displayed instead. Print using draft mode only when you intend to print 
the final copy on some other printer. If you really want ultimate copy 
(the best possible quality) from your currently selected printer, Cancel 
from the To Print option and select the Set Printer Info option in the 
Options menu. Then, either load a font width table which matches the 
printer in use, or select a printer which matches the width table. See 
the Set Printer Info section later in this chapter for further instruc
tions. 

The following paragraphs instruct you step-by-step on how to operate 
the settings for the Print Infonnation dialog box. 

To print only part of the chapter, pick Which Pages: Selected. Next, 
enter the number of the first page to print on the From Page line. Type 
the number of the last page to print on the Through Page line. The 
page numbers specified refer to the page numbers shown in the 
on-screen Page Number Indicator. To print only the current page, 
select Which Pages: Current. 

Duplex printing 

Which Pages: LeftlRight is used to print on both sides of the page 
(duplex printing.) To do this: 

1) Print all left pages (if the chapter begins on right page) 

2) Tum the paper over and re-insert in the paper tray (insert a blank 
sheet after the last page, if necessary) 

3) Print all right pages 

Some printers will bum or smear the toner if a page is re-inserted and 
printed on the second side. Consult your printer manual. 

To print more than one copy of the pages selected, move the text cursor 
to the Number of Copies line and type the number of copies desired. 
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Collated Copies: Set Collated Copies to On to collate multiple copies in numerical 
sequence. Note: when printing pages that contain pictures, selecting 
Collated adds a tremendous amount of time to the printing operation. 
Set this feature to Off and sort the sheets by hand if you want to print 
multiple copies as quickly as possible. 

Printing Order: You can change the Printing Order from 1st to Last to Last to 1st or 
vice versa, depending on how your printer stacks paper in the output 
tray. 

Paper Tray Your choices are: Default, Alt #1, Alt #2, and Manual. 

Crop Marks 

Device 
Name/Output To 
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Choose Default if you have only one paper tray or if you are using a 
dot matrix printer with automatic tractor feed that advances the paper 
automatically. 

Depending upon the configuration of your printer, choose Alt #1 or 
Alt #2 if you have additional paper trays that hold paper of varying 
sizes. 

Select Manual if you want to feed paper manually, one page at a time. 

Select Crop Marks: On to place camera crop marks exactly at the 
edge of the page. This feature is useful primarily for typesetting 
machines, since most laser printers don't print to the edge of the page. 
Note also that crop marks will print only if the paper in your printer is 
larger than the page size chosen in the Chapter menu. You can create 
custom page sizes which are smaller than the defaults in the chapter 
menu (see the Sizing & Scaling option in the Frame menu section). 

If you want to create custom crop marks closer to the center of the 
page: 

1) Select the page. 

2) Use the Graphic mode to draw individual crop marks. 

3) Select Show On All Pages from the Graphic menu for all crop 
marks if you wish to repeat them on every page. 

The settings for Device Name and Output To reflect, respectively, the 
printer and printer port that you have most recently selected through 
the Set Printer Info feature in the Options menu. For instructions on 
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how to change the settings, refer to the Set Printer Info section in the 
Options menu portion of this chapter. 

If you select Spot Color Overlays: On, a separate page is printed for 
each color enabled in the Define Colors option (Paragraph menu) plus 
a page for black. The Color Name you define is printed at the top of 
each page printed for that color. Each sheet contains only the text and 
graphics set for one specific color, and each color is printed as 100% 
black. 

If your document uses color on only a few pages, you can save paper 
and printing time: print with Spot Color Overlays: On only for those 
pages that actually contain color. Use the Which Pages setting to 
select the page, or range of pages, to print. 

Printing to a file There are several cases in which you may choose to print to a file 
rather than directly to your local printer. Common examples of such 
cases are: 
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• When you need to speed print time so that you can resume working 
on your document more quickly than if you printed the document 
directl y to your printer. Printing to a file saves time since a hard disk 
drive is much faster than a printer. 

• When you want to send a copy of your document to a typesetting 
service that does not own Xerox Ventura Publisher. 

~ Printers which use the Direct setting in the Set Printer Info dialog box 
cannot print to a file because of the large file size that will result. 

To print to a file: 

1) Select the Set Printer Info option in the Options menu. 

2) Select Output To: Filename. The extension COO is automatically 
appended to files printed to disk. 

3) Select To Print in the File menu. 

4) The Device Name line in the Print dialog box displays the word 
Filename. As soon as you select OK, the Item Selector appears and 
you can type the name of the print file you wish to create. 

To send this file to your printer (assuming your printer is connected to 
LPTl:), use the DOS COPY command as follows: 
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COPY filename. COO LPT1: IB 

The /B switch alerts DOS that the file contains binary information. 
Failure to include this switch may halt the copy operation prematurely. 

If you have selected page dimensions of 11 x 17 in the Page Layout 
option, a dialog box appears as soon as you have selected OK for the 
Print Information dialog box. This dialog box gives you three choices: 

• Shrink 

• Overlap 

• Nothing 

Choose Shrink if you want to reduce the 11 x 17 page to fit on an 8 1/2 
x 11 sheet. (This option is available only with PostScript printers.) 
Choose Overlap if you want to print four 8 1/2 x 11 pages which can 
later be pasted together to fonn one 11 x 17 page. Choose Nothing if 
your printer can actually print an 11 x 17 page. 

Broadsheet 

If Broadsheet is selected, you can also Shrink, or you can Print in 
Strips. Printing in strips prints three strips each 24 inches long. Note: 
broadsheet printing in strips is used with typesetting machines only 
and will not work with laser printers. 

The Multi-Chapter option, shown in gray, is not used by the To Print 
option. This option is available only when you are working on a 
multi-chapter publication (see the Multi-Chapter section in the Op
tions menu portion of this chapter). 

See also Set Printer Info, and Multi-Chapter. 
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DOS fi Ie operations 

DOS FILE OPERATIONS 

File Spec: C:\TYPESET\*.IM61f---_____ _ 

Operation: I Select Different File Specification I 
I Make Directory I I Relllove Directory I 
I Delete Matching File(s) I 

Figure 5-5 DOS File Operations dialog box. 

Description 

DOS File Operations allow you to delete files, and to make and delete 
DOS directories. 

Application 

Select different 
file specification 
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• Delete files before quitting from Xerox Ventura Publisher, if you 
run out of room on your hard disk while attempting to save a style 
sheet or chapter. 

• Create a subdirectory if you decide to save style sheets or chapters 
in a new DOS subdirectory. 

Choose this option to select a different file name and/or directory from 
the one currently listed on the File Spec line. An Item Selector appears 
to help you choose the directory or file name. 

If you already know the file spec you are seeking, you can type its 
name manually on the File Spec line as an alternative to choosing 
Select Different File Specification. 
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Delete files To delete a file or files: 

1) Select the DOS File Operations option in the File menu (Figure 
5-5). 

2) Type the file name to delete (including DOS wildcard characters) 
directly on the File Spec: line. Include the name of the subdirec
tory, if applicable. 

3) Select Delete Matching File(s) to delete all files matching the File 
Spec. 

Make directory To create a new directory: 

Remove 
directory 

1) Type the new directory name, including disk drive and any parent 
directories, directly on the File Spec line. 

2) Select Make Directory. 

For instance, to make a new sub-directory called STYSHET under the 
TYPESET directory, type the following: 

C:\TYPESET\STYSHET 

Then, select Make Directory. 

To remove a directory: 

1) Type the directory name, including disk drive and any parent 
directories, directly on the File Spec line. 

2) Select Remove Directory. 

For instance, to delete a sub-directory called CHAP!, type the follow
ing on the File Spec line: 

C:\CHAPl 

Then, select Remove Directory. 

All files must be removed from the directory before the directory can 
be removed. 

~ For all DOS file operations, no operation is performed if the file is 
write-protected, or if the directory or file selected does not exist. 
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Description 

The Quit option ends the current Xerox Ventura Publisher session and 
returns you to DOS. 

Application 

Move to other programs to do word processing, line art design, and 
image editing. 

Operation 

Select Quit in the File menu. If you have made changes to your chapter 
or style sheet since they were last saved, Xerox Ventura Publisher asks: 

Save or Abandon changes to this chapter? 
Save, Abandon, Don't Quit. 
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Select Save to save the changes before quitting; select Abandon to 
throwaway any changes made; select Don't Quit to continue editing. 

When you Quit from Xerox Ventura Publisher, the current Function, 
View, and Options settings are all saved. When you next use Xerox 
Ventura Publisher, you resume with the same settings that were in 
effect at the end of the previous session. These settings are saved in the 
VP.INF file in the VENTURA subdirectory. You can delete this file 
prior to running Xerox Ventura Publisher if you always want to use the 
factory default settings. 
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When you use Xerox Ventura Publisher the next time, any changes 
made by these other programs to text, image, or line art files will 
automatically appear in your chapter. 
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EDIT MENU 

Cut T~xt D~l 
Copy T~xt tD~l 
Paste Text Ins 

Ins Special Iten", A( 
Edit Special Iten", AD 

R~AOV~ T~xt!fil~> > > 
fil~ T ~!R~!lJA~» > 

Figure 5-6 Edit Menu 

Description 

EDIT MENU, Quit 

The Edit menu allows you to perform a variety of operations, depend
ing upon the mode in which you are working. 

In Frame mode, you can use the Edit menu options to: 

• Cut, copy and paste frames and their contents. 

• Remove files from the currently selected frame, or remove them 
from the Assignment List so that they no longer compose a part of 
the chapter. 

• Rename files in the currently selected frame. 

• Change a text file in the currently selected frame to another word 
processor's format. 

In Text mode, you can use the Edit menu options to: 

• Cut, copy and paste selected text. 

• Insert and edit box characters, footnote and index references, frac
tions, and the frame anchors at the current text cursor location. 
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Some of the Edit menu operations you can use in Graphic mode 
overlap with the ones available to you in Frame mode. In Graphic 
mode, you can: 

• Cut, copy and paste graphics and their contents. 

• Remove files from the currently selected frame, or remove them 
from the Assignment List so that they no longer compose a part of 
the chapter. 

• Rename files in the currently selected frame. 

• Change a text file in the currently selected frame to another word 
processor's format. 

No Edit menu options are available when you are working in the 
Paragraph mode. 

Each option in the Edit menu is described more fully on the following 
pages. 
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Description 

Cut, Copy, and Paste let you delete, move, and copy text, frames, and 
graphics depending upon the mode in which you are working. 

Cut removes the selected text, frame, or graphic from the screen and 
places it on an invisible clipboard. You can then paste (move) text, 
frame or graphics to another location. Xerox Ventura Publisher uses 
three independent clipboards: one for text, one for frames, and one for 
graphics. Operations on one clipboard do not affect information stored 
on another clipboard. 

Copy places an identical copy of the selected text, frame, or graphic 
on an imaginary clipboard, but does not remove the selected item from 
the page. 

Paste takes the last item which was cut or copied and places it: 

• At the current location of the text cursor, if the clipboard contains 
text and the Text mode is selected. 

• At the identical position on a new page or the current page, if the 
clipboard contains a frame and the Frame mode is enabled. 

• At the identical position on a new page or the current page, if the 
clipboard contains a graphic and the Graphic mode is enabled. 

Application 

• Move text, frames, and graphics from one part of a chapter to 
another, as well as between chapters. 

• Move text between different files. 

• Place identical copies of the same picture on more than one page 

• Duplicate several blank frames. (If you want to put the same frame 
on every page, use Repeating Frames instead.) 
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Text 

• Copy or move selected graphics associated with a frame. 

To cut (delete) text: 

1) Select the Text mode. 

2) Select the text to be deleted. 

3) Select the Cut Text option in the Edit menu, or press the Del key 
on the keyboard. 

The text disappears from the screen, and the remaining text on the page 
is reformatted. If a mistake is made, you can restore the text by 
immediately selecting Paste Text, or by pressing the Ins key on the 
keyboard. To include the Paragraph End mark, move the text cursor in 
front of the first word of the next paragraph during text selection. 

To move text to a new location after it has been cut, place the text 
cursor at the exact spot in the chapter's text where the cut text is to 
start. When the text cursor is placed correctly, select the Paste Text 
option, or press the Ins key on the keyboard. The inserted text is 
always converted to the tag and text attributes in effect at the point of 
insertion. 

To copy text: 

1) Select the Text mode. 

2) Select the text to be copied. 

3) Select the Copy Text option in the Edit menu or press and hold the 
Shift key and then press the Del key. The text is placed on the 
clipboard. 

4) Place the text cursor at the exact spot in the chapter's text where the 
text now on the clipboard is to start. 

~ When the text cursor is placed correctly, select the Paste Text option, 
or press the Ins key on the keyboard. 

A copy of the text remains on the clipboard after a paste operation. You 
can therefore place additional copies of the text which have been cut 
or copied elsewhere in the chapter by following the procedure in the 
previous paragraphs. However, you don't have to re-cut or re-copy the 
text. 
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As soon as you cut or copy a new piece of text, the text currently on 
the clipboard is lost. However, if you cut or copy a frame or graphic, 
any text on the clipboard remains on the clipboard. 

You can also use Cut, Copy, and Paste to move or copy any of the 
hidden Attribute Settings shown in the Current Selection indicator. To 
do this: 

1) Move the text cursor until the hidden attribute is shown in the 
Current Selection indicator. 

2) Press either the Del key (cut) or the Shift and Del keys (copy.) 

3) Move the text cursor to the new location and then press the Ins key. 

~ You must use the keyboard keys when cutting or copying attributes. 
The Cut and Copy options in the Edit menu will not work. 

Note that if the Current Selection indicator is blank, pressing the Del 
or Shift and Del keys will not cut or copy text attributes to the 
clipboard. 

To cut (delete) a frame, first enable the Frame mode and then select the 
frame to be cut. Next, select the Cut Frame option in the Edit menu, 
or press the Del key on the keyboard. If a mistake is made, you can 
restore the frame by immediately selecting Paste Frame, or pressing 
the Ins key on the keyboard. 

To move a frame to a new location once you have cut or copied it: 

1) Enable the Frame mode. 

2) Go to the page where the frame is to be moved, and then select the 
Paste Frame option, or press the Ins key. 

The frame, and the file it contains, is placed on the page. The frame's 
original location on the page prior to the cut or copy operation deter
mines where it is pasted. You can then move the frame to a new 
location on the page. 

To copy a frame: 

1) Activate the Frame mode and then select the frame to be copied. 

2) Select the Copy Frame option in the Edit menu or press the Shift 
and Del keys. 
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Graphics 
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3) Go to the page where the frame is to be copied and select the Paste 
Frame option, or press the Ins key. 

The frame, and the file it contains, is placed on the page. 

As soon as you cut or copy a new frame, the frame currently on the 
clipboard is lost. However, if text or a graphic is cut or copied, any 
frame on the clipboard remains on the clipboard. 

Captions and graphics attached to a frame will also be cut, copied or 
pasted. 

Xerox Ventura Publisher automatically generates new Table or Figure 
counters in captions which are pasted onto a page. The last frame 
pasted on a page is always assigned the highest Table or Figure number 
on the page. 

If multiple frames are selected, they are all Cut, Copied, or Pasted. 

To cut (delete) a graphic: 

1) Enable the Graphic mode and then select the graphic to be cut. 

2) Select the Cut Graphic option in the Edit menu, or press the Del 
key on the keyboard. If you make a mistake, you can restore the 
graphic by immediately selecting Paste Graphic, or pressing the 
Ins key on the keyboard. 

To move a graphic to another frame once it has been cut or copied: 

1) Select the Graphic mode. 

2) Select the frame (or the page itself) to which you want to attach the 
graphics currently on the clipboard. 

3) Select the Paste Graphic option, or press the Ins key. 

The graphic's original location on the page prior to the cut or copy 
operation determines where it is pasted. You can then move the graphic 
to a new location. 

To copy a graphic: 

1) Select the Graphic mode. 

2) Select the graphic to be copied. 
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3) Select the Copy Graphic option in the Edit menu or press the Shift 
and Del keys. 

4) Select the frame (or the page itself) to which the graphic is to be 
copied. 

5) Select the Paste Graphic option, or press the Ins key. 

As soon as you cut or copy a new graphic, the graphic currently on the 
clipboard is lost. Howevet:, if text or a frame is cut or copied, any 
graphic on the clipboard remains on the clipboard. 

If multiple graphics are selected, they are all Cut, Copied, or Pasted. 
See the Graphic Mode section of the Modes of Operation chapter for 
instructions on how to select multiple graphics. 

Pasting a frame or graphic onto the same page from which it was 
copied places two identical frames or graphics on top of one another. 
Since the two are identical and occupy the same position, you will see 
only one copy on the screen. However, you can select the frame or 
graphic on top and move it to another location on the page. 

Text, frames and graphics remain on the clipboard after you open a 
new chapter. Thus, if you want to copy text, frames or graphics 
between chapters: 

1) Cut or copy the text, graphic or frame. 

2) Save the chapter. 

3) Open the new chapter. 

4) Go to the page on which you want the text, frame or graphic to 
appear. 

5) Select Paste. 

See also the Text mode, Frame mode, and Graphic mode sections in 
the Modes of Operation chapter. 
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Box Char ... F1 
Footnote F2 
Index Entr9 ... F3 
Fraction ... F4 
Frallle Anchor ... FS 
Cross Ref ... F6 

Figure 5-7 Insert Special Item dialog box. 

The Insert Special Item option provides convenient access to the 
following features: 

• Box characters 

• Footnotes 

• Indices 

• Fractions 

• Frame anchors 

• Page and chapter numbers 

To insert any special item: 

1) Place the text cursor at the location where you want to insert a 
special code. 

2) Select Insert Special Item in the Edit menu or press Ctrl C. 

3) The selection box shown in Figure 5-7 appears. 

4) Select the special item you want to insert, or press the appropriate 
function key. The dialog box for the option you selected will appear. 

For instance, to insert an index, press Ctrl C and then press function 
key F3. 

The options and applications for each special item are described on the 
following pages. 
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Edit special item 

The Edit Special Item option allows you to easily edit the following 
special codes: 

• Index entries 

• Fractions 

• Frame anchors 

You can delete box characters, footnotes, and page/chapter number 
special codes, but you cannot edited them. 

Operation 

To edit a special item: 

1) Place the text cursor immediately in front of the special item. If 
necessary, move the text cursor until the name of the special item 
appears in the Current Selection Box in the lower left comer of the 
screen. 

2) Select Edit Special Item in the Edit menu, or press Ctrl D. The 
dialog box for the special item appears. 

3) Make whatever changes you desire, and then select OK. 

To delete a special item, press the Del key when the special item 
appears in the Current Selection Box. This item is deleted from the text 
and placed on the text clipboard. You can then paste this item in 
another location. Simply place the text cursor where you want the item 
to appear and then press the Ins key. 

~ Use the Ctrl D keyboard shortcut to edit a special item. 
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? 
WAIT 

Do you wish to insert a I Hollow I 
hollow or fill~d bo~ 
character at the selected I Filled I 
10cation J or cancel the 
request? ICancel I 

Figure 5-8 Box character dialog box. 

Many fonts do not provide square box characters. Xerox Ventura 
Publisher therefore includes the capability to generate them. To insert 
a box character: 

1) Select the Text mode. 

2) Place the text cursor where you want the box to appear. 

3) Select Insert Special Item. 

4) Select Box Char or press Fl. The dialog box shown in Figure 5-8 
appears. 

5) Select the type of box you wish to create, and then select OK. 

You can use the Text mode Set Font button to change the size of the 
box character, shift it up or down, or move it left or right. 
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Description 

The Footnote option places footnote references at the current text 
cursor position, and also adds a footnote at the bottom of the current 
page. 

Application 

Provide on-page references. 

Operation 

Footnotes must first be turned on using the Footnote Settings option 
in the Chapter menu. 

To create a footnote, follow these steps: 

1) Enable the Text mode. 

2) Place the text cursor where you want the reference inserted. 

3) Select the Insert Special Item option in the Edit menu. 

4) Select Footnote or press function key F2. 

Depending on the current Footnote Settings, a number or character 
appears next to the text cursor. The same footnote reference appears 
at the bottom of the page, followed by the End of File Marker 0 . 

5) Place the text cursor in front of the end of file marker at the bottom 
of the page and type the desired footnote. 

To delete the footnote reference and the footnote itself: 

1) Place the text cursor at the footnote reference in the main body of 
text. 
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2) Move the text cursor back and forth until the Current Selection 
Indicator displays the word Footnote. 

3) Press the Del key. Both the footnote reference and the footnote 
itself are deleted. 

The combined length of all footnotes on a page must be less than 
one-half page. If your footnotes are longer, tum Footnote Settings off, 
and then create footnotes manually by typing them into frames which 
you draw at the bottom of the page. 

Footnotes can be created from wi thin your word processor even if your 
word processor does not support footnoting. See Appendix D-Word 
Processors for more details. 

See also the Footnote Settings section in the Chapter menu. 
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INSERT/EDIT INDEX ENTRY 

hpe of Entr9: Index 

Pril1lar9 Entr9: Movie Technologies _______ _ 
Prilllar9 Sort Ke9: 

Secondar9 Entr9: 3· 0 
Secondar9 Sort Ke9: Thr'-eet-I -----------

Figure 5-9 Insert/Edit Index dialog box. 

Description 

The Insert/Edit Index option inserts an index reference at the current 
position of the text cursor. After all index entries have been inserted, 
use the Multi-Chapter option to generate an index. 

Application 

Insert hidden index references into the chapter. 

Definitions 

A Primary Entry is the major heading you wish to index. 

A Secondary Entry is an optional subheading which appears under 
the primary entry. 

Sort keys place entries beginning with articles (e.g., a, an, the), in a 
different alphabetic position than the actual entry's spelling dictates. 
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Operation 

Sort keys 

See, See also 

REFERENCE GUIDE 

1) Position the text cursor at the location in the text that you wish to 
reference and select Insert Special Item. 

2) Select Index Entry or press function key F3. The Index dialog box 
shown in Figure 5-9 appears. 

3) Select Type of Entry: Index. 

4) On the Primary Entry line, type the primary index reference. 

5) Optional: on the Secondary Entry line type a sub-heading. This 
will appear in the final index under the primary reference. 

For instance, in a book about the movie industry, a primary reference 
might be Movie Technologies and a secondary reference Sound, 3-D, 
or Wide Screen. 

Be careful to type precisely the same words on the Primary and 
Secondary lines for each index entry that references the same concept. 
Otherwise, you will create two different entries instead of multiple 
page references to the same entry. For instance, if you have a reference 
at one point to Wide Screen, and another reference to Wide Screens, 
two separate entries will appear in the index instead of two page 
references under the same entry. 

Use primary and secondary sort keys to place numbers and/or phrases 
beginning with articles (e.g., a, an, the), in an alphabetic position 
different from what the spelling of the number or phrase would 
suggest. For instance, if the primary entry is The Maltese Falcon, and 
you want to alphabetize this entry under Maltese rather than The, 
enter Maltese Falcon on the Primary Sort Key line. Sort keys work 
with all three types of index entries: Index, See, and See Also. 

See and See Also are used to reference other index entries. The index 
in this Reference Guide provides many good examples of how to use 
the See and See Also features. 

If you select Type of Entry: See, the word See precedes the Secondary 
Entry when you generate an index using the Multi-Chapter option. 
See Also works like See, except that the words See Also precede the 
Secondary Entry. (The Multi-Chapter Index option allows you to 
substitute the words of your choice in place of See and See Also.) 
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Entry in Insert~dit Index Index created by Multi -Chapter 
dialog box Make Index command 

Type of entry: Index ___ Auto-numbering, 5-54 - 5-60 . 
Primary: Auto-Numbering ~ Example, L-39 
Type of entry: Index 
Primary: Auto-numbering 

/ See also, Section numbers 

Secondary: Example 

Type of entry: See Also 
Primary: Auto-numbering 
Secondary: Section numbering 

Figure 5-10 Entries in the Insert/Edit Index dialog box are used by the Multi-Chapter Make Index 
feature to create index entries. 

Editing index 
entries 

5-44 

See and See Also index entries are alphabetized according to the Entry 
or Sort Key. They are not placed alphabetically under See. 

No page or chapter number is placed after a See or See Also entry. 
Therefore, the locations of these entries within a chapter or publication 
do not matter. It is therefore recommended that you group all See and 
See Also references together at the beginning or end of a chapter. You 
can then add and delete these cross-references without searching for 
them. 

If you want to include chapter and page references in the See and See 
Also entries: 

1) Select Type of Entry: Index 

2) Begin the Primary or Secondary Entry with the words See or See 
Also 

3) Duplicate the Primary or Secondary Entry on the Sort Key line, 
minus the words See or See Also. 

You can edit index entries in the following manner: 

1) Place the text cursor at the location of the index entry. (The location 
of the index entry is marked by a small circle if you select Show 
Tabs & Returns in the Options menu.) 
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three 

2) If necessary, move the text cursor back and forth until the Current 
Selection Indicator displays the word Index. 

3) Select the Edit Special Item in the Edit menu. Make whatever 
changes you desire, and then select OK. 

To cut (delete) an index entry: 

1) Follow the first two steps above. 

2) Press the Del key. 

To paste an index entry to another location: 

1) Place the text cursor at the location you wish to paste (insert) the 
index entry. 

2) Press the Ins key. 

You can type index entries in your word processor even if your word 
processor doesn't support indexing. If your word processor does sup
port indexing, you must still enter index references as shown below. 
For instance, to create the index entries shown in Figure 5-9 insert the 
following into the word processor text file: 

<$IMovie Technologies;3-D[Three]> 

The Multi-Chapter Make Index feature places this entry into the final 
index in this format: 

M 

Motion Picture 

See Movies 

Movie Technologies 

Sound 4-12,4-15 - 4-18 

~. See Also Technology 

~3-D 4-34,5-33 

Multiple page 
references 
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Wide screen 4-25, 5-15 

Entering the identical index entry in more than one location results in 
multiple chapter and page references, separated by commas. If the 
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identical entries appear on consecutive pages, the starting and ending 
pages are shown, separated by a dash (e.g., the secondary entry Sound 
above.) 

For advanced users: to automatically index the range of pages oc
cupied by a section or chapter, follow these steps: 

1) Use the 1st Match or Last Match feature in the Headers & 
Footers option to automatically place tagged text at the top and 
bottom of each page. (See the Headers & Footers section of this 
chapter, under the Chapter menu heading.) 

2) Insert the index entry in a paragraph. 

3) Tag that paragraph with the tag specified in the 1st Match or Last 
Match string in the Headers & Footers option. 

The tagged text-along with the index-will automatically be dupli
cated at the top or bottom of each page until the next tagged heading 
is encountered. When the Multi-Chapter Index feature is run, it will 
generate a range entry (e.g., the 4-15 - 4-18 Sound entry in the 
example above) which covers the entire section. 

See also: Multi-Chapter Index Generation (Options menu) and 
Headers & Footers (Chapter menu). 
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------ _. - -

Figure 5-11 Insert Fraction dialog box. 

Description 

True fractions look like this: 

1/2 34/47 1 not this: 
2 

1/2 34/47 

True typographic fractions use smaller type which is shifted up and 
down, and separated by a special fraction bar available in the symbol 
font. The Fraction option allows you to create typographically correct 
fractions without spending the time to change fonts, shift text and 
insert fraction bars. 

Application 

Quickly insert typographically correct fractions. 

Operation 

REFERENCE GUIDE 

To create a fraction: 

1) Select Text mode. 

2) Place the text cursor at the location where you want to create a 
fraction. 

3) Select Insert Special Item from the Edit menu, or press etrl e. 

5-47 



5-48 

EDIT MENU, Insert fraction 

4) Select Fraction from the Insert Special Item dialog box or press 
function key F4. The fraction editing screen appears. 

5) Type Ctrl C and then press Fl to insert a fraction of this type: 1;2 

Type Ctrl C and then press F2 to insert a fraction of this type: ~ 

6) Wait a moment and the results will appear below the fraction 
editing line. 

7) Alternatively, simply type the fraction. Type 1/2 to get IJ2 and type 

lover 2 to get ~. Be sure to leave a space on either side of the word 

over. 

8) Press and hold the Ctrl key and then press D to return to the main 
screen. 
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Insert/edit anchor 

INSERT/EDIT ANCHOR 

Frallle's Anchor Nallll?: Figure 34l-

Frallll?'s Nl?w Location: I Fixed, On Sallll? Pagl? As Anchor I 

I Relativl?, Below Anchor Linl? I 

I Re lati ve, Abovl? Anchor Line I 
Rl?lativl?, Autolilatically At Anchor 

Figure 5-12 Insert/Edit Anchor dialog box. Relative automatically at 
anchor is selected. 

Description 

The Insert/Edit Anchor option allows you to place a frame anchor 
into text. This frame anchor links a specified frame to the anchor's 
location in the text. The frame then moves whenever this location in 
text moves. You can also define anchors which move only the refer
enced frame when you execute the Re-Anchor Frames command. 

Application 

Make illustrations move automatically with text. 

Definition 

REFERENCE GUIDE 

To make a frame move when text gets moved from page to page, you 
must first label the frame, and then insert a reference to that label into 
the text of your document. This establishes a link between the frame 
and a particular location in the text. The frame label is entered using 
the Anchors & Captions feature in the Frame menu. Insert the 
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reference to this label (called a frame anchor) using the Insert/Edit 
Anchor feature. 

You can anchor a frame in one of three different ways: 

• Anchor the frame so that when text moves to a new page, the frame 
occupies the same location on the new page as it did on the old page 
(Fixed, On Same Page As Anchor). Use this option if illustrations 
al ways appear at the top or bottom of a page. 

• Anchor the frame directly above or directly below the text, but 
don't move it until the Re-Anchor Frames command (Chapter 
menu) is given (Relative, Above/Below Anchor Line). Use this 
option if you want illustrations to stay in their current positions until 
you give the command to move. 

• Anchor the frame in the line of text, and make it move whenever 
the text moves (Relative, Automatically At Anchor). Use this 
option if you want to anchor small pictures within a line of text so 
that they always move with the text. 

Operation 

To insert a frame anchor into the text on the page: 

1) Place the text cursor where you wish to insert an anchor point. 

2) Select Insert Special Item in the Edit menu. 

3) Select Frame Anchor or press function key FS. The Insert/Edit 
Anchor dialog box shown in Figure 5-12 appears. 

4) Type the Frame Anchor Name of the frame you wish to reference. 

This name must exactly match the name entered for that frame in the 
Anchors & Captions dialog box of the Frame menu (although upper 
and lower case don't matter). If the name doesn't match, an error 
message appears during the Re-Anchor Frames operation. 

If you select Relative, Below Anchor Line, the top of the frame 
moves to the line below the line containing the anchor. If you select 
Relative, Above Anchor Line, the bottom of the frame is moved to 
the line above the line containing the anchor. 
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Automatic 
frame anchoring 

Anchored 
graphics 
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If you choose Fixed, On Same Page As Anchor, the frame's position 
on a new page is identical to its position on the old page. 

If you select Relative, Automatically At Anchor, the frame automat
ically moves as the text moves. This feature allows you to create small 
drawings and insert them within tiny frames into a line of text. To use 
this feature, the paragraph tag for the paragraph containing the anchor 
should have Grow Inter-Line to Fit set at ON (Paragraph Typography 
option). When you anchor a frame using this feature, Xerox Ventura 
Publisher automatically turns Flow Text Around OFF (Sizing & Scal
ing option) for this frame. 

You can also use Relative, Automatically At Anchor to anchor a 
large frame to the end of a paragraph. Follow the procedures in the 
previous paragraph. To make the feature work correctly with a full size 
frame, note the following: 

• You must insert the anchor directly after a line break (Ctrl + Enter) 

• Column Snap in the Options menu should be turned on and the 
frame should be drawn so that both sides are snapped to a column 
guide. 

You can attach graphics drawn in the Graphic mode to any frame on 
the page (see Graphic mode in the Modes of Operation chapter). Use 
this feature to anchor arrows and callouts to locations in the text. 
Follow these steps: 

1) Anchor a small frame at the end of a paragraph using Relative, 
Automatically as described above. 

2) Select Graphic mode. 

3) Select the small frame and then draw the graphics. 

When the text moves, these graphics will move. 
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Insert cross reference 

? 
WAIT 

Do you wish to insert a I Page ~ 
reference to the current ~ ___ ... 
page or chapter nu~ber I Chapter ~ I 
or cancel the request? 

Cancel 

Figure 5-13 Insert cross reference dialog box. 

5-52 

Description 

The Insert Cross Reference option allows you to insert the current 
page or chapter number anywhere on a page, including captions, 
frames, and box text. 

Application 

This feature can be used in a number of ways: 

• Place page numbers in "thumb tabs" (created with box text) along 
the edge of the page. 

• Create a custom header or footer using the Repeating Frame 
option instead of the Header & Footer option, yet still include the 
required page and chapter numbers. 

Operation 

1) Place the text cursor at the location in the text where the page or 
chapter number should appear. 

2) Select Insert Special Item. Select Insert Cross Reference or press 
function key F6. The dialog box shown in Figure 5-13 appears. 

3) Select either Page # or Chapter #. 
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REFERENCE GUIDE 

The current page or chapter number appears at the text cursor's current 
location. 

To create a custom header (or footer): 

1) Select Turn Headers Off in the Headers & Footers dialog box. 

2) Draw a frame across the top of the page. 

3) Type the desired text into this frame using Text mode. Include page 
and chapter numbers using the Insert Cross Reference feature. 

4) Use the Repeating Frame option (Frame menu) to make this frame 
appear at the top of every page. 
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Remove text/fi Ie 
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REMOVE FI LE m 
File NaMe: NOZZLE .GE~ 

Figure 5-14 Remove File dialog box with pop-up menu displayed. 

Description 

Remove TextlFile completely removes a file and its contents from 
either a frame or the Assignment List. The file is not deleted from disk. 
(U se Delete Matching Files in the DOS Files Operations option to 
delete files from disk.) 

Application 

• Use Remove Text/File (From List of Files) when you wish to 
eliminate one or more text or graphic files from a chapter. 

• Use Remove Text/File (From Frame) when you wish to create an 
empty frame. Choose this option when you have set a frame's 
margins, columns, ruling lines, background pattern, etc., and want 
to use Copy Frame and Paste Frame to create more frames with 
these identical settings, but with nothing in them. 

Operation 

To remove a file name from either the list of files in the Assignment 
List or from a frame or page: 
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1) Select the Frame mode. 

2) Optional: select the frame or page which contains the file you wish 
to remove. 

3) Select Remove Text/File in the Edit menu. The dialog box shown 
in Figure 5-14 appears. 

4) If you selected a frame, the File Name line displays the name of the 
file in that frame. If no file name is displayed, type the name of the 
file you wish to remove. 

s) To remove the file from both the frame and from the list of files in 
the Assignment List, select Remove from: List of Files 

6) To remove the file from the frame or page only, but keep the file 
name in the Assignment List, select Remove from: Frame. 

~ It is a good idea to remove excess files from the Assignment List, since 
excess files slow down the time it takes to open a chapter. All text files 
in the Assignment List are loaded into memory, whether or not they 
are placed anywhere in the chapter. 

REFERENCE GUIDE 

You can place a file into a frame, even if that frame already contains a 
text or picture file: 

1) Select the frame. 

2) Select a file from the Assignment List. 

A Remove from Frame operation is automatically performed on the 
file already in the frame. 
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File type/rename 

FILE TYPE / RENAME 

Old NaNe: C:\TYPESET\BOOK. TXT ______ _ 
Enter new text file 

name on this line HeLf HaNe: C:\TYPESET\NEWBOO<. TXT!I-_____ _ 

5-56 

Text ForNat: 'Generated I IimII 'WordStar J I I WS 4.8/5.0 , 

, MS·Word I 'WOrdPerfect I 'X~Write I I B· Bit ASCII I 

'Writer I 'tkJltiMate I I OCA I 'WordPerfect 5 I 

Figure 5-15 File Type/Rename dialog box. A new file called 
NEWBOOK.TXT will be created the next time the chapter is saved. 

Description 

File Type/Rename allows you to create a new text file, or change the 
word processor format of an existing file. 

Application 

• Create a new text file. The next time the chapter is saved, a new text 
file is created. The file with the old name remains unchanged. 

• Convert from one word processor format to another. This option 
allows you to use text files from several word processors, and yet 
save each file in a common format. 

• Convert caption frames to text files. 

Operation 

1) Enable the Frame mode. 
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Convert 
captions to text 
files 

REFERENCE GUIDE 

2) Select the page or frame which contains the text file you want to 
rename or convert. 

3) Select the File Type/Rename option in the Edit menu. The dialog 
box shown in Figure 5-15 appears. 

4) Enter the new file name on the New Name: line. 

5) Select the word processor format to be used. 

When you next save the chapter, a new text file is created. The chapter 
will point to this new file instead of the old file. The old text file 
remains unchanged but will not longer appear in the Assignment List. 

Text that you type into a blank frame is stored in the chapter's caption 
(CAP) file. This type of frame is called a caption frame. If you select 
a caption frame, and then select File Type!Rename, you will cause its 
text to be stored in a separate file rather than in the chapter's caption 
(CAP) file. 

You cannot convert captions into separate text files ifthey are attached 
to frames or box text. 

5-57 



5-58 

VIEW MENU 

Reduced Uiew AR 
NorMal Uiew (1x) AN 
Enlarged Uiew (2x) AE 

AU 
AI 
AO 
Ap 

Figure 5-16 View Menu 

Description 

VIEW MENU, File type/rename 

The View menu provides four different ways to present the chapter on 
your computer screen: 

• Facing Pages View 

• Reduced View 

• Normal Page View (IX) 

• Enlarged View (2X) 

It also provides an alternative way to switch to a different mode of 
operation when the Side-bar is hidden. 
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Views and mode changes 

The View features in the View menu let you perform the following: 

• Check the overall layout of a page. 

• Provide better resolution when you are drawing graphics or editing 
text. 

Operation 

REFERENCE GUIDE 

Select the desired option in the View menu (Figure 5-16.) You can also 
use the keyboard to select any view, other than the Facing Pages View, 
by pressing one of the following key combinations: 

View 

Reduced View 
Normal View 
Enlarged View 

Key 

.Ctrl + R 

.Ctrl + N 

.Ctrl + E 

Select Normal Page View to edit and read text. This view provides the 
most accurate view of the final printed page. Use Enlarged View to 
check picture details and graphic placement. Use Reduced View to 
place frames and check overall layout. 

In Reduced View and Facing Pages View, text which is too small to be 
read on the screen is "greeked," meaning that a line of the appropriate 
height and length replaces the actual text. Greeking decreases the time 
needed to redraw the page on the screen. You can set the size of text to 
be greeked through the Set Preferences option in the Options menu. 

When changing to a more magnified view, you can zoom into a 
specific area of the page as follows: 

1) Place the mouse cursor at the spot which will be the upper left 
corner of the more magnified view. 

2) Use the keyboard shortcuts shown on the previous page to change 
view 
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In Facing Pages View, you cannot drag frames from one page to 
another. Use Cut, Copy, Paste instead. Facing Pages View is available 
only when Double Sided printing is enabled in the Page Size & Layout 
option of the Chapter menu. 

To enable any of the four Xerox Ventura Publisher modes when the 
side-bar is hidden, select the appropriate option in the View menu, or 
press a combination of the Ctrl key and one of the following keys: 

Function Ke~ 

Frame .Ctrl + U 
Paragraph .Ctrl + I 
Text .Ctrl + 0 
Graphic .Ctrl + P 
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CHAPTER MENU 

Page Size & La90ut .. . 
Chapter T9Pograph9 .. . 

Update Counters .. . 
Auto-Nu~bering .. . 
Renunber Chapter AS 
Re-Anchor Fra~es ... 

Headers & Footers ... 
Turn Header On 
Turn Footer On 
Footnote Settings ... 

Insert/Re~ove Page ... 
Go to Page... AG 

Figure 5-17 Chapter menu 

Description 

REFERENCE GUIDE 

The Chapter menu controls page formatting for the entire chapter. It 
is thereby distinguished from the Frame menu, which controls format
ting for each individual frame. 

Page Layout, Auto-Numbering, Chapter Typography, and Footnote 
Settings are stored in the style sheet. All other settings are stored with 
the chapter. In previous versions of Ventura Publisher, this menu was 
called the Page menu. 

The individual options available in the Chapter menu are described on 
the following pages. 
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Page size & layout 
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PAGE LAYOUT 

Orientation: Portrait t 
Paper Type & DiMension: Letter J D.S H 11 in. t 

Sides: Double t 
Start On: Right Side t 

I OK I Cancel I 

Figure 5-18 Page Layout dialog box. Settings shown are typical. 

Description 

Page Size & Layout defines the physical size of the paper used in the 
printer, printing orientation, and selection of either single or double 
sided fonnatting. You are pennitted only one set of size and layout 
specifications per chapter. 

Application 

• Change between portrait and landscape (Figure 5-19) display and 
printing. 

• Change paper sizes. 

• Penn it different fonnatting on left and right pages. 

Operation 

1) Select the Page Size & Layout option in the Chapter menu. The 
Page Size & Layout dialog box is shown in Figure 5-18. 
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Orientation 

Paper type & 
dimension 

Sides/Start on 

Portrait Landscape 

Figure 5-19 Portrait vs. Landscape printing 

Select whether you want the chapter to be printed in Portrait or 
Landscape. 

Select the physical size of the paper on which your chapter will be 
printed. Smaller page sizes can be printed on printers that handle only 
one size of paper if you decrease the page's height and width using the 
Sizing and Scaling option of the Frame menu. 

Select either Single- or Double-sided formatting, and whether the first 
page should start on the Left Side or Right Side. If you select both 
Single-sided formatting and Start On Left Side, only the Left Side 
settings for headers & footers, margins, column widths, vertical rules, 
and tag (In From Left, In From Right) spacing are applied to each page. 
The same comment applies to Single-sided formatting and Start On 
Right Side. 

The Facing Pages option in the View menu only works only when you 
select Double-sided printing. 

~ You must select Sides: Double in order to allow different headers & 
footers, margins, column widths, vertical rules, and tag (In From Left, 
In From Right) spacing settings for left and right pages. 

11 X 17 and 
Broadsheet 

REFERENCE GUIDE 

If you choose 11 x 17, a dialog box appears at print time which gives 
you three choices: shrink, overlap, and nothing. 
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5-64 

• Choose Shrink if you want to reduce the entire 11 x 17 page to fit 
on an 8V2 x 11 sheet. (This option only works on PostScript 
printers.) 

• Choose Overlap if you want to print four 8V2 x 11 pages which can 
be manually pasted together to form one 11 x 17 page. 

• Choose Nothing if your printer can actually print an 11 x 17 page. 

If Broadsheet is selected, you can also Shrink (if you have a PostScript 
typesetter), or print in strips. This latter option prints three strips, each 
24 inches long, and is used with certain typesetting machines. 

~ The Broadsheet strip option is intended for use only with typesetting 
equipment and will not work with laser printers. 

Page Size & Layout settings are stored in the style sheet file. 
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Chapter typography 

CHAPTER (DEFAUlT) TYPOGRAPHY SETTINGS [1] 

Widows (Min Lines at Top): 2 
Orphans (Min Lines at Botto(11): 2 

Colul11n Balance: Off t 
Move Down To 1st Baseline B9: Cap Height t 

Pair Kerning: On t 
Uert. Just. Within Fral11e: Feathering t 
Uert I Just I Around Fral11e: Moveable t 

Figure 5-20 Chapter Typography dialog box. Settings shown are typical. 

Description 

Chapter Typography controls the character-to-character and line-to
line formatting for the entire chapter. You can override these settings 
for any frame or any page you have inserted manually (see the 
Insert/Remove Page option in the Chapter menu) by selecting that 
frame or inserted page, then using the Frame Typography settings in 
the Frame menu. 

Application 

• Control text placement from column to column and page to page. 

• Match typography to the style of document you are creating. 
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Operation 

Widows & 
Orphans 

Select the Chapter Typography settings option in the Chapter menu. 
The dialog box shown in Figure 5-20 appears. 

A widow is a single line of text at the top of a page or column which 
has been separated from the paragraph that finishes the previous page 
or column. 

An orphan is a single line of text at the bottom of a page or column 
which has been separated from the paragraph that starts the next page 
or column (see Figure 5-21.) 

The Widows and Orphans controls increase or decrease the number of 
lines that can be widowed or orphaned. To operate: 

1) Select the Chapter Typography option in the menu. 

2) Move the mouse cursor to the widow or orphan number and select 
the minimum number of lines to leave at the top or bottom of the 
page or column. 

Widow ________ _ 

Orphan ~ 

Figure 5-21 A single line widow at column top and single line orphan at 
column end 
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Kerning 

The default setting is two. This means that at least two lines must 
remain on the previous page or column or be forced to the next 
page/column, if possible. 

Set both widow and orphan controls to two for most work. Set both to 
one if you want to disable this feature. Magazines and books often 
allow widows and orphans so a setting of one may be proper for these 
documents. 

Widow & Orphan settings are stored in the chapter (CHP) file. 

You can tum kerning globally on or off for the entire chapter by 
selecting Pair Kerning: Off. This overrides the settings you chose for 
Automatic Pair Kerning (Paragraph Typography option, Paragraph 
menu), but does not change them. If you set Pair Kerning to On, 
kerning will once again be take effect for those paragraph tags for 
which you selected Automatic Pair Kerning: On. Tum Pair Kerning 

(0 three mcgahYI(,~ ~hould :-.1111 he al/ail,lok vcr ... iol1 of Xcro;t; VCIllIlI:l Puhll:-.hcr i:-';lVail~hk 

afler Ill\I<lllatioll, Tl1i:-. 'pace 1\ ncctkd 10 Conlact Xerox. al 1-\:-\(0)-X22-X221 1'01 price 

holdyourdocumcnlt'ilc\andanyadtlilional :lndaViUlahillty 

fOllt\youmilyl,llcrchoo\c\oil1\\illi 

A graphics board: 
Preparing for installation 

A ~raphicsb()ard: 
IJreparing for imlallalion 

» Hcrclllc:-,Graphic~Card.orc411iv:dCnl 

IBM Color em.! and compatible colO! 

IBM Enhanced Graphic\ Adapter 

(EGA) or wmpalihlc 

IBM VGA oTcompatihlc 

Micro Displ:1Y SY:-'lcrns Gcniu", di:-,play 

" Wysc700 

> OthcrlsccAppcndixJforacomplclclisl 

of graphic hoard", and monitor", ,>up

ported) 

Software installation 

You ncctl 10 know lile foliowingahoul yOUl 

compulcrh,lHlw,lrc 

» The Iype of graphic~ bo:u"d in~tallcd in 

» Thc:-.crial port or .... pccial hoard lI~cd hy 

'>CTeen rom .... 'ystcill ~oftwurc_ uppllCallO(l 

Figure 5-22 Move down by cap height. The 
top of the words Setup and Installation touch 
the top of the column. 
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" AT&T63{XJ(MOX40()jorXcrox6065 

Ho::rculc:-.Graphic ... Cal"<t.orcquivalenl 

IBM Color Card and cOl1lpalih1c colol 

IBM Enharwcd Graphin AdarlC] 

IEGA)orcompatihk 

» IRM VGA or compatihle 

" MicroDi~playSY:-'IC'I11:-.(jcl1iu:-.di\play 

You need \0 know\hc following aboul your 

compUlo.::rhilrd .... arc 

\\ The lyp.:ofgraphlc:-, board lINalkd in 

> The 'erial ron or :-.pccial hoard u\cd h~ 

\crccn fOIlI,. :-')':-'1('111 \Oflwlln::. ilpplil'alioJl 

Figure 5-23 Move down by interline. The dis
tance/rom the top of the column to the base of the 
words Setup and Installation equals the Inter
Line space for the tag applied to this paragraph. 
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Move down to 
1st baseline 

Column balance 

CHAPTER MENU, Chapter typography 

off to improve print and screen refresh speeds, especially when Auto
matic Pair Kerning is On for Body Text. Note, however, that chang
ing this setting may change where text is placed in your document. 

Xerox Ventura Publisher provides two different ways to determine 
where the first line of text will begin on a page or within a frame. If 
you select Move Down To 1 st Baseline By Cap Height, the top of the 
column aligns with the top of the tallest capital letter in the font you 
have chosen. If you select Move Down To 1st Baseline By Inter-Line, 
the first line of text starts at a distance from the top margin equal to the 
inter-line spacing set in the Spacing option (Paragraph menu). See 
Figures 5-22 and 5-23. 

Set Column Balance at On when your document has multiple 
columns and you want all columns to end at the same position at the 
bottom of the page. Figures 5-24 and 5-25 show the difference at the 
bottom of a page between column balance on and column balance off. 

Column balance reduces text formatting speed. Therefore, you should 
temporarily turn column balance off if you plan to make extensive 
changes on a page. 

Figure 5-24 Column balance off Figure 5-25 Column balance on 
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Column balance and frame-wide text 

The Frame-Wide setting in the Paragraph Alignment option overrides 
the column settings for any paragraph. This allows you to automat
ically format headings which straddle several columns of text. How
ever, if this heading starts anywhere but on the first line of the page, it 
will interfere with text in adjacent columns. 

To solve this problem, set Column Balance at On. Figures 5-26 and 
5-27 show the results. 

Column balance limitations 

Certain options in the Chapter and Paragraph menus can limit the 
extent to which column balance is implemented. In particular, the 
Widows & Orphans (Chapter Typography) and Keep With Next 
(Paragraph Typography) controls force text to the next column or 
page. This creates gaps at the bottom of the previous column or page. 
Therefore, if you use Widow & Orphan and Keep With Next controls 
when Column Balance is turned on, you may need to manually add 

SETUP AND INSTALLATION SETUP AND INSTALLATION 

System requirements 

• A graphics board: 

" AT&T 6300 (MQ X 400) or Xerox 6065 

" Hercules Graphics Card. or equivalent 

» IBM Co[or Card and compatible color 

" IBM Enhanced Graphics Adapter 
(EGA)orcompalible 

» IBM VGA or compatible 

" Micro Di~play Sy~tems Gcniusdisplay 

» Wysc700 

If you previously installed version 1.0 of I A. If 
~eroxvcmurJ.publishcr.pleascconsultthcsc~-
lIOn Updating .'rom Version 1.0 in AppendiX "Ace ,,00 ;0>,,"11;0,, fonh' fi"tt;me'" 

Figure 5-26 Column balance off. Note how 
text does not balance above frame- wide text near 
bottom of page. 
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System requirements 

• A graphics board: 

" AT&T 6300 (640 X 400) or Xerox 6065 

" HcrculcsGr:tphicsCard.orcquivalcllt 

» IBM Color Card and compatihle color 

» IBM Enhanced Gnlphics Adapter 
(EGA) or compatible 

» IBM VGA or compatible 

» Micro Display Syslcm~ Genius display 

» Wysc700 

Figure 5-27 Column balance on. Note how 
text fills both columns above frame-wide text. 
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CHAPTER MENU, Chapter typography 

additional space between paragraphs using narrow frames if you want 
multi-column pages to balance exactly. See the Frame section of the 
Modes of Operation chapter for instructions on using frames to add 
space between lines and paragraphs. 

Even if you do not use Widow & Orphan and Keep With Next controls, 
Column Balance still cannot always make each page balance perfectly. 
This is because Column Balance adjusts the number of lines in adja
cent columns, but does not actually change the space between lines or 
paragraphs (vertical justification.) Therefore, for example, if a two 
column page contains an odd number of lines, one column will be a 
line shorter than the other. 

Vertical justification, which forces text to always end at the bottom 
margin, is available in the Professional Extension to Xerox Ventura 
Publisher. Call Xerox for price and availability. 
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Update counters 

UPDATE COUNTERS m 
Which Counter: I Chapter I " •• I This TJul~ I I This figur~ I 

I Initial Page I I Initial Table I I Initial Figure I 
Update Ml'thod: I Prl'vious NUlllbl'r + 1 IllImlllD 

Rl'start NUlllber: 00011 

.1l"UI'· , I 1,2 
A,B 

DO I Caned I a, b 
I, II 
i,ii 
Onl', Two 
ONE, TWO 
Olll' two 

Figure 5-28 Update Counter dialog box. Page numbering set to re-start on 
this page. 

Description 

This feature allows you to reset the chapter, page, table, and figure 
counters at any point in a chapter. It also allows you to automatically 
link page, table, or figure counters across chapter boundaries. 

Update Counters can set the numbering style to arabic numerals (1, 
2, 3 ... ), roman numerals, letters (A, B, C ... ) or text (One, Two, 
Three .... ) 

Application 

REFERENCE GUIDE 

• Override automatic numbering for a given page, figure, or table. 

• Number book introductions, table and figure numbering, or appen
dices using different number styles. 

• Consecutively number large books and technical manuals across 
chapter boundaries. 
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Operation 

Set the initial 
counter 

Reset counter 
for this page, 
table, figure 
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You can change counters in one of two ways: 

• Set the counter for the chapter, initial page, initial table or initial 
figure. Do this to link the current chapter with a previous chapter 
during a Multi-chapter Renumber operation (see Multi-chapter in 
the Options menu). 

• Override and reset the counter for this page, table or figure. Do this 
to change the numbering sequence within a chapter. 

To set the counter for the chapter, or the initial page, initial table or 
initial figure, follow these directions. Note that if no initial counter is 
set, the default is one, in arabic format (i.e., 1). 

1) Select the Update Counters option in the Chapters menu. 

2) For Which Counter, select either Chapter, Initial Page, Initial 
Table, or Initial Figure. After you have made your choice of the 
counter you wish to change, proceed to the next three steps. 

3) To start counting at one, numbered in arabic (i.e., 1, 2,3, ... ), do 
nothing. You don't need to make a selection. 

4) To automatically continue numbering from the previous chapter, 
select Previous Number + 1. Note that the actual numbering across 
chapters takes effect only when you select Renumber in the Multi
chapter option in the Options menu. 

s) To start counting at a number other than one, or to change the 
number format, select Update Method: Restart Number. 

- Enter the Restart Number. 

Select the Number Format. 

Repeat the last three steps, if necessary, for the remaining initial 
counters. 

You can select any frame or page and override the counter and number 
format. To change either table or figure numbering format: 

1) Select the Frame mode and then select the frame whose caption you 
wish to re-number. 
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2) Select the Update Counters option in the Chapter menu (see figure 
5-28). Select This Table, or This Figure. (Note: This Table and 
This Figure will not be available unless you first select a frame.) 

3) Select Update Method: Restart Number. 

4) Enter the Restart Number. 

5) Select the Number Format. 

6) Select OK. 

To change page or chapter numbering: 

1) Go to the page on which you want re-numbering to start. 

2) Select the Update Counters option in the Chapter menu (see figure 
5-27). Select This Page. 

3) Select Update Method: Restart Number. 

4) Enter the Restart Number. 

5) Select the Number Format. 

6) Select OK. 

To cancel a restart number, select the frame or page and then select 
Previous Number + 1. 

~ Restart Number is attached to the selected page or frame. If you 
move the selected frame to another page, the number will restart at the 
new frame location. Similarly, if text is moved to another location due 
to the editing process, the page number will still restart on the original 
page. 
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Auto-numbering 

AUTO· NUMBERING 

Usage: III [][] 
Level 1: [*Heading,11.--..;-_______ _ 
Level 2: [*Section Sub,1

1

1. _______ _ 
Level 3: [*Minor Head, 11}-. _______ _ 
Level 4: 
Level 5: 
Level 6: 
Level 7: 
Level B: 
Level 9: 

Level 10: 

Inserts: I Chapter n I OJ] [E]J QJJ [Q]J [LTIJ 

[3ii'jijiill"s Previous Levell I Tellt Attr. I f"""7iii"'" rr::::n 
. L....,Q!L,J Lill£!!..J 

Figure 5-29 Auto-Numbering dialog box. This example will place 1., 2., 
etc. infront of every paragraph tagged as a Heading; 1.1.,1.2., ... 2.1.,2.2., 
etc. infront of every paragraph tagged as a Section Sub, and so on. 

Description 

Auto-Numbering automatically inserts section numbers before 
selected paragraph types. These section numbers can contain com
binations of numbering styles and punctuation. 

Application 

Section 
Numbers 
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• Technical manual section numbers 

• Outlines 

• Automatic headings 

This feature automatically inserts numbers, letters or Roman numerals 
before every paragraph tagged with a specified tag. For example, the 
first paragraph tagged with the tag called Heading will be numbered 
1, the next Heading paragraph will be numbered 2, and so on. You can 
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create up to ten levels of section numbering by specifying ten different 
tag names in the Auto-numbering dialog box. 

To number paragraphs automatically, follow these directions: 

1) Select the Auto-Numbering option in the Chapter menu. The 
Auto-Numbering dialog box, shown in Figure 5-29, appears. 

2) Select the On option at the top of this dialog box to enable Auto
Numbering. Place the text cursor on the Levell line and then 
~om~efol~ 

~~~ I I,ll I I i,ii 

This determines whether arabic, letters, or roman numerals will be 
used. 

For example, if you select arabic numbering (i.e., 1,2), this places 
the words: 

[*tag name, 1] on the Level 1 line. 

3) Use the keyboard cursor and backspace keys to replace the words 
tag name with the actual tag name of the paragraphs you want 
numbered. You must type the tag name exactly as it appears in the 
Assignment List, although upper and lower case letters don't 
matter. 

For instance, to number all sections tagged with a tag called Head
ing, the level one line looks like this: 

[*Heading,l] 

4) Select OK. In this example an arabic number is inserted before 
every paragraph tagged with Heading. Each succeeding Heading 
paragraph is numbered consecutively, even if other paragraphs 
intervene. 

Numbers other than one 

To start numbering with a number other than one, enter this number 
just inside the right bracket, without erasing the default numbers. For 
instance, to start numbering with the number 3, modify the preceding 
example to look like this: 
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[*Heading,1,3] 

This starting number is optional and is always entered in arabic. If a 
starting number is omitted, one is assumed. 

Adding punctuation 

You can add punctuation (periods, hyphens, etc.) by placing the 
desired punctuation marks before or after the [ ] brackets that contain 
the tag name. For instance, to place a period after the section number 
associated with paragraphs tagged with Heading, change the Levell 
line to: 

[*Heading, 1] . 

Repeat the above procedure for each additional level or tag that you 
wish to number automatically. 

Example: the dialog box shown in figure 5-29 will place 1.,2., etc. in 
front of every paragraph tagged as a Heading; 1.1.,1.2., ... 2.1.,2.2., 
etc. in front of every paragraph tagged as a Section Sub, and so on. 

Each time a tag specified in the Auto-numbering dialog box is en
countered, the numbers for all lower level paragraphs are reset to their 
starting number. 

Section numbers are added, deleted, or changed only when you make 
a change in the Auto-Numbering menu, or when you select the 
Renumber Chapter option in the Chapter menu. Section numbers 
cannot be edited, although you can cut (delete) text which contains 
them. 

Only text in pages can be auto-numbered. Text in frames and box text 
cannot be numbered. 

In the previous examples, the section numbers accumulate at each 
level. Thus, a third level heading includes the numbers from the first 
and second levels, e.g., Section 2.5.3. 

For outlines and certain other numbering schemes, however, you will 
want to suppress the previous numbering levels. For instance you 
want: 
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Previous level not 
suppressed 
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I. First level 
A. Second level 

not 

I. Fiist(@.rel 
I.A. Second level 

To auto-number without including previous level numbers, use the 
Suppress Previous Level feature. For instance, to suppress level one 
numbering for a level 2 paragraph: 

1) Place the text cursor at the far left of the level 2 line. 

2) Select Suppress Previous Level. This places a [-] at the current text 
cursor position. 

3) Add the section number as described under Section Numbers. 

Figure 5-30 shows the settings for an outline that follows normal 
conventions (uppercase Roman letters, followed by uppercase letters, 
then arabic numbers.) 

AUTO· NUMBERI NG 

Usage: III []ill 
Level 1: [*Main, I]. 
Level 2: [·][*Sub H'-t'a--.d,'A'].---------
Level 3: [. ][*Minor Ht'ad,1].f-i _______ _ 
Level 4: 
Level 5: 
Lt'vt'l 6: 
Lm17: 
Level B: 
Level 9: 

Level 10: 

Inserts: I (haptt'r ~ I [IJJ []JJ [!JJ [LTI] [hTI] 

I Supprm Prt'viOU5 Lmll I TeHt Attr. I r-niiI rr::::n 
L....L~ 

Figure 5-30 Numbering for outline. Note that the [-] characters at the 
beginning of levels 2 & 3 suppresses printing of previous level numbers. 
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When section numbers are generated, each of the ten levels is automat
ically tagged with the following tags: 

Level 1 
Level 2 

Level 10 

Z SECI 
Z SEC2 

Z SECIO 

Although you cannot change these tags' names, you can alter their 
typographic settings. Generated tags are not shown in the Assignment 
List, unless you request Generated Tags: Shown in the Set Preferen
ces option (Options menu). 

Altering generated section number tags 

Initially, these generated tags have the same attributes as Body Text, 
which means that the section numbers appear on the line above the 
heading with which they are associated. If you want to place section 
numbers on the same line as their associated paragraphs, you can alter 
these generated tags by changing Paragraph menu settings for both the 
section number tag and the tag of the associated paragraph. 

Change the section number's tag attributes to: 

Font 
Alignment 
Spacing 
Breaks 

Ruling Lines Above 
Ruling Lines Below 

Same as paragraph 
Left 
No space below 
Line break before, 
Keep with next 
As desired 
None 

Change the paragraph's tag attributes to: 

Font 
Alignment 

Spacing 
Breaks 
Ruling Lines Above 
Ruling Lines Below 

Same as section tag 
Indent relative to 
previous line, 
plus one pica 
No space above 
Line break after 
None 
As desired 

REFERENCE GUIDE 



CHAPTER MENU, Auto-numbering MENU COMMANDS 

Changing paragraph 
tags places section 

numbers on same line 
with the headings. 

8.5.1 TextBlocking (Run ,\rounds) 

Placing text around an irregular object is called a Run 
Around. Normally, Ventura Publisher automatically 
"flows" text around rectangular Frames. However, text 
can also be made to flow around irregular objects. 
The technique for doing this, which involves turning 
Text Flow Around off in the Frame Menu, is 
described under the Layout heading in the Reference 
Section. 

8.5.2 Creating MuhiDle Frames 

Immediately after placing Frames on a page using the 
Layout function, Ventura Publisher automatically 

Figure 5-31 Generated section numbers placed on same line as headings. 

Chapter 
numbers 

Independent 
numbered lists 
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Figure 5-31 shows the results of changing the tags. 

During text editing, some paragraphs may print over the first line of 
the previous paragraph if you set the tags as described above. How
ever, if you change the Line Break (Breaks option, Paragraph menu) 
for all other tags in your sty Ie sheet from Before to After, you 
eliminate this effect. 

You can include chapter numbers at any level by selecting the Chapter 
# option in the Auto-Numbering dialog box. This places [C#] at the 
current text cursor position and automatically inserts the chapter num
ber at that location within the section number. 

If you create an outline or a numbered list using the approach shown 
in Figure 5-30, you cannot reset the top level number back to one. If 
you want to have several independent numbered lists within the same 
chapter, you need a way to reset numbering. 

To reset numbering: 

1) Place Body Text as the tag name on level 1 

2) Create your numbered list hierarchy starting with level 2. 

Thus, as soon as any body text paragraph is encountered, the outline 
or list numbering resets itself. Body text paragraphs will now be 
numbered. You can, however, eliminate numbering at any level merely 
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by deleting the paragraph numbering type. For instance, if you want to 
use body text to reset numbering, place the following on the level 1 
line: 

[*Body Text\ 

Note that numbering is removed 

This technique works with any paragraph tag, not just body text. 

You can place text on any level, either before or after the tag name. 
Figures 5-28 and 5-29 show periods placed after some of the tag 
names. Other text can be placed on these lines as well. If the section 
number is eliminated as described in the previous paragraph, you can 
add text to the beginning of every paragraph tagged with the desig
nated tag. For instance, to place the words Daily Times: at the 
beginning of every paragraph tagged as a Question (e.g., for a chapter 
that contains the text of an interview), type 

[*Question] Daily Times: 

at the appropriate level. 

You can use any of the text attributes (e.g., bold-<B» shown in 
Appendix D in section numbering. You must place these attributes 
outside the command brackets (i.e., outside the [ ] brackets). 

Example: to change the word Times in the above example to bold 
italic, type: 

<B>[*Question]Daily<BI>Times:<D> 
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Renumber chapter 

Description 

Renumber Chapter updates the numbering of paragraphs defined in 
the Auto-Numbering option. 

Application 

Use Renumber Chapter after you have edited your document to 
renumber the entire chapter according to the Auto-numbering settings. 

Operation 

Select Renumber Chapter from the Chapter menu, or press and hold 
the Ctrl key and then press B. The entire chapter is then renumbered. 
Select Renumber Chapter any time you want to update section 
numbering. 

~ Section numbers are not added, deleted or modified during text editing 
or paragraph tagging. You must select Renumber Chapter to update 
section numbers. 
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Section numbers are not saved in the text file. Instead, they are 
regenerated each time you load the chapter. 
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Re-anchor frames 
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Description 

Re-Anchor Frames moves every frame in the chapter to the page on 
which its anchor appears. You can also opt to move only those frames 
that are located on the current page. 

Application 

Move frames to anchor points in the text. 

Operation 

See the Anchors & Captions section under the Frame menu. If the 
name of the frame anchor you specified through the Anchors & 
Captions option matches a frame anchor in the text, selecting Re
anchor Frames causes the associated frame to move to a new loca
tion. 

To operate: 

1) Select the Re-Anchor Frames option in the Chapter menu. 

2) A dialog box appears. Choose whether you want to re-anchor only 
the frames on this page, or all the frames in this chapter. 

3) Go to each page to make sure that frames have been moved to a 
desirable location. 

If the anchor name in the text does not match the anchor name given 
to the frame, Xerox Ventura Publisher displays a message on the 
screen during the re-anchor process. You can then correct the name of 
the anchor in the text before the re-anchor process continues. 
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Headers & footers 

HEADERS & FOOTERS 

Define: I Left Page Header I Right P age Header 

I Left Page Footer I I Right Page Footer I 
Usage: III []f[J 
Left: [<Heading 1] ___________ _ 

Center: <P10>Page<P255> [C~HP~] ________ _ 

Right: ![<Chapter Head] ___________ _ 

Inserts: I Chapter ~ I []ill]] I 1st Match I I Last Match I 
I Text Attr. I I COP!! To Facing Page I 

Figure 5-32 Headers & Footers dialog box. The word Page is set at 18 
point. 

Description 

REFERENCE GUIDE 

Headers & Footers defines text which is placed at the top and bottom 
of each page in the chapter. 

Each header and footer can have three separate entries: one left-jus
tified, one centered, and one right-justified, each up to two lines. 

You can also specify different headers and footers for the left and right 
page. Thus, pages 1,3,5,7, ... can have a different set of headers and 
footers from pages 2, 4, 6, 8. 

Chapter numbers and page numbers can be inserted into any header or 
footer. 

Also, you can automatically create headings for books, manuals and 
directories by copying, to the header or footer, the first and/or last 
occurrence on a page of any paragraph tagged with a specified tag. 
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Application 

General 
operation 

• Create page and chapter numbers. 

• Create automatic section titles. 

• Create directory headings. 

• Create chapter headings. 

To use Headers and Footers, select the Headers & Footers option in the 
Chapter menu. The Headers & Footers dialog box (Figure 5-32) 
appears. 

Next, decide where you want to place text (e.g., left, center, right 
aligned.) For example, to place text at the top center of the left page: 

1) Select Left Page Header 

2) Turn Usage On 

3) Move the text cursor to the first line opposite Center, and enter the 
text 

If you select Double in the Page Size & Layout option (Chapter 
menu), you can cause a header or footer to be "mirrored" on opposite 
pages. Select Copy to Facing Pages to bring this about. Note that the 
words Copy to Facing Page do not remain highlighted. 

If you select Single and Start on Left Side in the Page Size & Layout 
option, only the left header and footer are used. The converse is true 
for Single and Start on Right Side. 

~ If either the right or left header/footer doesn't appear on the screen, 
check the Single and Double settings in the Page Layout option. Also 
check to make sure you have defined a header or footer for both the 
left and right pages. Finally, make sure the header/footer is turned on 
for this page. (See Turn Header OnlOff, Turn Footer On/Off in the 
Chapter menu later in this chapter.) 

Chapter and To place a chapter or page number in the header or footer: 
page numbering 

1) Select the header/footer location as described above. 
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Automatic 
section 
headings 

2) Select Inserts Chapter # or Inserts Page # at the bottom of the 
dialog box. For page numbering, this automatically places the 
following on the header or footer line selected: 

[P#] 

The symbol for chapter number is [C#]. 

Chapter and page numbers automatically start with one (1). You can 
override this default, however, using the features in the Update 
Counters option (Chapter menu). 

Section and chapter headings are often placed in the header or footer 
of a long document or directory. Changing these headers as you revise 
a document can be a time-consuming and error-prone process. For
tunately, Xerox Ventura Publisher can automatically place section 
headings and chapter titles in the header or footer. 

For instance, suppose that you want text tagged with a tag called 
Heading 1 to appear left-justified on each right page. 

1) Select Right Page Header. 

2) Place the text cursor on the Left line. 

3) Select the 1st Match option at the bottom of the dialog box. You 
will see the following appear on the Left line: 

[<tag name] 

~ Use the cursor and backspace keys to remove the word tag name and 
replace it with Heading 1. The text on your Left line should now look 
like this: 

[<Heading 1 ] 

This command copies the first occurrence of text tagged with the 
Heading 1 tag to the top left of every right-hand page. If no text on a 
given page is tagged as Heading 1, the most recent paragraph in the 
chapter tagged with Heading 1 is used. In this way, a section that 
continues for several pages will have the same headers. The headings 
at the top of every page in this Reference Guide were automatically 
generated using this feature. Figure 5-32 shows how to place text from 
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paragraphs tagged with Heading 1 and Chapter Head into the right 
header. 

Xerox Ventura Publisher also copies any index entries in the tagged 
text to the header or footer; as a result, index entries are created that 
will specify the entire range of pages in a section of the document. 

Xerox Ventura Publisher copies all attributes and font changes from 
the tagged text into the header or footer. 

Text attribute You can use the text attributes described in Appendix D to modify the 
header or footer text. Figure 5-32 shows how these attributes can be 
used to change the word Page to 18 point. 

Tagging 
headers & 
footers 

5-86 

The tags Z _HEADER and Z _FOOTER are automatically created the 
first time you create either a header or footer. These header and footer 
tags are each initially assigned Body Text attributes. However, you can 
change the tag attributes for both header or footer. For instance, to 
place the header closer to the body of the document: 

1) Select Paragraph mode. 

2) Select the header. 

3) Increase the header tag's Above space (Spacing option, Paragraph 
menu). 

To place the footer closer to the body of the document, decrease the 
footer tag's Above space. 

To place a ruling line below each header: 

1) Select Paragraph mode. 

2) Select the header. 

3) Select Ruling Line Below from the Paragraph menu. Customize as 
desired. 

~ Note: if the header Above space plus the header Below space is larger 
than the top margin, the top margin will be increased beyond what you 
set for the page's top margin. 

To correct this situation: 
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1) Select the Paragraph mode. 

2) Select the header text paragraph. 

3) Select Spacing from the Paragraph menu. 

4) Decrease the Above or Below space. 

The same procedure applies to footers. 
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Turn header/footer off (on) 

Description 

Turn Header Off (On) or Turn Footer Off (On) suppresses (enables) 
the header or footer/or the current page. 

Application 

Remove header or footer from the current page. 

Operation 

To turn headers off for the page currently displayed, select the Turn 
Headers Off option in the Chapter menu. To turn headers back on, 
select the Tum Headers On option in the Chapter menu. Tum Footers 
Off (On) works identically. 

~ Turn Headers Off/On remains associated with the page number 
shown in the Current Selection Indicator, even if text is moved from 
one page to another. Therefore, do not tum headers or footers off until 
you have finished creating the chapter. 

5-88 REFERENCE GUIDE 



CHAPTER MENU, Footnote setting MENU COMMANDS 

Footnote setting 

FOOTNOTE SETTINGS 

" 

Usage & ForMat: []ffJ I ~ FrOM Start of Page (1,2,3) I 
~ FroM Start of Page (User' Defined) 

I ~ FrOM Start of Chapter (1,2,3) I 
Start Wi th ~: 0005 

NUMber TeMplate: m 

User' Defined Strings: ........-:-=;.:=~-' * 3: *** 4: **** 
7: +++_ B: ++++ 

Space AbolJe line: 
Separator line Width: 24.'~0 fractional pts 

Height of line: 01. 0 [][] I Cancel I 

Figure 5-33 Footnote Settings dialog box. In this example,footnote refer
ences will begin afresh at the top of each page. Each footnote reference will 
be enclosed in parentheses ( ) and be superscripted. The first footnote refer
ence on the page will appear as a (*) character, and a one point line will be 
placed 24 points below the last line of text on the page. 

Description 

Footnote Settings controls chapter footnote formatting. Footnotes are 
created using the Insert Footnote option in the Edit menu. 

Application 

Provide quick references to other information 

Operation 
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1) Select the Footnote Settings option in the Chapter menu. (See 
Figure 5-33.) 

2) Select one of the three Usage & Format options: 
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# From Start of Page (1,2,3.) This re-starts footnote numbering 
at the top of each page, and numbers each footnote with an arabic 
number. 

# From Start of Page (User-Defined.) Same as above, but 
instead of arabic numbers, each footnote reference is shown by 
whatever is defined on the User Defined Strings: line. The 
default strings are shown in Figure 5-33, but you can enter any 
other characters for up to eight footnote references per page. 

# From Start of Chapter (1,2,3.) Same as the first option above, 
but the numbers continue increasing throughout the chapter. 

You must select one of the three options, or you can't create footnotes 
for this chapter. 

3) To start footnote numbering at a number other than one, place the 
text cursor on the Start With #: line and enter the starting number. 
This is useful when you are printing a single chapter in the middle 
of a long document. 

4) You can place fixed text immediately before and after the footnote 
reference at the bottom of the page by typing up to three characters 
on the Number Template: line. The # character specifies where to 
place the footnote number. For example, typing (#) on this line 
places parentheses around each footnote reference number at the 
bottom of the page. 

5) Next, select your choice of Subscript, Superscript, or No Shift. 
These settings control the vertical placement of the footnote refer
ence number or character within the text. The placement of the 
matching footnote number at the bottom of the page is controlled 
with paragraph tag settings. This procedure for modifying these 
settings is described at the end of this section. 

6) If you selected # From Start of Page (User Defined), you may 
alter any or all of the character strings that appear beside User
Defined Strings. Use the cursor and backspace keys to erase the 
default characters, and then type in the ones you wish to substitute. 

7) If you want to place a ruling line above the footnotes at the bottom 
of the page, enter the Space Above Line, Height of Line, and the 
Separator Line Width (the width of this line.) The separator line 
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width controls the length of the line across the page and is measured 
from the left edge of the page. 

To turn footnotes off, select the Off option and then select OK. 
Turning footnotes off does not affect the footnote text stored in the text 
files. As soon as footnotes are turned back on, all footnotes will once 
again be displayed. 

~ You can place footnote references on the page only. Xerox Ventura 
Publisher ignores footnotes in frames or in box text. 

Footnote frames Footnotes are placed at the bottom of the page in a frame that Xerox 
Ventura Publisher creates when footnotes are turned on. This frame is 
automatically enlarged as you add additional footnotes. If you wish, 
you can select this frame in the Frame mode and change any of the 
attributes available in the Frame menu to achieve different footnote 
formatting. You cannot, however, change the number of columns in the 
footnote frame. 

~ If you have specified a large amount of Above or Below space for 
Body Text prior to turning footnotes ON, the frame which is automat
ically created to hold the footnote will be much larger than you 
probably want. To correct this problem: 

Customizing 
footnote tags 
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1) Select the Paragraph mode. 

2) Select the footnote number. 

3) Decrease the Above or Below space using the Spacing option in the 
Paragraph menu. 

Repeat this process for the footnote text. 

The footnote number at the bottom of the page is automatically 
assigned a tag called Z _FNOT #, and the footnote itself is automat
ically tagged with a tag called Z_FNOT ENTRY. You can change 
each of these tags independently to achieve different formatting ef
fects. Use the various options in the Paragraph menu to customize the 
footnote number and entry tags. 
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Footnote numbers 

One common effect that you can create by changing the Paragraph 
menu options for the Z_FNOT # and Z_FNOT ENTRY tags is to 
place the footnote number on the same line as the footnote. To do this, 
follow the procedures given in the Automatic Section Numbering 
section for placing section numbers on the same line as the paragraph 
that follows. 

You can also make the footnote number at the bottom of the page 
superscripted. To do this: 

1) Select the Paragraph mode. 

2) Select any footnote entry at the bottom of the page. 

3) Select the Break option in the Paragraph menu and set Line Break: 
After. 

4) Select any footnote number at the bottom of the page. 

5) Select Font in the Paragraph menu, and make the footnote number 
a smaller font. 

6) Select the Break option in the Paragraph menu and set Line Break: 
After. 

7) Set Interline space (Spacing option in the Paragraph menu) for the 
footnote number to a small number, typically 0-5 points. This will 
cause the text in the next paragraph (i.e., the footnote itself) to start 
0-5 points below the footnote number. 

This method is simple, but results in space between each footnote. If 
you want to create superscripted footnote numbers without adding 
space between the footnote entries, consult the section Footnote 
Superscripts in the chapter Putting It Together. 
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Insert page/remove page 

INSERT/REMOUE PAGE m 
Operation: I Insert New Page Before Current Page I 

Insert New Page After Current Page 

I RertlolJe Current Page I 

Figure 5-34 Insert/Remove Page dialog box 

Description 

Insert Page allows you to insert a blank page anywhere in your 
chapter. You can then place text and pictures on this blank page. 
Remove Page removes an inserted page. 

Application 

• Add additional pages when text is placed in frames (e.g., newsletter 
or newspaper layout). 

• Create multiple formats in the same chapter. 

• Remove pages which have been added. 

Operation 

REFERENCE GUIDE 

To insert a page: 

1) Go to the page where the new page is to be inserted. 

2) Select the Insert/Remove Page option. The Insert/Remove Page 
dialog box shown in Figure 5-34 appears. 
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Newpage 

3) Select either Insert New Page Before Current Page or Insert 
New Page After Current Page, depending on whether the blank 
page should appear before or after the currently displayed page. 

Any text file that you place directly in an inserted page, rather than in 
a frame placed on top of the inserted page, automatically inserts 
additional pages as needed, until all text is placed in the chapter. Text 
already on the page that precedes the inserted page flows around the 
inserted file. 

Example: If text from file number one originally flows from page one 
to page eight, and a new page is inserted between pages six and seven, 
the text from file number one will flow from page one to page six, skip 
page seven, and finish on pages eight and nine. If you place file 
number two on the blank page seven, and if this file fills five pages, 
file one will now flow from page one to page six, then finish on pages 
twelve and thirteen. File two will be placed on pages seven through 
eleven. 

All attributes from the original page are copied to the inserted page. 
However, you can customize the Frame menu settings for each in
serted page. This allows you to change the page fonnat in the middle 
of a document. You cannot, however, change from landscape to 
portrait format or vice versa. 

Remove current 
page 

To remove an inserted page: 

1) Use the Remove File (from frame) option in the Edit menu to 
remove the file from the inserted page. 

2) Select Remove Current Page. 

The inserted page is removed from the chapter. You cannot remove the 
current page until you have removed all files from that page. The 
chapter is refonnatted from the first page of the chapter after you 
remove a page. 

~ When you remove a page, the Page Number Indicator counts through 
all the pages in the chapter and renumbers them. Do not become 
alarmed when you see this happen: only the page you selected is being 
removed. 
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Go to page 

GO TO PAGE 

Relative to: File I 

Which Page: Selected I 

Current Page: 9B1~ Selected Page: BBl 

OK I Cancel I 

Figure 5-35 Go To Page dialog box. Set to go to page 34. 

Description 

Go To Page allows you to go directly to the desired page in your 
chapter. 

Application 

• Find a specific page in a long chapter without searching. 

• Find the page on which a selected file continues, in a chapter which 
contains mUltiple text files. 

This is especially helpful in a newspaper or magazine layout, where 
many articles are placed across multiple, non-contiguous pages. 

Operation 

To go to another page: 
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1) Select the Go To Page option in the Chapter menu or press and hold 
the Ctrl key and then press G. The Go To Page dialog box shown 
in Figure 5-35 appears. 

2) Select which page to go to. You can go to the first, previous, next 
or last page in the chapter merely by making one of these selections 
and then selecting OK. 

You can also go directly to a specified page number by choosing 
Selected and then entering the appropriate page number on the 
Selected Page line. The current page number is shown for reference. 

To halt a Go To Page operation, press the Esc key. 

In newsletter, newspaper or magazine documents, text files can start 
in a frame on one page and then continue in a frame on a much later 
page. In a chapter with many files, it can become difficult to find the 
next page that contains the remainder of the file. The Relative To File 
selection solves this problem. To go to the next page that contains text 
from a selected file: 

1) Select frame mode. 

2) Select the frame that contains the file. 

3) Select the Go To Page option in the Chapter menu. 

4) Select the File option. 

5) Select First, Prev, Next, or Last to go to the first, previous, next, 
or last page which contains text from the selected file. 

The on-screen scroll bars move within a given page. Use the Go To 
Page option to change pages. 

When you change pages, you must place the text cursor at the desired 
location on the new page before you can resume editing. 

To move forward or back one page at a time, or go to the beginning or 
end of a chapter, use the following keyboard shortcuts (make sure 
N urn Lock is off): 

Previous page 
Next page 
First page 
Last page 

. Page Up key 

. Page Down key 

. Home key 

.End key 
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FRAME MENU 

Margins & Colu~ns", 
Sizing & Scaling", 
Fra~e Typography", 

Anchors & Captions", 
Repeating Fra~e", 

Uertical Rules", 
Ruling Line Above", 
Ruling Line Below", 
Ruling Bo~ Around", 
Fra~e Background", 

Figure 5-36 Frame Menu. 

The Frame menu controls the format of frames, as well as the page 
format (remember, the page is just another frame). Using the options 
in the Frame menu you can control margins, columns, ruling lines, 
frame sizing and scaling, frame typography, anchors and captions, 
background fill patterns, and image settings. 

The page itself is like any other frame, except that Margin and Column 
settings for the page are stored in the style sheet file. All other frame 
settings are stored with the chapter file. 

Changes made to any page affect all non-inserted pages (see In
sert/Remove pages in the Chapter menu). Changes to each inserted 
page or changes to frames which you draw affect only that one page 
or frame. 
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MRRGINS & COLUMNS 

# of ColuJIlns: OJ II [I] rn m m rn []] 
Settings For: IIU •• I Right Page I 

(oluJlln 1: 
2: 
3: 
4: 
5: 
6: 
7: 
0: 

Widths 
04.50 
02.50 
00,00 
00,00 
00,00 
00,00 
00,00 
00,00 

Gutters 
00.50 
00,00 
00,00 
00,00 
00,00 
00,00 
00,00 

Margins 
Top: 01.00 inches 

BottoM: 01.00 
Left: 00.5g 

Right: 00.5~ 

Calculated Width = 00,50 
Rctual FraJlle Width = 00.50 

Inserts: I Make Equal Widths I I COP? To Facing Page I 
[J[J I Cancel I 

Figure 5-37 Margins & Columns dialog box. Left page settings shown. 

Description 

The Margins & Columns option sets the margins for any page or 
frame, including frames automatically generated by Xerox Ventura 
Publisher (e.g., header, footer, footnote, or caption frames.) 

For the page or for any frame, Margins & Columns sets: 

• The top, bottom, left, and right margins 

• The number of columns 

• The width of each column and inter-column spacing (gutters) 

Application 

• Set unique margins & columns for each frame 

• Set different margins & columns for left and right page (e.g., 
binding margins) 
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• Create complementary facing pages 

• Move pictures within a frame 

Operation 

Basic steps 

Unequal column 
widths 
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You can change the margins and number of columns for the page or 
any frame by following the basic steps which follow. For special 
situations, you must modify these steps slightly as described in the 
sections on the next several pages. 

The basic steps given here allow you to create pages or frames which 
have the same widths for each column and the same margins for the 
left and right pages. 

1) Select the Frame or Graphic mode. 

2) Select the frame or page to be changed 

3) Select the Margins & Columns option in the Frame menu. The 
Margins & Columns dialog box shown in Figure 5-37 appears. 

4) Select the number of columns you want for the page or frame you 
selected. 

5) Set each margin (top, bottom, left, right). 

6) Set the first gutter space (the space between the first and second 
column). 

7) Select Make Equal Widths. 

8) Select OK. 

You can also independently set each column's width as well as the 
gutter space between each column. This allows you to create unusual 
page designs where each column is different from the next. 

1) Select the number of columns 

2) Set each margin (top, bottom, left, right). 

3) Set each column width 

4) Set each gutter space. 

After entering all information, but before selecting OK, make sure that 
the Calculated Width (which shows the current sum of left margin, 
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right margin, column widths, and inter-column space) equals the 
Actual Frame Width. Xerox Ventura Publisher cannot do this for you 
because you have independent control over each setting, and it is 
therefore possible to create margin and column widths that don't equal 
the width of the page or frame. 

If the margin and column appearance on-screen do not match what you 
specified, check to make sure that Calculated Width equals Actual 
Frame Width. 

If Double-Sided was selected in the Page Layout option, each frame 
or page can have different margins, column widths, and gutter space 
for the left pages than for right pages. This is useful for creating 
binding margins and for making left pages which look different from 
right pages. 

To set different margins and columns for left and right pages, follow 
the procedures for either equal or unequal column widths. However, 
before selecting OK, select Settings For the other page, then enter all 
settings for that page. You must set both pages before you select OK or 
the settingsfor the one page will be automatically reflected to the other 
page. 

Copy to facing page 

You can copy the left and right margin settings to the opposite page by 
selecting Copy to facing page. The margin settings automatically 
reflect, e.g., the right margin setting on one page becomes the left 
margin setting on the opposite page. The margin and column widths 
are not copied and must be explicitly set for both left and right pages. 

Captions Whenever you create a caption using the Anchors & Caption menu, a 
frame is automatically created for the new caption. This caption frame 
is automatically attached to the frame which contains the picture. The 
caption frame's settings can be changed independently by selecting it 
and setting its margins. The caption frame can also be selected and 
made larger or smaller. 

~ Hint: if you set different left/right page margins for a frame, use the 
Anchors & Captions option after you have set the frame's margins. 
Since the caption's initial margins are copied from the frame's mar
gins, this eliminates the need to set the caption's margins. 
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Header & footer 
frames 

Footnote frames 
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When you first create a header or footer, a frame is automatically 
created to hold it. This frame's margins are initially set to vertically 
center the text. To place the headers and footers in a different location 
within the header or footer frame you can change either the frame 
margins or change the header or footer paragraph tag's above, below, 
or left/right spacing. Changing the tag spacing is a better choice 
because it is stored in the style sheet and will therefore affect other 
documents in a similar manner. 

When you first create a footnote, a frame is automatically created to 
hold it. The frame's margins are initially set to vertically center the 
footnote text. However, like header & footer frames, you can change 
either the frame margins or the paragraph's above, below, or left/right 
spacing to change the footnote's location within a frame. You should 
change the paragraph tag's spacing whenever possible for the same 
reasons described in the previous paragraph. 
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Sizing & scaling 

SIZING & SCALING 

X Crop Offset Flow Text Around: On 

+ moves picture 
left 

Upper Left K: 
Frallle Width: 

Horiz. Padding: 
-moves . . 

. . h Plcture Scallng: 
picture ng t 

'\ Aspect Ratio: 

"'---- - K Crop Offset: 
Scale Width: 

Scale Width / 
defines width of / 

picture. 

B2.BB Dc:::J 
BUB 
BB.BB 

Upper Left Y: B1.BB D c:::J 
Frallle Height: B1. BB 

Uert. Padding: BB.BB inches ---/!-----' 

I Fit in Frallle I l:a"ljiiA#ilD 
liMNI I Distorted I 
BB.BB Dc:::J Y (rap Offset: DB.BB Dc:::J ----tt ____ 
BUB Scale Height: 01.42 

[]i[] I Cancel I 

Figure 5-38 Sizing & Scaling dialog box 

Description 

Measurement units 
controls 
measurements for 
entire dialog box 

Y Crop Offset 

+ moves picture up 

-moves down 

The Sizing & Scaling option allows you to precisely control the size 
and placement of frames. It also allows you to exactly control picture 
reduction or enlargement. Finally, this option controls the way text is 
formatted around a frame. 

Application 

• Superimpose text on pictures 

• Place the frame at a precise location 

• Scale pictures 

• Crop pictures 

• Create runarounds 

Text flow around When you create a frame, Xerox Ventura Publisher automatically 
causes text in your document to flow around it. You can override this 
setting, either to allow text to be superimposed on pictures or to create 
runarounds. 
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Frame 
placement 

Frame 

Page --l 

To allow text to flow under a frame, turn Flow Text Around off. If the 
text contains tabs, text may not completely flow around frames. 

Use of this feature to make text wrap around pictures is covered in the 
Frame section in the Modes of Operation chapter. 

Normally, you use the mouse to place frame's where you want them 
on a page. If, however, you want to position a frame with absolute 
precision, use the Sizing & Scaling option as follows: 

1) Select the Frame mode 

2) Select a frame 

3) Select the Sizing & Scaling option in the Frame menu 

4) Set the Upper Left X and Upper Left Y coordinates of the frame. 

I-

These numbers refer to the distance of the upper left corner of the 
frame from the upper left corner of the physical page (Figure 5-39). 
The X coordinates are measured horizontally, the Y coordinates 
vertically. 

i 
Upper Left Y 

1 
Upper Left X _ 

Frame Height 

r- Frame Width --1 

Figure 5-39 X and Y Frame placement defined 
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5) Set the frame size by modifying the frame's Width and Height 
settings. 

Scaling Pictures The Picture Scaling and Aspect Ratio options let you control a 
picture's size and aspect ratio. 

Figure 5-40 

Picture scaling: fit in frame 

When you select Picture Scaling: Fit In Frame, you can increase or 
decrease the size of a picture by changing the size of the frame that 
contains it. 

If you select Aspect Ratio: Maintain, the height to width aspect ratio 
of the original picture is maintained as you make the frame larger and 
smaller (Figure 5-40). By contrast, choosing Aspect Ratio: Distorted 
scales the picture to fill the entire frame, even if this distorts the image 
(Figure 5-41). 

Picture scaling: by scale factors 

Picture Scaling: By Scale Factors (Figure 5-42) allows you to 
precisely increase or decrease the size of the picture, independent of 
the size of the frame. When you select this option, Scale Width and 
S cal e 

Figure 5-41 Figure 5-42 
Fit in Frame, Aspect Ratio: Fit in Frame, Aspect Ratio: By Scale Factors. Scale width 

& height both doubled. Maintain Distorted. 
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Cropping 

Height control the width and height of the picture. For instance, 
selecting a Scale Width of 03.00 inches makes the picture exactly three 
inches wide. 

When you select Aspect Ratio: Maintained, only the Scale Width 
can be set. The Scale Height is automatically increased or decreased 
as necessary to maintain the original aspect ratio of the picture. Neither 
scale width or height can exceed 27 inches. 

When you select Aspect Ratio: Distorted, you can enter settings for 
both the Scale Width and Scale Height. 

Any picture can be cropped as follows: 

• Select Frame or Graphic mode. 

• Select the frame which contains the picture you wish to crop. 

Actual Picture Size - .. i\ i •..• i .. Y Crop (+) 
(shaded area) 

Frame 
O.25x 1.5 inch) 

X Crop (+) 

Figure 5-43 Cropping for picture which is scaled 1.5 inches in the X 
direction, 3.0 inches in the Y direction. X Crop Offset is 0.25 inches (+). Y Crop 
Offset is 0.50 inches (+). 
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• Press and hold the ALT key. 

• Place the mouse cursor in the center of the selected frame. 

• Press and hold the mouse key and move the image to a new location 
within the frame. 

Ignore any "clutter" that may be created as you crop the image. This 
will be eliminated when you release the mouse button. 

You can also crop pictures by specifying the X (horizontal) and Y 
(vertical) amount to move the scaled picture relative to the frame (see 
Figure 5-43). 

The Padding settings let you increase space around a frame to keep 
surrounding text from touching the side of a frame. You should set a 
vertical padding space equal to the body text inter-line spacing. 

Padding is particularly important when you place pictures across 
column boundaries in multi-column documents. Use vertical padding 
to stop the vertical rules between columns from touching the top and 
bottom of the picture frame. Use horizontal padding to keep text in 
adjacent columns from touching the sides of the picture. 

The Page Size & Layout option in the Chapter menu offers a few 
fixed page sizes. If your document requires that you create custom size 
pages, use the Frame Width and Frame Height options in the Sizing 
& Scaling dialog box to create a custom size page. Custom pages must 
be smaller than the size selected in the Page Size & Layout option. To 
create custom size pages, follow these steps: 

1) Select Frame mode. 

2) Select the page. 

3) Select the Sizing & Scaling menu. 

4) Set the Frame Width and Frame Height to the size of the page 
you want to create. 

5) Select OK. 

Note that after you select OK, the custom page is positioned at the 
upper left comer of the page. If you want to center the custom page, 
adjust the Upper Left X and Upper Left Y values as necessary. 
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Scanned images Scanned images look best when printed at exactly their original size. 
If this is not feasible, you can obtain the next best results by making 
the picture an exact integer multiple larger or smaller (e.g., 2X, 3X, 4X 
... or IJ2X, V3X, IJ4X ... ). If you scale the picture by an odd amount, 
the picture may be marred by horizontal and vertical moire lines. 
These result from the scaling process and are unavoidable. 

You will see similar moire lines when the image is displayed on the 
screen. These lines result from the difference between the resolution 
of the screen and the printer resolution. They are normal, do not affect 
printing, and should be ignored. 

~ To ensure that your scanned images are always scaled correctly, 
always select Picture Scaling: By Scale Factors and Aspect Ratio: 
Maintained. Immediately after you select By Scale Factors, the Scale 
Width will show the original size of the image. If you select OK at this 
point, the picture will print at exactly its original size, with the best 
possible quality. If you want to double or halve the size of the image, 
simply enter a Scale Width which is exactly twice or half the original 
picture width. 
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Frame typography 
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FR~ME TYPOGRAPHY SETTINGS [!] 
Widows (Min Lines at Top): Default I 

Orphans (Min Lines at Botto~): Default I 
(olu~n Balance: Default t 

Move Down To 1st Baseline B~: Default I 
Pair Kerning: Default t 

OK I (ancell 

Figure 5-44 Frame typography dialog box. 

Description 

The Frame Typography option overrides the global settings defined in 
the Chapter Typography menu. Settings will apply only to the frame 
or inserted page you have selected. 

Application 

The features in this menu option are used for sophisticated layouts to 
fine-tune the typography on a given page. 

Operation 

Follow these steps to use the Frame Typography option: 

1) Select the Frame mode. 

2) Select the Frame you wish to change. 

3) Select the Frame Typography option in the Frame menu. 
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The Frame Typography dialog box appears (see Figure 5-44.) Opera
tion of the features in this dialog box is identical to the operation of the 
Chapter Typography dialog box (Chapter menu). Selecting Default 
sets that feature to the value provided in the Chapter Typography 
option. Selecting any other setting overrides the Chapter Typography 
for this frame. 
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Anchors & caption settings 
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ANCHORS & CAPTIONS 

Anchor: Nozzle __ _ 

Caption: Be low 

label: Figure [c~]-[mf-I __________ _ 
Inserts: ~ I Figure ~ I I Chapter ~ I I Tellt Attr. I 

Figure 5-45 Anchors & Caption Setting dialog box 

Description 

The Anchors & Caption Settings option allows you to: 

• Assign an anchor name to a frame. 

• Attach a caption frame above, below, or to the left or right of any 
given frame. 

Two different caption counters-a Table counter and a Figure 
counter--can be used to number captions. These counters are automat
ically updated as you add and delete captions. (See the Update 
Counters option in the Chapter menu.) 

All captions for a chapter are stored in a caption file. You can edit and 
check this file for spelling errors later using the ASCII text function of 
a standard word processor. 

Application 

• Create captions for pictures 

• Automatically generate figure/table numbers 

• Anchor a picture to a location in the text 
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Anchor 

Captions 
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Type the anchor name you wish to assign to a frame on the Anchor 
line. This name must exactly match the anchor name you inserted into 
the text using the Insert/Edit Anchor feature (available in the Insert 
Special Item option in the Edit menu). Whenever the Re-Anchor 
Frame command is executed, this frame will be moved to the page that 
contains the corresponding anchor reference in the text. 

You can attach a caption to any frame in the chapter. A caption consists 
of two parts. The first part is entered from the Anchors & Captions 
dialog box. This part of the caption contains text automatically gen
erated by Xerox Ventura Publisher, including the chapter, table, and 
figure counters. This text is stored in the chapter (CHP) file). 

The second part can contain any text you wish, and can be as long as 
you like. The Anchors & Caption option automatically creates and 
attaches a caption frame. It also creates the generated portion of the 
caption. You create the rest of the caption by enlarging the caption 
frame and typing directly into it. 

To create a caption: 

1) Select the frame which is to be captioned. 

2) Select the Anchors & Caption option (Frame menu). 

3) Choose whether to place the caption above, below, to the left or 
right of the frame. 

4) Type the first part of the generated caption. on the Label line. This 
is usually a word like figure or table. 

s) Using the Inserts command, select the Table #, Figure #, or Chapter 
# options at any point that you want to insert a generated number. 
Selecting these options places the following codes on the label line: 

Inserts 

Table # 
Figure # 
Chapter # 

Code 

[T#] 
[F#] 
[C#] 

These codes generate table, figure, or chapter numbers. You can use 
either the table or figure number (not both) plus chapter number in 
each caption. 
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For example, if the caption settings shown in Figure 5-45 were the 
ninth caption in the fifth chapter, and the previous eight captions all 
specified the [F#] figure counter, this caption would display as: 

Figure 5-9 

If you want to change the text attributes of the generated portion of the 
caption, select the Text Attribute button. The default code <D> for 
nonnal body text appears. You can modify this code to insert other text 
attributes, as described in Appendix D. 

Once the caption frame is attached, it always moves with the original 
frame, even when you use the Cut, Copy, or Paste options in the Edit 
menu. You can re-size the caption frame in the vertical direction. 

To remove a caption, select the frame and Set Captions: Off. 

If no text appears in the caption frame, select the Frame mode, select 
the caption frame, and make this frame longer or wider until the 
caption appears. Then enable the Paragraph mode, select the caption, 
and adjust the above, below, and in from left/right space as necessary 
using the Spacing option in the Paragraph menu. 

If you make the caption frame longer, and if you select Show Tabs and 
Returns in the Set Preferences option, you will notice an end of file 
mark 0 in the caption frame next to or below the caption. Select the 
Text mode and place the text cursor directly in front of this end of file 
mark. You can then type additional text directly into the caption frame 
in exactly the same manner as you would add text to any other frame 
in the chapter. By making the caption frame larger, you can make this 
free-form caption very long. 

This additional text is saved in the chapter's caption (CAP) file. The 
caption file is an ASCII text file that you can edit with a word 
processor or check with a spelling checker. Be careful not to change 
the number of paragraphs, or text will appear in the wrong captions. 

Two tags are automatically generated when you add a caption to a 
frame: one for the generated caption (the part entered from the dialog 
box) and one for the additional text. These tag names are Z_LABEL 
FIG, and Z_CAPTION. 
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The basic attributes for these tags are initially copied from Body Text. 
You can change both caption tags so that additional caption text 
immediately follows the generated caption. To do this, select the 
Paragraph mode, select the captions, then change the generated 
caption's tag attributes using the options in the Paragraph menu, as 
follows: 

Font 

Line Break 
Alignment 
Spacing 
Ruling Lines Above 
Ruling Lines Below 

Same as additional 
text caption 
Before 
Left 
No space below 
(As desired) 
None 

Change the additional text caption's tag attributes to: 

Font 

Line Break 
Alignment 

Spacing 
Ruling Lines Above 
Ruling Lines Below 

Same as 
generated caption 
After 
Indent relative 
to previous line 
plus I pica 
No space above 
None 
(As desired) 

The figure captions in this document consist of two parts. For instance, 
the words "Figure 5-45" are created in the caption dialog box, and the 
remaining text is entered as additional text. 
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REPEATING FRAME II] 

FDr All Pages: [][] []ill] []!iiiI] IIU':I:m!tl 
On Current Page: Show This Repeating FraMe 

I Hide This Repeating FraMe I 

I ShDw All Hidden FraMes I 
[][J I Cancel I 

Figure 5-46 Repeating Frame dialog box 

Description 

The Repeating Frame option duplicates a frame, its ruling lines, 
background, and contents, on every page in the chapter. 

Application 

• Letterhead. Place the company logo on every page of the chapter. 

• Thumb tab: Place a box at the edge of every page with a page 
number in it. 

• Place a large header or footer on every page. 

Operation 

1) Create the frame you wish to repeat. If it is to repeat on left pages 
only, make sure you create it on a left page. The same comment 
applies to the right page. 

2) Place a file into the frame 
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3) Add ruling lines, background pattern, etc. 

4) Make sure that this frame is selected 

5) Select the Repeating Frame option in the Frame menu. 

6) If you want the frame to appear only on Left pages, select For All 
Pages: Left. If you want the frame to appear only on Right pages, 
select For All Pages: Right. 

7) If you want the frame to appear on both left and right pages, select 
For All Pages: Left & Right. The frame is automatically reflected, 
like a mirror image, on facing pages as shown in Figure 5-47. 

To place the frame in the same position on both left and right pages 
without reflecting: 

1) Copy the frame to the next page. (See the Copy option in the Edit 
menu.) 

2) Select the frame on the left page, then select For All Pages: Left. 

3) Select the frame on the right page and then select For All Pages: 
Right. 

You can select a repeating frame, but the selection boxes around the 
edge of the frame are displayed in gray rather than black to alert you 
to the fact that this frame is a repeating frame. Repeating Frames 
cannot be cut, copied, or pasted. They can, however, be re-sized and 
moved. Any change made to a repeating frame changes every occur
rence of that frame on all pages. 

Left Page Right Page 

Figure 5-47 Repeating Frames reflected 
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~ You can repeat up to six separate frames within a chapter. Repeating 
Frames cannot have captions. 

Hide/delete To remove a repeating frame from the current page only: 
repeating 
frames 

Large headers 
and footers 

Create more 
columns per 
page 
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1) Select the frame 

2) Select Hide This Repeating Frame in the Repeating Frame op
tion. 

To restore this frame to view, select Show This Repeating Frame. 
Once you select another frame, however, you must select Show All 
Hidden Frames to make all hidden repeating frames on the current 
page reappear. You can then selectively re-hide any repeating frame on 
the current page that you don't wish to see. 

To remove a repeating frame from the entire chapter: 

1) Select the repeating frame. 

2) Select For All Pages: Off in the Repeating Frame option. 

The frame is removed from every page except the current page. Since 
this is now a normal frame, you can remove it from the page using the 
Cut option in the Edit menu. 

To create a header larger than allowed by the Header & Footer function 
or create a multi-column header: 

1) Tum Headers off (Chapter menu). 

2) Create a frame at the top of a page. Make it extend the entire width 
of the page. Make it's height equal to the top margin. 

3) Type the header text directly into this frame. Use the Insert Refer
ence option to insert page or chapter numbers into this frame. 

4) Make this frame a repeating frame. 

The same technique works for footers. Use the Insert Reference 
feature to place chapter and page numbers in this repeating frame. 

Normally, the same exact text appears in each repeating frame, even if 
you place a large text file in the frame. However, if you first place the 
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text file in the page, then continue it into the repeating frame, the text 
will flow naturally from page to page. 

This means you can use repeating frames to create more columns per 
page, or to produce unusual formats. For instance, you can produce 
documents where text flows into a single column at the top of the page, 
and then into four columns at the bottom of the page. 

To create this effect: 

1) Place a text file in the page. 

2) Draw a frame. 

3) Use the Margins & Columns option to set four columns in the 
selected frame. 

4) Continue the text file from the page into this frame by selecting the 
text file name in the Assignment List. This will cause the text in the 
page to continue into the frame. 

5) Select the Repeating Frame option. 

6) Select For All Pages: Left & Right to make this frame repeat on 
both left and right pages. 

7) Optional: draw yet another frame (up to six repeating frames are 
allowed) and repeat the previous three steps. 

On each page, the text will flow from the page into the repeating 
frame(s). 

~ Do not completely cover the page with repeating frames when using 
this technique. Some text must still flow into the page. 
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This same technique can be used to create a large document which 
contains more columns per page than the eight Xerox Ventura Publish
er can normally handle. Simply start the text on the page and continue 
it into several frames. Each frame can have up to eight columns. Since 
the page can have eight columns and up to six repeating frames are 
allowed per chapter (each of these with up to eight columns). 
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Vertical rules 
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UERTICAL RULES rn 
Settings For: Inll. I Right Page I 

Inter· Col. Rules: On t Width: 00.50 

Rule 1 Position: 02.00 inches 
Rule 1 Width: 02.00 fractional pts 

Rule 2 Position: 00.0' 
Rule 2 Width: DO. 

Inserts: I COPY To Facing Page I 

Figure 5-48 Vertical Rules dialog box 

Description 

The Vertical Rules option allows you to place ruling lines in the gutter 
between each column on either left pages, right pages, or all pages, or 
between columns of text within any frame. You can place up to two 
vertical rules anywhere within a page or within a frame. 

Application 

• Place rules between columns 

• Place rules at edge of page or column 

Operation 

1) Select the frame in which you want to place vertical rules. 

2) Select the Vertical Rules option in the Frame menu (Figure 5-48.) 

3) Choose whether to position the rules on the left or on the right page. 
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I--- Vertical Rule Placement 
Measured From Edge Of 
Underlying Page 

Vertical Rule 
Within 
Frame 
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Figure 5-49 Vertical Rule placement is measured from edge of page, not 
edge of Frame 

4) To place ruling lines between each column, tum inter-column Rules 
On and set the inter-column Rules Width. 

5) Enter Rule Width and the Rule Position for Rule 1 and/or Rule 2. 
The Rule Position is measured from the left edge of the physical 
page, not the edge of the frame. It is independent of margin settings. 

Set the dimensions for all vertical rule widths by changing the Rule 1 
Width dimension. 

If the same settings are desired for the opposite page (when Double 
sided is selected in Page Layout), choose Copy to Facing Page. If 
different settings are desired for the opposite page, select Settings 
For: the opposite page, and enter the opposite page vertical rule 
information as described above. 

If you don't immediately see a vertical rule within a frame, the frame 
is probably in the wrong position on the page relative to the rule. (See 
Figure 5-49.) 

~ Frame-wide paragraphs (see the Alignment option in the Paragraph 
menu) interrupt vertical rules. Column-wide paragraphs do not. 
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Ruling lines 

The height of these 
ruling lines ... 

... is defined by these 
settings 

\ 
RULIN6 LINES ABOUE \ 

Width: Frallle 
Color: Black 

Pattern: Solid 
Dashes: Off 

Space Above Rule 1: B6.BB 
Height of Rule 1: B7.BB CustOIll Indent: 

Space Below Rule 1: BS.BB CustOIll Width: 
- He ight of Rule 2: B4.BB 

Space Below Rule 2: 03.B~ Dash Width: 
Height of Rule 3: B2.B Dash Spacing: 

Space Below Rule 3: ~~t~~ Dc:J 
Overall Height: 

Figure 5-50 Ruling Lines dialog box 
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III 

:1 
36.00 

O(UJO Gc:J 
00,00 

00,00 
00,00 fractional pts 

DiD I Cancel I 

Description 

5-120 

You can place up to three ruling lines, each of different height and with 
different spacing between each rule, below, or around a frame or the 
page. Texture and color can be assigned to each set of ruling lines. 

All three Ruling Lines dialog boxes function the same way. 

Application 

Isolate pictures or text in frames from the surrounding text. 

Operation 

1) Select the Frame mode. 

REFERENCE GUIDE 



FRAME MENU, Ruling lines MENU COMMANDS 

REFERENCE GUIDE 

2) Select the frame. 

3) Select the appropriate ruling line option (Above, Below, or Box 
Around.) 

4) Select Width: Frame to make this ruling line available. The 
choices Text, Margin, and Custom are available only when you use 
the Ruling Line options in the Paragraph menu. 

5) Select the ruling line Color and Pattern. The same color and pattern 
is assigned to all three rules. 

6) Enter the appropriate ruling line height, as well as space between 
each ruling line, for each of the three rules. 

7) If you wish to make dashed rules, tum dashes on, and then select 
the width ofthe dash and the space between each dash. Note: Xerox 
Ventura Publisher cannot display or print thick dashed rules. If 
dashes do not display on the screen, reduce the ruling line height. 

The ruling lines appear in the dialog box display immediately to aid in 
determining the proper line thicknesses and spacing. The total height 
occupied by all ruling lines is shown on the Overall Height line. This 
display is limited to about 0.5 inch. You can create larger ruling lines, 
but they will not display in the dialog box. 

If ruling lines overwrite text or pictures inside the frame, increase the 
margins of the frame using the Margins & Columns option in the 
Frame menu. 
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Frame background 

FRAME BACKGROUND 

Color: Blue I 
Pattern: 1 I 

Result: 

OK I· Cancel 1 

Figure 5-51 Frame Background dialog box. 

Description 

The Background option sets the frame background color and texture. 

Application 

• Isolate a picture or text frame from the surrounding text. 

• For printers that support white on black printing, set the back
ground to black. The text within the frame is automatically set to 
white. 

Operation 

1) Activate the Frame mode and select the frame. 

2) Select the Background option in the Frame menu. 

3) Select the color and pattern desired. 

~ Selecting a background pattern that is too dark may make the printed 
output unreadable. For most applications, stay with the lightest pat-
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terns. Also, avoid White Solid. Use White Hollow instead for easier 
text editing. 

The background pattern fills the frame, minus: 

• The space above the ruling line above 

• The space below the ruling line below 

• The space above the ruling box around. 
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IMAGE SETTINGS· (Gray Scale I~age) [!] 
Halftone Screen Type: 

Halftone Screen Angle: 
lines Per Inch: 

Default 

B4S 
BBS31 

I OK 

Figure 5-52 Image settings dialog box. 

I Cancel I 

Description 
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The Image Settings option allows you to control halftone processing 
for images which contain shades of gray. This control is available only 
for PostScript and TIFF images, and is only enabled when these 
images contain shades of gray. In addition the Image Settings control 
only affects printing to PostScript printers. 

TIFF files which contain shades of gray will print to non-PostScript 
printers, but the Image Settings will have no effect. Also, as mentioned 
elsewhere in this documentation, a representation of a PostScript 
images is printed to non-PostScript printers if the PostScript file 
contains a TIFF bit map or Windows metafile representations of the 
PostScript code (if an image is displayed on the screen, an image will 
print). 

Definitions 

Gray scale image. A gray scale image is a scanned image in which 
every dot in the picture is a shade of gray rather than just black. 
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Half toning. Half toning is the process of modifying a gray scale image 
so that it can be printed by a device that is capable of producing only 
black dots. Half toning converts each gray dot within a picture into a 
pattern of black dots: light shades are represented by sparsely spaced 
dots, while dark shades are represented by densely spaced dots. If 
halftoning is done by the scanner, the resulting image is called a 
dithered image. The gray information for dithered images is thrown 
away before the image is brought into Xerox Ventura Publisher. 
Therefore, the Image Settings option is not available for dithered 
images, because they do not contain any true gray scale information. 

Operation 

Halftoning 
process 

REFERENCE GUIDE 

To change the halftone image settings: 

1) Select the frame which contains the gray scale image. 

2) Select the Image Settings option in the Frame menu (Figure 5-52). 

3) Select the Halftone Screen Type, Screen Angle, and Lines Per Inch 
you want and then select OK. 

Recommended settings. The default screen is typically used for most 
work. The screen angle is normally 45 degrees. Set lines per inch to 60 
for laser printers, 90 for 1200 dot per inch typesetters, and 150 for 2540 
dot per inch typesetters. These settings will work for most situations. 
However, you may be able to dramatically reduce the size of gray scale 
images, and also obtain better results if you understand the halftone 
process. This is described in the following subsection. 

The Image Settings option is but one control in the process which starts 
with scanning a photograph into the computer, and ends with the 
printing of that photograph from Xerox Ventura Publisher. 

Four parameters in this process interact to produce various different 
levels of picture quality. What follows is a definition of each parameter 
along with recommended ranges. Use these formulas and ranges to 
decide on the tradeoff which is right for your particular situation. 

Printer resolution. Printer resolution is the number of dots that the 
printer can place within a square inch of paper or film. Laser printers 
usually print at 240,300, 400, or 600 dots per inch. Most print at 300 
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dots per inch. Once you buy a printer or typesetting machine, the dots 
per inch is fixed. 

Gray levels. Each dot which a printer or typesetting machine puts on 
paper or film is black, not a shade of gray. Therefore, gray must be 
approximated by a group of dots. For instance, you can print a small 
square which is five dots wide 'and five dots high. If you print all the 
dots in this little square, then the square looks totally black. If you print 
every other dot, then the square looks 50% gray. If you print only every 
fifth dot, then the square looks 20% gray. Thus, this little square in 
essence becomes a gray dot which can have 5 x 5 = 25 shades of gray. 
However, instead of being able to print 300 dots per inch, you can only 

. 300 60 d . h pnnt - = gray ots per mc . 
5 

Screen frequency. The screen frequency refers to how may gray dots 
you place on the page per square inch. The screen is set in lines per 
inch. This unit of measure is used because in the traditional printing 
process, fine-mesh screens are placed over the photograph to convert 
the gray image into a series of dots. In the example in the previous 
paragraph, the screen frequency is 60 lines per inch. 

Screen type and angle. The screen produces a regular pattern through 
the image. To make this pattern less noticeable, the screen is normally 
rotated at an angle with respect to the picture. Also, to create special 
effects, you can use screens which use patterns other than circular dots. 

Scanner controls. If you use a scanner to create an image, you can 
usually vary the number of gray levels stored with each image, as well 
as the resolution. Scanners which recognize and store gray information 
usually let you vary the number of gray levels stored with every dot in 
a picture. The more gray levels per dot, the bigger the resulting file. 
Typical values are 16 levels (4 bits per dot), 64 levels (6 bits per dot), 
and 256 levels (8 bits per dot). Most scanners for desktop publishing 
can create images at 300 dots per inch, but let you scan at lower 
resolutions in order to create smaller files. 

As you can see from the previous paragraphs, you can trade resolution 
for levels of gray. Therefore, before you scan an image, you should 
decide on the number of gray levels and the screen frequency you 
want. The relationship between these two is: 
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Printer Resolution 
Screen Frequency = ----r=====-

'VGray Levels 

Thus if you want to print 25 levels of gray on a 300 dot per inch printer, 
you should select a screen frequency of 60 lines per inch. Typical 
screen frequencies and gray levels are as follows: 

• Screen frequency. Newspaper picture quality is created with 
screen frequencies of 65-75 line per inch. Magazine picture quality 
is created with screen frequencies of 120-150 lines per inch. 60, 75, 
120, 133, and 150 are typical values. 

• Gray levels. The eye cannot discern 256 different gray levels. 
Therefore, storing more than 256 levels of gray is a waste of space. 
At the other end of the spectrum, 32 gray levels is coarse, but 
adequate for many uses. 

You can significantly decrease the size of scanned image files without 
degrading image quality by limiting scanner resolution to roughly the 
screen frequency, and by limiting the number of gray levels stored to 
just slightly more than the screen frequency and printer resolution 
allow. Restating the formula given earlier: 

G L 1 
Printer Resolution 

ray eve s = 2 
[Screen Frequency] 

For instance, if you intend to print with a 60 line per inch screen to a 
300 dot per inch printer, you should scan the image at only 20% more 
than 60 dots per inch, which is roughly 75 dots per inch. Also, you 
should scan for just a little more than 25 levels of gray, which trans
lates to 32 or 64 gray levels on most scanners. You will need to 
experiment with your particular setup to find values that produce 
pleasing results with the smallest possible numbers. 

The scanner resolution you use also depends on the enlargement done 
in Xerox Ventura Publisher. The general formula is: 

Scanner Resolution ~ 1.2 x Screen Frequency x Magnification 

Thus, if you plan to double the size of the image using the Sizing & 
Scaling option, and you have set screen frequency to 60 lines per inch, 
you should scan the image at 1.2 x 60 x 2 ~ 150 dots per inch. The 

5-127 



MENU COMMANDS FRAME MENU, Image settings 

factor of 1.2 is based on experience. You should experiment to see 
what works for you. 

Finally, if you want to create special effects, you can try changing the 
Screen Angle and Screen Type. 

Figures 5-53, 5-54, and 5-55 show the results of changing the Lines 
Per Inch setting. The image was scanned at 75 dots per inch with 16 
levels of gray. 

Figure 5-53 3 0 -I i n e 
screen, 45 degrees, default 
screen. 

Figure 5-54 6 0 -I i n e 
screen, 45 degrees, default 
screen. 

Figure 5-55 120-line 
screen, 45 degrees, default 
screen. 
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Font ... 
Alignlllent .. . 
Spacing .. . 
Breaks .. . 
Tab Settings ... 
Special Effects ... 
Attribute Overrides .. . 
Paragraph Typography .. . 

Ruling Line Above .. . 
Ruling Line Below .. . 
Ruling Box Around .. . 
Paragraph Background ... 

List... AK 

Figure 5-56 Paragraph Menu 

The Paragraph Menu defines the individual Tags (paragraph for
mats) contained within a style sheet. These tags are used to change the 
text format for each paragraph in a chapter. 

Each tag defines a set of font, alignment, spacing, breaks, tabs, special 
effects, text attributes, typographic characteristics, and ruling lines for 
a paragraph. A collection of tags, plus the current page layout and 
margin and column settings, is stored in a style sheet. Xerox Ventura 
Publisher includes a series of style sheets designed by typographers. 
See Appendix L. You can also create your own style sheets, as de
scribed in the next chapter, Putting It Together. 

~ Before any option in the Paragraph menu can be selected, the Para
graph mode must be enabled and a paragraph selected. 
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The tag Body Text is reserved by Xerox Ventura Publisher. Although 
you can change the characteristics of Body Text, you cannot remove 
the name itself. All text not formatted with a specific tag is automat
ically formatted as Body Text. 
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Note that before you can change a tag's attributes, you must first select 
a paragraph that has been tagged with this tag. This allows you to see 
what the tag's attributes currently look like, and also allows you to see 
immediately the effect of any changes you have made. 

~ Any attributes you placed in the text using the Text mode take 
precedence over the paragraph tag. 

The following pages describe each option in the Paragraph menu. 
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Font 

"Bod!l Text" FONT 

Style un 
Light 
Norlilal 
Bold 
L-Italic 

B·ltalic 

(UstOIil Size: B12.~ points 

Overscore: OfH 
Strike· Thru: Off ~ 

Underline: OfH 
Double Underline: OfH 

Figure 5-57 Font dialog box. Size option displays the word Custom for 
PostScript printers .. displays discrete sizes for other printers. 

Description 

The Font option defines the typeface, type size, type style (bold, 
italic), color, and attributes for each paragraph. 

Application 

• Set the font for each paragraph tag 

• Change text to white to print white text on a black background 

• Change text colors for color separations 

• Create paragraph line attributes for tables. 

Operation 

To change a tag's font: 
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1) Select the Font option in the Paragraph menu. (The typefaces and 
fonts available depend on the printer width table installed. See the 
Set Printer Info option in the Options menu.) 

2) Select the desired typeface, size, style, and color. The Font sizes are 
displayed in Points, where 72 points equal one inch. Ten, eleven, 
and twelve points are standard sizes for Body Text. 

When you select OK, the paragraph selected, and all other para
graphs tagged with the same tag will be formatted with the new font. 
Note, however, that the paragraph font does not override any font 
attributes that you assign to blocks of text using the Text mode. 

For PostScript printers, select the size (in points) on the Custom Size 
line. (See Figure 5-57.) Any integer size between 1 and 254 points is 
allowed. For other printers, only certain font sizes are available, and 
the Custom Size option cannot be selected. Instead, select one of the 
discrete sizes shown in the Size menu. 

Depending on the printer installed, not all styles are available for every 
typeface. Those selections not available appear in gray rather than in 
black. With the HP LaserJet Plus, for instance, Nonnal type is avail
able for 10 point Dutch (Times Roman) type, but is not available for 
24 point Dutch. You can add additional fonts to overcome these 
limitations. If you have a PostScript printer, you can print only the 
fonts ac tu all y installed in your printer or on your computer's hard disk. 

You can make adjustments to paragraph tags more automatic by 
setting the Auto Adjust Styles control in the Set Preferences option 
(Options menu) at Yes. If Auto Adjust Styles is set to Yes, changing 
the size of the font automatically changes the tag's spacing and its line 
attributes. For instance, changing from 10 point to 18 point increases 
the tag's Inter-Line, Inter-Paragraph, above, and below spacing by a 
factor of 1.8. If you want a different spacing, change the space in the 
Paragraph Spacing option after changing fonts. 

The names Helvetica and Times Roman are trademarked and are not 
available for all printers. When not available, Xerox Ventura Publisher 
uses a typographically equivalent substitute. Swiss takes the place of 
Helvetica, and Dutch takes the place of Times Roman. 
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Alignment 

"Body Text" ALIGNMENT 

Horz, Alignlllent 
Vert, Alignlllent 

T ext Rotation 
Hyphenation 

Successive Hyphens 
Overall Width 

First Line 
Relative Indent 

I n/Outdent Width: 
In/Outdent Height: 

Justified 
Top 
99 
USENGLSH 
2 
(o!ullln' Wide 
Indent 
Off 

91, ag picas & points 
a91 lines 

In fron Ri9ht to DecinJl: 00,00 
MaxilllulII Rotated Height: 1B,9a 

DO I (ancell 

Figure 5-58 Alignment dialog box. (Indent width is set to one pica.) 

Description 

Alignment controls the way in which text lines up within a column. 
The controls available include horizontal alignment, vertical align
ment, text rotation, hyphenation controls, first line indent/outdent, 
decimal alignment, and column-wide or frame-wide overall paragraph 
width. 

Application 
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• Change from ragged right to fully justified and hyphenated text. 

• Center headlines. 

• Align text within tables. 

• Force a paragraph to go across the entire frame or page, even when 
the document has multiple columns. 
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• Cause the first lines in a paragraph to be indented either by a fixed 
amount, or relative to the length of the last line in the previous 
paragraph. 

• Change hyphenation algorithms (allowing simultaneous hyphena
tion in two languages within the same document.) 

Use this control to align text horizontally within a page, frame or box 
text. To alter the horizontal alignment of a tag, follow these steps: 

1) Select the paragraph for which you want to change tag settings. 

2). Select the Alignment option in the Paragraph menu (Figure 5-54). 

3) Choose one of the five Horizontal Alignment options: Left, Center, 
Right, Justified, or Decimal. 

Selecting Left causes text to align with the left column guide; this type 
of alignment is also known as "ragged right." Selecting Right causes 
text to align with the right column guide. Choosing Center causes text 
to be centered within the column. 

Selecting Justified causes the edge of text to align evenly with both 
left and right column guides. Note, however, that tabs cannot be 
displayed with justified text. 

If the selected paragraph consists of numbers in a table, select 
Horizontal Alignment: Decimal to align text automatically without 
using tabs. The first decimal point in the line will be placed at the 
distance from the right margin that you specify using the In From 
Right to Decimal setting at the bottom of the dialog box. 

The default decimal character is a period. To change the decimal 
character to a comma (e.g., foreign language usage), see the Set 
Preferences section in the Options menu portion of this chapter. 

This feature allows you to align a paragraph vertically within a page, 
frame or box. Combine this feature· with Horizontal Alignment to 
place text at any corner, on any side, or in the middle of any page, 
frame or box text. 

Middle and Bottom should be used only for text within frames or box 
text. Use on the page itself will work, but may become confusing. 
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Xerox Ventura Publisher allows you to rotate selected paragraphs in 
increments of 90 degrees. Use this feature to create headings for tables 
or annotate graphs and charts which you have placed in frames. 

To use this feature once you have selected the Alignment option: 

1) Select Text Rotation. A pop-up menu appears with the choices 
None, 90, 180, and 270. 

2) Select the angle of rotation. Note that the Maximum Rotated 
Height feature is now available for selection. 

3) Set the Maximum Rotated Height to the height you wish the 
rotated paragraph to occupy. 

Hints for rotating text 

Edit the text before you rotate it, if possible. If you must edit the text 
after tagging it for rotation, you may find it easier to tag the text 
temporarily with a tag which has Text Rotation: None. Assign the tag 
which contains the rotated text attributes when you are finished edit
ing. 

You will find rotated text easier to work with if you place the text in a 
box or frame rather than directly on the page. This is because rotated 
text displaces other text on the page. If you place rotated text in a frame 
or box, on the other hand, you can move the frame or box easily to 
position the text properly. You can then anchor the frame or box to the 
surrounding text. 

You can tum hyphenation on or off for any paragraph tag. Select the 
language for which hyphenation should be performed. The default 
installation sets both hyphenation options to US English. See Appen
dix B if you want to set hyphenation for another language. 

The Successive Hyphenation feature controls the number of lines in 
a row that can be hyphenated. The default setting is 2. To change this 
number, select the desired number from the pop-up menu. 

Occasional additional hyphenation points can be added by using 
discretionary hyphens. See the Text mode sections of the Modes of 
Operation chapter. If you always want to hyphenate a word at a 
different place in the word, or if you don't want to hyphenate a given 
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Column 
overrides 

First line 
in/outdents 

word, you can modify Xerox Ventura Publisher's hyphenation diction
ary. See Appendix B for more information on hyphenation. 

To override column settings and make a paragraph print across the 
entire frame or page, select Overall Width: Frame-wide. Text after a 
frame-wide paragraph continues below the frame-wide paragraph. 
Frame-wide paragraphs in other than the left column print over the 
paragraphs in the left column. Therefore, Column Balance should 
always be turned on whenever frame-wide tags are applied to para
graphs which are not at the top of the frame. See the Chapter 
Typography option in the Chapter menu for more information about 
Column Balance. 

Frame-wide paragraphs interrupt vertical rules. 

First Line: Indent/Outdent allows you to force the first line of a 
paragraph in or out from the left margin by the space specified on the 
Indent/Outdent Width line. To set an indent of 0.1 inch: 

1) Select First Line: Indent 

2) Select Relative Indent:None 

3) Position the text cursor on the Indent/Outdent Width line and type 
00.10 (make sure the measurement units are set to inches). 

If you specify a temporary margin using the In From Left setting in 
the Spacing option, the Indent/Outdent is calculated from this tem-
porary margin. 

~ Do not use Indent/Outdent Width in conjunction with right aligned or 
centered text. 

Relative indents Relative Indent: On adds a first line indent to the current paragraph 
exactly equal to the length of the last line in the previous paragraph. If 
you specify Indent Width, Xerox Ventura Publisher adds an addition
al fixed amount to the length of the previous line. When used in 
conjunction with the Breaks option in the Paragraph menu, this feature 
is useful to create lead-ins. (The Putting It Together chapter describes 
lead-in paragraphs in more detail.) 
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Indent/Outdent Height allows you to specify the number of lines for 
which the indent/outdent is to take effect. Normally, only the first line 
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is indented or outdented, but you can indent any number of lines. This 
can be used to make space for a lead-in which uses a much larger font. 

If you select First Line: Outdent, and then specify a very large number 
for Indent/Outdent Height, you can force the entire paragraph to move 
to the left of the existing margin. 

To indent the entire paragraph, use In From Left spacing in the 
Spacing option instead. 
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"Bod~ Tellt" SPACING 

Above: B1, BB picas & points 
Below: B1,BB 

Inter- Line: B1, BB picas & points 
Inter- Paragraph: BB, BB 

PARAGRAPH MENU, Spacing 

Add in Above: []lliill When Not at (o!uflln Top 

Settings For: IttllM I Right Page I 
In Frofll Left: B2, Bg picas & points 

In Frofll Right: B2, B~ 

Inserts: I (op~ T 0 Facing Page I 

Figure 5-59 Spacing dialog box. Add in Above When Not at Column Top 
means above space is not added when paragraph is at top of column or page. 

Description 
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The Spacing option controls the space between lines and paragraphs, 
and sets temporary margins. 

Application 

• Set Inter-Line spacing (leading) 

• Set space between paragraphs 

• Set temporary left and right margins (for quotes, bullets, etc.) 

• Create complementary left and right pages (Figure 5-60). 
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Figure 5-60 Complementary left and right pages 

Operation 
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1) Select the Paragraph mode. 

2) Select the paragraph for which you want to adjust spacing. 

3) Select Spacing in the Paragraph menu. The dialog box shown in 
Figure 5-59 appears. 

4) Adjust each control and then select OK. 

Inter-line space is measured from 
baseline of one line to baseline of 

the next line. 

Total space between paragraphs is 
controlled by above, below, 

inter-paragraph, and ruling line space. 
See next figure for details. 

Figure 5--61 Paragraph vertical space 
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Now is the time 
for all good men 
to come to the 
aid of their country. 

Now is the time 
for all good men 
to come to the 
aid of their country. 
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Inter-Line spacing ("leading") sets the space between the base of the 
characters on one line and the base of the characters on the following 
line (Figure 5-61). Typesetting aesthetics usually allow a comfortable 
amount of spacing between lines, depending on the font size selected. 
A good rule of thumb is that Inter-Line spacing should be roughly 1.2 
times the font size. Thus, a tag which uses 10 point type should have 
12 point Inter-Line spacing. Make the Inter-Line spacing greater than 
this nominal amount when the columns in your document are wide. 

Above and Below space both add additional space between para
graphs. For instance, if you set Inter-Line spacing to 12.00 points and 
Below space to 12.00 points, you will create exactly one blank line 
between paragraphs, much like pressing the Enter key twice in a row 
in your word processor. However, unlike a word processor where you 
can only add discrete lines of space between paragraphs, Xerox Ven
tura Publisher allows you to add any amount of space above or below 
a paragraph. 

Interaction between above and below space 

Above and Below space settings always add additional vertical space 
between paragraphs. Think of Above and Below space as the mini
mum acceptable blank space between the currently selected paragraph 
and the paragraphs which precede and follow it. 

Xerox Ventura Publisher prevents interference between Above and 
Below space settings for adjacent paragraphs. If, for example, you add 
Below space to a paragraph, and the paragraph that follows it has 
Above space added to it, only the greater of the two spaces is used (see 
Figure 5-62). This feature lets you design each paragraph tag without 
needing to computer the endless permutations of how much space can 
appear between each possible pair of paragraph tags. 

Whereas Above and Below space always add additional space be
tween paragraphs, Inter-Paragraph spacing only adds space between 
paragraphs that have identical settings for Inter-Line space 

Inter-Paragraph space is occasionally useful when you want the space 
between similar paragraphs to be greater than the space between these 
paragraphs and the headings or other paragraphs which precede them. 
The &PRPT-Pl.STY style sheet in Appendix L provides a good ex
ample of how to use Inter-Paragraph space. In this style sheet, the 
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A 

B 

c 

This is the first paragraph of the text. The 
space between lines is controlled by 
Inter-line spacing. However, the space 
between this paragraph and the next is 
controlled by a combination of several 
different settings. This paragraph has a 
ruli line below. 

_______ T 
This is the second paragraph of text. The ± 
space between the base of the first line in 

this paragraph and the base of the last 

line in the last paragraph is calculated as 

shown below. This paragraph has a ruling 

line above. 

A = Paragraph 1 total ruling line below height 
B = Paragraph 1 Below space 
C = Paragraph 1 Inter-line space 

D = Paragraph 2 Above space 
E = Paragraph 2 total ruling line above height 
F = Paragraph 1 Inter-line space 

Space between two paragraphs equals the greater of : 

A + B + C o-r D + E + F 

D 

E 
F 

Figure 5-62 How Xerox Ventura Publisher calculates space between para
graphs 
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PARAGRAPH MENU, Spacing 

space between Body Text paragraphs is set with Inter-Paragraph space. 
The Inter-Paragraph settings for Head Level I and Head Level 2, on 
the other hand, are different and therefore do not apply when the two 
types of paragraphs are placed adjacent to one another. 

For most style sheets, you will not need to use the Inter-Paragraph 
space setting. As a rule of thumb, use Above and Below space settings 
to control the amount of space between paragraphs, and set Inter-Para
graph space to zero. 

The space between paragraphs is controlled by Inter-Line, Above, 
Below, and Ruling Line space as follows: 

• The greater of 

- The first paragraph's Below space plus the overall height of 
ruling below or around or 

- The second paragraph's Above space plus the overall height 
of ruling above or around 

plus 

• The Inter-Paragraph space, if the Inter-Paragraph space is identical 
for both paragraph tags 

plus 

• The first paragraph's Inter-Line space 

See Figure 5-62. 

If you inadvertently set spacing in inches instead of fractional points, 
you might set spacing which is greater than the page length. When you 
press Page Down, the page counter begins counting and will never 
stop. To correct this problem, press ESC to stop the formatting, and 
then press HOME. If the paragraph tag name is still shown in the 
Current Selection indicator, you can simply change the spacing set
tings. If the paragraph tag is not shown, then you must use the Remove 
option to delete the tag. 

The option Add in Above: When Not at Column Top suppresses any 
Above space when the paragraph begins a new column. You should 
almost always select When Not at Column Top whenever Above space 
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Extra Enters 
between 
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Multiple column 
spacing 
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is set to anything other than zero. Otherwise, you could introduce an 
extra undesired space at the top of a page. 

Because space between paragraphs is controlled by the paragraph tag's 
Above, Below, and Inter-Paragraph settings, you should press the 
Enter key only once at the end of each paragraph, not twice as you 
nonnally do in a word processor. If you have already created a 
document in a word processor which contains two Enters at the end 
of each paragraph, go back to your word processor and place this 
statement as the first line in the file: 

@PARAFILTR ON 

This causes two consecutive Enters to be converted into one Enter 
when the file is loaded into Xerox Ventura Publisher. (If you want to 
preserve two Enters at some point in your document, place a blank 
space in front of the second Enter.) 

To ensure that text in adjacent columns aligns properly, the total 
vertical space for every tag in a multi -column style sheet should 
always equal an integer multiple (e.g., 1, 2, 3, ... ) of Body Text's 
Inter-Line spacing. 

To assure that adjacent columns of Body Text always align when 
designing a multi-column style sheet, follow these rules for each tag: 

1) Set Inter-Line spacing to an integral multiple of Body Text's Inter
Line spacing. 

2) Set Inter-Paragraph spacing to an integral multiple of Body Text's 
Inter-Line spacing. 

3) Set Above space and overall ruling line height above so that both 
together equal an integral multiple of Body Text's Inter-Line spac
ing. 

4) Set Below space and overall ruling line height below so that both 
together equal an integral multiple of Body Text's Inter-Line spac
ing. 

The style sheets in Appendix L provide examples of how to set 
multi-column tag spacing. 
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Set temporary margins using In From Left and In From Right. In 
From Left and In From Right refer to the distance towards the center 
of the column from the column edges. (See Figure 5-63.)You can set 

In From Left 
Margin is 
measured 
from left 
column edge 

In From 
Right Margin 
is measured 
from right 
column edge 

Figure 5-63 Infrom left/right setting 

In From Left and In From Right differently for Left and Right pages. 
To enter different settings for each page, first select Left Page and enter 
its In From Left/Right settings, then repeat for the Right Page. You 
can copy the In From LeftlRight settings to the opposite page at any 
time by selecting Copy To Facing Page. 

~ Note that the Settings For: Left Page/Right Page option applies only 
to In From Left and In From Right, not to the rest of the Spacing 
option. 

Margin width 
ruling lines 
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Ruling Lines which are set to Margin Width are affected by the In 
From Left/Right settings. A paragraph ruling line set to Margin Width 
will move in from the left and right margins by the In From LeftlRight 
amount. 
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Breaks 

"Bod9 TeKt U BREAKS IT! 
Page Break: ID []ilili] I After I I Before & After I 

I Before/Until Left I I Before/Until Right I 
(o!ul1In Break: ID I Before I I After I I Before & After I 

Line Break: U!!J IilmiI LM!.ITJ I Before & After I 

NeKt Y Position: _ I Beside Last Line of Prev, Para I 

Allow Within: lID []i] 
Keep With NeKt: ~ ID 

Figure 5-64 Breaks dialog box. These are the appropriate settingsfor most 
tags. 

Description 

A Break controls the flow of text between paragraphs. After a break, 
the next paragraph can begin on a new line (line break), at the top of a 
new column (column break), at the top of a new page or frame (page 
break), or at the top of the next left or right page or frame (page break 
before/until left/right. ) 

The break can occur before, after, or both before and after the para
graph. If your settings for a particular paragraph tag include Page 
Break Before and After, for example, any paragraph so tagged will 
always start at the top of a new page, and will be the only paragraph 
on that page. 

Application 

• Vertical tabs 

• Outdented heading 
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• Paragraph lead-ins 

• Page breaks 

• Keep paragraph from being split across columns or pages 

• Auto-numbers, footnote numbers and caption numbers on same 
line as text which follows 

Operation 

Page and 
Column breaks 

Line break 
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To adjust the break settings for paragraphs: 

• Select the Paragraph mode. 

• Select the desired paragraph. 

• Select the Breaks option from the Paragraph menu. A dialog box 
like the one in Figure 5-64 appears. 

• Adjust the settings and then select OK. 

The Page Break settings control whether text is forced to the next page 
(or frame). The setting for most tags is Page Break: No. 

If you select Page Break Before, then any paragraph tagged with this 
tag will appear at the top of a new page or at the top of the next frame. 
If you select Page Break After, then the following paragraph will 
begin on a new page or in a new frame. 

Page Break Before/Until Left forces the text to a left page, inserting 
a blank right page if necessary. Page Break Before/Until Right forces 
the text to a right page, inserting a blank left page if necessary. 

Column Breaks work the same way except the paragraph appears at 
the top of a new column instead of a new page or frame. 

A Line Break controls whether space is added between paragraphs. If 
you select Line Break After for this paragraph, or Line Break Before 
for the next paragraph (or both), then the space between these two 
paragraphs is determined by the formula shown in Figure 5-62 (see 
the Paragraph Spacing option). When no Line Break is set between 
two paragraphs, the space between these paragraphs is set by the Next 
Y Position. 
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Next Y Position 
Normal 

The "Y" in Next Y Position refers to vertical space. 

Assuming that Page Break, Column Break, and Line Break between 
two successive paragraphs are all set to No, a setting of Next Y 
Position: Normal causes both paragraphs to begin at the identical 
vertical position on the page. This may cause both paragraphs to print 
on top of each other, which is not particularly useful. However, if you 
increase the second paragraph tag's In From Left spacing, and increase 
the first paragraph's In From Right spacing, the two paragraph's will 
print next to each other. This is how you create a vertical tab, as shown 
in Figure 5-65. See the Putting It Together chapter for more infor
mation. 

First paragraph. No line 
break after. In From Right 
(Paragraph Spacing option) 
set to 12,00 picas from 
right margin, In From Left 
7,06 picas from left 
margin. Allow Within set 
to NO, Keep With Next set 
to YES. 

Figure 5-65 Vertical tab. 

Second paragraph. No line break before. 
In From Left (Paragraph Spacing 
option) set to 16,00 picas from left 
margin. Next Y Position set to Normal 
(which makes this paragraph format on 
the first line of the previous paragraph.) 

Next Y Position 
Beside Last Line 

If no break of any type is set between two paragraphs and if Next Y 
Position: Beside Last Line of Previous Paragraph is set for the 
second paragraph, the second paragraph begins on the same line as the 
last line of the previous paragraph. For example, the following "para
graph" is actually two different paragraphs. The first paragraph-The 
style sheet examples-is formatted with Line Break Before. The 
second paragraph (the remainder of the text) is formatted with Line 
Break After, Relative Indent On (Alignment option), and Next Y 
Position: Beside Last Line of Previous Paragraph. 

This is a 
separate 

paragraph 

---I The style sheet exampleslin Appendix L show how tag options can be 
combmed together. 

~ Most paragraphs in the style sheets supplied with Xerox Ventura 
Publisher use Line Break Before. However, if you change Body Text 
to Line Break After in order to place lead-ins or section numbers on 
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the same line, as in the example paragraph above, you may find that 
text sometimes overlaps the previous paragraph during text editing. To 
fix this problem, change the other tags in the style sheet from Line 
Break Before to Line Break After. 

Each break further down in the dialog box is overridden by the break 
shown immediately above (e.g., if both Page Break Before and 
Column Break Before are selected, only Page Break Before takes 
effect.) 
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Tab settings 

"Bod~ Tellt" TAB SETTINGS rn 
Tab NUlI1ber: 1 + I 1 1"1 

Tab T~pe: Left t 
Tab Shown As: Lead~ Char t 
Tab Location: 83.8 inches 

Leader Char: t 846 (ASCII ) 

Leader Spacing: 2 
Auto' Leader: Off 

Figure 5-66 Tab Settings dialog box. First tab stop set to 3 inchesfrom left 
margin, with dot leader turned on, left aligned. Two spaces will be placed 
between each leader dot. 

Description 

Use Tab Settings to align text or numbers for simple tables. 

Whenever Xerox Ventura Publisher encounters a horizontal tab char
acter in the text, it positions the next character at the next tab location. 
You may set up to 16 tabs for each paragraph tag. Placement of each 
tab is measured relative to the left column edge rather than the page 
edge. You can choose right, center, left, or decimal alignment of text 
relative to each tab position. 

You can fill the space created by the tab with any character. These fill 
characters are called Leaders (pronounced leed-ers.) 

Application 

• Tables 

• Directory listings 
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• Simple equations 

• Table of contents 

• Index 

Operation 

To set tabs: 

1) Select the Tab Settings option in the Paragraph menu (Figure 
5-66.) 

2) Choose the Tab Number you want to set. Start with tab number 1. 

3) Choose whether the text is to be Left, Center, Right, or Decimal 
aligned (Tab Type). 

4) Select Tab Shown As: Leader Char if you want to place leader 
characters for this tab stop. Select Open Space if you don't want 
leader characters for this tab stop. 

5) Enter the tab location. The tab location is measured from the left 
edge of the current column, not from the left edge of the page. 

6) If you want to set additional tab stops, repeat this process for 
additional tab numbers. 

~ After you select a Tab Number, remember to select Left, Center, Right, 
or Decimal. One of these options must be chosen, or the tab stop will 
not take effect. 

Leaders If you choose Tab Shown As: Leader Character for any tab stop, 
follow these steps: 

5-150 

1) Select the leader character (spaces, periods, underlines, or some 
other character) for this tag. You may choose only one leader 
character for the paragraph tag. 

2) If you choose Custom, consult the character set table in Appendix 
E, choose the decimal number which corresponds to the character 
you want to put in the tab space, place the text cursor on the Leader 
Char line, and type this number. 
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Tables 

Equations 

3) Enter the Leader Spacing between leader characters. For instance 
if you select Leader Spacing: 2, you will put two spaces between 
each leader character. 

If you set Auto-Leader On, the leader characters you have selected 
will be placed between the end of the last line of the paragraph and the 
right margin, even if you insert no tab at the end of the paragraph. Use 
this feature to completely fill a box with dots or dashes. This is useful 
for tables. 

~ Justification (set in Alignment option) overrides tab settings. There
fore, tabs do not work if Horizontal Alignment is set at Justified. Also, 
tabs cannot be set for headers or footers created with the Header & 
Footer option in the Chapter menu. 

~ Do not set tabs to create a first line indent. Use the First Line Indent 
feature in the Alignment option instead. 

Tabs are designed to be used on a single line. Terminate this line with 
a paragraph end (Enter) or line break (Ctrl plus Enter.) Also, when 
tabs are set, automatic wordwrap will not work. Therefore, text on any 
line which contains a tab may extend beyond the right margin. Use a 
line break (Ctrl plus Enter) to force this text down to the next line. 

When using proportionally spaced fonts, you cannot format tables 
(such as those imported from a spreadsheet) using spaces between 
entries. Therefore, you must use tabs to make columns align correctly. 
See the Putting It Together chapter for more information. 

You can also use tabs to format simple equations. Set a center tab stop 
at the position on the page where you want to center the equation. 
Then, type a tab character followed by the equation. The equation 
automatically centers itself at the location defined by the tab stop. 

The Professional Extension to Xerox Ventura Publisher provides com
plete Equation and Tables features. 

Superscript ~ 

Aligned around 
centered tab 

X2+ y2+Z2 

5X + 2Y +3Z 
t 

_ Overscore 
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"Bod9 Text" SPECIAL EFFECTS 

Special Effect: I]Mt] IlnOOI.. I Bullet I 
COfllfllands: I Set Font Properties I 

Space for Big First: I Noml I IIDD 0021 lines 

. Show Bullet ;is: ~ rc:l m R.n n .1::1 n.m r;] .. 

Figure 5-67 Special Effects dialog box. Settings arefor bigfirst character 
at beginning of paragraph. 

Description 

Special Effects allows you to add a Big First Character (also called 
a Dropped Capital) or Bullet at the beginning of a paragraph. You can 
select font and text attributes (bold, italic, etc.) for the bullet or big 
character independently from the rest of the paragraph. 

Application 

• Dropped capitals at beginning of paragraph 

• Real typographic bullets for lists (e.g., • instead of *) 

Operation 

Big first 
character 
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To create a Big First Character: 

1) Select Special Effects in the Paragraph menu. (See Figure 5-67.) 
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Bullet 

2) Choose Special Effect: Big First Char 

3) Select Set Font Properties. The font selections available depend 
on the printer installed. 

4) Select Face, Size, Style, Color, attributes (overscore, etc.), and 
character Shift up or down. Zero shift usually works best. 

5) Select OK to return to the first dialog box. 

6) Specify a setting for Space for Big First Char. This feature 
specifies how many lines of text the first character will occupy. 
Normal creates the number of line automatically. Custom allows 
you to specify the number of lines. 

When you select Custom, the big character rests on the baseline of the 
last line specified in the Space for Big First setting. When you select 
Normal, the top of the big character aligns with the top of the first line 
of the paragraph. These default positions can be overridden by select
ing Set Font Properties and then selecting Shift Up or Down. 

To add a Bullet: 

1) Select Special Effects in the Paragraph menu. 

2) Choose Special Effect: Bullet. 

3) Select Set Font Properties to make the bullet a different font from 
the rest of the paragraph. The Font Settings For Bullet dialog box 
appears. The actual font selections available depend on the printer 
installed. Select Face, Size, Style, Color, attributes (overscore, 
etc.), and character Shift up or down. 

4) Select OK to return to the first dialog box. 

5) Select the bullet you want to use from the Show Bullet As: line. To 
use some other bullet character, select Other,. place the text cursor 
on the Bullet Char line, and type the number from the table in 
Appendix E for the desired bullet character. 

6) Select the Indent After Bullet. This indent specifies the space 
between the bullet and the text following the bullet. 

~ If you fail to specify an indent after the bullet, the first line in the 
paragraph will overlap the bullet. 

Select None to remove an existing special effect from a given para
graph tag. 
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Attribute overrides 

"Body Text" ATTRI BUTE OU ERRIDES 

Line Width: Text· Wide I 

Overscore Height: 00. 5~ Shift t By: 09.96 fractional pts 
Strike·Thru Height: 00.54 03.12 

Underline 1 Height: 01.02 Shift * By: 01.68 
Under line 2 Height: 01.02 01.68 

Superscript Size: 008 Shift t By: 04.68 
Subscript Size: 008 Shift * By: 01.08 

Sl'Ilall Cap Size: 008 points 

[J[] I Caned I 

Figure 5-68 Attribute Overrides dialog box 

Description 

Attribute Overrides allows you to customize the following text 
attributes: overscore, strikethrough, underline, small text, superscript, 
and subscript. 

Application 

• "Fine tune" typography. 

• Keep super- and subscripted characters from touching the adjacent 
line. 

• Create special effects (e.g., move strike-thru up so that it can be 
used as a second overscore.) 

Line Width Line width controls what portion of the line is covered by a text 
attribute. The usual setting is Text-Wide, which applies the attribute 
only to the currently selected text. However, if you select Margin
Wide, the attribute extends from the left to right margin, even if the 
text is only a few characters long. This is useful in tables to place a line 
above or below an entry in a table. 
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Line heights 

Attribute fonts 
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You can customize any or all line attributes (i.e., overscore, 
strikethrough, underline, double underline) available in the Text Edit
ing mode for each paragraph tag. For each line attribute, you can 
specify both the height (thickness) of the line and the distance to shift 
this line from the text baseline. The height and shift for Underline 1 
controls both the underline and the first line in the double underline. 
Underline 2 controls height and shift for the second line in the double 
underline. 

Attribute heights and font size automatically increase and decrease 
when you change a paragraph's font size, unless you specify Auto-Ad
justments: None in the Set Preferences option. The height scales 
proportionally to the font size change; the attributes' fonts are set to 
two points less than the tag's fonts size. 

You can set the font size and vertical placement of text which is 
superscripted, subscripted, and you can change the font size of small 
text. Specify both the size of the font (in points) and the distance to 
shift the super- or subscripted characters vertically from the text 
baseline. 

The font size can be larger than the paragraph font as well as smaller. 
You can therefore use this feature to create a shortcut for font changes. 
For instance, if you often need to set selected text to 14 point within a 
paragraph set to 12 point, set the Small Cap Size to 14 point. Then, any 
time you want 14 point text, simply select that text and assign Small 
from the Assignment List. 
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Paragraph typography 
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HBody Tellt" TYPOGRAPHY SETTINGS ill 
Auto(ilatic Pair Kerning: On I 

Letter Spacing: On I Up to: B.109 E(ils 
Tracking: Tighter I B. BSB E(ils 

'row Inter-Line To Fit: On 

Miniooltl Space Width: B.7BB * (space width) = B.174 E(ilS 
Nomal Space Width: 1. BBB * (space width) = B.246 E(ils 

Malli(iluJII Space Width: 2.BBB * (space width) = B.491 E(ils 

Figure 5-69 Paragraph typography dialog box 

Description 

The Paragraph Typography option allows you to control important 
typographic attributes for each tag, including kerning, letterspacing, 
spacing between words, and spacing between lines. 

Application 

• Automatic Pair Kerning-Makes headlines more attractive by 
placing individual letters closer together. It can also reduce the page 
count of long documents which contain large blocks of body text. 

• Letter Spacing-Reduce visual impact of loose lines (lines with 
too much space between words) by adding space between letters. 

• Tracking-Expand or contract headlines to fit a given space. 
Apply Tracking to Body Text to expand or reduce the size of the 
entire document with only a subtle change in overall appearance. 

• Grow Inter-Line To Fit-Automatically increases space between 
lines whenever selected text is made larger. 
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Automatic pair 
kerning 
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• Space Widths-Control the amount of space between words on a 
justified line. 

Certain pairs of letters should be squeezed together in order to improve 
the appearance and readability of the page. The classic example is the 
capital letter A followed by a capital V (e.g., AV). Note how the upper 
left position of the V actually precedes the lower right position of the 
A. The process of reducing space between certain pairs of letters is 
called kerning. 

Xerox Ventura Publisher allows you to reduce the space between 
characters in one of two ways: manually or automatically. Manual 
kerning is described in the Text mode section of the Modes of Opera
tion chapter. Automatic pair kerning is described here. None of the 
automatic kerning controls have any affect on manual kerning and vice 
versa. 

Automatic pair kerning is most frequently used in headings and other 
parts of document which use large type sizes. Automatic kerning can 
be used for body text as well, but will reduce formatting speed by 
about 30% and will increase print time. The style sheets supplied with 
Xerox Ventura Publisher turn automatic kerning on only for headings. 

Only a few of the over 30,000 possible pairs of characters actually 
require kerning. Depending on the font, a width table contains between 
100 and 500 kerning pairs. For information on which character pairs 
to kern automatically and how much space to reduce for each pair, or 
to adjust the kerning values for existing fonts, see the width table VFM 
format in Appendix K. 

To tum automatic pair kerning off for the entire chapter, use the 
Chapter Typography option in the Chapter menu. If you tum kerning 
on in the Chapter Typography option, you must still tum Automatic 
Pair Kerning on for the currently selected paragraph. 

To see the effect of automatic kerning on the computer screen, On
Screen Kerning must be turned on in the Set Preferences option in the 
Options menu. 

This feature will work only if the font width table for your printer 
includes kerning information. All width tables supplied with Xerox 
Ventura Publisher contain kerning information. 
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Grow Inter-Line When you select text within a paragraph and change its font size using 
the Text mode Set Font function, the space between lines is not 
adjusted unless you turn Grow Inter-Line To Fit: On. For example, 
Grow ~nter-Line is turned off for this paragraph and therefore the 
words DIg text overlap the previous line. 

Letter Spacing 
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By contrast, Grow Inter-Line is turned On for this paragraph so that 

the big text does not overlap the previous line. 

Grow Inter-Line To Fit is very important for creating local overrides 
to Paragraph font settings without needing to create a new tag. For 
instance, if you want to change a paragraph's font, but don't need to 
change alignment or spacing between this paragraph and the para
graphs before and after it: 

1) Select the text mode. 

2) Select the entire paragraph. 

3) Change the font typeface, style and size. 

The Inter-Line spacing is automatically adjusted if Grow Inter-Line To 
Fit is turned On. 

When a line of text is justified, Xerox Ventura Publisher adds or 
subtracts space between each word until the last character in the line 
exactly reaches the right column. If a word at the beginning of a line 
is long compared to the length of the previous line (very likely in a 
multi-column document), the space between words on the previous 
line above may exceed the Maximum Space Width. This results in a 
loose line (Figure 5-70). 

Letterspacing is controlled by these settings: 

• Letter Spacing On/Off 

• Minimum, Normal, and Maximum space widths 

• Letter Spacing Up to: __ Ems 

The automatic letters pacing control attempts to improve the ap
pearance of a loose line by adding additional space between letters 
thereby reducing space between words. Technically, the line is still 
considered loose and will still be flagged by the Show Loose Lines 
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Example: Normal Space Width 
(line is not justified) 

L·· ··fi d I l·d me IS not Justt Ie . Norma space WI tho 

This is line is justified and has as many characters as 

Maximum number of characters on a justified line / 
results in Minimum Space Width. 

Letterspacing OFF results in more than 
the Maximum Space Width 

This is a lOOS~ line and therefore the line 

This is a loose line and therefore the line 

. / 
Letterspaclng ON adds space between letters 

and reduces space between words to the 
Maximum Space Width 

Figure 5-70 Letterspacing controls. 

control in the Options menu. However, it will look better with addi
tional space between letters. 

If Letter Spacing is turned On, Xerox Ventura Publisher adds addition
al space between letters until the space between words is equal to or 
less than the Maximum Space Width. 

To use Letter Spacing: 

1) Set alignment to Justified using the Alignment option in the Para
graph menu. 

2) Select Letter Spacing: On. 

3) Set the Minimum Space Width to less than the Normal Space 
Width. A typical number is 0.700 (i.e., 70% of Normal Space 
Width.) Values above 1.000 have no effect. The Minimum Space 
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Width is .the smallest space that can appear between words in a 
justified line. 

4) Set the Normal Space Width to 1.000. 

5) Set the Maximum Space Width to the largest space allowable 
between words during justification. A typical value is 2.000 (i.e., 
twice the Normal Space Width). 

6) Set the Up To amount to the maximum space allowed between 
letters during letterspacing. 0.100 Ems is a typical amount. 

The Up To control prevents letterspacing from adding more space 
between letters than between words. In extreme cases this can actually 
happen. For most documents, keep this set to 0.100 Ems. 

The resulting space width is calculated and shown in ems, a typo
graphic measurement equal to the width of the capital M in the current 
paragraph font size. 

Normal Space Width 

The Normal Space Width setting allows you to control the amount of 
space between words. This allows you to increase or decrease the size 
of any paragraph formatted with this tag. For instance, choosing a 
value of two doubles the space between every word. 1.000 is the 
normal setting for most documents. 

Tracking allows you to increase or decrease the space between every 
letter in a paragraph. To use this control: 

1) Select Looser to increase, Tighter to decrease space between 
letters. 

2) Enter, on the Tracking line, the amount to add or subtract between 
individual letters. 

Tracking is set in Em units, which are equal to the width of the capital 
M in the current font. You will quickly find that even a few hundredths 
of an Em makes a dramatic difference. 

Tracking is typically used for very large headlines. Larger type sizes 
often look better if the letters are moved slightly closer together. You 
can also change tracking for body text. This will dramatically change 
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Local tracking 
override 
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both the look of the document and the number of pages needed to fit 
all the text in your document. 

The Paragraph Typography Tracking control changes tracking for 
the entire paragraph. To override the tracking setting for an individual 
paragraph or just for part of a paragraph, select the Text mode and use 
the manual kerning/tracking feature described in the Modes of Opera
tion chapter. 
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Ruling lines 

"Bod~ Text" RULING LINES ABOVE 

Width: (olullln t 
(olor: Black t 

Pattern: Solid t 
Dashes: Off t 

Space Above Rule 1: BB.BB 
Height of Rule 1: B4.BB (ustOIll Indent: 

Space Below Rule 1: B3.BI (ustofll Width: 
Height of Rule 2: B1.5 

Space Below Rule 2: BB.B Dash Width: 
Height of Rule 3: BB.BB Dash Spacing: 

Space Below Rule 3: BB.BB D8 
Overall Height: B8.5B 

PARAGRAPH MENU, Ruling lines 

rn 

136.00 
mUJO 08 
00,00 

00,00 
00,00 fractional pts 

Figure 5-71 Ruling Lines dialog box. Two rules will be created. Both rules 
will be the width of the column. 

Description 
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All three Ruling Lines Menus function in an identical manner and 
provide the capability to place ruling lines above, below, and around a 
paragraph. 

You can place up to three ruling lines, each of different thickness, with 
different spacing between each rule, above, below, or around a para
graph. You can then assign texture and color to each set of ruling lines. 
Ruling lines can be dashed. 

Application 

• Isolate text from surrounding copy. 

• Provide lines between entries in a table. 

• Place text within a ruling line to create the "reverse video" effect 
shown in Figure 5-72. 

• Create change bars 
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Operation 
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To place ruling lines above, below or around a paragraph: 

1) Select the appropriate ruling line option in the Paragraph menu. 

2) Select the ruling line Width. These options include: 

- Text-The ruling line width equals the width of the first line 
of text. Any indent set using the Alignment and Spacing 
options (Paragraph menu) will affect a Text ruling line. 

- Margin-The ruling line width equals the width of the cur
rent column, less the paragraph's In From Left and In From 
Right spacing as set in the Paragraph Spacing option. 

- Column-The ruling line width equals the width of the 
current column. 

- Frame-The ruling line width equals the width of the frame 
if you have set Overall Width (Alignment option) at Frame
wide. 

- Custom-You can set the starting point and width of the 
ruling line to any value you wish. Specify distance in (+) or 
out (-) from the left margin (Custom Indent) and width of the 
ruling line (Custom Width). 

3) Select the ruling line color and pattern. The same color and pattern 
must apply to all three rules. 

4) Enter the height of each ruling line and the space above and below 
each ruling line: Place the text cursor next to the Space 
Above/Below and Height of Rule lines and type the desired heights. 
The ruling line and line spacing are displayed immediately to aid 
you in determining the proper line thicknesses and spacing. Keep 
changing the height and spacing until you are satisfied. 

5) Finally, if you wish to make dashed rules, select Dashes On, then 
select the width of the dash and the space between each dash. (Tum 
off dashes by selecting Dashes Off.) Xerox Ventura Publisher 
cannot display or print thick dashed rules. If dashes do not display 
on the screen, reduce the ruling line thickness. 

6) When you are satisfied with the results, select OK. 
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~ Ruling Boxes Around paragraphs are intended for headlines and 
other short paragraphs. Placing a ruling box around a long paragraph 
which continues into the next column or page causes the first part of 
the paragraph to be enclosed in a box. The second part of the paragraph 
is placed in the next column or page without any ruling box. To avoid 
this problem, select Allow Within: No using the Breaks option in the 
Paragraph menu. 

White text on 
black rule 

Overall Height: provides continuous feedback on the total space 
occupied by all ruling lines. 

The Space Below Rule 3 setting allows you to shift a Ruling Line 
Above up or down by the amount you specify, without moving the text 
in the tagged paragraph. One application of this feature is creating 
reverse video text, i.e., placing white text on top of a black ruling line 
as shown in Figure 5-72. To achieve this effect: 

1) Create a new tag called, for example, White Text. 

2) Set the Font Color for this tag to White. 

3) Select Ruling Line Above and create a height for Rule I that is 
higher than the tag's font size. (Note: the display area in the dialog 
box will not display lines higher than 36 points correctly, although 
you can still create them.) 

4) Select the - on the Space Below Rule 3 line and enter the distance 
required to move the ruling line down over the text. This distance 

Chapter 1 

i The Adventure Begins 

This trip rl?ally bl?gan in Sl?ptl?mbl?r last Yl?ar whl?n Gl?rry 
won first priZI? in a raffll? at thl? fashion show which Rush

Prl?sbytl?rian-St. Luk\?'s Ml?dical Cl?ntl?r holds I?vl?ry yl?ar. Thl? 
prizl? was two round trip tickl?ts to Hong Kong on Unitl?d Air
linl?s, and tl?n nights in thl? Hong Kong Hyatt Hotl?l. Analyz
ing our good fortunl?, WI? concludl?d that WI? wantl?d to do 
mOrl? than spl?nd tl?n days in Hong Kong and rl?turn, but at 
thl? saml? timl?, Unitl?d, having just gottl?n its routl?s and I?quip-

Figure 5-72 White text within black ruling line 
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Change bars 

REFERENCE GUtDE 

is approximately one half the sum of the ruling line Overall Height 
plus the Font Size. 

For example, if you want to place 24 point white type within a 36 point 
ruling line, enter approximately 0.5 * (24 + 36) = 30 points for the 
Space Below Rule 3. 

Some printers cannot print white text on a black background. Print the 
CAPABILI chapter, located in the TYPESET directory, to see 
whether your printer is capable of this effect. 

A change bar alerts the reader that the contents of a paragraph have 
changed. You can also use a change bar as a custom vertical rule to 
highlight headlines in newspapers, newsletters, or magazines. Design 
a change bar as follows: 

1) Using the Add New Tag function in the sidebar, add a new tag 
called Change Bar and copy the attributes from Body Text. 

2) Assign this tag name to a special function key using the Assign 
Function Keys feature in the Update Tag List option (Paragraph 
menu). 

3) Select a paragraph and tag it with this new tag. 

4) Select Paragraph Ruling Box Around from the Paragraph menu. 

5) Enter a Custom Width of 1 point. 

6) Enter a Height of Rule 1 of less than 2 points. 

7) Add a small (e.g., 1 pica) negative (-) Custom Indent. 

Because change bars are created with a ruling box around, and because 
ruling boxes do not continue across column or page boundaries, 
change bars will not continue to the top of the next column or page. 

The Putting It Together chapter contains other creative ways to use the 
paragraph ruling line feature. 
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DEFINE COLORS 

Screen Displa~: Colors 

Color NUAber: ~ 

Color Setting: Enabled 

Color NaAe: MapleL

C~an: I .. I '}I I}:':':':':,":':': .... · 

Magenta: I .. I'::: '}A [::::::::::::;:0:':":' . ",','}:q .. I 029.6 

Yelloll: I .. I/o':'::" """""'?::}:o] \::::':i' ,:\ .. I 066.6 

Black: I .. II::: :1 1:::::::0"" "'::}}l .. I 025.2 

DO/Cancel/ 

Figure 5-73 Define Colors dialog box 
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Definition 
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The Define Colors option allows you to define both colors and shades 
of gray. You can then apply these colors and shades to text, ruling lines, 
and graphics. On a VGA or multi-sync style monitor you will see the 
actual colors and shades of gray. On other monitors you will see 
representative shades of gray. 

You can print colors in one of three ways: 

• If you print to a color PostScript printer such as the QMS Color
ScriptTM 100, each page is printed in color. 

• If you print each page to a black and white laser printer or typeset
ter, the colors are converted to shades of gray (some limitations 
apply-see the Limitations section for your printer in Appendix 
F). 

• If you print each page to a black and white laser printer or typeset
ter, and select Spot Color Overlays in the To Print option, a 
separate black page is printed for each color you have defined and 
enabled. Colors are not converted to shades of gray. 
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The paragraphs under the Color Printing heading at the end of this 
section describe the conventional printing process and color printing 
terminology more fully. 

Application 

• Create exactly the color you desire for printing directly to a color 
printer. You can choose from more than 125 million colors. 

• Define a shade of gray to be printed to a black and white printer. 

• Define a color name that you can assign to fonts, rules, and back
ground patters. A different page can be printed for each color. 

Operation 

1) Select the Paragraph mode. 

2) Select Define Colors. The dialog box shown in Figure 5-73 ap
pears. 

3) Select Screen Display: Colors if you plan to print to a color printer. 
If you plan to print to a black and white printer, select Screen 
Display: Shades of Gray. 

4) Select a Color Number. Color numbers range from 2 to 7. White (0) 
and Black (1) are not available for selection nor can you change 
them. Select either the right or left arrow in the dialog box to 
increase or decrease the color number. By changing the color 
number, you select a different Color Name. 

5) Enable the Color Setting if you want to print a color separation for 
this color. Disable the Color Setting if you want to suppress color 
separation printing for this color. 

~ Disable all colors that you do not plan to use. If you select Spot Color 
Overlays: On in the To Print option of the File menu, a separate sheet 
of paper will be printed for each color enabled,jor every page. 
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6) Define a Color Name. The Color Name you define is printed at the 
top of each page printed for that color when Spot Color Overlays is 
turned On. 
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Define and print 
gray 

Color printing 
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7) Define a color by selecting the percentage for each color plus a 
percentage for black. Define a shade of gray by setting the three 
colors to 0% and then setting Black to the shade of gray you desire. 
Each color can be set to any value between 0 and 100% in incre
ments of 0.2%. 

8) To select a color percentage, use the scroll bar next to that color. 
Selecting either arrow in the scroll bar increases or decreases the 
setting by 0.2%. Use the mouse to move the hollow box within the 
scroll bar to make changes to the color setting in large increments. 

9) Select OK. 

You can define any of 500 shades of gray using the Define Colors 
option as described in the instructions above. Once you define a shade 
of gray, you can use it within any of the dialog boxes that support color. 
To assign a gray level after you have defined it using the Define 
Colors option, follow these steps: 

1) Select the shade of gray from the Color setting within any dialog 
box which contains color options. 

2) If the dialog box includes a Pattern setting, set this to Solid. 

The Pattern setting available in most dialog boxes provides an alter
nate, but less flexible, way to produce shades of gray. Combining a 
gray color with a pattern can be confusing and is not recommended. 

Printing gray 

When Spot Color Overlays (To Print option, File menu) is On, 
colors-including shades of gray-all print as solid black. A separate 
page is printed for each color. 

When Spot Color Overlays is Off, colors-including those which are 
represented as shades of gray-print as shades of gray. On non-Post
Script printers, text and lines drawn in the Graphic mode print 100% 
black. 

The Define Colors option allows you to create a color name and assign 
a unique color value to that name. Colors are created from three 
primary colors (Cy~ Magenta, Yellow) plus Black. You can set the 
percentage of each color in increments of 0.2 percent. This yields 500 
settings for .each color or, in -combination, 125million colors. 
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The actual hue you create is useful only when you print to a color 
printer which can print a large range of colors. The only color printers 
supported are PostScript printers such as the QMS ColorscriptTM. 
However, by assigning color names to text and graphics, you can print 
color separations which can be sent to an offset printing facility as the 
input to color production of your document. 

Color separations 

Conventional ink printing creates colors in one of two ways: 

• Run the page through the press four times, once for each of the three 
primary colors and once for black. The colors are, in essence, mixed 
on the page to produce an almost limitless range and hue of colors. 
This is called Process Color. 

• Run the page through the press once for each specific color on the 
page, plus once for black. This is called Spot Color. 

Process Color is used to produce color photographs and other images 
that require reproduction of a large range of colors. Because the color 
you see depends on correct placement ofthe different color dots placed 
on the page by the printing press, process color requires near-perfect 
alignment of the three colors on the page to produce good results. This 
perfect alignment is called registration. 

Spot Color is used when only a few discrete colors are needed, such as 
a single color for headings and ruling lines. Registration is not as 
critical with spot color, because no color mixing is done on the page. 

Xerox Ventura Publisher supports Spot Color. 

If you plan to have your document printed using a conventional 
printing process, and plan to use spot color, follow this procedure: 

1) Define Color Names using the Define Colors option. 

2) Assign the Color Names you have defined to fonts, ruling lines, 
background fill patterns, and graphics. 

3) When you print draft copies of your document using the To Print 
option in the File menu, set Spot Color Overlays: OfT. This will 
produce a black and white representation of your final color page. 
Each color is converted to an appropriate shade of gray, depending 
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on the capabilities of your printer (See Appendix F and look under 
the Limitations subheading for your printer to see the limitations 
it may have in printing gray text and lines.) 

4) When you are ready to print the final copy, select Spot Color 
Overlays: On. Xerox Ventura Publisher will print a separate black 
and white page for each color you have enabled, plus a page for 
black. 

For each page, only the text and graphics for that color is printed, and 
each color is printed in 100% black. During the offset printing process, 
these individual black and white pages are transferred to color plates. 
The people who make these plate and the people who control the 
printing presses determine the shade and hue of each color. 
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Update tag list 

UPDATE TAG LIST (E:\TYPESET\BOOK2.STY) m 
ag 

t ~~t~e~ext 
I- Change Bar 

ChaDter ~ 

Pl Firstpar 
• Major heading 

Minor heading 

COlllland: I Print St~lesheet ... II Rellove Selected Tag I 
I Save As Hew SMesheet ... II Renalle Tag ... I 
I Assi~n Func Ke~s ... I 

DiD I Cancel! 

Figure 5-74 Update Tag List dialog box. 

Description 

The Update Tag List provides several tools to help you manage the 
paragraph tags that are stored in the style sheet. These tools include: 

• Print the style sheet 

• Remove tags 

• Save the style sheet 

• Rename tags 

• Assign tag names to function keys 

Application 

• Remove tags you no longer use. 

• Make tags easier to find in the Assignment List. 

• Make similar tags appear together in the Assignment List. 

• Document existing style sheets. 
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Operation 

Remove tag 1) Select Update Tag List from the Paragraph menu (see Figure 
5-74.) 

2) From the list of tags, select the tag name to remove. 

3) Select Remove Selected Tag. The dialog box shown in Figure 5-75 
appears. 

4) Paragraphs tagged with the tag you are about to remove must be 
converted to some other tag. Enter this new tag on the Tag Name 
to Convert To: line. If you don't specify a Tag Name to Convert 
To, the affected paragraphs are converted to Body Text. 

If, for example, you remove a tag called Headline and replace it with 
a tag called Sub Head, each paragraph in the entire chapter previously 
tagged with Headline is tagged with Sub Head, and the tag Headline 
is removed from the style sheet. 

Use caution with this feature if you use the same style sheet for more 
than one chapter. Although Remove Tag removes the selected tag from 
paragraphs in all text files in the currently opened chapter, all other text 
files previously formatted with this style sheet may still contain para
graphs tagged with the removed tag name. When you once again open 
chapters containing these text files combined with the revised style 
sheet, all paragraphs previously tagged with the removed name are 
formatted as Body Text, and the removed tag name appears in upper 
case in the Assignment List. 

REMOVE TAG 

Tag Na~e to Re~ove: Chapter Titl~ 

Tag Na~e to Convert to: Bod~ Text ____ 

OK I Cancel I 

Figure 5-75 Remove Tag dialog box 
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~ If any tags are removed, use the Save As New Stylesheet option to 
save the style sheet under a new name. This avoids changing the 
format of other documents that use the same style sheet. 

Rename tag 

Once you remove a tag, this tag is removed from the current chapter. 
If you decide you do not want these tags removed from the current 
chapter after you select OK in the Remove Tag dialog box, you can 
still recover the original chapter as follows: 

1) Select Cancel from the Update Tag dialog box. 

2) Select Abandon when asked if you want to save or abandon 
changes to the style sheet. If you want to save the changes, save 
them under a new name. 

3) Select Abandon in the File menu. 

Rename Tag allows you to change the names of existing tags. To use 
Rename Tag, follow these steps: 

1) Select Update Tag List in the Paragraph menu (see Figure 5-74.) 

2) From the list of tags, select the tag name to rename. 

3) Select Rename Tag. The dialog box shown in Figure 5-76 appears. 

4) Enter the New Tag Name. 

~ If you rename any tags, select Save As New Stylesheet to save the 
style sheet under a new name. This avoids changing the format of other 
documents that use the same sty Ie sheet. 

Print style sheet Select Print Stylesheet. The contents of the current style sheet are 
extracted and copied in a readable format to a file with the same name 

RENAME TAG 

Old Tag NaMe: Chapter Title 

New Tag NaMe: DOCUMent Headl 

OK I Cancel/ 

Figure 5-76 Rename Tag dialog box 
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as the current style sheet, with the extension GEN. You can then load 
this file into Xerox Ventura Publisher using the Load TextlPicture 
option and selecting Text Generated. Create your own style sheet to 
fonnat this text, or use the STYLOG.STY style sheet provided in the 
TYPESET directory, and then print the document. 

The Assign Function Keys feature allows you to assign tag names to 
each of the ten keyboard function keys. These tags can be assigned to 
paragraphs in either the Paragraph or the Text modes. 

Use this feature to tag paragraphs and edit text simultaneously, without 
switching between the Paragraph and Text modes. It greatly decreases 
the time required to fonnat and edit a document. 

To use this feature: 

1) Select the Assign Function Keys feature. The dialog box in Figure 
5-77 appears. 

2) Type the name of each tag next to the name of the function key. Use 
the mouse, the up and down keyboard cursor keys or tab and back 
tab to move from line to line. 

3) Select OK when finished. 

If you enter a tag name that doesn't exist for this style sheet, a message 
appears on the screen. If you enter the same tag name twice, only the 
last name entered is used. Once you have assigned tags to function 
keys, you can apply them in one of two ways: 

ASSIGN FUNCTION KEYS lIJ 
F1 : FirstpaL F2: Major heading 
F3: Minor heading F4: Bullet 
FS; Chapter Title F6; Chapter ~_ 
F7: FB: Page Break_ 
F9: Change Bar_ F1D: Bod~ Text_ 

OK I Cancel I 

Figure 5-77 Assign Function Keys dialog box 
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• In Paragraph mode, press the appropriate function key to assign that 
tag to the selected paragraph. 

• In Text mode, press the desired function key to assign a tag to the 
entire paragraph in which the text cursor is currently positioned. 

All style sheets included with Xerox Ventura Publisher use function 
key FlO for Body Text. You can change this default assignment by 
using the Assign Function Keys feature. 
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GRAPHIC MENU 

Show On All Pages 
Send to Back AZ 
Bring to Front AA 

Line Attributes ... AL 
Fill Attributes ... AF 

Select All AQ 
Grid Settin s ... 

Figure 5-78 Graphic Menu 

The options in the Graphic Menu allow you to perform four major 
functions on selected graphics: 

• Make them repeat on every page. 

• Move them in front or behind one another. 

• Change line and fill (shading) attributes. 

• Create a grid to which all graphics will snap. 

See the Modes of Operation chapter for information on how to use the 
graphic drawing features. 
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Show on all pages 

Description 

This feature allows you to make a graphic print on every page in the 
document. 

Application 

• Create camera crop marks anywhere on the page 

• Create custom column guides which are not centered in the gutter 

Operation 
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Select the desired graphic and then select Show On All Pages from 
the Graphic menu. 

If you select a graphic that already displays on all pages, then this 
menu option displays Show On This Page. If you want to stop the 
graphic from repeating on every page in the document, select this 
option. The graphic will be shown only on the current page. 

Graphics repeat at the same place on both left and right pages. If you 
want graphics to repeat at different locations on left pages than on right 
pages, follow these steps: 

1) Go to any left page. 

2) Select the Graphic mode. 

3) Add a small new frame in the margin of your document. The 
placement of this frame does not matter as long as it doesn't 
interfere with any of the text. 

4) Make sure that the frame you just drew is still selected and then 
draw all the graphics which you wish to repeat on left pages. 
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5) Select the Repeating Frame option in the Frame menu and make 
this repeating frame repeat on Left pages only. 

6) Go to any right page. 

7) Repeat steps 2-5 except substitute the word right for left. 

If you do not want graphics attached to a repeating frame to show on 
a particular page: 

1) Go to the page where you do not want graphics to appear. 

2) Select the frame to which you have attached graphics. 

3) Select the Repeating Frame option in the Frame menu. 

4) Select Hide This Repeating Frame. 
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Send to back 

Description 

Send to Back takes the selected graphic and places it at the bottom of 
all graphics associated with the currently selected frame. 

Application 

Change the way graphics overlap each other 

Operation 

Select the graphic you wish to place behind all other graphics. Select 
the Send to Back option in the Graphic menu, or press and hold the 
Ctrl key and then press Z. 

Sometimes you can't select a graphic because it is positioned behind 
another graphic. This situation can be corrected as follows: 

Figure 5-79 Line sent to back of rectangle 

REFERENCE GUIDE 5-179 



MENU COMMANDS 

5-180 

GRAPHIC MENU, Send to back 

1) Press and hold the Ctrl key. 

2) Position the mouse cursor over the graphic you wish to select. 

3) Press and release the mouse button until the graphic you want is 
selected. 

Each time you press the mouse button, you select the next graphic 
further down in the stack. 
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Bring to front 

Description 

Bring to Front takes the selected graphic and places it on top of all 
graphics associated with the currently selected frame. 

Application 

Change the way graphics overlap each other 

Operation 

Select the graphic you wish to place on top of other graphics. Select 
the Bring to Front option in the Graphic menu, or press and hold the 
Ctrl key and then press A. 

Sometimes you can't select a graphic because it is positioned behind 
another graphic. This situation can be corrected as follows: 

Figure 5-80 Line brought to front of rectangle 
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1) Press and hold the Ctrl key. 

2) Position the mouse cursor over the graphic you wish to select. 

3) Press and release the mouse button until the graphic you want is 
selected. 

Each time you press the mouse button, you select the next graphic 
further down in the stack. 

REFERENCE GUIDE 



Line attributes 

LINE ATTRIBUTES for RECTANGLE rn 
Thickness: CustoA 1 91.251 fractional pts 

Color: Black 1 

End St9les: J _ _ 

+J+~ - -Defaults: I Load FroA ... I I Save To ... I 

[][] I Cancel I 

Figure 5-81 Line Attributes dialog box 

Description 

Line Attributes allows you to change the thickness, color, and end 
style of a line drawn in Xerox Ventura Publisher or of an outline 
surrounding other graphics drawn in Xerox Ventura Publisher. 

Application 

• Change the thickness of graphic lines used as extra rules. 

• Create one- or two-way arrows for callouts. 

Operation 
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1) Select the graphic. 

2) Select the Line Attributes option from the Graphic menu. A dialog 
box similar to Figure 5-81 appears. Each of the five graphic types 
has its own dialog box. 
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Load from/ 
Save to 
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GRAPHIC MENU, Line attributes 

3) Choose either a preset thickness for the line, or select Custom 
Width to produce a line of any thickness. If you select Custom 
Width, place the text cursor on the Custom Width line and enter the 
desired width. 

4) Select the Color and End Styles for the line. The beginning and 
ending of each line can have a different end style. The End Styles 
in the left column are for the beginning of the line (i.e., the point at 
which you started drawing), and the End Styles in the right column 
are for the end of the line. 

You can save the Line Attributes for each graphic type (box text, line, 
ellipse, rectangle, rounded rectangle) by using the Defaults: Save To 
feature. If you select Save To, the next graphic you create of the same 
type will have identical attributes. 

If you want to apply the saved defaults to an existing graphic of the 
same type: 

1) Select the desired graphic. 

2) Select the Line Attributes option. 

3) Select Defaults: Load From. When you select OK, the saved 
defaults are automatically applied to the selected graphic. 

To copy attributes from one graphic to another: 

1) Select the graphic whose attributes you wish to copy. 

2) Choose the Line Attributes option. 

3) Select Defaults: Save To. This makes the attributes of the currently 
selected graphic the default for that graphic type. 

4) Select the graphic whose attributes you want to change. 

5) Choose the Line Attributes option and select Defaults: Load 
From. The attributes just saved are copied to the selected graphic. 
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Fill attributes 

FIll ATTRIBUTES for RECTANGlE m 
Color: Black t 

Pattern: 4 t 

Result: Eid 
I Transparent I 

Defaults: I load Frofll ... I I Save To ... I 

[]L] I Cancel I 

Figure 5-82 Fill Attributes dialog box 

Description 

The Fill Attributes option allows you to change the color and back
ground of each graphic. 

Application 

Provide a background for cells in a form or table. 

Operation 
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1) Select the desired graphic. 

2) Select the Fill Attributes option in the Graphic menu. A dialog box 
similar to Figure 5-82 appears. Each graphic types has its own 
dialog box. 

3) Select the color and pattern desired. 
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Load from/ 
Save to 

You can save the Fill Attributes for each graphic type (box text, ellipse, 
rectangle, rounded rectangle) by using the Defaults: Save To feature. 
If you select Save To for the current graphic, the next graphic of that 
type that you create will have the same attributes. 

If you want to apply any saved defaults to an existing graphic of the 
same type: 

1) Select the desired graphic. 

2) Select the Fill Attributes option. 

3) Select Defaults: Load From. When you select OK, the saved 
defaults are automatically applied to the selected graphic. 

To copy Fill Attributes from one graphic to another: 

1) Select the graphic whose attributes you wish to copy. 

2) Choose the Fill Attributes option. 

3) Select Defaults: Save To. This makes the attributes of the currently 
selected graphic the default for that graphic type. 

4) Select the graphic whose attributes you want to change. 

5) Choose the Fill Attributes option. 

6) Select Defaults: Load From. The attributes just saved are copied 
to the selected graphic. 

Opaque/Transparent 

The Opaque and Transparent options allow you to change overlapping 
graphics. If you select Opaque for the graphic on top, that graphic will 
block completely any other graphics below it. If you select 
Transparent for the graphic on top, and if its fill pattern is anything 
other than solid, then the graphics below will show through the graphic 
on top. 

~ Not all printers can print transparent graphics. Print the CAPABILI 
chapter (located in the TYPESET directory) to determine the 
capabilities of your printer. 
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Select all 

Description 

Select All selects every graphic associated with the currently selected 
frame. 

Application 

• Move every graphic associated with a frame to a new location 
relative to the frame. 

• Change the attributes for all graphics tied to a frame. 

Operation 
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1) Select the Frame mode. 

2) Select the frame whose graphics you wish to select. 

3) Enable the Graphic mode. 

4) Choose the Select All option in the Graphic menu, or hold the Ctrl 
key and press Q. All graphics associated with the selected frame are 
now selected. 

If after choosing Select All you want to de-select individual graphics, 
follow these steps: 

1) Press and hold the Shift key. 

2) Point to the desired graphic. 

3) Press the mouse button once. 

To move all the graphics selected: 

1) Move the mouse cursor to the center of anyone of the selected 
graphics, then press and hold the mouse key. 
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GRAPHIC MENU, Select all 

2) Wait until the mouse cursor changes to the shape of two outward 
pointing arrows. 

3) While still pressing and holding the mouse key, move the graphics 
to a new location. 
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Grid settings 

GRID SETTINGS 

Grid Snap: On 

Horizontal Spacing: 12.8~ fractional pts 

Vertical Spacing: 12.88 

[]I[] I Cancel I 

Figure 5-83 Grid Settings dialog box 

Description 

The Grid Settings option defines an invisible piece of graph paper for 
the currently selected frame. All graphics are then fastened to the grid 
points on this graph paper when drawn or moved. 

Application 

• Provide alignment for forms and tables, where adjacent boxes must 
line up exactly. 

• Assure perfect vertical or horizontal alignment. 

Operation 

1) Select the Graphic mode. 

2) Select the Grid Settings option in the Graphic menu. 

3) Select Grid Snap: On. 

4) Set the horizontal and vertical spacing. 
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For Vertical Spacing, you should normally enter a value equal to the 
Inter-Line spacing of Body Text, or a sub-multiple of this space. For 
instance, if Body Text's Inter-Line spacing is 12.00 points, set Vertical 
Spacing to 12.00,6.00,4.00, or 3.00 points. 

In general, enter the largest Horizontal and Vertical Spacing values 
possible, which provides the resolution you need. Keeping the grid 
large allows you to easily see whether two graphics are indeed aligned 
with one another. 
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OPTIONS MENU 

Set Preferences ... 
Set Ruler ... 
Set Printer Info .. . 
Add/Re~ove Fonts .. . 

Show Side-Bar AW 
Show Rulers 
Show Colu~n Guides 
Hide All Pictures 
Hide Tabs & Returns AT 
Show Loose Lines 

Turn Colu~n Snap Off 
Turn Line Snap Off 

Multi -Cha ter ... 

Figure 5-84 Options Menu 

The Options Menu performs several functions: 

• Set global user interface preferences. 

• Set screen and printer options. 

• Add or remove fonts. 

• Perform multi -chapter operations. 

MENU COMMANDS 

• Copy Xerox Ventura Publisher chapters and all associated files. 

~ Use the Copy All feature in the Multi-Chapter option to copy chapters. 
DO NOT use the DOS COpy command to copy chapters. The Xerox 
Ventura Publisher chapter file (CHP file) retrieves files from the 
directories where they were last saved. If you copy those files to 
another directory or disk drive using DOS copy, the chapter file (CHP) 
will not know where to find them. 
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Set preferences 
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SET PREFERENCES rn 
Generated Tags: Hidden t 
Text to Greek: 19 t 

Keep Backup Files: Yes t 
Double Click Speed: Fast t 
On·Screen Kerning: None t 
Auto-Adjustnents: Both t 

Pop·Up Menu S~nbols: Shown t 
Menu Type: Drop·Down t 

Deci~al Tab Char: 9461 (ASCI n 
I OK I (ancell 

Figure 5-85 Set Preferences dialog box 

Description/Application 

The Set Preferences option allows you to: 

• Show or hide tags in the Assignment List for generated text (e.g., 
captions). 

• Control the size below which text is "greeked." The word greek is 
described on the next page. 

• Choose whether to create backup files. 

• Change the speed at which two mouse clicks in a row will be 
recognized as OK. 

• Turn screen kerning on or off. 

• Choose whether to adjust the Inter-Line spacing when you change 
fonts sizes. 

• Convert inch marks and hyphens into their typographic 
equivalents. 
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• Eliminate pop-up menu reminder symbols from the dialog boxes. 

• Change menu operation from drop-down to pull-down. 

• Change the tab-align character for decimal numbers. The US uses 
the period, Europe uses the comma. 

Operation 

Hide generated 
tags 

Greeking 

Backup files 

Double click 
speed 
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Choose Gel~rated Tags: Hidden to reduce the number of tags shown 
in the Assignment List. Since generated text tags are automatically 
assigned to headers, footers, section numbers, etc., you don't need to 
see them in the Assignment List. 

The word greeking describes the practice in the graphics art industry 
of quickly drawing horizontal lines on a page to approximate how a 
real page of text will look. Xerox Ventura Publisher uses greeking to 
speed up the time required to re-draw the screen when displaying 
either a Reduced or Facing Pages View. Select larger numbers to 
display only the largest text as readable text. Select smaller numbers 
to display much smaller text as readable text. The numbers in the 
pop-up menu refer to the screen pixel height of the font. 

Depending on the resolution of your display, text below a certain size 
may not be readable in Reduced or Facing Pages View when greeking 
is completely turned off. This is normal. 

Select Keep Backup Files: Yes to create style sheet, chapter, and text 
backup files each time you save a chapter. Backup files have the same 
name as the original, with the first letter of the extension changed to $. 
Unless your hard disk is almost out of space, you should always keep 
Backup Files set to Yes. 

If you ever need to use your backup files, use the DOS RENAME 
command to rename the backup files to their original names (i.e., 
without the $ in the extension). 

When making selections in the Item Selector, you can select a file and 
select OK in one step by pressing the mouse button twice quickly, 
while pointing to the desired file name. You can change the double
click speed necessary to activate the selection process by selecting 
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Auto 
adjustments 

Quote and em 
dash conversion 
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Double Click Speed, then choosing the speed you desire. Note that 
Xerox Ventura Publisher delays all selection operations by the time 
required for two mouse clicks. Therefore, always pick the fastest speed 
you can handle. 

If you do not use the double-click shortcut, set double-click speed to 
Fast. 

When you select Kerning using the Paragraph Typography option, the 
change in the space between letters is shown on the screen as well as 
on the printed output. However, the additional calculations necessary 
to adjust the space between each character take additional time and 
therefore slow down the screen drawing speed. Also, because of the 
relatively limited resolution of the computer screen, the subtle dif
ferences provided by kerning may not be noticeable at small font sizes 
(i.e., less than 18 points). Therefore, to provide optimum performance, 
you can choose whether to show kerning on the computer screen. 

To show kerning on-screen, select the minimum font size you wish to 
kern. All characters equal to or above the font size chosen will be 
kerned. 18 or 24 point are typical font sizes to choose. 

If kerning is turned on in the Paragraph Typography option, and if the 
printer fonts provide kerning information (see Appendix K), the 
printed output will always be kerned, regardless of whether you select 
on-screen kerning. 

Whenever you change a tag's font size, the font's line attributes, 
superscript font, subscript font, small font, above, below, Inter-Line, 
and Inter-Paragraph spacing for that font increase or decrease automat
ically. Thus, if the font was originally 12 points with 14 point Inter
Line spacing, and you increase the font size to 24 point, the Inter-Line 
spacing is automatically increased to 28 points. If you don't want these 
options automatically adjusted, select Auto Adjust Styles No. 

Word processors and typewriters use inch marks (") instead of typo
graphic open and close quotation marks (" "), and two hyphens (--) 
instead of an ern dash (-). Xerox Ventura Publisher allows you to 
continue to use these conventions within your word processor, then 
automatically convert them into their correct typographic equivalents 
whenever you load text using the Load Text/Picture option. To enable 
this conversion, select Auto Adjust: " and --. You can also enter ern 
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Pop-up menu 
symbols 

Menu type 

Decimal tab 
character 

REFERENCE GUIDE 

dashes (as well as en dashes) and open and close quotes directly in 
Xerox Ventura Publisher using the Alt key and decimal characters. See 
the Modes of Operation chapter for details. 

Once converted, em dashes and open/close quotes are not converted 
back into their typewriter equivalents when the text is saved back to 
the word processor file. 

The quotation mark conversion algorithm works on a paragraph basis. 
The first inch mark encountered which either starts a paragraph or is 
preceded by a space is converted to an open (beginning) quotation 
mark. The next inch mark is converted to a close quotation mark, 
unless a numeral precedes it. This allows you to still use inch marks as 
they were originally intended, e.g., 7" means seven inches. 

Select Auto-Adjust Both if you want both the typographic and style 
conversions. 

Many features in dialog boxes are available through pop-up menus. 
The presence of these menus is indicated by this symbol: t . If you 
want to remove this symbol from the dialog boxes, select Pop-Up 
Symbols: Hidden. 

This option allows you to choose whether menus appear whenever the 
mouse touches the top of the screen (Drop-Down), or whether you 
must also press and hold the mouse button (Pull-Down). Choose 
whichever option feels most comfortable and is most like other 
software you use frequently. 

One of the choices in the Tab Setting and Alignment options in the 
Paragraph menu is decimal tab. When selected, the text aligns at the 
first decimal point in the text. Xerox Ventura Publisher initially as
sumes that the period character is used as the decimal point. However, 
some European countries use the comma instead. Consult Appendix 
E and enter the numeric value on the Decimal Tab Character line for 
the character you wish to use as a decimal point. (The comma is 
decimal 044.) 

This feature also allows you to set the decimal tab character to a slash 
(/), an equal sign (=) or other character to force alignment around some 
other character. 
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SET RULER 

Horizontal Units: Picas 
Uertical Units: Inches 

t 
t 

Horizontal Zero Point: 06 J O§ picas & points 
Uertical Zero Point: 09JO~ 

I OK I I (ancell 

Figure 5-86 Set Ruler dialog box 

Description 

The Set Ruler option allows you to set different ruler measurement 
units for the vertical and horizontal rulers shown on the edge of the 
screen. 

Application 

• Measure the page horizontally in picas and vertically in inches or 
some other combination of units of measurement. 

• Move the ruler so that it begins relative to the column edge rather 
than page edge 

Operation 

1) Select the Set Ruler option. 

2) Select the desired measurement unit for both the horizontal and 
vertical ruler. 

3) Set the horizontal and vertical zero points. 
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The default value for horizontal and vertical zero point is zero. This 
allows you to easily measure from the page edge. However, since tabs 
are measured from the column edge, you may find it useful to set the 
horizontal zero point equal to the left margin. The numbers on the 
horizontal ruler will then show the distance from the left column edge. 

You can also set the rulers interactively, as shown below. 

To move the rulers with the mouse, D,~ , 11 , I~ , , 13 , 

or to pull the ruler cross-hairs onto the 1-1,,~Io.oooo!.o.o""""':-":"~:.-.I.o"':'-Io.oooo!.o.o""""I......!.u"""":.-.I.o....!....J~"""""~""""''''''''''....!....I''''' 

screen, point to the 0,0 box, press and 
hold the mouse button, and then ... 

.. . drag the cross-hairs onto the D, D J1 !~ .e 
screen. Use these cross hairs to check 1---+"'10.0000!.0.0 ......... :-..:..~:...' ........,.' ........ ...:.....0. .......... ...:.....0.""""'........,. ........ """"" ........ ""', ......... ' ......... ....!....I ..... 

for vertical and horizontal alignment. 
In Facing Pages View, you can check 
for alignment across pages. When you 
release the mouse button ... 

. ... ~ ......................................... + ................................. . 

~ 

.. . the zero points move to the mouse D , D 1, ( ! 0 ) 1 

location. To reset only the vertical ruler, f-+I0.0000!.0.0 ......... :-..:..~!oo.' J~' ....... .!u.o.Io.(-.Ioooo~'~.....!.u."""+......I..u.o!.o.o.o.I.. ....... o!.o., ..... l....!, ......... ...!.0.0.0.1.....! 

move the mouse to the top ruler before 1_ 

releasing the mouse button. Select 0,0 
to reset the horizontal ruler zero point 
to the upper left corner. 
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Ruler zero point set 
to location of mouse 
prior to releasing the 
mouse button. 
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When the width table 
contains fonts for the 

selected device (in this 
case PostScript), this line 

displays the word 
Ultimate. 

Load new screen fonts by 
typing the extension of 
the screen font files on 
this line (e.g., PSF for 

PostScript fonts) 
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SET PRINTER INFO (POSTSCRIPT· Uitilllate) 

Device Nallle: Ig.;n"im' I XEROX 4845, 3B8dpi I 

UGA! (Use thDse lIIatching this file eKtensiDn.) 

1!iIIllf1I] mill [1Q![] I (OM2 I I Direct I I Filenallle I 

Width Table: E:\UENTURA\OUTPUT.WID ________ _ 

CDlllllland: mad Different Width Table (i. e" FDnt Metrics) I 

Figure 5-87 Set Printer Info dialog box. 
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Description 

The Printer Info option allows you to change printers, printer connec
tions, and printer and screen fonts. It also allows you to direct the 
printed output to a file. 

Application 

• Switch between several output devices connected to different com
puter ports. Use this option to switch, for example, between a black 
and white printer and a color printer. 

• Print the chapter to a disk. This disk can be sent to another location 
for printing on a high speed laser printer or typesetter. 

• Load a different printer width table. This allows you to change 
fonts. It also allows you to change the character widths to match 
those used on a different printer or typesetter. 
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Operation 

Device name 

Adding new 
screen fonts 

Output to 

You can switch between different installed printers or typesetters by 
selecting the appropriate Device Name in the Set Printer Info dialog 
box (Figure 5-87.) After changing the Device N arne, you should select 
a different Width Table. See Changing Printer Width Tables later 
in this section. 

To add new screen fonts to Xerox Ventura Publisher, copy the fonts to 
the VENTURA or the VENTURA \ VPFONTS directory. (All screen 
fonts must be in on directory or the other.) The fonts must all have the 
same file extension. To select these screen fonts, specify the file 
extension on the Screen Fonts line. 

You may also need to change the computer port. To change computer 
ports (e.g., from COMI to COM2), select the correct option on the 
Output To line. 

Output to disk file 

If you select Output To: Filename, then the information normally 
sent to the output device during a print operation is instead sent to a 
disk file. Nothing is sent to the output device. This disk file can then 
be sent via floppy disk, network, or modem to a remote printer or 
typesetter for printing at a later time. 

To output to a file, select the To Print option from the File menu after 
selecting Output To: Filename within this dialog box. 

~ The disk file created using this command will be at least as big as the 
sum of all the files contained in your chapter or publication. Make sure 
your computer hard disk has enough room. 
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This option is not available for JLaser, Cordata, AST TurboLaser, and 
IBM 4216 printers. 

Printing a chapter outputted to a disk 

After you have outputted the chapter to a file, you will eventually want 
to send this file to a printer or typesetter. To do this, use the standard 
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DOS COpy command, and copy the file directly to the output device 
by typing the following directly from the DOS prompt: 

COpy filename port: IB Enter 

Replace filename with the name of the disk file you want to print, and 
port with the name of the port selected, exactly as shown on the 
Output To: line. Remember to place a colon directly after the port 
name. 

For example, to print a file named TECHDOC1.COO to a printer 
connected to LPTl, type the following at the DOS prompt: 

COpy TECHDOC1. COO LPT1: IB Enter 

This only works with output devices connected with a parallel cable. 
For output devices connected with a serial cable, you must first 
execute the following commands (assuming your device is connected 
to COMl): 

MODE COM1: 96, N, 8, 1, P Enter 
MODE LPT1: =COM1: Enter 

Then execute the COPY command to LPTl: exactly as shown above. 

Use the XPRINT utility to copy Interpress files. 

PostScript printers 

When copying to a PostScript printer or typesetter, you must first 
insert the Utilities Disk into the A drive and then type the following 
command directly from the DOS prompt: 

COPY A:\POSTSCPT\DTR.TXT LPT1: Enter 

DTR.TXT is a file contained on the Xerox Ventura Publisher Utilities 
disk in the POSTS CPT directory. Once this file is transmitted, it does 
not ever need to be re-transmitted unless another program resets your 
printer. It remains in the printer, even when the power to the printer is 
turned off. 
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Changing width 
tables 
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Each printing device creates individual letters and symbols differently, 
with a different shape, height, and width. Xerox Ventura Publisher 
must know, for each device installed, the width of each character for 
each typeface and size. This width information is then used to adjust 
the position for each character on the screen so the end of each line, 
paragraph, and page match the printed output. 

During the initial installation process, Xerox Ventura Publisher auto
matically creates files, called width tables, which provide this infor
mation for each printing device installed. When you select a different 
device, as described in the section Changing Output Devices, the 
matching width table should be loaded. 

To load a different width table: 

1) Select Load Different Width Table (i.e., Font Metrics.) The Item 
Selector appears, and width table files names are shown. These files 
have names like XRX4045.WID and POSTSCPT.WID. 

2) Select the width table desired. 

3) Select OK for you choices to take effect. 

If the current width table is for a different printer than the Device 
Name currently selected, Quality (shown at the top of the Set Printer 
Info dialog box) changes from Ultimate to Draft. 

Whenever you save a style sheet, a reference to the width table 
currently in use is stored with that style sheet. This assures that the 
chapter always prints the same way, even if you later load another 
width table. 

Draft printer 

If you ultimately want to print to a device not connected directly to 
your computer (perhaps a typesetting machine), but want to create 
rough draft copies on your local printer, you have a problem. The 
character widths used by your draft printer don't match the widths 
used by the ultimate output device. When you print the chapter on the 
Ultimate device with a different width table, lines, paragraphs, and 
pages will all contain the wrong number of characters, and the chapter 
will look totally different from the one you originally created. 

5-201 



MENU COMMANDS OPTIONS MENU, Set printer info 

The solution is to use the Ultimate output device width table with your 
local printer. While this produces a chapter on your local printer with 
the wrong word spacing, justified text will still look justified, and the 
number of characters on each line, paragraph and page will exactly 
match what gets printed on the ultimate output device. 

Default width table 

The width table for the first output device installed (primary device) is 
automatically copied during installation to a file called 
OUTPUT.WID. This is the default width table. Its purpose is to 
reconfigure style sheets which are transferred between systems which 
use different printers. 

As an example, a style sheet created on a system which uses an HP 
LaserJet and copied to a system which uses a PostScript printer will 
automatically adapt correctly to the PostScript printer's width table if 
you load OUTPUT.WID before the style sheet is copied from the 
LaserJet system. 

~ Use the width table name which matches the printer name (e.g., 
POSTSCPT.WID) if you want the character widths to remain the same 
regardless of which printer you are currently using. Use 
OUTPUT. WID if you want the character widths to change automat
ically whenever you copy the style sheet to a different system. 
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Add/remove fonts 

ADD/REMOUE FONTS (E:\UENTURA\OUTPUUID • POSTSCRIPT) III 

(OAAand: I Merge Width Tables ... I I ReADVe Selected Font I 

I Save As New Width Table... I 

Figure 5-88 Add/Remove Fonts dialog box 

Description 

The Add/Remove Fonts option allows you to add additional printer 
fonts. It also allows you to disable automatic font downloading for 
each individual font. 

Application 

Add fonts 
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• Add typefaces 

• Enable or disable automatic font downloading 

Sooner or later you will want to add new fonts to Xerox Ventura 
Publisher. You can purchase fonts from anyone of over a dozen 
companies. While these fonts are all different, the process of installing 
them is the same. 

To add new fonts, follow these directions: 

1) Copy all new fonts to the VENTURA directory. If you are adding 
fonts for a PostScript printer, make a directory called PSFONTS 
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and copy the fonts to this directory instead. (LaserJet fonts can also 
be copied to a different directory-See Appendix K.) 

2) Copy the width table for these new fonts to the same directory to 
which you copied the fonts. Most font vendors supply a Ventura 
Publisher width table. Use the utilities described in Appendix K to 
create a width table if the font supplier did not provide one. 

3) Run Xerox Ventura Publisher. 

4) Select the Set Printer Info option in the Options menu. 

5) Select Load New Width Table and load the width table for the 
existing fonts for your printer. 

~ Do not load the new width table using the Load Different Width Table 
command in the Set Printer Info option. You must always merge a 
new width table into one which already exists. 

6) Select the Add/Remove Fonts option from the Options menu. The 
Add/Remove Fonts dialog box appears (Figure 5-88). 

7) Select Save As New Width Table and save the existing width table 
under a new name to avoid accidentally modifying an existing 
width table. 

8) Select Merge Width Tables and select the width table for the new 
fonts. These new fonts are added to those already in the existing 
width table. The combined set of faces, sizes, and styles are imme
diately shown in the Add/Remove Fonts dialog box. 

9) Select any face, size or style which you don't wish to use, and then 
select Remove Selected Font. The font is removed from the com
bined width table. 

10) Select Save As New Width Table and save the combined width 
table under a new name. 

All the new fonts are now available for use. 

~ The two width tables merged together must both be for the same 
printer. 

Resident and 
Download 

The word Resident in the style portion of the dialog box means that 
the selected font (i.e., the Face, Size, and Style) is already resident in 
the printer prior to running Xerox Ventura Publisher. The word 
Download means that Xerox Ventura Publisher will download the font 
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Decrease print 
time 
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from the computer's hard disk automatically during the print opera
tion. 

Whenever the fonts used to print a chapter reside on the computer hard 
disk, select Download. Anytime the fonts used to print a chapter have 
been placed in the printer and made permanent prior to running Xerox 
Ventura Publisher, select Resident. Appendix F describes how to 
download fonts to HP LaserJet printers. 

Each font (i.e., each combination of face, size and style) must be 
individually set to Download or Resident. 

You can decrease print time when using an HP LaserJet or PostScript 
printer by eliminating automatic downloading. To do this, you must 
first download the fonts into your printer, and make them permanent 
prior to running Xerox Ventura Publisher. Use the utilities provided by 
the printer manufacturer. Use HPDOWN.EXE for the LaserJet printer 
(see Appendix K). 

PostScript fonts should be downloaded to the printer prior to running 
Xerox Ventura Publisher to avoid excessively long printing times. 

Although you eliminate the time needed to download the fonts at the 
beginning of each print job, Xerox Ventura Publisher will not free the 
memory used by the fonts when pages which contain many graphics 
and few fonts are printed. Unless your printer contains several 
megabytes of memory, your printer may produce out of memory error 
messages. 
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Description 

The Side-Bar is the left part of the Xerox Ventura Publisher screen 
which contains the Mode Selector, Assignment List, Current Selection 
Indicator, and Page Counter. Hide Side-Bar removes the entire side
bar from the screen, letting you see more of the page. 

Application 

Show/Hide Side-Bar provides a more complete view of the document 
which helps you to perform text editing and paragraph tagging. 

Operation 

1) Make sure the function you want to use (e.g., Text) is selected. 

2) Select Hide Side-Bar in the Options menu, or press and hold the 
Ctrl key as you press W. The Side-Bar disappears. 

To show the side-bar, select Show Side-Bar in the Options menu, or 
press and hold the Ctrl key as you press W. 

While the Side-Bar is hidden, you can perform most of its functions in 
alternative ways: 

• Change between modes using the View menu or the keyboard 
shortcuts. 

• Tag paragraphs using the function keys (see the Update Tag List 
option in the Paragraph menu). 

• Select Set Font (Text mode), Add New Tag (Paragraph mode), or 
Add New Frame (Frame mode) by pressing and holding the Ctrl 
key and then pressing 2. 
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Show/hide rulers 

Description 

Show/Hide Rulers turns rulers at the top and left edges of the screen 
on or off. 

Application 

On-screen rulers help position pictures and graphics. 

Operation 

REFERENCE GUIDE 

Select Show Rulers to turn rulers on. Select Hide Rulers to tum rulers 
off. 

When rulers are shown, the position of the mouse cursor is always 
shown by a thin hairline which moves across the face of each ruler. 
These hairlines allow you to make accurate frame and graphic place
ment on the page. 

To ensure precise frame size and placement, use the Sizing & Scaling 
option in the Frame menu. 

To make precise graphics placement, use the Grid Setting option in 
the Graphic menu. 

5-207 



MENU COMMANDS OPTIONS MENU, Show/hide column guides 

Show/hide column guides 
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Description 

Show Column Guides paints faint dashed lines on the screen that 
show the outline of each column. 

Application 

• See how much space is left at the bottom of the column. 

• Aid in frame placement. 

OperaUon 

To turn column guides on, select the Show Column Guides option in 
the Option menu. To turn column guides off, select the Hide Column 
Guides option in the Option menu. 

Column guides cannot be printed. 

When Column Snap is turned on, frames which you create, move, or 
re-size will snap to these column guides. Column Snap works regard
less of whether the column guides are shown. 
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Show/hide pictures 

Description 

The Hide Pictures option replaces line art and images with a gray 
rectangular box. 

Application 

• Increase the screen drawing speed. 

• See the frame margins, if the frame contains a picture. 

Operation 

To turn all pictures off: 

1) Make sure that no frame is selected. 

2) Select Hide All Pictures in the Option menu. 

To tum all pictures back on again, select Show All Pictures from the 
Option menu. The frame and the picture it contains can still be moved, 
sized, scaled, cut, copied, and pasted while pictures are hidden. 

To hide or show just one picture: 

1) Select the Frame mode. 

2) Select the picture you wish to hide/show. 

3) Select the Hide/Show This Picture option. 

~ Unless specified otherwise at print time, hidden pictures do not print. 
Use this feature to produce draft copies without having to wait the 
additional time that some printers require to print a picture. 
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When pictures are hidden, a gray box appears within each frame, 
covering the exact area occupied by the picture. The space between 
this gray box and the frame edge shows you the current frame margin 
settings. 
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Show/hide tabs & returns 

Tab 

-+ 

Description 

Show/Hide Tabs & Returns provides visual markers for tabs, non
breaking spaces, line breaks, end of paragraph marks, end of file 
marks, index points, frame anchors, discretionary hyphens and other 
hidden inserted characters. 

Application 

Locate hidden characters while editing text. 

Operation 

To show tabs and returns, select Show Tabs & Returns from the 
Options menu press Ctrl T. To hide these characters, select Hide Tabs 
& Returns in the Options menu. Figure 5-89 shows some of the 
symbols used to display hidden characters. 

Showing these characters takes additional space, which changes the 
location of characters on the screen slightly. This shift in no way 
affects how the page is printed. 

~ It is recommended that you Show Tabs & Returns whenever possible 
to avoid accidentally deleting hidden characters. 

Non-breaking 

Discretionary and other fixed 
Line Break Paragraph End of file Hyphen spaces 

• L.I .J " [] 

Figure 5-89 Tab, return, and space characters. Index and anchors display as small circle. Actual 
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Show/hide loose lines 
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Description 

The Show/hide Loose Lines option highlights lines which exceed the 
Maximum Space Width setting in the Paragraph Typography option. 
Although Letter Spacing may be turned on to compensate for the loose 
line which results when this space is exceeded, the line will still be 
flagged as loose. 

Application 

Provide a visual landmark to aid in editing loose lines. You should 
place a discretionary hyphen in the first word below the loose line to 
correct a loose line. 

Operation 

To show loose lines, select the Show Loose Lines option from the 
Options menu. To turn the loose line display off, select the Hide Loose 
Lines option from the Options menu. 

Loose lines are shown in reverse video (i.e., white text on a black 
background) on a monochrome display. They are shown in red on a 
color display. When displaying the page in Reduced View, loose lines 
may not be visible, depending on the resolution of your monitor. 

To correct a loose line, place a discretionary hyphen in the first word 
below the loose line. See the Text mode section of the Modes of 
Operation chapter. 
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Turn column snap on/off 

Description 

'furn Column Snap On forces all frames to align with the sides of the 
page's column guides. 

Application 

Force picture and text frames placed on the page to align perfectly with 
the text columns. 

Operation 
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To turn column snap on, choose 'furn Column Snap On from the 
Options menu. To tum column snap off, choose 'furn Column Snap 
Off from the Options menu. A frame positioned within approximately 
0.1 inch of a column guide will snap to that guide when Column Snap 
is turned on. 

Turning column snap on does not move frames already in the Chapter 
until those frames are moved or re-sized. 

When re-sizing a frame already placed on the page, only the side of 
the frame currently being moved snaps to a column guide. 

Frames do not snap to the top or bottom of the column guides. 
However, if the top margin is an integral multiple of Body Text 
Inter-Line spacing, and Line Snap is turned on, you can force the frame 
to align exactly with the top of the column guide. (See Turn Line 
Snap On in the Options menu.) 

5-213 



MENU COMMANDS OPTIONS MENU, Turn line snap on/off 

Turn line snap on/off 
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Description 

The Turn Line Snap On option forces frames to line up exactly with 
the Body Text Inter-Line spacing in the page. 

Application 

• Ensure that frames in adjacent columns line up exactly. 

• Force the top of one frame to align with the bottom of the frame 
above it. 

• Force a line or lines of text in a column to move down by exactly 
one line by increasing the height of a frame that has been snapped 
to the column. 

Description 

To turn line snap on, choose 'furn Line Snap On from the Options 
menu. To tum line snap off, choose 'furn Line Snap Off from the 
Options menu. 

This option uses the Inter-Line spacing for Body Text to create an 
invisible grid to which frames are snapped. If Line Snap is turned on 
or if Body Text Inter-Line spacing changes after frames have been 
placed, you must move both the top and bottom of each frame in order 
to align the frame with the new Body Text grid. 

If you change the font size of Body Text, and if Auto-adjust styles is 
turned on, the Inter-Line spacing for Body Text will change. When you 
next select a frame, it will jump to the new line grid. To avoid this 
problem, either turn Auto-adjust styles off prior to changing Body Text 
font size, or turn Line Snap off prior to selecting a frame that you have 
already placed in the chapter. 
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Multi-chapter 

MULTI· CHAPTER OPERATIONS 

mm!mHHiHmmi!iiiHHi!Hii C: \ TYP ES ET\&EKAMP LE. PUB 
t C: \TYPESET\CAPABI LI. CHP 

C: \TYPESET\SCOOP. CHP 
---" C:\TYPESET\CHARSET.CHP 

C: \TYPESET\&BOOK· P1. CHP 
C: \ TYP ES ET\&BOOK· P2. CHP 
C: \TYPESET\&BRO· L2. CHP 

7. C: \TYPESET\&BRO· P3. CHP 
C: \TYPESET\&INU· P1. CHP 
C: \TYPESET\&LSTG· P2. CHP 
C: \TYPESET\&LTR1· P1. CHP 
C: \ TYP ES ET\&MAG· P3. CHP 

• C:\TYPESET\&NEWS·P3.CHP 

New 
Open 
Close 

Save, , , 
Save As ... 

Add Chapter ... 
RenoIJe Chali 

Print ... 
Make TOC ••. 
Make IndeK ••. 
RenulIlber •.• 
COpy All ... 

[lM] 

Figure 5-90 Multi-Chapter Operation dialog box 

Description 

The Multi-Chapter option allows you to combine a large number of 
chapters together into a Publication. You can then print, generate a 
table of contents, create an index, or renumber the pages for the entire 
publication. 

Multi-Chapter also includes a file management utility that allows you 
to copy all files associated with a chapter or publication. 

~ Always use the Multi-chapter copy operation to copy chapters. Do not 
use the DOS COpy function. 

Application 

• Print very large publications, such as books or technical manuals. 
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Each chapter can be created separately and can point to its own set 
of text, pictures and style sheets. 
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• Quickly see every file associated with an individual chapter. 

• Automatically create front and back matter (table of contents and 
index.) 

• Automatically continue page numbers across chapter boundaries. 

• Copy every file associated with a chapter or publication, without 
accidentally losing a file. 

Xerox Ventura Publisher can print or copy publications consisting of 
up to 128 chapters. The Multi-Chapter Operations dialog box allows 
you to build a list of chapters, which can then be saved as a Publica
tion. (A publication is nothing more than this list of chapters.) This list 
then tells Xerox Ventura Publisher which chapters to use during 
multi -chapter operations. 

To create a publication: 

1) Select Multi-Chapter from the Options menu. If you have made 
changes since the chapter or style sheet was last changed, you are 
prompted to save them. The Multi-Chapter Operations dialog 
box shown in Figure 5-90 appears. 

2) If you want to create a publication that does not include the chapters 
already displayed, select New. The file names are removed from the 
dialog box. (The chapter files removed with this New command are 
not altered or deleted.) 

3) If you want to retrieve a previously created publication, select 
Open. The Item Selector appears, and you can then specify which 
publication you wish to retrieve. Select OK. The Multi-Chapter 
Operation dialog box reappears, with the publication's chapters 
displayed. 

4) If you want to add additional chapters to the list displayed, select 
the Add Chapter option. The Item Selector appears. After specify
ing the chapter file name, select OK, and the Multi-Chapter 
Operation dialog box reappears. 

5) Continue selecting Add Chapter for each additional chapter you 
want to place in your publication. If you make a mistake and add a 
chapter that you don't want, select that chapter name, and then 
select Remove Chapter. 

REFERENCE GUIDE 



OPTIONS MENU, Multi-chapter MENU COMMANDS 

See all files in 
chapter 

Multi-chapter 
print 
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Rearrange chapter order 

You can easily change the order in which chapters are placed in the list 
once you have created a list of chapters. Simply move the mouse 
cursor over the name of the file you wish to move, press and hold the 
mouse button, and then "drag" the file name to the new location. When 
you release the mouse button, the file name is inserted at the new 
location in the chapter list, and all file names below this point are 
pushed down. 

To move a file name from the bottom to the top of a long list of 
chapters, scroll to the end of the list, and move the file to the top of the 
display area. Repeat until the file is at the top of the list. 

Once the list of chapters is complete and in the correct order, save it 
by selecting the Save As option. The Item Selector appears, and you 
can then specify the file name. The extension PUB is automatically 
added to the file name. Note that you actually are saving nothing more 
than a list of chapters. The individual chapters and their associated text 
and picture files have already been saved. 

Once the publication has been saved, you can create a table of contents 
or index for it, renumber the chapters in the order specified, print all 
chapters, or copy all the files associated with every chapter. 

If you want to see what files are associated with any given chapter, first 
select the chapter name and then select Open. The individual files for 
that chapter are temporarily displayed. Select Close to return to the 
original display. 

Select Open when a chapter name is selected to display the contents of 
that chapter. Select Open with no chapter name selected to retrieve a 
previously saved publication. 

To print the multi-chapter publication currently displayed, select Print 
in the Multi-Chapter Operations dialog box. 

The options are identical to those described in the To Print option in 
the File menu, with one exception: if you have selected Output To 
Filename using the Set Printer Info option in the Options menu, you 
can specify whether you want to Combine print files into one big file 
or whether you want Separate files for each chapter. If you select 
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Separate, Xerox Ventura Publisher automatically creates individual 
files for each chapter, with the name you specify followed by the 
extensions COO, CO 1, C02, etc. If you select Combined, the entire 
publication is placed in one big file with the extension COO. 

Xerox Ventura Publisher can automatically generate a table of con
tents by extracting tagged text from the publication. For instance, you 
can create a table of contents that contains every occurrence of text 
tagged as Chapter Head or Sub Headline, along with the associated 
chapter and page numbers. This table of contents is then stored as a 
text file, which you can load and format later just like any other text 
file and added to the front of the publication file. 

To generate a table of contents for the publication displayed in the title 
bar of the Multi-Chapter Operations dialog box: 

1) Select Make TOC. The Generate Table of Contents dialog box 
appears (Figure 5-91.) The current publication name is shown on 
the TOC File: line, with the last three letters changed to TOC and 
the extension GEN added. This is the name of the text file which 
will be created during the process of generating the Table of 
Contents. 

2) Use the text cursor to change the TOC file name if you don't like 
the default name provided. 

GENERATE TABLE OF CONTENTS m 
TOC File: C:\UPDOC\UPDOCTOC.6EN, _____ _ 

Title String: Table of Contents, _______ _ 
Level 1: [*Chapter Head] 
Level 2: [*Heading 11'+[(""#]---;' [=p#;-.t]I------
Level 3: 
Level 4: 
Level 5: 
Level 6: 
Level 7: 
Level B: 
Level 9: 

Level 19: 

Inserts: I Tag Tellt I Dill I Chapter # I Il!iL[] 

I Tellt Attr. I 

Figure 5-91 Table o/Contents dialog box 
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3) Modify the Title String, if desired. This is the title that appears at 
the top of the first table of contents page. 

4) Place the text cursor on the Level 1 line, and then select Tag Text. 
This places the following words on the Level 1 line: 

[*tag name] 

5) Use the keyboard cursor keys to delete the words tag name and 
replace them with the first tag associated with text you wish to place 
in the table of contents. 

6) Move the text cursor to the end of the Level 1 line. 

7) Select Tab. 

8) Select Chapter # (if you want chapter numbers included). 

9) Type a hyphen. If you want an En dash, type: <196> 

10) Select Page #. 

The Level 2 line on your display should look like the one in Figure 
5-91. Repeat this procedure for additional levels. 

What you have just done is specify the text tagged with the name you 
specified to start at the left margin, followed by a tab, and then the 
chapter number and page number on which that text was found. You 
can add any other text or format information you require. 

When finished, select OK. Xerox Ventura Publisher then automat
ically creates a table of contents. 

This text file is automatically tagged with different tags for each level, 
and another tag for the title. These tags are called Z_ TOe 1, Z_ TOC2, 
etc., and Z_ TOC TITLE. 

You can then load the resulting text file (using the Load Text/Picture 
option), format it with a style sheet, edit it, and print it just like any 
other text file. Load this text file using the Generated option in the 
Load/Text Picture dialog box. 

~ To save the options you specified in the Generated Table of Contents 
dialog box, save the publication after creating the table of contents. 
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The table of contents for this manual was created using Xerox Ventura 
Publisher. 
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Index generation Xerox Ventura Publisher can automatically create an index from the 
references you inserted into the text using the Insert/Edit Index 
option in the Edit menu. 

To generate an index for the publication displayed in the title bar of the 
Multi-Chapter Operations dialog box: 

1) Create a publication file as described earlier in this section. 

2) Select Make Index. The Generate Index dialog box appears (Fig
ure 5-92). The current publication name, with the last three letters 
changed to IDX and the extension GEN added, is shown on the 
Index File line. Change this name if you don't like the default name 
provided. 

3) Modify the Title String, if desired. This is the title that appears at 
the top of the first index page. 

4) If desired, select Letter Headings: On. This places an A before the 
first index entry beginning with the letter A, a B before the first 
index entry beginning with the letter B, and so on. An exclamation 
point (!) is used as the heading for all non-alphabetic entries. 

The rest of the dialog box is automatically filled out as shown in Figure 
5-92, and usually does not need to be changed. For those wishing to 
change the default format: 

GENERATE INDEX 

Index Fill!: C: \UPDOC\UPDOCIDX. GEN, _____ _ 

Titll! String: Indl!x, ___________ _ 

Ll!tter Hl!adings: On ~ 

Bl!forl! #s: ~ 
For Each #: [t#]·[P#)· [(#]·[P#] _____ _ 
Between #s: J ____________ _ 

After #s: 
"SI!I! II: See -;-__________ _ 

"See Also": Sl!e also _________ _ 

I nSl!rts: [!i[} I Chapter # I [lill]] I T I!xt Attr. I 

Figure 5-92 Generate Index dialog box. 
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Before #s inserts the text you specify in front of the chapter and 
page numbers. The default is one horizontal tab character. For the 
index in this manual, the tab was replaced with a comma 
followed by a space. If you want to make the page numbers a 
different font than the rest of the index, place the typeface or size 
change code on this line. For example, to make the numbers print 
in ten point Helvetica, you would type: 

<PIOF2> 

For Each # describes how the chapter and page numbers will 
appear in the index. If you don't want chapter numbers, delete 
both occurrences of [C#] -. If you want chapter numbers to 
appear bold, type: 

<B> [C#J <D> - [P#J - <B> [C#J <D> - [P#J 

Between #s describes the punctuation that should be placed 
between each chapter/page number referenced. The default is a 
comma, followed by a space. 

After #s describes what punctuation should be placed after the 
chapter/page numbers. The default is no punctuation at all. If you 
changed font using the Before #s setting, you can reset to the 
default font by typing the font or size change code on this line. 
For example, to reset the typeface and size to the default 
specified by the Paragraph tag, you would type: 

<P255F255> 

See defines the text that should be added for a cross reference 
entry. Usually the word See is used. If you want the word See to 
appear in italic, type: 

<MI>See<D> 

See Also defines the text that should be added for a secondary 
cross reference entry. Usually the words See Also are used. 

To save changes made to the default settings, save the publication after 
creating the index. 

During the process of generating an index, the actual text from each 
index entry is collected from the publication, along with the chapter 
and page number on which that entry is currently placed. This text is 
then sorted and placed into a text file. Each entry is followed by a line 
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break and horizontal tab character. The last entry for each letter in the 
alphabet is followed by a paragraph end (carriage return.) 

The index for this manual was generated with Xerox Ventura Publish
er's index feature. 

The Renumber option automatically renumbers chapter, page, table, 
and figure numbers across chapter boundaries. This is used for books 
or other long documents which are numbered consecutively across 
chapter boundaries. 

To make this feature work, you must use the Update Counters option 
(in the Chapter menu) and set the initial chapter, page, table, and figure 
counter for each chapter to Previous Number + 1. 

To renumber chapters, select the Renumber option. 

Since both Chapter and Publication files point to many different text 
and picture files, each of which may be in a different subdirectory, 
copying every file in a complete Chapter or Publication using the DOS 
COpy command is a laborious process. In general, the DOS COpy 
command does not work unless you intend to copy every file back to 
the same disk drive and subdirectory. 

Do not use the DOS COPY command to copy chapters. 

The Copy All feature automatically copies all files associated with a 
chapter or publication (except hyphenation dictionaries). You can 
copy each type of file (e.g., style sheet, picture, text) to a different disk 
drive and subdirectory. Xerox Ventura Publisher automatically up
dates the references in the chapter (CHP) and publication (PUB) files 
to these new drives and subdirectories. 

To copy the entire publication: 

1) Open a publication file, or build a list of publications using the Add 
Chapter command, then save the resulting publication. 

2) Select Copy All. Make sure no chapter name is selected, or you will 
only copy that one chapter. (To de-select a selected chapter, move 
the mouse cursor to an empty portion of the screen, and then press 
the mouse button once.) 
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3) The Copy All dialog box appears. (Figure 5-93). The PUB or 
CHP: line shows the name of the publication or chapter to be 
copied. The destination lines show the disk drive and subdirectory 
to which each file type will be copied. 

4) On each destination line, enter the disk drive name, followed by a 
colon,jollowed by a backslash (\), followed by the subdirectory (if 
any) where you wish to place that file type. 

5) Shortcut: if you want to save all files to the same disk and 
directory, enter information on the first destination line only, and 
then select Make all Directories the Same as the First. 

6) Select OK to begin the copying process. Xerox Ventura Publisher 
creates any directory names requested that were not already in 
existence. 

For example, to save all files in the publication to the root directory on 
the A drive, edit each line to look like Figure 5-93 

~ Pressing the Enter key does nothing in the Copy All dialog box in 
order to reduce the chance of accidentally starting the copy process 
before you are ready. You must select OK with the mouse to begin the 
copy process. 
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COPY ALL 

SOURCE (froA this file) 

PUB or CHP: C:\TYPESET\&EXAMPLLPUB, _____ _ 

DESTINATION (to these directories) 

PUB & CHPs: A:~l-_________ _ 
STYs & WIDs: A:\ 
Text Files: A:\'-------------

Graphic Files: A:\, ____________ _ 
IAage Files: A:\, ____________ _ 

COAAand: I Make All Directories the SaAe As the First I 

Figure 5-93 Copy All dialog box. Set to copy all files associated with EX
AMPLE.PUB to the A drive. You must include the backs lash (\) at the end of 
each destination line or you may copy files to a different directory than you 
intended. 
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DOS allows only 112 files in the root directory of a floppy disk, but 
places no limit on the number of files that you can place in a subdirec
tory. Therefore, when you copy chapters containing a large number of 
small files, you should copy these to a subdirectory on the floppy disk. 

If all the files from the publication will not fit on one disk, the 
following message appears when the disk becomes full: 

There is not enough space on the target disk to save 
the file. Do you wish to continue with a new disk or 
cancel the archive process? 

Retrieving a 
publication 

Retrieving a 
single chapter 
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To continue the archive process, insert a blank, formatted disk in the 
drive, close the drive door, and then press Enter. 

To copy only one chapter: 

1) Select that chapter name from the list of files shown in the Multi
Chapter dialog box. 

2) Select Copy All and follow the preceding instructions for copying 
a publication. 

3) Select the Open option in the Multi-Chapter dialog box. 

4) Change the disk drive as described in the Item Selector section of 
the User Interface chapter. 

5) Once the publication is opened, select Copy All and fill in the 
destination lines with the appropriate disk drive and directories, as 
described in the preceding paragraphs. 

Figure 5-94 shows the Item Selector set to retrieve a publication that 
was previously copied to the A drive. All files are copied to the 
TYPESET subdirectory. 

To retrieve a single chapter that has been copied to another disk 
drive: 

1) Select Add Chapter. 
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2) Once the chapter is shown in the Multi-Chapter dialog box, select 
the chapter name. 

3) Select Copy All. 

4) Fill in the Destination lines with the appropriate disk drive and 
directories. 

When retrieving publications or chapters that you have saved on more 
than one disk, the following message appears: 

This file could not be found: filename. Do you wish to 
skip over it, or retry with a new disk, or cancel the 
archive process? 
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Insert the next disk, and then select Retry, or press Enter. 

COpy ALL 

SOURCE (frolll this file) 

PUB or CHP: A:\&EHAMPLE.PUB, _______ _ 

DESTINATION (to these directories) 

PUB & CHPs: C:\TYPESET~I----------
STYs & WIDs: C:\TYPESET\ 

Tellt Files: C:\TYPESET\---------
Graphic Files: C :\TYPESET\, ________ _ 

lIilage Files: C:\TYPESET\, ________ _ 

COlllllland: I Make All Directories the Salile As the First I 

Figure 5-94 Copy All dialog box set to copy EXAMPLE.PUBfilesfrom the 
A drive to the TYPESET directory. 
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PUTTING IT TOGETHER 

This chapter tells you how to combine all the features in Xerox Ventura 
Publisher to produce your documents. It is divided into six sections: 

• Learning hints 

• How to create documents 

• How to produce style sheets 

• Creating typographic effects 

• Performance improvement tips 

• Shortcuts 

Learning hints. This section tells you how to get the most of the 
training materials provided with Xerox Ventura Publisher, as well as 
where to get more information. The concepts which are unique to this 
product--chapters and tags-are reviewed briefly. 

How to create documents. This section shows three fundamentally 
different ways to create a document. Each approach is described both 
visually and in writing. 

How to produce style sheets. This section provides step by step 
procedures for creating a style sheet. Once you finish this section, read 
the next section on creating typographic effects. 

Creating typographic effects. This section shows how to combine the 
different paragraph attributes together into tags to produce both com
mon as well as unusual typographic effects such as lead-ins, outdented 
headings, and reversed text. 

Performance improvement tips and shortcuts. For the advanced 
user, these sections provide tips that will improve your productivity 
and increase the speed of operation. 
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Learning hints 

Training 

Read the 
training guide 

Read this guide 

Other training 
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Xerox Ventura Publisher combines both word processing and drawing 
functions with several unique features. One of the keys to learning this 
program quickly is to learn these unique capabilities immediately. 

Ideally you should read the Training Guide before proceeding with this 
chapter. The Training Guide provides a series of exercises designed to 
acquaint you with basic operations and features. You should be able to 
produce simple documents after reading the Training Guide. 

The purpose of this Reference Guide is to explain each feature in 
detail, and to provide examples of how to get the most out of Xerox 
Ventura Publisher. This guide assumes that you already understand the 
basic operation described in the Training Guide. See page 1-1 in this 
manual for an overview of how to use this Reference Guide. 

Training is available for Xerox Ventura Publisher from many sources: 

• Style guide. A complete guide to proper design practices is avail
able for free if you send in your registration card. 

• Xerox courses. Several different courses, including Orientation, 
Long Documents, Newsletters, and Business Correspondence, are 
offered regularly in major cities throughout the world. In the US, 
contact (800) 445-5554 for more information. 

• Xerox authorized dealer training. In the US, contact (800) 445-
5554 for more information. 

• Books. A number of excellent books are available about desktop 
publishing in general and Xerox Ventura Publisher in particular. 
These include: 

- Desktop Publishing Primer with Ventura Publisher, Kathy 
Lang, Howard W. Sams. 

- Inside Ventura Publisher, James Cavuoto and Jesse Berst, 
MicroPublishing. 

REFERENCE GUIDE 



Learning hints-Unique features PUTTING IT TOGETHER 

Mastering Ventura, Matthew Holtz, Sybex. 

Publishing Power With Ventura, Martha Lubow and Jesse 
Berst. New Rider Publishing. 

- Ventura Publisher for the IBM PC: Mastering Desktop Pub
lishing, Richard Jantz, Wiley. 

- Ventura Tips and Tricks, Ted Nace, Peachpit Press. 

• User Groups. 

Ventura Publisher Users Group (VPUG). 

- Ventura Users of North America (VUNA). 

• Other Products. Contact your local dealer for information on other 
products which enhance Xerox Ventura Publisher. These products 
include fonts, file management software, clip art, typesetter drivers, 
large screen displays, print buffers, and many other products. 

Unique features 

Xerox Ventura Publisher is similar to other programs you may already 
use. You can edit text as you do in your word processor, and you can 
draw the way you do in your drawing or CAD program. However, 
Xerox Ventura Publisher does contain several unique features which 
you must learn before you can enjoy the full power of the product. 
These unique features are described in this section. 

Chapters Most programs can work with only a few files at one time. For 
instance, word processors can handle only two documents at once. 
Most databases can manage only a few database files simultaneously. 
By contrast, Xerox Ventura Publisher can combine and publish up to 
128 different text and graphic files in one document. To make it simple 
to save and retrieve all these different files, Xerox Ventura Publisher 
creates a blueprint of how they should be combined together. This 
blueprint is called a Chapter File (Figure 6-1). When you use the 
Open, Save, or Save As options in the File menu, you retrieve or save 
this blueprint. You also retrieve or save all the files which this blueprint 
(i.e., chapter) references. 

Tags All word processors let you change text to boldface, italic, underline, 
etc. These changes are usually called text attributes. Xerox Ventura 
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Chapter File 

Creates a blueprint which shows which files are in chapter and 
determines where they are placed. 

Figure 6-1 The chapter file creates a blueprint of how all files in your 
document should be combined together. 

Publisher doesn't restrict you to a few pre-set text attributes. Instead, 
you can create virtually any attribute you want by combining different 
fonts, spacing, special effects, color, and ruling lines. To help you keep 
track of all the different effects you've created and to let you apply 
these effects easily to different paragraphs in your documents, Xerox 
Ventura Publisher allows you to attach a name to each style. These 
names are called tags. Tags are stored in style sheets. 

Differences from a word processor. The Text mode provides a 
built-in text editor. Like a word processor, the Text mode allows you 
to add, delete move, and copy text. However, unlike a conventional 
word processor, the text appears in the exact location and in the format 
that you will see on the final printed page. This results in the following 
differences in operation compared to most word processors: 

• You must always use the mouse to place the text cursor on the page 
at the location where you want to edit text before you begin typing. 

• Since you can place text anywhere on the page (by placing text in 
a frame or in box text), paragraph measurements are calculated 
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from the left column edge, not from the edge of the page. For 
instance: 

- Tab Settings are measured from the left edge of the current 
column. 

- Paragraph Alignment and Spacing are also measured from 
the left edge of the current column. 

Using Ventura Publisher as a word processor. You can create a new 
document directly within Xerox Ventura Publisher, without ever using 
an external word processor. Follow these steps: 

1) Run Xerox Ventura Publisher by typing VP Enter. If Xerox Ven
tura Publisher is already running, select New from the File menu. 

2) Select the Text mode. 

3) Move the mouse cursor to the upper left comer of the page and 
press the mouse button once. 

4) Begin typing. 

5) Select Save from the file menu. The file name you choose will 
create both a chapter file and a text file. The chapter file will have 
the extension CHP and the text file will have whatever extension 
and whatever file format you specified the last time the Load 
TextlPicture function was used. 

You may want to create a different text file name or word processor 
format from those automatically provided when you select Save. To 
do this, follow these steps prior to selecting Save: 

1) Select the Frame mode. 

2) Select the page. 

3) Select the File Type/Rename option from the Edit menu. 

4) Enter on the New Name line the text file name you wish to create. 

5) Select the Text Format you wish to create then select OK. 

When you select Save, the text files will be saved with the file name 
and format you specify. 
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Although every document is unique, most fall into one of three broad 
classifications. Each class of document is best created using a specific 
approach. The three classes of documents are: 

• Books 
Books contain only one text file, which continues from one page to 
the next. The typographic style and columnar structure remains 
essentially the same from page to page, although each page may 
contain unique illustrations, tables, and figures. Books, technical 
manuals, proposals, databases, catalogs, overhead transparencies, 
and office correspondence are typical examples of these docu
ments. 

• Newsletters 
These documents contain many text files, each representing a 
different article or story. The text in these documents does not 
usually flow consecutively from one column to the next, but instead 
skips columns or pages (e.g., the text on page one of a newspaper 
continues on the back page). Typography, however, is similar on 
every page in that the same fonts and text spacing are maintained. 
Examples include newsletters, newspapers, magazines, and some 
types of brochures. 

• Forms 
These documents have no structure or typographic consistency 
from page to page. Forms, ads, and some types of brochures are 
typical examples of this type of document. 

The best way to design each class of document is to use an approach 
which fits its unique characteristics. These approaches are described 
in the remainder of this section. 

You can create virtually any size book or technical manual using the 
steps outlined in this section. 
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1) Load a style sheet which is similar to the format you are trying to 
produce. If no similar style sheet is available, load DEFAULT.STY 
from the TYPESET directory. 

2) Immediately save the style sheet using the Save As New Style 
option in the File menu. Pick a new name for the style sheet. This 
avoids making any unplanned changes to other documents which 
use the original style sheet you loaded. 

3) Load the text and picture files you plan to use in your document. 
Use the Load Text/Pictures option in the File menu. 

4) Select the Frame mode. 

5) Select the Page Size & Layout option in the Chapter menu and 
change the Orientation and Page Type & Dimension. 

6) Change the Chapter Typography settings, if necessary (see the 
Chapter menu). 

7) While still in Frame mode, select the page, then modify Margins 
& Columns, Ruling Lines, and Frame Background for the page 
(Frame menu). These changes will affect every page in the docu
ment. 

The steps up to this point are the same for each of the three document 
types (i.e., book, newsletter, and form). The remaining instructions 
apply to book documents only. 

1) Select the page, then select the main text file (the one which should 
flow automatically from page to page). This action will place that 
text file on the first page and it will automatically create as many 
pages as necessary to fit the entire file. 

2) Save the chapter using the Save option in the File menu. The 
chapter is given the same name as the text file you placed on the 
page, but with the extension changed to CHP. (Select Save As if 
you want to save the chapter under a different name.) 

3) Change to the Paragraph mode. Modify the style sheet attributes to 
achieve the typographic effects you desire for each paragraph type 
(this is covered in more detail in the next major section in this 
chapter). For instance, select a paragraph that you want to use as a 
headline, select Add New Tag (in the Addition Button in the 
Side-bar), and then modify the Paragraph attributes for this new tag 
(Figure 6-2). You can now use this tag to format other paragraphs 
in the chapter. 
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_ .................................................................................. (/ 
[The Adventure Begins1f 
[This trip really began in September last year when Gerry won 
: . . . ong on United Airl 

nd return, but at the 
ADD NEW TAG in the Far Eas!."1f 

thority, and on Febr 
Tag Nallle to Add: s on four airlines, m 

Tag Nallle to COP!I Frolll: Bod!l TeKt_ ewhere over the W 
Los Angeles. ~ 

[][] I Cancel I and! gue8sit'sjust 

!Left the house at 7:00 A.M.~ 

Figure 6-2 Add new tag to create new paragraph attributes. 

I,Bbil151immmmmm Wi 

!The Adventure Begins1f 
[This trip really began in September last year when Gerry won 
[prize was two round trip tickets to Hong Kong on United Airl 
[more than spend ten days in Hong Kong and return, but at the 
[fly to other destinations or between points in the Far East. "1f 
[On February 1 Oth, United acquired this authority, and on Febr 
:seven countries, traveled over 25,000 miles on four airlines, m 
[Chicago to Tokyo~ :::::: 
[11:03 P.M. Chicago time. _39,000 feet somewhere over the W\: 
[about an hour and ten minutes late out of Los Angeles. ~ «: 
[Travel Lo~)( 
[So far, it's been a long and interesting day and I guess it's just:( 
!11 ....... . 

Figure 6-3 After creating a new tag, use the Paragraph menu to create new 
attributes. Then, assign this tag to a paragraph as shown above. 

leha pier I1J 

: rI'his trip really began in Septembe 
ill::: .... ····wrrhe Adventure Begins1f 

~enter holds every year. _ The priz 
Analyzing our good fortune, we co 
paving just gotten its routes and eq 

~ ~~ l pn February 10th, United acquire 
, March 26th. We entered seven co l prints, and 51/2 hours of color and :;::::::: 
: ~hicago to Tokyo~ }{ 
< P:03 P.M. Chicago time. _ 39,000 :::: 

ji~i:~iE~~~~o l~n" on~~~t~:::;:::o:: ::~\~,~::oa:,~~:,:~i:l 
Figure 6--4 Add new frame to position pictures or additional text where you 
want them. Select from the Assignment List the name of the file you wish to 
place in the frame. 
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4) Tag each paragraph that you want to be typographically different 
from Body Text. To tag a paragraph (and change its format), first 
select the paragraph, then select one of the tags from the Assign
ment List. 

5) Use the Add New Frame Addition Button in the Side-bar to draw 
frames where you want to place pictures or additional text. Once 
the frame is drawn, place pictures or text into the frame by selecting 
the frame and then selecting the file name from the Assignment List 
(Figure 6--4). 

6) After you have placed a file in a frame, select that frame, then look 
at each option in the Frame menu. Modify, as necessary, the settings 
for Margins & Columns, Sizing & Scaling, etc. for each frame. 

7) If you want to annotate the information in a frame, switch to 
Graphic mode. Select the frame and then draw arrows, circles, box 
text, etc. to enhance the text or picture in the frame. 

8) Use the Text features to edit text on the page, text in frames, and 
text in box text. 

9) Use the Chapter menu options, such as Headers & Footers, Foot
notes, Auto-numbering, and Counters to generate additional text 
for the chapter automatically. 

When you are finished, save and then print the chapter. When all 
chapters have been created and saved, use the Multi-Chapter option 
in the Options menu to number all pages correctly (if you number 

IIILTHHAPTER OPERATIOHS rn 
"",";eC""";""""~," (: \TYPESET\FR" III.PUB ;;;~;ft1f;;;;;g;;~i,;;;gm"; Hew 

(:\TYP~IT\BOOI{'(HP "en 
~ (:\TYPESET\BOOK1.CHP [lm 

(: \TYPESET\BOOK2.CHP ........•.••... 

-. 

SJvc ... 
Save As ... 

Add (hapter ... 
Rcnove ChJp 

Print ... 
Hake TOC ... 

Renullber ... "\ 
(ODU All .. . 

lJm] 

Figure 6-5 Create a publication which consists of all the chapters in your 
document. Use this publication to re-number chapters, make a table of con
tents, index, print all chapters, and archive every file in your document. 
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chapters with consecutive page numbers), create a table of contents, 
and produce an index (Figure 6-5). 

Finally, use the Copy All feature in the Multi-Chapter option to 
archive the publication (the collection of all your chapters) to floppy 
disks or to another directory on your hard disk. 

Newsletters 

Newsletter 
Layout 
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This sub-section describes how to create newsletter chapters. A news
letter chapter contains multiple articles, each saved in a different text 
file. These articles can start on any page and can continue on any later 
page. Each portion of each article can be placed in a frame anywhere 
in the chapter. Each frame can have its own set of margin, column, and 
vertical rule settings. 

Newsletters, newspapers, and magazines combine a variety of differ
ent typographic styles, column widths, and margins. You can generate 
this type of complex layout by placing text into frames, rather than 
directly onto the page. For those familiar with the traditional publish
ing process, this strategy very closely mimics the process of pasting up 
galleys on a page: once you draw a frame and place text into it, the 
frame becomes a galley that can be "pasted" anywhere on the page. 

To compose a newsletter layout: 

1) Follow the first seven steps for the book strategy shown on page 
6-8. 

2) Use the Margin & Column option in the Frame menu to provide 
column guides to which frames can be snapped (Figure 6-6). Tum 
Show Column Guides On to show these guides on the screen. In 
the book approach, the column settings are used to format the text 
on the page. In this approach, the column settings provide a grid to 
align the separate frames which you will manually draw. You will 
then place the respective text files into these frames. 

3) Use the Add New Frame command in the Side-bar to place frames 
wherever you want text to appear (Figure 6-7). 

4) Place text or pictures into each frame that you drew in the last step 
(Figure 6-8). To place text in a frame, select a frame, then select a 
file name from the Assignment List. 
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Each frame can have 
its own set of Frame 
menu settings (e.g. 
Margins & Columns. 

For instance, select this 
frame and make it two 
columns. 
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Figure 6-6 First step in newspaper layout: Create underlying grid with 
Margins & Columns. 

Figure 6-7 Second step in newspaper layout: Create Frames to hold vari
ous textfiles. Set margins and columns/or individualframes. 
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To place text into this 
frame, select the frame 
and then select the file 
you want to put into it. 

To continue the same 
file into this frame, 
select this frame next --!I-''-I---...... ~ 

and then select the 
same file name from 
the Assignment List. 
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Figure 6-8 Place additional frames on page. Place text and pictures files 
in each frame. NEWSLOGO.TXT was placed in top frame, and NEWS
LET. TXT was placed in second frame. 

5) Increase or decrease the size of the frame to change the amount of 
text it contains. Move the frame around on the page to the location 
you want. 

6) Use the Insert New Page option in the Chapter menu to insert a 
new page. Continue drawing frames and placing text and pictures 
into these frames as needed to complete your layout. 

7) To continue text into a new frame from a previous frame, first select 
the new frame, then select the text file name in the Assignment List. 
The text continues from the previous frame. This process can 
continue with as many frames as you wish, on different pages, until 
all text from the file is placed in the chapter. Each new frame can 
be placed on the current or any succeeding page. Text cannot be 
made to flow to a previous page. 

8) Change frame attributes as needed using the options in the Frame 
menu. You can change the number of columns, margins, ruling 
lines, and frame background for each frame to create special ef
fects. 

9) Once you have placed text in a frame, you can tag it in exactly the 
same manner as text placed in the page. Tagging text changes text 
attributes, and changes the placement of text within the frame (e.g., 
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right justified, centered.) All tag spacing is measured from the edge 
of the frame, not from the edge of the page. You can set the Page 
Break feature (Breaks option, Paragraph menu) to force text into 
the next frame. 

If you want to annotate the information in a frame, switch to Graphic 
mode. Select the frame and then draw arrows, circles, box text, etc. to 
enhance the text or picture in the frame. Use the Text features to edit 
text in frames and text in box text. 

Figures 6-6, 6-7, and 6-8 show how to compose part of the first page 
of a newsletter. 

~ When placing text from the same file into different frames on the same 
page, you must always place the first part of the text into the frame that 
you placed on the page first, and the last part of the text into the frame 
that you placed on the page last. 

Has all text 
been put into 
the chapter? 
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If you cut a frame and then immediately paste it back on the page, this 
frame becomes the last frame on the page. Use this technique to 
re-order text flowing within frames on the same page. 

Also note that if one text frame partially overlaps another text frame, 
the last frame created appears on top of the first frame created. The text 
in the bottom frame flows around the frame on top. 

Since the newsletter approach places text in frames rather than directly 
on the page, new pages are not created automatically. Therefore, use 
the Insert New Page option in the Chapter menu to add new blank 
pages, as needed. Then continue placing new frames and adding text. 

Xerox Ventura Publisher doesn't require that all text from a given file 
be placed in the chapter. This is a useful feature because newsletter 
layouts often require that the end of a story be truncated in order to fit. 
Even when you truncate a story in this way, Xerox Ventura Publisher 
still saves the entire original article when you save the chapter. 

However, most of the time you will want to make sure that all the text 
from an article has actually been placed into the document. To find out 
whether the entire contents of a file have been placed in the chapter: 

1) Tum Show Tabs & Returns on (Options menu). 
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templates 

2) Select the Frame mode. Select a frame which contains the text from 
the file you want to check. 

3) Select the Go To Page option from the Chapter menu and select 
Relative to: File, Which Page: Last. This will take you to the last 
page in the chapter which contains text from this file. 

4) Select the frame on this page which contains text from this file. If 
the end of file marker appears in this frame, the entire file has been 
placed in the chapter. Otherwise, you must draw another frame and 
continue text from the file into that frame. 

Different issues of a newsletter or newspaper often use the same 
layout. Rather than spend the time to place frames in the same place 
on the same pages for each new issue, you can create a template from 
an existing chapter, which you can use then use to create subsequent 
chapters quickly. To create a template: 

1) Open an existing chapter. 

2) Use the Remove File option in the Edit menu to remove each file 
in the Assignment List from your chapter. For instance, select the 
first frame on the first page and then select Remove File in the Edit 
menu. 

3) Select Remove from: List of Files, then select OK. 

The file is removed from each frame in the chapter, but the frames, and 
all the frame settings, remain. After you have removed all files in this 
way, use the Save As option to save the chapter under a new name. For 
the next issue, all you need to do is retrieve this blank chapter, load the 
appropriate text and picture files, place these files in the frames that 
are already in the chapter, save the chapter under a new name, and 
then print. 

An even faster approach is to use the DOS COPY command to copy 
the new text for the next issue to the same file names which you loaded 
into the chapter for the previous issue. Then, when you open the 
chapter, the text flows from frame to frame and page to page exactly 
as it did for the previous issue. 

~ Make sure you archive the text files from the last issue before you copy 
over them with the new text. Use the features in the Multi-Chapter 
option in the Options menu. 
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Forms 
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Xerox Ventura Publisher is extremely well suited to producing struc
tured documents such as technical manuals and books. However, you 
can also use it to produce unstructured documents such as forms, ads, 
and brochures just as easily. You will want to use the following 
techniques when creating these free-form documents: 

• Use the Graphic mode's Box Text feature to place all text in the 
document. 

• To change text attributes frequently, use the Text mode's Set Font 
feature rather than using tags. 

Like text in frames, Box Text can be placed anywhere on the page. 
Unlike text in frames, however, Box Text does not cause other text to 
move out of the way. 

Follow this general procedure: 

1) Follow the first seven steps for the book strategy shown on page 
6-8. 

2) Select Show Tabs & Returns. 

3) Select the Graphic mode. 

4) Select the page. 

5) Select the Grid Settings option and set both horizontal and vertical 
grid spacing to the same amount you set for Inter-Line spacing (in 
this example, 3.00 points.) 

6) Select the Box Text tool and draw a box on the page (Figure 6-9). 
If necessary, select Line Attributes from the Graphic menu and 
change the line thickness, or set Thickness to None. Select Save To 
prior to selecting OK in the Line Attributes dialog box. 

7) Select Paragraph mode. 

8) Create three new tags, then select Alignment from the Paragraph 
menu and set the tag alignment at Left, Center, and Right respec
tively. Change the font for these tags to whatever font you expect 
to be using most frequently. Create additional tags as desired to 
control placement within the box. Using combinations of Horizon
tal and Vertical alignment (Alignment option), you can place text 
in any comer, in any side, or in the middle of any box on the page. 
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Figure 6-9 First step in form creation. Turn grid snap on. Draw box text 
and other graphics. 

9) Use the Update Tag List option (Paragraph menu) to assign these 
new tags to the keyboard function keys. 

to) Select the Text mode and type the text you want, into the boxes you 
just drew .. 

11) Tag text in the boxes, using the assigned function keys, to place text 
where you want it within each box (Figure 6-10). 

12) While still in the Text mode, select text, then select the Set Font 
button to change its font. You can change the typeface, size, and 
style (weight). Alternatively, press and hold either shift key and 
press the up and down arrows to make the font larger and smaller 
interactively. Use the left and right arrows, while holding the shift 
key, to tighten or loosen the text. 

13) Return to the Graphic Drawing mode and draw more box text, 
repeating the above procedures. You can move each box text 
around the page and place it wherever you want. 

When you want to create a new page, select Insert New Page After 
Current Page in the Insert Page/Remove Chapter menu. 

Figures 6-9 - 6-11 show how to create a simple calendar using this 
approach. 
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Figure 6-10 Type text in each cell. Then, tag each paragraph to align it 
within each box text. In the above example, the selected text is being centered. 

9 

Figure 6-11 Use the Text mode to select text and increase its/ont size. 
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Figure 6-12 Finished calendar. 

How to produce style sheets 
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Style sheet definition 

A style sheet is a computer file which controls text attributes (e.g., font, 
line spacing, color) and text placement (e.g., widow & orphan control, 
keep with next) for each paragraph in your document. When you 
design a style sheet, you give each set of typographic attributes a name. 
These names are called Tags. You assign attributes from the style sheet 
to each paragraph in the document by first selecting a paragraph and 
then selecting the appropriate tag from the Assignment List. When you 
assign a tag name to a paragraph, the tag name is inserted invisibly into 
the paragraph, and the paragraph is reformatted according to the 
attributes contained in the style sheet for that tag name. 

The style sheet approach allows you to apply the same typographic 
formats to many chapters, regardless of which word processor you 
used and regardless of who wrote the chapter. It also allows you to 
instantly change the format of an entire chapter by loading a different 
style sheet. 
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Loading a Style Sheet 

Load an existing style sheet either by choosing the Load Different 
Style option in the File menu, or by opening an existing chapter (which 
automatically loads the associated style sheet.) Once you have loaded 
a style sheet, you can modify it by: 

• Changing the settings in the Paragraph menu. 

• Changing the setting for the Page Layout, Chapter Typography, 
Widows & Orphans, Auto-numbering, and Footnote settings 
options in the Chapter menu. 

• Modifying the frame settings for the page. 

• Loading a new printer width table. 

If you save either the style sheet or the chapter, the changes made are 
saved in the original style sheet file. However, if you select the Save 
As New Style option in the File menu, and specify a new file name, 
then a new style sheet is created. 

~ Any modification to the style sheet is saved whenever you save the 
current Chapter. If you don't want these changes to affect other 
Chapters which use the same style sheet, select Save As New Style and 
enter a different style sheet name before saving the chapter. 

To assure that a style sheet is never modified, use the DOS ATTRIB 
(DOS 3.2 or higher) or similar utility to set the style sheet to READ
ONLY. 

Creating style sheets 

REFERENCE GUIDE 

To create a style sheet, follow these steps: 

1) Load an existing style sheet. Most people find it easier to modify 
an existing design than to create a completely new style sheet. Use 
the Load Different Style option in the File menu. If you do want 
to start with a blank style sheet, load DEFAULT. STY from the 
TYPESET directory. 
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2) Save the style sheet under a new name. This keeps you from 
accidentally modifying an existing style sheet. 

3) Load a text file. Place a text file on the page. This puts sample text 
on the page. As you make changes to the style sheet, you can see 
the effects on this sample text. 

4) Change the margins and columns. Enable the Frame mode and 
select the page. Then select the Margins & Columns option in the 
Frame menu and enter information for both the left and right page. 
If the document is to be bound, add additional space to the right 
margin on left facing pages, and more space to the left margin on 
right facing pages, to allow space for stapling and hole drilling. 

5) Change the settings for Page Layout, Chapter Typography, 
Auto-Numbering, and Footnote Settings options. These five 
options in the Chapter menu are stored with the style sheet. 

6) Set the page's vertical rules. Select the Vertical Rules option in 
the Frame menu, and enter information for both the left and right 
page. 

7) Modify existing tags. Enable the Paragraph mode, select a para
graph and then tag that paragraph with the tag you wish to modify. 
Use the options in the Paragraph menu to change the attributes of 
the tags in the existing style sheet. You may want a different 
typeface or size, or perhaps different spacing between lines. For 
each tag, it is good practice to examine each option in the Paragraph 
menu starting with Font and working down the menu to the Define 
Colors options. Any changes that you make are immediately re
flected in the tagged paragraph. If you don't like what you see, 
change it. Pay special attention to Body Text, since the format for 
this tag provides the foundation for the overall design. 

~ Hint: use Ctrl + X to retrieve immediately the last menu. 

8) Create new tags. To create a new tag name, select the Paragraph 
mode and tag a paragraph with a tag similar in design to the one you 
want to create. Then select the Add New Tag button (located just 
below the Mode Selector). When you select OK, the new tag name 
is added to the Assignment List, and the new tag is assigned to the 
selected text automatically. Once you have created a new tag, 
modify it by following the directions given in the previous instruc
tions. 

9) Delete unwanted tag names. Use the Remove Tag feature located 
in the Update Tag List option to get rid of any tags you do not need. 
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10) Save the style sheet. Select the Save as New Style option in the 
File menu. Type a new name on the Selection line if you want to 
create a new style sheet. Otherwise, select an existing name in the 
Item Selector, and then select OK. 

When you are finished, print the style sheet. Use the Print Style Sheet 
feature in the Update Tag List option (Paragraph menu) to produce a 
printed copy of all the settings in the style sheet. Print Style Sheet 
actually produces a file that you can load into Xerox Ventura Publisher 
and then print. 

Examine the printed copy to make sure that the settings for each tag 
are correct. Pay particular attention to the settings in the Font, Spac
ing, and the Breaks options. If you want Body Text in adjacent 
columns to align, you must make the total spacing above and below 
each paragraph equal to a multiple of Body Text spacing (see the 
Paragraph Spacing section in the Menu Commands chapter for further 
details). 

~ You should save any style sheets to which you have made modifica
tions under a different name. This assures that you don't inadvertently 
change the format of other documents. 

Menu options The following are stored with the style sheet: 
stored with 
style sheet 

• All paragraph tag settings 

• Margin and column settings for the page. (Margin and column 
settings for each individual frame are stored with the chapter.) 

• Page layout settings 

• Chapter typography settings (except Widow & Orphan) 

• Auto-numbering settings 

• The printer width table name 

Tag Names Most good designs use very few different tags. Although Xerox Ven
tura Publisher allows you to define up to 128 different tags, most 
design experts agree that you should use only one or two typefaces per 
chapter, and should only use three or four combinations of sizes (e.g. 
10 point, 14 point) and weights (e.g., bold, italic.) Therefore, most 
style sheets should consist of only a few tag names. 
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Pick tag names that are short, so that the author can enter them easily 
into the original word processor. (See Appendix D for a description on 
how to enter tag names directly in your favorite word processor.) 

Choose tag names that make it easy for the user to see the hierarchy 
between related tags when looking at the Assignment List. For in
stance, the names Heading and Sub Heading definitely reflect a 
hierarchy, even though the two names will appear in different parts of 
the alphabetized Assignment List. A better choice is'Head 1 and Head 
2, or even HI and H2. 

Choose identical tag names as you design different style sheets. This 
approach allows you to instantly reformat old text with new style 
sheets, and also reduces training as you design new style sheets. 

The name Body Text cannot be changed or removed. 

Text which you load using the Load Text/Picture option (File menu) 
may contain tag names which do not match the tag names in the 
current style sheet. Xerox Ventura Publisher adds these names, in 
capital letters, to the style sheet. They are assigned Body Text attri
butes. 

So that you may differentiate these added tag names easily from the 
tags you have already created, you should always enter tag names in 
lower case, or with initial capitals. You can then see whether the style 
sheet in use matches the tags already in the text. If you see a tag name 
in all capital letters, indicating that a mismatch has occurred, either 
select the correct style sheet, or modify the upper case tag attributes, 
as appropriate. If you do modify the uppercase tags, use the Rename 
Tag function to convert the tag name to lower case or initial capitals. 

When you create a header, footer, caption, automatic section number, 
table of contents, or index, a tag is automatically created with the name 
Z_HEADER, Z_FOOTER, Z_CAPTION, etc. The initial tag attri
butes for these Generated Tags are taken from the current definition 
of Body Text. However, you can modify these generated tags like any 
other tag. For instance, to put a ruling line under each header, first 
enable the Paragraph mode, then select the header and, finally, use 
the Ruling Line Below option in the Paragraph menu to add the ruling 
line. 
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Total number of 
tags 

REFERENCE GUIDE 

Generated Tags are always preceded by the capital letter Z. These tags 
are usually not shown in the Assignment List because they are not 
generally assigned to any non-generated paragraph. However, you can 
display them in the Assignment List by selecting Show Generated 
Tags in the Set Preferences option. 

The number of tags in the current style sheet, plus the number of 
non-matching tags in all current text files, plus the number of gener
ated tags, cannot exceed 128. 
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This section gives step-by-step instructions for combining several 
Paragraph options together to create common typographic effects. The 
style sheets in Appendix L contain other effects not explicitly covered 
here. 

This section describes the following effects: 

• Big First Character (white on black) 

• Footnote superscripts 

• Headings (outdented) 

• Indents/Outdents 

- Lead-ins 

- Hanging indent 

- Simple indents 

• Reverse Type/Shaded Type 

• Tables 

- Tabs 

- Vertical Tabs 

- Spreadsheets 

Reversed big first character 

The Special Effects option in the Paragraph menu allows you to create 
a big first character at the beginning of a paragraph. Occasionally, you 
may want to create an effect similar to the one shown in Figure 6-13, 
where white text appears inside a black box. You can create this effect 
using a combination of options from the Paragraph menu. Once cre
ated, you can instantly format any paragraph in your document. This 
is the most complex effect described in this section. 
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D he Special Effects option in the Paragraph menu lets you 
create a big first character at the beginning of a para

graph. Occasionally, you may want to create an effect similar 
to the one shown in Figure 6-9, where white text appears 
inside of a black box. You can create this effect using a 
combination of options from the Paragraph menu, then format 
any paragraph in your document to display this newly-created 

Figure 6-13 Reversed big character. 

Note: not all printers can print white text on a black background. Print 
the CAPABILI.CHP chapter located in the TYPESET directory to see 
whether your printer is capable of producing this effect. 

1) Make the first letter (the one you want to make large) a separate 
paragraph (Le., the paragraph consists of just one letter). 

2) Create two new tags, one for the first paragraph which consists of 
just one letter, and one for the paragraph that follows it. Both should 
have the same attributes initially. 

3) Select the Paragraph mode, then select the first paragraph that 
contains just the first character. 

4) Select the Ruling Line Above option from the Paragraph menu. 

RULING LINES ABOUE III 
Width: Text ~ 
Color: Black ~ 

Pattern: Solid ~ 
Dashes: Off ~ 

Space Above Rule 1: 84. /' 

He ight of Rule 1: 28. CustOIil Indent: 00,00 GJG 
Space Below Rule 1; 00.00 (ustOfll Width; 00,00 

He ight of Rule 2: 88.88 
Space Be low Rule 2: 88.88 Dash Width: 00,00 

Height of Rule 3: 88.G8 Dash Spacing: 00,00 fractional pts 

Space Below Rule 3: 24.L 0. 
Overall Height: 88.88 

T able Rule List: Hidden ~ 

Figure 6-14 Ruling Line Above dialog boxfor the first paragraph. 
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5) Select Text for the Width setting. 

6) Enter a Height for Rule 1 that is about 20% less than the point size 
you plan to use for the big first character. For example, create a 20 
point rule for 24 point type. 

7) Enter the difference, on the Space Above Rule 1 line, between the 
point size you plan to use and the rule height. In our example, you 
would enter 4 points (24 - 20). This amount controls the space 
between the character and the top of the rule and can be changed 
later. 

8) Enter a Space Below Rule 3 equal to the point size you plan to use 
for the big character. 

9) Select the - (minus sign) for the Space Below Rule 3. Select OK. 

Figure 6-14 shows the Ruling Line Above dialog box for the first 
paragraph in the example shown in Figure 6-13. 

1) With the first paragraph (the single letter) still selected, select the 
Special Effects option in the Paragraph menu. 

2) Select Space for Big First: Custom. 

3) Set the Space For Big First to the number of lines you wish to create 
for the big first character. 

4) Select Set Font Properties and select the character size and typeface 
for the big character. 

5) Select White for color. 

6) Select OK and then select OK again. 

7) Select the Breaks option from the Paragraph menu, then select 
Line Break: Before. 

You have now finished creating the tag attributes for the first para
graph. To design tag attributes for the second paragraph: 

1) Select the tag for the text that will follow the reversed letter. 

2) Select the Alignment option (Paragraph menu). 

3) Select Relative Indent On. Then enter an indent value of 2 to 3 
fractional points. 

4) Enter a number to indicate how many lines should be indented to 
allow for the reversed box. The number of lines should equal the 
number of lines selected for Space For Big First Character. 
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IBigChar2" ALIGNMENT rn 
Horz. Alignlllent: Justified ~ 
Uert. Alignlllent: Top ~ 

T ext Rotation: None ~ 
H!lphenation: USENGLSH ~ 

Successi ve H!lphens: 2 ~ 
Overall Width: Colullln·Wide ~ 

First Line: Indent ~ 
Relative Indent: On ~ 

I n/Outdent Width: B2. Bg fractional pts 
In/Outdent Height: BB1 lines 

In Frolll Right to Decilllal: BB.BB 

[][] I Cancel I 

Figure 6-15 Alignment dialog box for the second paragraph. 

5) Select OK. The Alignment dialog box settings for this example are 
shown in Figure 6-15. 

6) With the paragraph text still highlighted, select the Breaks option 
in the Paragraph menu. 

7) Select After for the Line Break setting. 

Footnote superscripts 

Footnote 
number 

REFERENCE GUIDE 

By creating the proper settings for the Z _ FN OT # and Z _ FN OT 
ENTRY tags, you can make the footnote number at the bottom of the 
page superscripted, without adding any additional space between 
lines. These are the tag names automatically assigned to the footnote 
number and footnote entry respectively. 

To modify the footnote number: 

1) Select the paragraph mode. 

2) Select any footnote number at the bottom of the page. 

3) Change its paragraph settings as follows: 

Font 
Horizontal Alignment 
Vertical Alignment . 

Two points less than footnote 
Left 
Top 
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Heading Note how this first line is placed on the same line as the first 
I· 

In From Right space for first paragraph. II 

for a line of the heading which precedes it. Also note how the text 

l
~aragraPh ·1 for this paragraph is moved in from the left margin. This is not 
-------- done by setting multiple columns in the Frame menu. Instead, 

In From Left create a blank left margin by setting the In From Left space for 
space for second this paragraph. 

paragraph. 

Footnote text 
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Figure 6-16 Outdented heading. Set Line Break: Before for heading, Line 
Break: After for paragraph whichfollows. 

Spacing Above 
Spacing Below 
Spacing Inter-Line 
Spacing Inter-Paragraph 
Breaks .... 
Ruling Line Above . . 

0.00 points 
0.00 points 
4.00 points 
0.00 points 
No line, column, page breaks 
Space Below Rule 3 equal 
to Inter-Line spacing. Select-

Next, select any footnote at the bottom of the page. Set its Paragraph 
attributes as follows: 

Spacing Above 
Spacing Below 
Spacing Inter-Line 
Spacing Inter-Paragraph 
Breaks ..... . 

0.00 points 
0.00 points 
Normal Inter-Line spacing 
0.00 points 
Before and After 

The superscript height is controlled by the Inter-Line space of the 
footnote number. Use the Ruling Line Above option to subtract verti
cal space so that the footnote number does not add additional space 
between lines. No ruling line is actually created. 

You can vary the height of the superscript by increasing or decreasing 
the Inter-Line spacing of the footnote number. If you do change its 
height, make sure to change the Space Below Rule 3 setting for the 
footnote number (Ruling Line Above) so that it matches the new 
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Inter-Line spacing. Also, you must select the minus button for Space 
Below Rule 3. 

Finally, if you want to add space between each footnote, increase the 
Space Above setting for the footnote number. 

Headings (outdented) 

One of the most common typographic effects is a heading or sub-head 
which is outdented into the left margin. The heading at the top of this 
page is a good example. Note how the text in the paragraph following 
the headings continues at the same vertical position as the first line in 
the heading. 

You must set all the tags in a style sheet correctly to make this effect 
work properly. Every tag, except the headings, should be set as fol
lows: 

Line Break .... 
Spacing In From Left 

· After 
· equal to the left gutter space 
(this manual uses 7 picas) 

The headings should be set as follows: 

Line Break ..... 
Spacing In From Right 

· Before 
· Column width minus left gutter 
(this manual uses 24 picas) 

I ndents/Outdents 
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The following sub-sections describe common types of indents and 
outdents, along with the typical Paragraph settings needed to achieve 
these effects. The indents and outdents described include: 

• Lead-ins 

• Hanging indents 

• Simple indents 
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A lead-in is the first text in a paragraph. This text is often printed in a 
font that is different from that of the remaining text. 

This is a lead-in paragraph. This is a separate paragraph 
from the lead-in. This paragraph has Relative Indent: On, 
Indent 5 points (both are in the Alignment option), and Line 
Break: After (Breaks option). The lead-in has Line Break 
Before, Keep With Next: Yes, and Allow Within: No. 

Figure 6-17 Lead-in example. Note that the lead-in is a separate para
graph. 

The simplest way to create an occasional bold or italic lead-in is to 
select the lead-in text (use the Text mode) and assign one of the 
attributes from the Assignment List or the Set Font option. However, 
if you use lead-ins frequently, you will find it easier to design a 
paragraph tag which creates the lead-in automatically. If you use this 
method, the lead-in text is actually a separate paragraph from the text 
which follows, even though both appear to constitute part of the same 
paragraph. The following steps show you how to design a lead-in. 

1) Select the Paragraph mode. 

2) Select the lead-in paragraph. (If necessary, select the Text mode and 
make the lead-in a separate paragraph by placing the text cursor 
immediately after the lead-in and then pressing the Enter key.) 

3) Select the Add New Tag button and create a new tag name for the 
lead-in. 

4) Select the Paragraph menu and change the lead-in attributes to: 

- Font: Bold Italic (or other attribute which will highlight the 
lead-in). 

- Line Break: Before (Breaks option). 

- Keep With Next: Yes (Breaks option). 

5) Select the paragraph which follows the lead-in. 

6) Select the Add New Tag button and create a new tag name for the 
paragraph which follows the lead-in. 
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7) Change this second paragraph's attributes to: 

Alignment 
Breaks 

.Relative Indent: On 

. Line Break After 

.Beside Last Line ofPrev. 

~ This effect will work correctly with justified text only if the lead-in is 
less than the width of one line. 

Hanging indent The hanging indent shown in Figure 6-18 is identical to an outdented 
heading. Follow the procedures given in the previous section. 

Simple indents 
and outdents 

Page 3 

To create this effect easily, assign both the outdented head, as well as 
the paragraph which follows, to function keys. Then, while typing in 
the Text mode, simply press the function key to make the text move 
into or away from the margin. 

Create simple indents and outdents of the type shown in Figure 6-18 
by using the In/Outdent Width feature in the Alignment option of the 
Paragraph menu. Simply set the Width and the Height (i.e., the number 
of lines to be indented). To set an outdent rather than an indent, change 
First Line from Indent to Outdent. 

This is another example of a hanging indent. The words Page 
3 are actually a separate paragraph. See the previous section 
(Headings (Outdented) for a description of how to create this 
effect. This outdent has Horizontal Alignment set Right. 

This is an example of a hanging indent. In the 
Alignment option select First Line: Indent, and In/Outdent 
Width: 4 picas (or whatever the first line indent should be). 

This is an example of a hanging outdent. Select First Line: Outdent, and 
In/Outdent Width: 4 picas (or whatever the first line outdent 
should be). 

Figure 6-18 Hanging outdents and indents. 
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Reverse Type 

The text in this frame is automatically reversed by changing 
Frame Background to black. 

Figure 6-19 Reverse type. Your printer must be able to print white text 
(LaserJet printers cannot). 

Reverse type means that white letters are printed on a black back
ground. Check Appendix F to see whether your printer supports this 
style of printing. To reverse all text on the page or frame: 

1) Select Frame mode and then select the page or frame. 

2) Select Frame Background. 

3) Select Background: Black. 

You can also create a single line of white text inside a black ruling line, 
by creating a paragraph tag which has a ruling line shifted down over 
the paragraph. Follow these steps: 

1) Select the Paragraph mode. 

2) Select the one-line paragraph that will print in reverse type. 

3) Select the Font option from the Paragraph menu. 

4) Select Color: White. Note that after you select OK, you cannot read 
the text, because the letters and background are both white. Follow 
these next steps to correct this apparent problem. 

5) With the paragraph still selected, choose Ruling Line Above option 
in the Paragraph menu. 

6) Select Width: Frame. Select Pattern: Solid. 

7) Enter a Height for Rule 1 that is larger than the point size of the tag. 
For example, create a 36 point rule for 24 point type, or a 24 point 
rule for 18 point type. 

8) The ruling line must be shifted down to cover the line of text below. 
Calculate the distance to shift the ruling line as follows: 

- Add the ruling line height and the type point size. 

- Divide the total by 2. 
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Shaded type 

- Enter the result on the Space Below Rule 3 line. 

9) Select the - (minus sign) for Space Below Rule 3 feature. Choosing 
minus subtracts space, so that the ruling line moves downward, on 
top of the text. 

Example: 

For the text shown in Figure 6-20, the text is 24 points and the ruling 
line is 36 points. The amount of shift entered on the Space Below Rule 
3 line is: 

24+ 36 = 30 
2 

Thus, in this example you would enter 30 fractional points for Space 
Below Rule 3 and would then select - (minus sign) to move the rule 
downward by 30 points. 

Experiment with different Space Below Rule 3 amounts to place the 
text at different vertical positions within the rule. 

You can also place text within backgrounds which are not completely 
black. Simply use one of the other Patterns for the frame background 
or ruling line. Change the text color from white to black, if the pattern 
is an extremely light one. 

Text reversed within a rule 
The text in the previous paragraph is contained within a ruling 
line. The most important setting for this paragraph is the 
Space Below Rule 3 for the Ruling Line Above. This space 
must be negative to move the ruling line down over the text. 

Figure 6-20 Reverse text within a ruling line. 
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Tables 

The Professional Extension to Xerox Ventura Publisher (available as 
a separate option--consult Xerox or your local dealer) includes capa
bilities for creating sophisticated tables. This includes the ability to 
import text from spreadsheet print files and database delimited files 
and place them direct! y into tabular format. 

Simple tables You can, however, design many types of simple tables with the stan
dard version of Xerox Ventura Publisher. Design the simplest types of 
tables by placing tabs between each item in the table. Use the Tab 
Settings option in the Paragraph menu to set the horizontal position 
for each item following a tab. Tables such as the one shown in Figure 
6-21 can be easily formatted in this way. 

The table in Figure 6-21 has been created with one tag. The first tab 
stop for this tag is set to 1 pica to provide the indent for the words 
Cash, Marketable Securities, etc. The next tab stop has Tab Shown 
As: Leaders rather than Tab Stop Shown As: Open Space. To make 

dots appear, Leader Char: ••• has been selected. The leaders between 
the words Assets and 1987 in the heading are covered with a rectangle 
drawn in the Graphic mode. The rectangle has no line attributes and 
has a solid white fill pattern. 

Assets 1987 1988 Change 
Short Term Assets 

Cash ..... $300,00 $1,534,768 $1,234,768 
Marketable Securities .. 25,00 27,000 2,000 

Total Short Term Assets . $325,000 $1,561,768 $1,236,768 

Long Term Assets 
Property, plant, equip. · $5,353,233 $5,833,987 $480,754 
Development costs · 2,386,682 75,231 ($2,011,454) 

Total Long Term Assets · $7,739,918 $6,209,218 ($1,530,700) 

Total Assets .... · $8,064,918 . $7,770,986 ($293,932) 

Figure 6-21 Simple table using tabs. 
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Vertically 
tabbed tables 

For the last three tab stops, Tab Type has been specified as Decimal. 
Since no decimal point (.) has been typed, the text for these tabs 
appears to be right aligned. Note, however, the use of decimal tabs 
causes parentheses around negative numbers in the Change column to 
extend automatically into the margin. 

The ruling line for the heading has been drawn using the Graphic 
mode. The Ait key has been pressed during the drawing process to 
ensure that the line is drawn in precise horizontal alignment. 

The ruling lines under the words Short Term Assets and Long Term 
Assets are actually underlines that have been created by highlighting 
selected text in Text mode and assigning the Underline attribute from 
the Assignment List. To make the line appear thicker, the Attribute 
Overrides option in the Paragraph menu was selected and the Under
line 1 Height increased. Use of this technique with tables allows you 
to create a single or double ruling line of any thickness for each tag 
while you work in Text mode. 

Text often requires several lines within the cell of a table. For instance, 
in Figure 6-23, the text Prepares instructional material for 
customers takes two lines within the table. Although you can create 
this effect by using the simple tab approach described in the last 

Position 
Depart. 
Duties 
Grade 
Technical writer 
Doc/Ed 
Prepares instructional material for customers 
10 
President and chief cook and bottle washer 
Admin 
None 
99 

Figure 6-22 Table prior to tagging with the four paragraph tags used to create the vertical tab 
effect. Note that the text for each cell in the final table is typed as a separate paragraph. 
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Column1: 
In From Left: 
0,00 
I n From Right: 
23,06 
Line Break: 
Before 
Keep With 
Next: Yes 
Allow Within: 
No. 

sub-section. editing such a table can be very tedious; addition or 
subtraction of characters can cause text to go out of alignment. 

A better, more sophisticated approach to building tables that contain 
several lines within each cell, uses several paragraph tags, one for each 
column in the table. The horizontal position for the column is set using 
the Spacing option's In From Left and In From Right Settings. Line 
Break is set to NO for each middle column, to Before for the first 
column and to After for the last column. These Breaks option settings 
enable the text in each paragraph to start at the same vertical position 
as the beginning of the previous paragraph. 

The Breaks option settings also keep the columns in the table together. 
Keep With Next is turned On and Allow Within is set to No for each 
column except the last one. When a paragraph tag finally causes a line 
break, the next paragraph after the line break will begin below the 
longest column since the last line break. 

Note, for instance, how the paragraph Prepares instructional mate
rial for customers controls where the words President and chief 
cook and bottle washer start. If this table had another row, the start 
of the next row would be determined by the length of the cell contain-

Column 2: 
In From 
Left: 7,00 
In From 
Right: 
17,06 
Line Break: 
No 
Keep With 
Next: Yes 
Allow 
Within: No. 

Column 3: 
In From Left: 13,00 
In From Right: 7,00 
Line Break: No 
Keep With Next: Yes 
Allow Within: No. 

Column 4: 
In From Left: 
24,00 
In From 
Right: 0,00 
Line Break: 
After 
Keep With 
Next: No 
Allow Within: 
No 

Figure 6-23 Tag settings for each column in Figure 6-23. 
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Position 

Technical 
writer 

President and 
chief cook 
and bottle 
washer 

Depart. 

Doc/Ed 

Admin 

Duties 

Prepares instructional 
material for customers 

None 

Grade 

10 

99 

Figure 6-24 Same table as Figure 6-22 after the text for each column has been tagged .. The last 
"column" is centered within the margins set by the Spacing option. 

Tables created 
with box text 

Import text from 
spreadsheets 
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ing the phrase President and chief cook and bottle washer, which is 
the longest in its row. 

The effect which results from this approach is called a vertical tab. 
The &TBL2-Ll style sheet in Appendix L provides a good example 
of a vertical tab. 

See Figure 6-23 for examples of Spacing and Breaks settings for 
tables with vertical tabs. 

For more complex tables, type the text directly into text boxes created 
using the Graphics Drawing option, then use the Line Attributes 
option to draw lines around these boxes. Follow the procedures de
scribed earlier in the Forms section of this chapter. 

You can bring text into Xerox Ventura Publisher from any spreadsheet, 
including Lotus 1-2-3 and Microsoft Excel. The range in the 
spreadsheet must first be printed to a file. This ensures that any 
formatting you see on the screen will actually be transferred to Ventura 
Publisher. 

For instance, to print to a file from Lotus 1-2-3, enter the following: 

/PFfilenameRrangeAGQ 

6-37 



PUTTING IT TOGETHER Creating typographic effects-Tables 

6-38 

Where filename is replaced with the name of the print file you wish to 
create and range is the name of the range you wish to print. 

Text in a spreadsheet print file does not contain tab characters. Instead, 
spaces are inserted between columns. When you tag this text with 
proportionally spaced fonts, columns will no longer line up because 
the total width of the characters in each row is different. 

If you want the text to align after you import it into Xerox Ventura 
Publisher, you must do one of three things: 

• Tag the spreadsheet text with the Courier font. This is not propor
tionally spaced and therefore the columns will align. 

• Manually edit the text using the Text mode or an external word 
processor to replace the space between columns with tabs. You can 
then format the text with the Simple Tables approach. 

• Make each cell a separate paragraph. You can then format these 
paragraphs using the vertical tab approach. 
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Performance improvement tips 

For advanced users, the following changes can dramatically improve 
Xerox Ventura Publisher's performance. 

Downloading fonts 

Memory 

Manage 
conventional 
memory usage 

REFERENCE GUIDE 

If you own a LaserJet Plus, LaserJet Series II, or compatible printer, 
Xerox Ventura Publisher automatically copies fonts from the computer 
to the printer as needed during the To Print operation (File menu). 
This feature makes Xerox Ventura Publisher simple to use, but it can 
result in long print times if each page in your document uses different 
fonts than the previous page. In addition, the first page will always take 
longer to print because all the fonts for that page must first be copied 
to the printer at the start of every print job. If your printer contains at 
least one megabyte of memory, you can improve performance dramat
ically by copying fonts to the printer before running Xerox Ventura 
Publisher. The HPDOWN utility will automatically copy fonts to the 
printer. For complete instructions on downloading fonts using this 
utility, see Appendix K under the heading Downloading Fonts in the 
section on the HP LaserJet printer. 

Remove as many device drivers and co-resident programs (such as 
Sidekick) as possible. Xerox Ventura Publisher is a large program that 
requires as much memory as possible. After you load Ventura Pub
lisher, approximately 100-150K bytes of conventional memory re
main. If you use 60-100K bytes of this for other programs or device 
drivers, very little space remains for your document. This in turn 
dramatically reduces performance by forcing Xerox Ventura Publisher 
to store part of the document on the computer hard disk rather than 
placing it entirely in RAM. You will begin to notice delays as you go 
from one page to the next if no conventional memory is still available. 
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Disk Cache 

EMS memory 

6-40 

If your computer contains more than 640K bytes of memory, you can 
utilize this extra memory to improve performance by using it to create 
a disk cache or RAM disk. If you have a choice, create a disk cache. 

If your computer contains EMS or extended memory, you can use a 
di~k cache program to improve performance greatly. The disk cache 
must be installed into EMS or extended memory, not conventional 
(640K byte) memory. 

The performance improvement is particularly noticeable in the follow
ing situations: 

• Documents such as the SCOOP.CHP chapter in the TYPESET 
directory which use many fonts on a page. 

• Long documents which do not completely fit in RAM memory 
(typically those which contain over lOOK bytes of text). 

• Network workstations and other systems in which background 
utilities reduce the amount of conventional RAM memory left for 
Xerox Ventura Publisher documents. 

• Systems which have been enhanced by the addition of many new 
screen fonts. 

Consult your dealer or RAM card manufacturer for recommendations 
on disk caches which will work with your system. 

When using a disk cache, you can often eliminate the BUFFERS = 
statement in the CONFIG.SYS file. Taking this step makes more 
conventional memory available, thus further improving performance. 

EMS memory can be utilized through a disk cache, as explained in the 
previous section. The Professional Extension to Xerox Ventura Pub
lisher can address EMS memory directly, resulting in dramatic perfor
mance improvements, especially for long documents. 

However, you can improve performance with EMS memory even 
without the Professional Extension, by making sure at least 128K 
bytes of EMS memory is available (i.e., not used by a disk cache or 
other program) before you run Xerox Ventura Publisher. Although 
only the Professional Extension uses EMS memory for storing the 
document itself, Xerox Ventura Publisher is able to place up to l08K 
bytes of system software in EMS memory. This makes additional 
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RAM disk 

conventional memory available for the document, thus improving 
performance. 

If your computer contains more than 640K bytes or memory, but you 
cannot use this memory for a disk cache, you can still improve 
performance by creating a RAM disk as follows: 

1) Use the DOS VDISK command or other utility to create a RAM 
disk. This RAM disk must not reside in conventional memory (i.e., 
the 640K memory). It must reside in either expanded (EMS) or 
extended memory. 

2) Use the ASCII function of your word processor to edit the VP.BAT 
file and add the command 

/O=n: 

to the end of the last line in this file, where n is replaced by the drive 
letter of your RAM disk. 

As explained in Appendix A, the /0 command directs all overflow 
files, created while Xerox Ventura Publisher is running, to another disk 
drive. 

If you have created a disk cache, you do not need a separate RAM disk. 

File management 
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If you create documents which contain many text and picture files, you 
can accumulate a large number of files quickly. If more than 128 files 
are placed in a subdirectory, you may begin to notice delays in 
accessing the files contained in this directory. For this reason, as well 
as to make files easier to find, you should place the files contained in 
a Xerox Ventura Publisher chapter in different subdirectories. The 
Multi-Chapter Copy option allows you to place the following file 
types in different directories: 

• Publications and chapters 

• Style sheet and width tables 

• Text files 
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• Graphic (line art) files 

• Image files 

Change Screen Fonts 

If you installed a full page display (e.g., Wyse 700, MDS Genius), 
Xerox Ventura Publisher automatically installed high resolution 
(VGA) screen fonts. These fonts look much better on your display, but 
because they contain more dots per inch, they take 40-60% longer to 
draw. If you want your screen to draw faster, you can switch to EGA 
resolution fonts. To do this follow these directions. 

1) Change to the root directory of your hard disk (CD \). 

2) Rename the VP.BATfile to VP.OLD 

RENAME VP.BAT VP.OLD 

3) Run the VPPREP installation program. 

4) When VPPREP asks" Are you installing for the first time?" answer, 
N. This is very important. If you answer Y, you will re-install 
everything. 

5) For screen display, select anyone of the IBM EGA options. It 
doesn't matter which one you choose. 

6) Choose the same mouse and same printer you have already in
stalled. (If you installed more than one printer, you only need to 
specify one of them-anyone of them will do.) 

7) Follow the directions provided by VPPREP. When VPPREP is 
finished, copy VP.OLD to VP.BAT: 

COPY VP.OLD VP.BAT 

8) Run Xerox Ventura Publisher. 

9) Select the Set Printer Info option in the Options menu. On the 
Screen Fonts line, replace the letters VGA with EGA. 

You can now switch between EGA and VGA fonts as needed simply 
by typing the appropriate three letter name on the Screen Fonts line in 
the Set Printer Info option. Use the VGA fonts when you want a high 

REFERENCE GUIDE 



Performance improvement tips-Menu option settings for speed PUTTING IT TOGETHER 

Remove screen 
fonts 

quality display. Use the EGA fonts when you want the screen to 
re-draw faster. The magnification of the screen will change slightly as 
you switch from one font resolution to another. This is normal. 

Xerox Ventura Publisher allows you to add up to 700 screen fonts at 
one time. However, all screen fonts are loaded each time you run the 
program, which can significantly increase the time you must wait for 
the program to start when you type VP. You may also notice a slight 
hesitation as the page redraws when you press the ESC key. It is good 
practice, therefore, to remove any fonts you do not regularly use. 

As an alternative, group fonts together that you use for a given job and 
give all these fonts the same file extension. When you need these fonts, 
type this extension on the Screen Fonts line in the Set Printer Info 
option. Only the fonts specified on this line are actually loaded, and 
therefore screen redraw and program loading time are both signifi
cantly improved. 

Menu option settings for speed 

Kerning Show kerning on the screen reduces drawing and editing speed. Since 
the computer screen has insufficient resolution to show kerning for 
small sizes, select 18 for On-Screen Kerning in the Set Preferences 
menu. 

In addition, if your work does not require that Body Text be kerned 
automatically, tum Automatic Pair Kerning for Body Text OfT in the 
Paragraph Typography option (Paragraph menu). 

Mouse speed Set Double Click Speed to Fast in the Set Preferences option if you 
don't normally use the "double-click" shortcut to select files in the 
Item Selector. The slower this setting, the longer Xerox Ventura 
Publisher must wait after your press the mouse button before it recog-
nizes the selection. . 

Hide pictures Use the Hide/Show All Pictures option in the Options menu to hide 
pictures when you do not need to look at them. This decreases the time 
you must wait for the screen to re-draw when you go to a new page or 
tag a paragraph. 
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Column balance Column Balance (Chapter Typography option, Chapter menu) should 
be temporarily turned Ofr if you plan to edit a document extensively. 
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Math Coprocessor 

A math coprocessor will make no difference whatsoever in the perfor
mance of Xerox Ventura Publisher. 

Print buffer 

The letterspacing, kerning, tracking, and other Xerox Ventura Pub
lisher features provide total control over the horizontal and vertical 
position of each character. This positioning information when com
bined with font files and graphics results in the transfer of large blocks 
of information between the computer and printer, even if you pre
downloaded the fonts as described under Downloading Fonts. One 
solution is to print the document to a file and then, at a later time, copy 
this file to the printer as described in the Set Printer Info section. The 
total time required to print to a file and then copy this file to the printer 
is about the same as printing directly to the printer. However, the time 
to print to a file is only 20-50% of this total time, thus letting you 
resume your working session must faster. You can set up a small batch 
file that will copy all the print files and then delete them during lunch 
or overnight. 

Print buffer programs can provide almost this same time savings 
without needing to manually copy the print file at a later time. These 
programs cause the printing to be temporarily stored in disk or RAM 
memory and then printed in the background while you continue to 
work with Xerox Ventura Publisher. The one drawback is that these 
programs are always loaded in the background and therefore reduce 
the space for your document which may result in somewhat slower 
response when moving from page to page in longer documents. 
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Performance degradation 
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If performance degrades at any time, check to ensure that the 
CONFIG.SYS and AUTOEXEC.BAT files have not been changed by 
some other program which you installed after Xerox Ventura 
Publisher. 
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Shortcuts 
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Create identical frames 

If the same size frame with identical margins, sizing & scaling, 
captions, ruling lines, captions, background, and image settings is to 
be used over and over, make one master frame of the proper size and 
add the desired margins, ruling lines and backgrounds. Then copy this 
frame to the clipboard, go to each page where you want the frame to 
appear, and paste a copy of the frame on the new page. 

If the frame contains a caption with a figure or table counter, the 
correct number is automatically created when you paste a copy of the 
frame. If the page already contains other frames, the table or figure 
number of the frame you paste will be the highest number on the page. 

~ Pasting a frame onto the page from which it was copied results in two 
identical frames being placed on top of one another. Merely move one 
of the frames to another location. 

Select frame underneath 

When you place one frame entirely under one or more frames, you 
cannot select the frame on the bottom in the normal way. To correct 
this problem, press and hold the Ctrl key while you select. In this way, 
you can select each frame in succession, starting with the currently 
selected frame. 

Precise frame size and placement 

You can be place, size, and crop frames precisely using the Sizing & 
Scaling options in the Frame menu. On the other hand, the mouse 
provides a much faster way to accomplish these functions. 
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A good way to take advantage of both features is to select Show 
Rulers (Options menu) and then use the mouse to create and place the 
frame as closely as your eye and the resolution of the screen allows. 
Then select the frame and use the Sizing & Scaling option to make 
minor, but exact, adjustments to the frame's placement and size. 

Multiple frame/graphic selection 

You can select several frames (or graphics) at the same time, then 
move, cut, copy, paste, or re-size them as a group. To select several 
frames, make sure the Frame mode is enabled. Press and hold either 
Shift key on the keyboard as you select each frame. Finally, release the 
Shift key, then move, cut, copy or paste the group of frames. 

To de-select one of a group of selected frames, hold down either shift 
key and select that frame. 

Selecting any frame without pressing the Shift key de-selects all other 
frames. 

Display without selection borders 

When you are using any mode other than Paragraph, a light textured 
border is displayed around each picture. This border illustrates the 
placement of the frame and will not be printed. Select the Paragraph 
mode to display the frames without these selection borders. To add 
borders that will print, use the Ruling Lines options in the Frame 
menu, as described in the Menu Commands chapter. 

Copy-fitting 
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Copy-fitting is the process of making the copy (text) fit a given space. 
Xerox Ventura Publisher provides several copy-fitting tools that you 
can use individually or together to solve copy-fitting problems. These 
tools and their application are described below: 
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1) Text Editing. The traditional way, and still the best, to get copy to 
fit a given space is to add and delete text. Xerox Ventura Publisher's 
Text mode gives you a word processor that not only allows you to add 
and delete text, but also allows you to see instantaneously how the 
page will look when it is printed. 

2) Frame Size. If a frame has been placed on the page, its size can be 
increased or decreased. As its size is changed, more or less text is 
placed in the page and text is "pushed" or "pulled" from the next 
column or page as needed. If Line Snap is turned on, you can easily 
control the number of lines of text in the page that are pushed or pulled 
to and from the next column or page. 

A variation on this technique is to add an empty frame, with both 
Column Snap and Line Snap turned on. Make the frame exactly one 
or two lines high and equal to the width of either the column or the 
page, as necessary. This method is equivalent to the old practice of 
adding a one line block of lead, when type was set in lead. 

~ When using this technique, remember that the Widow and Orphan 
control and Keep With Next settings (in the Breaks option of the 
Paragraph menu) may cause several lines of text and any associated 
heading to move to the next column or page. If this happens, use one 
of the other copy-fitting techniques instead. 

3) Change tracking. You can change the space between every letter 
within a selected text block, thus increasing or decreasing the space it 
occupies. This method is not approved by most designers, but it works 
and is easy to use. 

1) Select the Text mode and then select all the text which you wish to 
fit in a column. 

2) Hold either Shift key. 

3) Press the right or left arrow. This adds or subtracts a small amount 
of space between each letter. 

4) Continue pressing the appropriate arrow until the text fits the space. 

4) Vertical Justification. The Professional Extension to Xerox Ven
tura Publisher provides a vertical justification feature, which automat
ically assures that text reaches the bottom of a page or column. 
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How to enter typographic characters 

Xerox Ventura Publisher can create documents with real typographic 
attributes, including em (-) dashes and typographic quotes (" ".) 
Since your computer keyboard doesn't contain these characters, Xerox 
Ventura Publisher allows you to enter them using the Alt key, as 
described in the Text mode section of the Modes of Operation chapter. 

However, you can also enter these characters directly from your word 
processor by enclosing the decimal equivalent for the character (see 
Appendix E) inside of the appropriate brackets. For instance, you can 
insert an EN dash from a word processor by typing <196>. These 
codes can be entered easily if your word processor supports keyboard 
macros. 

The most common typographic characters are open and closed quota
tion marks (" ") and em dash (-). If you select Auto Adjust: "and
in the Set Preferences option, then Xerox Ventura Publisher automat
ically converts inch marks (i.e. ") into open and close quotation marks, 
and also converts two successive hyphens (i.e., --) into a single em 
dash. Note that this is a one way conversion. When the chapter is 
saved, these characters are saved using the decimal codes inside of < 
> brackets. 

Page break 
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With many word processors, you can create a new page at any point in 
the text. Xerox Ventura Publisher allows you to do this by selecting 
Page Break: After in the Breaks option of the Paragraph menu. 
However, you may want to create a page break during editing process. 
This is easy to do: 

1) Create a new tag. When you select Add New Tag, copy the attri
butes from Body Text. 

2) Set Page Break at After for this new tag. You can find this setting 
in the Breaks option of the Paragraph menu. 

3) Use the Assign Function Keys feature in the Update Tag List option 
(Paragraph menu) to assign this tag to a special function key. 
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To create a page break, press this function key while editing a Body 
Text paragraph. Text following the paragraph in which you are editing 
is then pushed to the next page or frame. 

Create identical graphics 

You can change the default line and fill attributes for each graphic 
object. This means that each time you draw a circle, rectangle, etc. the 
new object can be created with the line and fill attributes that you 
specify. 

1) Select any graphic drawn in the Graphic mode (including Box 
Text.) 

2) Select either the Fill Attributes or Line Attributes option from the 
Graphic menu. 

3) Set the values you want. 

4) Select Save To •.. 

5) Select OK 

All graphics of the same type (i.e., all rectangles) that you create after 
following this procedure will have these new default attributes. 

You can also apply the new default values to any graphic which has 
alread y been created. 

1) Select a graphic. 

2) Select the Line Attributes or Fill Attributes option in the Graphic 
menu. 

3) Select the Load From ... option. 

4) Select OK. 

The default values for that graphic type will be applied to the selected 
graphic. 
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APPENDIX A 
INSTALLATION SUPPLEMENT 

This appendix contains additional information about installing Xerox 
Ventura Publisher. 

Xerox Ventura Publisher is contained on either sixteen 51/4" or eight 
31/2" disks. Most of these disks contain printer drivers and fonts which 
let you customize the program for your particular combination of 
computer, graphics board, mouse, and printer. Typefaces designed for 
your particular display and printer are also included on these disks. 

Installation with other programs 

It is recommended that background utilities, such as Sidekick, not be 
installed when running Xerox Ventura Publisher. These utilities reduce 
the amount of memory available, resulting in slower operation. If 
background utilities are installed, it is not recommended that they be 
activated while you are running Xerox Ventura Publisher. 

Hard disk space required 
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You need the following amount of space on your hard disk to install 
Xerox Ventura Publisher: 

• 1.2M bytes for Xerox Ventura Publisher, display driver, one printer 
driver, screen fonts, and hyphenation dictionaries. 

plus 

• 300K bytes for example files, if installed. These can later be 
deleted, if desired. 

plus 
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• 2.2M bytes for printer fonts (this space is not needed for PostScript 
printers). 

Updating from version 1.0 

If you previously installed version 1.0 of Xerox Ventura Publisher, 
read this section. No special steps are necessary to upgrade from 
version 1.1. 

If you added any additional fonts to version 1.0, these new fonts and 
associated width tables must be copied to a new subdirectory called 
VENTURA. If you modified the HYPHUSER.DIC file, also copy this 
file to the VENTURA directory prior to installation of version 1.1. 

If you have not installed any other GEM programs, and have not 
copied any files to the following directories, delete all files in the 
GEMSYS, GEMBOOT, GEMDESK, and GEMAPPS directories 
as follows: (Respond with Y anytime the computer asks Are You 
Sure?) 

CD \GEMSYS Enter 

DEL *. * Enter 

CD \GEMBOOT Enter 

DEL *.* Enter 

CD \GEMDESK Enter 

DEL *.* Enter 

CD \GEMAPPS\VPSYS Enter 

DEL *.* Enter 

CD \GEMAPPS Enter 

DEL *.* Enter 

RD VPSYS Enter 

CD \ Enter 

RD GEMAPPS Enter 

RD GEMSYS Enter 

RD GEMBOOT Enter 

RD GEMDESK Enter 
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Installation notes 

Displays 

Mouse 

Printers 
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VGA Gray Level Display. If you own a VGA display which is 
capable of producing levels of gray, select the VGA display option 
during installation which provides gray level support. Choice of this 
option will let you see shades of gray in TIFF images and will improve 
screen re-draw performance. 

VGA 16 Color Displays. If you choose one ofthe multi-function cards 
shown at the end of the VPPREP display, you must use an analog 
monitor. Also, you must connect this monitor with a IS-pin to 9-pin 
cable. The IS-pin end connects to the board; the 9-pin end connects to 
the display. If you use the 800 x 600 mode available with some ofthese 
cards, you must use an analog multi-sync type monitor. 

EGA Color Display. If you have an EGA display which is capable of 
displaying 16 colors, you can choose the color EGA option, even if you 
don't have a color printer. While the menus still display in black and 
white, you can set the color of any paragraph, selected text, ruling 
lines, or background pattern and the result will display on the screen. 

If you are installing for a Microsoft Bus Mouse, an IBM PS/2 mouse, 
Xerox 6065 or AT&T 6300, type the letter C. If your bus mouse does 
not function, consult the mouse documentation for information on 
proper configuration of the jumpers on the mouse plug-in board. 

Other bus mice not listed, and serial mice that require a MOUSE.COM 
file (such as most models of the Logitech mouse) should also be 
installed as option C. Note: the Logitech serial mouse can be installed 
as option B, but better results are usually obtained by installing it as 
option C, and then installing the MOUSE.COM or MOUSE.SYS 
program (supplied with the mouse) prior to running Xerox Ventura 
Publisher. 

If you choose a Summagraphics tablet, the active tablet area may not 
extend to all four comers of the tablet. This is normal. 

Xerox 4045. The Xerox 4045 must have at least 450K RAM installed 
in order to use the 150 dpi driver, and at least 1.0 Megabyte RAM in 
order to use the 300 dpi driver. The status sheet which prints whenever 
you tum on the printer tells you the amount of RAM in your printer, 
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and shows the current configuration switch settings. Check these 
switch settings with those shown in Appendix F. If you have less than 
1.0 megabyte in your 4045, install the 150 dpi printer driver. If you 
have more than 1.0 megabyte, install the 300 dpi driver. 

Apple LaserWriter. Note that the Apple LaserWriter, LaserWriter 
Plus, LaserWriter NT, and other PostScript printers are installed by 
typing E. Consult Appendix F for important cabling and setup infor
mation for Postscript printers. The Apple LaserWriter can be con
nected directly to the PC, if the proper cable shown in the Appendix F 
is used. 

IBM 4216. The IBM 4216 is also a PostScript printer, but one which 
connects to your computer through a special board. When you install 
this printer, select LPTl: as the port to which the printer connects. 
When you run Xerox Ventura Publisher, select the Set Printer Info 
option in the Options menu, and then change from LPTl: to Direct. 

JLaser boards. The JLaser boards may require certain changes to the 
CONFIG.SYS file. Consult the JLaser reference manual, or call Tall 
Tree Systems for assistance. 

HP Laser Jet. The HP LaserJet (selection B) is different from the HP 
LaserJet Plus/LaserJet series II(selections C and D.) If you own an HP 
LaserJet, you need to purchase either the 92286F font cartridge or the 
LaserJet Plus upgrade kit from Hewlett-Packard. The 92286F font 
cartridge is the only HP font cartridge that works with Xerox Ventura 
Publisher. 

When installing the HP LaserJet Plus, install both the 150dpi and the 
300 dpi drivers. Install the 300 dpi driver first. You can then switch to 
the 150 dpi driver if the LaserJet displays an Error 20 message in its 
status display during printing to indicate that it has run out of memory. 

The HP LaserJet II and other LaserJet-compatible printers are installed 
as option D. 
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VP.BAT file 

CD C : \ VENTURA 
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The advanced user can edit the VP.BAT file to quickly modify certain 
installation parameters without running VPPREP. You can also modify 
how Xerox Ventura Publisher is loaded into memory. 

The following is a VP.BAT file which shows all the possible options: 

DRVRMRGR VP %1 /S=SD_WY705.EGA/M=01/X=D:/X=E:/O=C:!I=C:\MINE/E=256/A=32 

REFERENCE GUIDE 

/s= Specifies the screen driver used. The extension for the screen 
driver determines the screen fonts which will initially be loaded. This 
can be overridden using the Set Printer Info option in the Options 
menu. 

/M= Specifies the mouse port and the type of mouse. The first number 
specifies the port. O=COMl, 1=COM2, 2 or 3 = any connection other 
than COM ports. The second number specifies the mouse type. O=No 
mouse, l=Mouse Systems or PC Mouse, 2=any mouse that used 
MOUSE.COM or MOUSE.SYS, 3=Microsoft Serial mouse, := IBM 
PS/2 mouse. 

/x= Specifies additional drives to include in the Item Selector. These 
will appear when you use the Backup button to move to the top level 
of the Item Selector. You can specify more than one additional drive, 
as shown in the example. 

/0= Specifies a different drive for overflow files. This allows you to 
direct temporary files to a RAM drive for increased performance. The 
Professional Extension to Xerox Ventura Publisher uses EMS 
memory, eliminating the need for this option if you have EMS memory 
in your computer. 

/1= Specifies a different directory for the INF files, which are stored at 
the end of each session when you Quit from Xerox Ventura Publisher. 
The INF files store the following types of information between ses
sions: 
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• The measurement system (i.e, inches, centimeters, etc.) used in 
each dialog box. 

• View menu settings 

• Option menu settings 

• Mode (Frame, Text, etc.) settings 

• The most recent style sheet used. 

If more than one person uses the same computer, each can have his or 
her own BAT file. Each BAT file can specify a different directory for 
the INF files. 

/E= Specifies the total amount of EMS memory that the Professional 
Extension of Xerox Ventura Publisher will take for the document. You 
must set !E=O for Jlaser and certain other printers when running the 
Professional Extension. This switch is not used with the non-profes
sional version. 

/ A= Specifies amount of memory to take from the screen graphic 
buffer (which is used to display images) and screen font buffer, and 
add to the text area. This effectively increases the memory available 
for your document and therefore may improve performance. Any 
integer between I and 32 can be specified. The number represents 
K-bytes of memory. 

If you specify /A=O, 16K bytes of memory is taken from the screen 
font buffer, but none from the screen graphic buffer. This lets you 
increase performance without affecting the re-draw speed of image 
files. Xerox Ventura Publisher will not be able to load as many screen 
font files, however. Note that certain printers and some of the graphics 
converters contained in LOD files may not work if any number greater 
than ° is used. 
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HYPHENATION 

Xerox Ventura Publisher automatically hyphenates text whenever Hy
phenation (see the Alignment option) is turned on. The placement of 
hyphens within a word is determined by a combination of a computer 
algorithm and a small dictionary (contained in the file 
HYPHEXPT.DIC, located in the VENTURA directory.) This dictio
nary overrides the algorithm for words where the algorithm fails. Since 
the algorithm fails on only a few words, only a few words are actually 
looked up in the dictionary. The result is very fast hyphenation. 

However, while this combination of algorithm and exception dictio
nary seldom inserts incorrect hyphens, it may occasionally miss op
portunities to insert hyphens. Also, you may want to suppress 
hyphenation for certain words. Therefore, Xerox Ventura Publisher 
also provides a User Hyphenation Dictionary in the file called 
HYPHUSER.DIC, also located in the VENTURA directory. This 
dictionary overrides both the algorithm and the system exception 
dictionary. Because of this dictionary, you not only can add hyphens 
that might otherwise be missed, but you can also force Xerox Ventura 
Publisher to hyphenate at a different point than the system would 
otherwise choose. You can also suppress hyphenation for a given 
word. 

Add words to hyphenation dictionary 
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To add words to the dictionary, modify the file called 
HYPHUSER.DIC using your word processor. Read this file into your 
word processor as an ASCII text file. Add the words with the hyphens 
inserted, as shown on the following pages, and then save the file back 
to disk as an ASCII text file. Words can be inserted in lower case only. 
Insert words alphabetically. Several words are already included in 
HYPHUSER.DIC to get you started. 
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~ Failure to store this file as an ASCII file will result in incorrect 
hyphenation. 

Long words Only the first seven characters of each entry in the dictionary are read 
by the hyphenation algorithm. Thus, entering the following: 

Suppress 
hyphenation 

Hyphenation 
dictionary 
examples 

con-sid-er -able 

will not produce a hyphen between er and able because this part of the 
word occurs after the seventh character. If you want the algorithm to 
read more than seven characters, place an asterisk * before the eighth 
character and each character thereafter, e.g., 

con-sid-e*r-*able 

The asterisk means "read the next character." If you do not place an 
asterisk before the b, I and e at the end of the example word, the rest 
of the letters are not read. Consequently, other derivatives, such as 
consideration and considerate, will be hyphenated at the same points 
as considerable, even if you do not enter them separately in the 
dictionary. 

If you want to suppress hyphenation for a particular word-perhaps 
your company's name-you can enter that word into the 
HYPHUSER.DIC file without hyphens. 

The following are examples of entries into the hyphenation dictionary. 

in-de-fat-i-ga-ble 
moth-er-hood 
plu-ral-i-ty 
ventura 
xerox 

Foreign language hyphenation 

Xerox Ventura Publisher provides seven hyphenation algorithms; 

• American English (fast) 
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• American English (exhaustive) 

• French 

• German 

• Italian 

• Spanish 

• UK English 

Any two algorithms can be installed at anyone time and any two can 
be used within the same document. This allows you to create multi-lin
gual, justified and hyphenated documents. 

When you first install Xerox Ventura Publisher, both hyphenation 
choices are set to American English (fast.) To install different hyphen
ation algorithms, copy the appropriate hyphenation algorithm from the 
Utilities Disk to the VENTURA directory. Hyphenation algorithms 
are found in files with the extension HY2. Rename the extension from 
HY2 to HYI if you want the algorithm to be the first hyphenation 
choice in the Alignment option. If only one hyphenation algorithm 
exists on the VENTURA subdirectory, it is the only algorithm used. 

~ Only one file with the extension HYI and one file with the extension 
HY2 should exist in the VENTURA directory at anyone time. 

Only one exception dictionary is used for all languages. To enter words 
for languages which use characters not available on your computer 
keyboard, use the < > codes, as described in Appendix D. For instance, 
to enter the French word kaleidoscope, with appropriate hyphens, 
type the following into the HYPHUSER.DIC dictionary: 

ka-k130>i-do-scope 

Hyphenation accuracy 
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The standard algorithm used for American English is very fast and 
quite accurate, but it may miss some hyphenation opportunities. When 
you create documents with narrow columns, this may result in an 
excessive number of loose lines. For critical applications, a second 
algorithm for American English provides more complete, equally 
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accurate hyphenation, but takes somewhat longer to insert hyphens 
when text files are loaded and when text is added during text editing. 
This algorithm is contained in the file USENGLS2.HY2 in the Utility 
Disk. Install as described in the previous paragraph. 

For even more critical applications, the Professional Extension to 
Xerox Ventura Publisher contains a complete 130,000 word hyphena
tion dictionary, plus additional controls governing the rules of hyphen
ation. 
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PROBLEMS 

Common questions 

Fonts 
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Consult the Index under the heading "Problems" to find references to 
common problems, along with the recommended solutions to these 
problems. 

Can I buy additional fonts for my printer and use them with Xerox 
Ventura Publisher? 

Yes. Many companies produce both printer and matching screen 
fonts which are compatible with Xerox Ventura Publisher. Consult 
Add/Remove Fonts in the Options menu section of the Modes of 
Operation chapter for information on how to install these fonts. 
Also, see Appendix K for additional details. 

I loaded my font width table, but I can't seem to get my fonts to display 
or print. 

1. Fonts which you add for your printer won't display on the 
screen unless you also purchase and load matching screen fonts. If 
you don't add matching screen fonts, only Helvetica (or Swiss), 
Times Roman (or Dutch), Courier, and Symbol will display on the 
screen. Screen fonts must all be copied to the VENTURA directory 
and must all have the same file extension in order for them to load 
correctly into Xerox Ventura Publisher. This extension must then 
be specified in the Set Printer Info dialog box. 

2. You must use the Add/Remove Fonts option to merge a new 
width table into an existing width table. Otherwise, the wrong 
printer fonts may be selected. Do not use the Load New Width 
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Table function in the Set Printer Info option to load a new width 
table directly. 

I can't get downloaded fonts to work correctly. What have I done wrong? 

Xerox Ventura Publisher normally downloads the fonts for you 
automatically. You can download fonts yourself before running VP 
in order to decrease printing time. After you download the fonts, 
however, make sure you have done the following: 

1. The resident/download feature must be set to download for 
each font (i.e., each combination of size, face, and style) in the 
Add/Remove Fonts option. 

2. The fonts must be either in the VENTURA directory or in a 
directory specified in the HPLJPLUS.CNF file (LaserJet printers) 
or POSTSCPT.CNF file (PostScript printers). 

3. The fonts must be downloaded using a utility that comes with 
the printer, a batch file, or (for the LaserJet printers) the HPDOWN 
utility that comes with Xerox Ventura Publisher. The HPDOWN 
utility is described in Appendix K. 

Why do Swiss and Dutch look like Helvetica and Times? What's the 
difference? 

Helvetica and Times Roman are trademarked fonts. If these fonts 
are not available for a particular printer, Xerox Ventura Publisher 
substitutes the Swiss and Dutch typefaces, which are quite similar. 

What is the width table used for and why do I need it? 

Each printer creates individual letters and symbols differently, with 
a different shape, height, and width. Xerox Ventura Publisher must 
know, for each printer installed, the width of each character for 
each typeface and size. This width information is then used to 
adjust the position for each character on the screen so that the end 
of each line, paragraph, and page matches the printed output. This 
information is contained in a width table file. One width table file 
can contain width information for many different fonts. 
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I changed the font for one paragraph, but now all the paragraphs have 
been changed to the new font. Why? 

The Paragraph Menu controls the font of paragraph tags, not 
individual paragraphs. When you select a paragraph and change its 
font, you actually change the font of the tag which controls the 
format of that paragraph. Every other paragraph to which this tag 
is assigned will also change. 

My printer doesn't print. What should I check? 

I. Check that the cable is connected. 

2. Check that the cable is attached to the correct connectors on the 
computer. 

3. If you are using a serial cable, check the wiring diagrams in 
Appendix F. 

4. If you are using a serial cable and your computer contains more 
than one serial port, make sure these ports are not configured 
identically (e.g., both set to COMI :.) 

5. Check Appendix F for other important information specific to 
your printer. 

I can see my headers and footers on the screen but they don't print. Why 
not? 

Laser printers cannot print to the exact edge of the paper. Most 
leave between 0.25 and 0.50 inches blank space around the edge of 
the page. Xerox Ventura Fublisher has no way to tell what your 
printer is capable of printing. However, you can easily find out. 
Load the CAPABILI chapter located in the TYPESET directory 
and print it to your printer. The white space around the edge of the 
page indicates the area to which your printer can't print. Once you 
print CAPABILI, you should also note the other effects on the page 
which your printer can or cannot produce. 
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How can I send the printer output to a disk file instead of to the printer? 
How can this disk file then be printed? 

Copy files 

Read the Set Printer Info section in the Options menu portion of 
the Menu Commands chapter. 

How do I copy all the files associated with a chapter? The DOS COpy 
command does not work. 

The Xerox Ventura Publisher chapter (CHP) files contain refer
ences to every file contained in your document. The DOS COpy 
command will not change these references when you copy the 
chapter file and all the associated files to another location on your 
hard disk, or when you copy them to a floppy disk. As a result, 
when you open the copied chapter, it will attempt to retrieve files 
from their original location. When it can't find them, an error 
message appears on the screen. In addition, when using the DOS 
COpy command, you may forget to copy some of the files in your 
chapter. 

Fortunately, Xerox Ventura Publisher provides its own copy com
mand which copies all files associated with either a single chapter 
or with an entire publication. In addition, the chapter file is modi
fied to retrieve the files from their new locations after the copy 
process has been completed. See the Multi-Chapter option in the 
Options section of the Menu Commands chapter for details on how 
to use the Copy All feature. 

General operation 

I loaded a text (or picture) file, but it doesn't appear on the page. What's 
wrong? 

You must do the following to place text or picture files on the page 
or in a specific frame: 

1. Select the Frame mode. 
2. Select the frame or page where you want the text or graphic to 
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appear. 
3. Select the file name from the list of files in the Assignment List. 

If you select the frame mode and then select the frame or page prior 
to loading a file, that file will automatically be placed into the 
frame or page. 

I cannot get text to appear in a frame (or in footnotes, box text, captions, 
footers, or headers.) 

This generally occurs when the tag for a given paragraph type (e.g., 
Z_BOXTEXT) is first generated. Since this tag's attributes are 
copied from Body Text, the Above, Below, In From Left, or In 
From Right space applied to the text may exceed the space avail
able in the frame, footnote, box text, caption, header or footer. The 
solution is to: 

1. Select Show Tabs & Returns from the Options menu. 
2. Temporarily make the frame, box text, etc. larger until the end 
of paragraph or end of file mark is displayed. 
3. Select the end of file mark, then select the Spacing option in the 
Paragraph menu. Reduce the Above, Below, In From Left, or In 
From Right spacing as necessary. 

Why does the computer beep when the Item Selector appears? Also, 
why can't I find my file in the Item Selector? 

The Item Selector cannot display more than 100 files. When more 
than 100 files match the file filter shown on the Item Selector's 
Directory line, the computer beeps and only the 100 most recent 
files are displayed. To correct the problem, modify the file filter 
(i.e., file extension) on the Directory line to display fewer files. 

How can I access a disk drive other than C? 

Simply edit the disk drive name on the Directory line in the Item 
Selector. For example, if the directory line displays 
C:\TYPESET\*.CHP and you want to access the TYPESET 
directory on the D drive, change this line to read: 

D:\TYPESET\*.CHP. 

If you always want the drive letter to appear when you use the 
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Backup Button to access the top level of the Item Selector, you 
need to specify the drive letter in the VP.BAT file. Add /X=n: to 
the end of the last line of the VP.BAT file, where n is replaced by 
the letter of the disk drive you want to appear in the Item Selector. 
For example, to make the E and F drive appear in the Item Selector, 
edit the VP.BAT file to look like this: 

DRVRMRGR VP %1 /S=SD X6655.EGA/M=32/X=E:/X=F: 

My chapter has O's and 1's in it. What happened to my text? 

You used the Load Text/Picture option to load a chapter (CHP) 
file. You should have used the Open option. Remember, the Load 
Text/Picture option allows you to add files to an existing chapter 
whereas the Save and Open options save and retrieve all files that 
were previously loaded. 

I can't see both pages of the document at once. 

Select Sides: Double in the Page Size & Layout option of the 
Chapter menu. 

How do I change text attributes in the headers or footers? 

Use the codes shown in Appendix D within the Headers & 
Footers dialog box. The figure in the Headers & Footers option 
in the Menu Commands chapter provides an example of how to 
change point size. For example, to change to bold, use <B>. To 
change to italic, use <MI>. To change back to the paragraph's font, 
use <D>. 

I placed a tab in the text and now the rest of the line has moved beyond 
the edge of the column. What should I do? 

Tab stops move all text in a line to the right. Text does not 
automatically wrap to the next line. Use aline break (etrl + Enter) 
to end the line. 

I cannot see pictures I placed into a frame. Why? 

This usually occurs when large pictures are placed into relatively 
small frames. The picture is actually in the frame; however, the 
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portion displayed happens to be all white. The solution is to use the 
AU key and mouse to pan a black portion of the picture into the 
frame. Alternatively, choose Fit in Frame in the Sizing and Scal
ing menu. 

My color PC Paintbrush image only displays and prints in one color. 

Multiple colors are not retained when PC Paintbrush images are 
converted into Xerox Ventura Publisher. Only the black color is 
retained and printed. 

Why doesn't the text cursor appear in the middle of a blank page when 
I try to place it there? 

Xerox Ventura Publisher is designed to format text within a given 
frame, starting at the upper left comer. If you want text to appear 
in the middle of a blank page, draw a frame at this point, placing 
the upper left corner of the frame at the position where you wish to 
start typing. Then, either place the cursor inside this frame and 
begin typing, or attach a box text to this frame and place the text in 
it. 

When should I place text directly into a frame, and when should I use 
box text? 

Place text directly into a frame when: 

1. The text originates in your word processor. 
2. The text must continue into another frame (e.g., a newspaper 
article). 
3. The text must be formatted into more than one column. 

Use box text in all other situations. 

Which scanners does Xerox Ventura Publisher support? 

Xerox Ventura Publisher supports any scanner that converts its 
images into TIFF, GEM image, or Z-soft's PC Paintbrush (version 
2.5 or above) format. 
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Can I make text flow around irregularly shaped images like circles and 
triangles? 

Yes. See the Frame mode section in the Modes of Operation 
chapter. 

I can't get my PC Paint files to load. Why? 

PC Paint is a different product from PC Paintbrush, and is not 
compatible with Xerox Ventura Publisher. 

When I try to print a document, I get a message "device not receiving 
power." What is wrong? 

Check to see if: 

1. The printer is turned on. 
2. Cables are attached and secured. 
3. The cable you are using is the correct one for this printer. 
4. The DOS MODE command (if used) has mapped the COM port 
to the LPT port correctly. 

If you encounter this problem when you first use Xerox Ventura 
Publisher, an incorrect cable is the most likely cause of the prob
lem. Check the cable with a continuity tester or similar device in 
order to verify correct wiring. 

Does Xerox Ventura Publisher work on a network? 

Xerox Ventura Publisher is neither licensed for, nor will it operate 
when runfrom a centralfile server. Separate copies of the program, 
running on individual computers, can print over the network to a 
shared printer in some network configurations. However, the net
work software which runs on the local computer may occupy so 
much RAM in some networks that very little space remains for 
Xerox Ventura Publisher. This decreases performance. 

A network version of Xerox Ventura Publisher is available. Contact 
Xerox for pricing and other information. 
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The following is an alphabetical listing of some of the messages that 
can appear in Xerox Ventura Publisher, along with an explanation of 
what they mean and what to do when they oCcur. For the sake of 
brevity, many of the simple messages are not included here. 

A file by that name already exists. Do you wish to choose a new name 
or overwrite the existing file? 

This message allows you to know that you are about to destroy an 
existing file. You can either save the file under a new name, or 
overwrite the existing file. 

A second Z_TBL_BEG tag was found in the midst of a table definition. 
Check for a missing Z_TBL_END tag or remove the extra Z_TBL_BEG 
tag and try again. 

An unexpected tag named: Filename was found between the 
Z_TBL_BEG and the Z_TBL_END paragraphs. Check for missing 
Z_TBL_END. 

These error messages appear in the Professional Extension only. 
They indicate that a file brought into Xerox Ventura Publisher does 
not have the proper beginning and end statements for a table 
definition. You must use a word processor to modify the file. 

All 6 of your repeating frames are already in use. 

Xerox Ventura Publisher allows up to six repeating frames per 
chapter. To correct this problem, you must make one of the existing 
six repeating frames a normal frame. 

An ASCII error file named: Filename has been created with a list of the 
errors that occurred during cross-referencing. 

This error messages appears in the Professional Extension only. 
Read the file into Xerox Ventura Publisher to see the list of marker 
and frame names which could not be referenced. 
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Caution! This request will delete Filename matching files. Are you sure 
you want to delete these files? 

This message appears during DOS File Operations as a reminder 
that you are about to erase a file or files. Select Cancel if you don't 
want to continue with the delete operation, 

Couldn't find overlay file. 

This usually indicates that your system has too little memory to run 
Xerox Ventura Publisher. Use the DOS CHKDSK command to 
check on how much memory is left. If less than 520K bytes 
remains, Xerox Ventura Publisher probably will not run. Remove 
any background utilities. 

Do you wish to remove the text from the selected frame or cancel the 
request? 

When you type text directly into a frame (rather than using the 
Load Text/Picture option to load text into a frame), this text is 
stored in the chapter's caption file, along with all other captions, 
box text, and text typed into other frames. If you later try to assign 
a picture or text file to this frame, this message appears, warning 
you that the text in this frame will be permanently lost. If you don't 
want to lose this text, but you still want to place text into this frame, 
use the Text mode to cut the text from the frame, then go ahead and 
put the text or picture file into the frame. You can then paste the 
text on the clipboard to another location in the document. 

Do you want to save, save as, or abandon the changes you've made to 
this style sheet by removing/assigning tags? 

This message appears when you select OK in the Update Tag List 
option. If you Abandon, all changes made in the Update dialog box 
are lost. 

Do you wish to re-anchor just this page's frames, or all page's frames, 
or cancel the request? 

This message appears when you select Re-Anchor Frames (Chap
ter menu). If you select This Page, Xerox Ventura Publisher looks 
through all the text on this page for anchor entries, and then moves 
frames throughout the document to these anchor points. If you 
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select All Pages, this process is carried out across the whole 
document. 

Fatal Error! The VP.RSC file couldn't be found or would not fit in memory. 

Fatal Error! The GEM VOl screen driver couldn't be loaded. 

Fatal Error! There wasn't enough memory for the screen graphics buffer. 

These messages usually indicate that you don't have enough 
memory to run the program. Remove any background utilities. Use 
the DOS CHKDSK command to check on how much memory is 
left. If less than 520K bytes remain, Xerox Ventura Publisher 
probably will not run. 

Check the CONFIG.SYS file. If this file contains the statement 
DEVICE = GEMPRINT.SYS, try removing this statement, re-boot 
the computer, and then try running Xerox Ventura Publisher again. 

Another possibility is that the INF files (which store configuration 
information between sessions) may have been corrupted. If 
CHKDSK indicates sufficient memory (more than 520K), delete 
all files in the VENTURA directory with the extension INF and 
then try again to run Xerox Ventura Publisher. 

File name collision: filename. Do you wish to rename this file, ignore the 
collision & copy over, or cancel the archive process? 

During the Multi-Chapter Copy process, this message appears if 
two files with the same name, but located in different directories, 
are to be archived to the same place. If you rename the file, you 
will end up with two unique files on the target directory. If you 
ignore, then the last file copied will be the only one used. The safest 
thing to do is to rename the file. This way no information is lost. 

filename already exists on the target drive. Do you wish to overwrite the 
old version, keep the old file, or cancel the archive process? 

This message appears during the Multi-Chapter Copy process if a 
file with the same name, but a different date and time, is found on 
the target disk drive. Choose the option desired. If the file has the 
same name and the same date and time, Xerox Ventura Publisher 
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assumes that they are identical and does not bother to re-copy the 
file. 

Headers, Footers, and other Repeating Frames can't be cut or copied to 
the clipboard. 

You cannot cut, copy, or paste frames which are placed automat
ically by Xerox Ventura Publisher. This includes headers, footers, 
and footnotes. 

Index entries can't be inserted inside of a footnote entry. 

You cannot place an index entry into footnote text placed at the 
bottom of a page. 

Internal System Error! (Filename) 
1. Note what you just did. 
2. Use Save As ... to save your work. 
3. Call Tech. Support. 

This message indicates that RAM memory may have been cor
rupted. Make certain that you are not running any background 
utilities simultaneously with Xerox Ventura Publisher. Follow 
these steps exactly: 

1. Do not make any further changes to your chapter. 

2. Use the Set Preferences option to change Keep Backup Files 
to YES. 

3. Use the Save As option and save the chapter under a different 
name than shown in the Title Bar. 

4. QUIT from Xerox Ventura Publisher. 

5. Re-boot your computer and then run Xerox Ventura Publisher 
again. Re-Ioad the chapter. If the message appears again, contact 
Xerox Technical support for further assistance. 
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No directory can be removed until all the files it contains have been 
deleted. 

You must first delete all files within a subdirectory before the 
directory itself can be deleted. 

No file by the name you've typed exists. Therefore, it can't be removed 
or have its file type changed. 

You probably typed the wrong name. Spaces within the name make 
a difference. For example, Heading 1 and Headingl are two 
different names. 

No tag by the name you've typed exists. Therefore, it can't be renamed, 
removed, or converted to. 

Check the tag name as shown in the Assignment List and try again. 
You probably typed the wrong name. Remember, spaces within the 
name make a difference. For example, Heading land Headingl 
are two different names. 

Not enough memory to run the program. Either add memory to your 
system or check your CONFIG.SYS and AUTOEXEC.BAT files for any 
drivers or resident applications that can be removed. 

You may be trying to run in a system which has less than 640K 
RAM. 

You may be running a background utility that takes up memory 
space. Remove this background utility and try again. 

Check the CONFIG.SYS file to see if any commands have been 
given which restrict the space available. 

Only text files can be renamed and retyped using this command. 

The File Type/Rename option is available only for frames that 
contain text. 
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Over 95% of internal memory has been used. You need to reduce the 
number of pages, frames, files, or paragraphs in this chapter or divide 
this chapter into two chapters. 

This message appears when the combination of text, number of 
frames, number of paragraphs, and number of tags exceeds the 
amount of memory available. If your computer contains EMS 
memory, this does not help. However, the Professional Extension 
to Xerox Ventura Publisher allows you to use EMS memory to 
dramatically increase the size of the document you can produce 
without running out of memory. 

Save or Abandon changes to this publication? 

When you select Done in the Multi-Chapter Operations dialog 
box, Xerox Ventura Publisher reminds you to save the Publication 
if any changes have been made since it was last saved. Since table 
of contents and index settings are saved with the publication, any 
changes made while generating a table of contents or index will 
cause this message to appear. 

The current width table & the merge width table are set for different 
devices: what should be done? 

You cannot merge width tables intended for different printers (e.g. 
HP LaserJet Plus and Xerox 4045). 

The file named: filename referenced in the chapter or publication you 
are currently loading, could not be found. 

A text, picture, or chapter file has been deleted or moved to another 
subdirectory_ This message often occurs if you use the DOS COPY 
command to copy chapters. You must use the Multi-Chapter COpy 
command to copy chapters. Otherwise the chapter will look for text 
and picture files in the location where they resided prior to the copy 
operation. When it doesn't find them, this message appears. See the 
Multi-Chapter option in the Options menu (Menu Commands 
chapter). 
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The file you're trying to open as a Ventura Publisher CHP file is not in 
the standard chapter file format. 

You have selected a file which is not a standard chapter file. You 
probabl y renamed or copied an incorrect file; edited a CHP file and 
saved it as something other than an ASCII file; or specified the 
wrong file name. 

The file you're trying to open as a Ventura Publisher PUB file is not in 
the standard publication file format. 

You have selected a file which is not a standard publication file. 
You probably renamed or copied an incorrect file, or specified the 
wrong file name. 

The file you're trying to load as a Ventura Publisher STY file is not in the 
standard style sheet file format. 

You have selected a file which is not a standard style sheet file. You 
probably renamed or copied an incorrect file, or specified the 
wrong file name. 

The file you're trying to use as a Ventura Publisher WID file is not in the 
standard width table file format. 

You have selected a file which is not a standard width file. You 
probably renamed or copied an incorrect file, or specified the 
wrong file name. 

The new width table you created using the utilities on the Utilities 
Disk has not been created correctly. Make sure you placed the fonts 
in the correct order (i.e., Normal, Italic, Bold, Bold Italic.) 

The format of the file named: Filename requires a loadable converter 
which is not present in the \ VENTURA directory. 

The file is not in a format recognized by any of the text or graphics 
converters currently available in the program. This error message 
also occurs if you use the j A switch in the VP.BAT file to increase 
the memory available to the program. With most configurations, 
you cannot use any number greater than 16 (i.e. jA=17 may not 
work). The error only occurs with the converters which are external 
to Xerox Ventura Publisher and contained in the files in the VEN-
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TURA directory with the extension LOD (e.g., 
MULTMATE.LOD). Converters not contained in the LOD files are 
not affected by the / A setting. 

The HYPH*.DIC and/or *.HY1 and/or *.HY2 files couldn't be found or were 
too large. These files are used to make sure that all words are correctly 
hyphenated. 

At least one hyphenation dictionary and one algorithm must be 
located in the VENTURA subdirectory. To correct this problem, 
copy the appropriate files from the UTILITIES DISK to the VEN
TURA subdirectory. 

The new Width Table file couldn't be loaded. You may wish to try 
reloading this width file after doing a NEW. For now, we are using the 
current file instead. 

Whenever you load a style sheet file, either directly or by opening 
a chapter, the style sheet file automatically loads the width table 
that was in use when the style sheet was last saved. If that width 
table has been deleted, or if the style sheet has been copied to 
another system using the DOS COpy command, Xerox Ventura 
Publisher will not be able to find the width table. The current width 
table (e.g., OUTPUT.WID, located in the VENTURA subdirec
tory) will be used instead. 

To prevent this problem, always use the Multi-Chapter Copy com
mand rather than the DOS COpy command, when copying chap
ters to disk. To correct the problem, look at the contents of the style 
sheet file using the DOS TYPE command. While most of what 
appears on the screen will not be readable, you will see the name 
of the width table and the disk drive and subdirectory in which the 
width table file should be placed. Copy the width table to this 
directory. 

The picture file you tried to load couldn't be converted. Either it wasn't 
iFl the proper format or there wasn't enough disk space for the conver
sion. 

The most common reason this message occurs is when you try to 
load pictures directly from a floppy disk. If your disk is almost full, 
and the picture file is large, the floppy disk will not have room for 
both the original picture file and the GEM file which is created 
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during conversion. The solution is to copy the picture to your 
computer hard disk before running Xerox Ventura Publisher. 

If the error occurs when you try to load a picture from the hard disk, 
delete some files to make room on your hard disk. This message 
also occurs if you select a file which does not match the picture file 
format for the type of file you specified (e.g., You selected 
AUTOCAD in the Load Text/Picture option, but loaded a LOTUS 
file instead). 

The tabs you have defined for this tag won't show up since the tag is 
marked as Justified. To make them show up, choose Left Aligned in the 
Alignment dialog box. 

Justification overrides tab settings. Therefore, you must select a 
Horizontal Alignment setting other than Justify (Alignment op
tion, Paragraph menu) in order for tab settings to take effect. 

There is not enough space on the target disk to save the file. Do you 
wish to continue with a new disk or cancel the archive process? 

This message indicates you've run out of room on the target disk 
during a Multi-Chapter Copy operation. Insert the next disk and 
then select Continue to continue the archive process. 

There isn't enough memory to merge these two width tables into one 
width table. 

This message occurs during a Merge Width Table operation within 
the Add/Remove Fonts option. You must delete files on your hard 
disk to make room for the new, merged width table. 

There was not enough memory to begin the archive process. 

Terminate the Multi -Chapter Operations by selecting Done, then 
select NEW in the File menu to remove the existing chapter from 
memory. Finally, select the Multi-Chapter option and resume the 
archive process. 
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There wasn't enough space for all the requested font files. Some fonts 
may not display or print correctly. 

This occurs if you use large screen fonts, or if you copy a large 
number of screen font files to the VENTURA directory. Either 
delete screen font files, or upgrade to the Professional Extension, 
which uses EMS memory to increase the number of screen fonts 
which can be loaded. 

There wasn't enough memory to load and hyphenate all of the text file 
you requested. You may have to split this chapter & file into two parts 
and try again. 

In a 640K system, Xerox Ventura Publisher can load approximate
ly 500K bytes of text, which can contain up to 48,000 paragraphs. 
These figures are approximate and depend on the following fac
tors: 

• The version of DOS you are running 

• The screen driver you installed (higher version of DOS, and the 
color EGA driver reduce the amount of text) 

• The size of the width table 

• The number of paragraphs in your text 

• The number of tabs in your text. 

To correct this problem, use your word processor to break the text file 
into several smaller files, and then create two or more chapters instead 
of one large chapter. When publishing data from a database, you may 
be able to eliminate this error message by replacing paragraphs with 
line breaks. The Professional Extension to Xerox Ventura Publisher 
dramatically increases these limits through the use of EMS memory. 

This file could not be found: filename. Do you wish to skip over it, or 
retry with a new disk, or cancel the archive process? 

This message appears when you retrieve a large publication from 
several floppy disks. Insert the next disk, and select Retry. If you 
can't find the file, but want to continue the archive process, select 
Skip. 

The message also occurs if a file to which a chapter points has been 
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deleted. If you Skip, the rest of the files in the chapter will be 
copied. 

This frame is too complex to completely format. Try splitting it into two 
frames or reducing the number of columns, tabs, leaders, and lines of 
text. 

This problem is caused by memory limitations in a 640K DOS 
computer. If this error message appears, try to format the page with 
fewer attributes (i.e, bold, italic), fewer columns, fewer tabs, fewer 
frames or fewer paragraphs. 

You can also eliminate this message by drawing frames on top of 
each column on the page and then placing text into these frames 
instead of in the page. Since each frame is formatted inde
pendently, and since the memory limitation applies per frame 
rather than per page, the error will be eliminated if you place the 
text into many frames on the page. 

For long documents, you will not want to draw frames on every 
page. To make the text flow automatically from page to page, read 
the Repeating Frames section of the Menu Commands chapter 
(Frame menu). The subsection entitled Create more columns per 
page describes a technique that allows you to eliminate the Frame 
Too Complex To Format message without drawing frames on 
every single page in a long document. 

If you encounter this message frequently, you should consider 
upgrading to the Professional Extension and adding EMS memory 
to your computer. This will eliminate this error message without 
requiring any of the workarounds described here. 

Unable to find Anchor Frame: frame name. Do you wish to ignore, 
rename, or delete this unresolved anchor frame reference? 

This message indicates that Xerox Ventura Publisher can't find any 
frame in the chapter which has an anchor name to match an anchor 
you placed in the text. If you select Ignore, Xerox Ventura Publish
er continues with the anchoring process. If you select Rename, you 
are then asked to specify a new text anchor name. If you can 
remember the name which you specified for the frame, enter that 
name. If this name is correct, this new name replaces the old name 
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in the text, the frame is re-anchored, and the frame anchoring 
process continues. If you select Delete, the anchor name in the text 
is deleted. 

Using the f A=memory command line switch may allow you to run but 
could cause some printers not to work. Read more about the fA= switch 
in the manual. 

If your computer contains less than 640K RAM, or if you are using 
background utilities, or if you are using network software which 
uses more than 50K of RAM, you may not be able to run Xerox 
Ventura Publisher. In some cases, you can still run the program if 
you start Xerox Ventura Publisher by adding / A=n to the end of the 
second line of the VP.BAT file, where n is replaced with a number 
between 1 and 32. This number represents the number of K bytes 
to subtract from memory allocated to the printer and graphics 
buffers and reallocate to text files. The second line in the VP.BAT 
file will then look something like this (depending on which mouse 
and display are installed): 

DRVRMRGR VP %1 IS=SD_X6655.EGA/M=32/A=32 

Note, however, that the Cordata, AST, and JLaser printers may not 
work if you specify a large number. These printers may therefore 
not be usable in your system unless you upgrade to 640K RAM, 
eliminate background utilities, or run with a non-networked ver
sion of DOS. Also, larger numbers may degrade the drawing speed 
of graphic images on the screen. Numbers larger than A=16 may 

. cause the word processor and graphic converters contained in the 
LOD files not to work correctly. 

You're trying to load a file containing a paragraph that is larger than 8000 
characters. This has corrupted memory, so quit as soon as possible. 

Paragraphs are limited to 8,000 characters. This is about 1,600 
words or eight typewritten pages. Paragraphs longer than this may 
cause problems in some circumstances. The solution is to reduce 
the size of the paragraph by splitting it into several paragraphs. If 
you want to maintain the appearance of one solid paragraph, create 
a new tag for the second paragraph and set Line Break After 
(Breaks option) and Indent Relative (Alignment menu) for this 
paragraph. Set Line Break Before for the first paragraph. This will 
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cause the second paragraph to continue immediately after the first 
paragraph. 

The Professional Extension to Xerox Ventura Publisher increases 
the paragraph size by over ten times, depending on how much EMS 
memory your computer contains. Therefore, upgrading to the 
Professional Extension and adding EMS memory is a way to create 
larger paragraphs. 

You can't remove a tag and then convert the paragraph back to the same 
tag. 

The name on the Tag Name to Remove and Tag Name to Convert 
to lines cannot be the same. 

You can't remove every face, size, and style font from a width table. 

You must leave at least one font in a width table. 

Your disk is full. The file named: filename has not been saved. Before 
trying to save it agai~, delete enough files to make room. 

You have run out of room on your hard disk. Use the DOS File 
Operations to delete enough files to make room for the chapter or 
style sheet you are saving. If you Quit from Xerox Ventura Pub
lisher at this point without deleting some files and then saving, all 
changes made since the chapter or style sheet was last saved are 
lost. 

You're out of memory. Save your document and quit the program as 
soon as possible. 

If you add a large number of frames or add text to a large chapter, 
you may run out of memory. Save the chapter and then quit from 
Xerox Ventura Publisher. To correct the problem, you must reduce 
the amount of text in one or more of the text files in the chapter. If 
this error occurs frequently, you should consider adding EMS 
memory and upgrading to the Professional Extension of Xerox 
Ventura Publisher. 
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You've used 128 tags, files, or chapters. There are no more ~vailable. If 
possible, remove those that are no longer in use and try again. 

The combination of tags in the style sheet, plus generated tags, and 
tags in the chapter text files that don't match the style sheet, cannot 
exceed 128. This error message usually occurs when you load a 
text file containing tags that don't match the style sheet currently 
loaded. The tags which don't match are added to the tags already 
in the style sheet. The solution is to select New, load the correct 
style sheet, and then Load the desired text file(s.) 
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TEXT FROM OTHER PROGRAMS 

Xerox Ventura Publisher can read text directly from many popular 
word processors. It can also read text from many other programs which 
save text as a standard ASCII file. Text is read using the Load 
Text/Picture function. Text is saved automatically when saving a 
chapter using the Save or Save As options. Once saved, text can be 
edited using a word processor. It can also be checked for spelling 
errors using a word processor's spelling checker. Finally, text origi
nally loaded into Xerox Ventura Publisher in one word processor 
fonnat can be converted to another word processor fonnat using the 
File Type/Rename option in the Edit menu. 

The two-way communication between a word processor and Xerox 
Ventura Publisher allows you to combine the familiar user interface 
and advanced text processing capability of your favorite word process
ing program with the graphics and typesetting features of Xerox 
Ventura Publisher. Thus, you can add and delete text in Xerox Ventura 
Publisher, while still using a word processor for spell checking, search 
and replace, and moving large blocks of text. 

This section explains how to prepare text from various word proces
sors, spreadsheets, and databases for use by Xerox Ventura Publisher. 

~ The infonnation in this appendix can also be used by a programmer to 
convert text from a word processor or other program into text which 
can be read by Xerox Ventura Publisher as an ASCII or word process
ing file. 

Scope of text translation 
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Xerox Ventura Publisher creates typeset documents. The information 
needed to produce these typeset documents is far more complex than 
that needed to simply print typewriter-style text from a word proces
sor. Therefore, Xerox Ventura Publisher adds typesetting margins, 
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indents, hyphenation, page breaks, bullets, page numbering, headers 
and footers, footnotes, tab settings, picture anchoring, font informa
tion, table of contents, index, and section numbering into the text 
which is ultimately stored back into the word processor file. In addi
tion, much of the format information used by the word processor is 
ignored when the text is read into Xerox Ventura Publisher. For 
instance, a center command in a word processor is used to center text 
across a page. However, in a typeset page, text can be centered not only 
across a page, but within a column, across two columns, or within a 
frame. Thus, the word processor's center command does not provide 
sufficient information to unambiguously define what Xerox Ventura 
Publisher should do. 

Since the format information from the original word processor is 
eliminated as soon as the chapter is saved, you must save the text file 
under a different name before loading it into Xerox Ventura Publisher 
if you want to retain the original word processor formatting. 

However, text attribute information used by the author to convey 
meaning is used. All attributes used in Xerox Ventura Publisher's Text 
mode (e.g., underline, boldface, font settings) can be transferred to and 
from any word processor or any ASCII file. This is described in the 
sections which follow. 

~ In order to store typesetting information into a word processor format, 
the word processor's format information--other than text attributes
is removed when Xerox Ventura Publisher saves the chapter. 

Tags 

Xerox Ventura Publisher's paragraph format tags can be inserted from 
within your word processor as follows (the @ must be the first charac
ter in the line at the beginning of a paragraph): 

@TAGNAME /\ = /\ 

where TAG NAME is replaced by the name of the tag assigned to the 
paragraph. (The 1\ symbol indicates that you should insert a space.) 
Thus, whether tagged originally by the author, or whether entered in 
the word processor or in Xerox Ventura Publisher, these tags can be 
inserted into the text as shown in Figure D-l. 
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@CHAPTER HEAD = APPENDIX C<R>PROBLEMS 

@HEADING 1A = Common questions 

Consult the Index under the heading <169>Problems<170> to find 
references to common problems, along with the recommended solu
tions to these problems. 

@HEADING 2 = Fonts 

@HEADING 4 = <$IFonts;Adding new>Can I buy additional fonts 
for my printer and use them with Xerox Ventura Publisher? 

Figure D-1 Textfor Appendix C, as it appears in a word processor. Note index entries, line break, 
typographic quotes «169> and <170» and tag names. 

Non-keyboard characters 
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Additional characters not found on the keyboard can be inserted into 
text by enclosing the ASCII decimal equivalent within brackets. (See 
Appendix E.) For instance, to insert a trademark symbol (TM), you type: 

<191> 

To use the < > characters without having them interpreted as part of a 
character attribute code, type two brackets in a row. For instance, to 
produce: 

<text in brackets> 

type: 

«text in brackets» 

If the word processor can create and edit foreign characters, Xerox 
Ventura Publisher will translate these without the need to use the < > 
codes. 
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Tabs 

Tab stop settings in 
your word processor 

Text before tab 1 

Text on second line 

Any time you press the Tab key on the keyboard, you insert a tab 
character into the text. The word processor then moves the cursor to 
the next tab stop setting for that paragraph. If the tab settings in the 
Xerox Ventura Publisher style sheet are at different locations from the 
tab stops in the word processor, this will lead to incorrectly formatted 
tables, as shown in Figure D-2. To avoid this problem, use tab settings 
in the word processor that are similar to the style sheet to be used. 
Because word processor tab stops are set according to the number of 
characters which you want to skip, while Xerox Ventura Publisher's 
tab stops are set according to distance from the left column edge, this 
may require a little experimentation. However, you can closely ap
proximate the word processor's tab settings by setting the Paragraph 
tab settings to Left aligned and setting the distance (in inches) to a 
value given by the following formula: 

Tab Stop 
Pitch 

Left Margin 
Pitch 

Distance 

Text in your wordprocessor 

I I 

~ Text after tab 1 

~ This text is longer than line 1 

I 

~ Text after tab 2 

~ Text in line 2 

Text in Xerox Ventura Publisher 

Tab stop settings in Xerox 
Ventura Publisher I I I 

Text 
misalignment 

Text before tab 1 

Text on second line 

~ Text after tab 1 ~ Text after tab 2 

~ This text is longer than line 1 ~ Text in line 2 

Figure D-2 Tab stops set differently from those in your wordprocessor causes text to mis-align 
within Xerox Ventura Publisher. 
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Text attributes 

Tab check list 
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Tab Stop and Left Margin are measured in numbers of characters. 
Pitch is measured in characters per inch. Distance is measured in 
inches. For instance, if your word processor prints at 10 pitch (i.e., 10 
characters per inch) and you have a tab stop set at 30 characters from 
edge of the page, and a left margin of 15 characters, the Xerox Ventura 

Publisher tab stop should be set for ~~ - ~~ = 1.50 inches. 

• Tum justify off for any paragraph that contains tabs. 

• Make sure the word processor is configured to insert tabs. Certain 
word processors (such as Wordstar) when configured incorrectly, 
add spaces rather than tabs. 

• Text which includes tab characters does not automatically wrap 
around frames. 

Text attributes 
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Xerox Ventura Publisher correctly translates, displays, and prints text 
attributes, such as boldface and underline, from each word processor 
supported. Similarly, any text attributes added using Xerox Ventura 
Publisher's Text mode are stored back in the word processor's native 
file format. 

However, because Xerox Ventura Publisher can create a much wider 
range of text attributes than any word processor, and because combi
nations of these attributes are treated differently within Xerox Ventura 
Publisher, many attributes are stored back into the original file using 
the codes shown below. 

For instance, the beginning of medium italic text is set by inserting the 
following directly before the text to be italicized: 

<MI> 

In general, attributes native to the word processor, such as boldface, 
when used alone, are translated back to the original attribute when a 
chapter is saved in Xerox Ventura Publisher. When used in combina
tion with other attributes, they are translated back to the original 
attribute using combinations of the following Xerox Ventura Publisher 
codes. 
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Attribute 

Medium weight type 
Bold weight type 
Italics 
Underline 
Double underline 
Overscore 
Strikethrough 
Small 
Superscript 
Subscript 
Color index 

(replace n with one of the following numbers) 
White 0 
Black 1 
Red 2 
Green 3 
Blue 4 
Cyan 5 
Yellow 6 
Magenta 7 
Reset to tag color 255 

Typeface 

Code 

<M> 
<B> 
<I> 

<U> 
<=> 
<0> 
<X> 
<S> 
<II.> 
<v> 

<Cn> 

<Fn> 
replace n with one of the Font ID numbers shown in the Typeface section of 

Appendix K. Reset to the tag's paragraph font with <F255>. Additional fonts 

which you purchase may have font IDs different than those shown. The legal range 

of font ID numbers is I to 65,535. 

Point Size <Pn> 
replace n by the type size, measured in points (I point equals 1/72 inch). n=255 

resets to point size specified by the paragraph tag. 

Base Line Jump <In> 
replace n by the vertical offset. n may range from I to 255. 

The amount of jump up, in points (p), is translated to n as follows 

300 
n = 256 - (n)(p). 

The amount of jump down, in points (p), is translated to n as follows 

300 
n = (n)(p). 

<10> is reserved and used to reset the Base Line Jump to zero. For example, jump 

up 6 points is <1231>. Jump down 6 points is <125>. 
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Begin Kerning <Kn> 
This method of kerning was used in previous releases and is included here for 

completeness. Replace n the amount of left horizontal shift, measured in 1/300 of 

an inch. n may range from -127 to + 127. The measurement -00 1 is used to reset 

the kerning to zero. Use the following method for kerning instead of this older 

method. 

Kern/Track <B%n> 
Replace n with the number of ems to add (positive values of n) or subtract 

(negative values of n) between each character in the selected text. Place <D%O> 

to mark the end of the text which should be kerned/tracked. 

Resume Normal <D> 

~ All attributes are terminated at the end of a paragraph, even if the 
Resume Normal character «D> ) is not encountered. Also, all previ
ous attributes are terminated any time new attributes are set. 

Examples: 1) Attributes can be grouped together into sequences. For example, to 
set Bold, Italic, Blue, the code is <BIC4>. Any new text attribute 
sequence encountered cancels all previous attributes. 

REFERENCE GUIDE 

2) Attributes native to the word processor and the codes described on 
the previous pages can be inter-mixed. For example to create the 
following effect using Wordstar: 

airplane automobile 

where the first word is boldfaced and underlined, and the second word 
is boldface only, would require the following within Wordstar: 

"U"Bairplane"U automobile"B 

This same effect can be produced using the codes described on the 
previous pages as follows: 

<BU>airplane <B>automobile<D> 

The author can choose either to use the attribute set shown above, or 
continue to place attributes in the text using the word processor's own 
commands. 
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Other inserted text 

Line Break <R> 

0-8 

In addition to paragraph tags and text attributes, Xerox Ventura Pub
lisher also inserts other fields into the text file, including line breaks, 
discretionary hyphens, non-breaking spaces, frame anchors, index 
references and footnotes. These are always stored back into the word 
processor file inside of < > brackets. The codes for each attribute are 
as follows. Some of these are described more fully in the paragraphs 
which follow this table. 

A line break begins a new line without creating a new paragraph. It 
does not begin a new paragraph. Use line breaks when printing large 
database files to separate individual lines within a record. The fewer 
paragraphs in a database printout, the larger the database file can be. 
Make sure, however, that you do not create a paragraph longer then 
4-6K bytes. 
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Discretionary 
Hyphen <-> 

Non-Breaking 
Space <N> 

Footnotes <$F> 

Frame anchors 

Hidden text 
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A discretionary hyphen <-> presents an additional hyphenation oppor
tunity to Xerox Ventura Publisher's hyphenation algorithm. If the 
word which contains a discretionary hyphen is not placed at the end of 
a line, no hyphen is shown on the screen and no hyphen is printed. 

Placing a discretionary hyphen at the beginning of the word disables 
hyphenation for the one occurrence of that word. 

The non-breaking space <N> inserts a space, but unlike a normal 
space, no break (line break, page break, etc) may occur at this point. 
The non-breaking space is used to keep words together on the same 
line. 

The non-breaking space is expanded and compressed during justifica
tion, unlike the thin, figure, em, and en spaces which are always fixed 
width, regardless of justification. 

Footnotes can be inserted at any point in a text file by specifying 
<$Ftext> where text is the footnote text which will appear at the 
bottom of the page. Within Xerox Ventura Publisher, the appropriate 
footnote number is generated at the location in the text where the 
<$Ftext> appears. 

Frames can be anchored in one of four ways: 

• Fixed, on the same page 

• Relative, above the anchor location 

• Relative, below the anchor location 

• Relative, automatically at anchor 

The anchor reference is placed in the text as indicated in the earlier 
table. For instance, <$&SCREEN23 [v]> will anchor the frame named 
SCREEN23 to the spot immediately below the line which contains 
this anchor. 

The hidden text allows you to place comments and other text in your 
files which Xerox Ventura Publisher will not display or print. Thus, if 
you place the following in a text file 

<$! Note: this section revised on June 26, 1989> 
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Index 

D-10 

this text will not appear in your document, but will still be available to 
edit within your word processor. 

Index entries are placed within a text file as follows: 

<$IPrimary [Primary sort] ; Secondary [Secondary sort] > 

where Primary is replaced by the primary index entry; Secondary is 
replaced by the secondary index entry; and Primary sort and Second
ary sort are replaced with the two sort keys. For See references, $S is 
used in place of $1. For See Also references, $A is used in place of $1. 

If no sort keys are specified, the correct code is: 

<$IPrimary;Secondary> 

If only a primary reference is used, the code is: 

<$IPrimary> 

Index references can easily be entered directly into your favorite word 
processor. Simply locate the point you wish to index and type the index 
references. For instance, this paragraph was indexed within Word 
perfect by typing: 

<$IWord processor; Developing index in> 

at the beginning of the paragraph. 

Deleting null paragraphs 

Each time you press the Enter key when using the word processor, 
you create a new paragraph. If you type Enter twice in a row in order 
to place a blank line between paragraphs, Xerox Ventura Publisher 
creates a null paragraph, complete with all the space normally placed 
between paragraphs. If this is not desirable, you can delete all extra 
carriage returns by using your word processor to place the following 
tag at the beginning of the text file: 

@PARAFILTR ON = 
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This must be added from within your word processor, not from within 
Xerox Ventura Publisher. The extra paragraphs will be eliminated the 
next time you load thistext file or open a chapter containing the text 
file. When you save the chapter, the extra paragraphs are permanently 
eliminated. 

If you want to retain two carriage returns at a few places in a document, 
but still use the @PARAFILTR ON = feature, place a space in front of 
the second carriage return. Xerox Ventura Publisher will see carriage 
return-space--carriage return rather than two carriage returns in 
a row and will not eliminate the second carriage return. 
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ASCII text 
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Most word processors, spreadsheets, and database programs save 
information in their own file format, usually identified by a unique file 
extension. For instance, Lotus 1-2-3 saves worksheets in WKS or 
WKI files, and dBase III saves databases in DBF files. Text can be 
moved to and from many of these popular programs as standard ASCII 
text files. You can load ASCII files using either the ASCII option, 8 
Bit ASCII option, or Wordstar option. Loading as an ASCII or 8 Bit 
ASCII file requires two carriage return-line feed combinations to 
create a new paragraph. Loading as a Wordstar file treats single 
carriage returns as a new paragraph. Most spreadsheet and database 
files should be loaded as Words tar files. 

Characters not used in ASCII text 

The American Code for Information Interchange (ASCII) uses seven 
bits for data and one bit for parity. This allows 128 characters. How
ever, to allow for non-English and typographic characters, Xerox 
Ventura Publisher provides an 8 Bit ASCII converter which uses the 
parity bit as data. This allows the entire Xerox Ventura Publisher 
character set to be represented in a pseudo-ASCII format. Please note 
that ASCII characters below decimal 3 2 (except tab--decimaI9-) are 
not translated to or from Xerox Ventura Publisher. 

Text from mainframe computers 

Some ASCII files, especially those transferred via a communication 
program to your PC from mainframe computers, do not have two pairs 
of carriage return (decimal 13) and line feed (decimal 10) characters 
at the end of each paragraph ([CR] [LF] [CR] [LF].) Additional carriage 
returns without a matching line feed (or vice versa) will cause unpre
dictable results. 
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Spreadsheets and databases 

Lotus 1-2-3 

Lotus 1-2-3 and other spreadsheets can be saved as ASCII files using 
the spreadsheet's PRINT FILE option (/PF in Lotus 1-2-3.) In 1-2-3, 
The file name chosen automatically has the extension PRN added. 
Howev'er, most spreadsheets, including Lotus 1-2-3, place spaces, not 
tabs, between each column and cannot be configured to automatically 
insert TAB characters between columns. Therefore, when using pro
portionally spaced fonts on Xerox Ventura Publisher, the columns will 
not align, unless you manually place tabs between each column, as 
described on the next page. 

As an example, to create a table using a Lotus 1-2-3 print file, first set 
the tab stops for Body Text to the desired positions. Then, use the 
Load/Text Pictures option to load the 1-2-3 PRN file as a 
WORDSTAR file. (Because each row is separated by a single carriage 
return, and because Xerox Ventura Publisher ignores single carriage 
returns in ASCII text, loading as an ASCII file would cause each line 
to run directly into the next line. In Wordstar files, Xerox Ventura 
Publisher treats single carriage returns as paragraph breaks.) 

Finally, use the Text mode to delete all spaces and then insert tabs 
between each column in each row. 

A much simpler solution which doesn't require inserting tabs is to 
simply change the imported spreadsheet text to Courier or some other 
font which is not proportionally spaced. This can be done by creating 
a new tag (Add New Tag), changing its font to Courier, and then 
tagging the spreadsheet paragraph(s) with this new tag. Alternatively 
you can select all the text from the spreadsheet in Text mode and then 
use the Set Font option to change the font to Courier. Make sure to set 
the Normal Space Width in the Paragraph Typography option to 1.0 
in order to get the columns to align perfectly. 

~ The Professional Extension to Xerox Ventura Publisher contains a 
utility which will automatically read spreadsheet or data base print 
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files and convert them into a format that will read directly into the 
Professional Extension's Table mode. 

Dbase III generates ASCII text using the dBase III TO FILE option 
with commands such as REPORT and LABEL. The extension TXT is 
automatically added to the file name you choose. Appendix H contains 
an application note on how to publish a phone directory from dBase 
III. 

REFERENCE GUIDE 



DCA APPENDIX D-TEXT FROM OTHER PROGRAMS 

Word processors 

DCA 

Lotus 
Manuscript 

Displaywrite III 

Xerox Ventura Publisher can read and write standard DCA version 2.0 
files. Displaywrite III and Displaywrite IV can save and retrieve DCA 
files. 

Xerox Ventura Publisher automatically converts standard DCA text 
attributes to Xerox Ventura Publisher text attributes. 

All other attributes, attribute combinations, footnotes, index refer
ences, and text characters must be entered into DCA using the < > 
commands outlined earlier in this chapter. 

To convert a Lotus Manuscript file into DCA format, follow these 
steps: 

1) Select File Conversion Utility from the Document Manage/Main 
Menu. 

2) Select DCA Revisable Form Export. 

3) Type the DCA file name. The RFT extension is added automati
cally. 

4) Press the Ins (insert) key. 

To convert a Displaywrite III document into DCA, follow these steps: 

1) Select J-Document Utilities from the main menu. 

2) Select F-Convert Document from the document utility menu. 

3) Enter the Displaywrite III file name and then type the file name of 
the DCA file you wish to create. 

4) Select A-Document to Revisable Form Text. Press Enter. 

Displaywrite III automatically assigns the RFT extension to the con
verted file name. 

Displaywrite IV To convert a Displaywrite IV document into DCA, follow these steps: 
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Volkswriter 3 

Office Writer 

Wordstar 2000 
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1) Select 6-Utilities from the main menu. 

2) Select 6-Document Conversions from the utility menu. 

3) Enter the Displaywrite IV file name and then type the file name of 
the DCA file you wish to create. 

4) Select Document to Revisable Form Text. Press Enter. 

Displaywrite III automatically assigns the RFT extension to the con
verted file name. 

To convert a Volkswriter 3 document into DCA, follow these steps: 

1) Select the U utility from the main menu. 

2) Select B-Volkswriter to DCA Revisable Form Text from the 
Utility menu. 

3) Type the Volkswriter document name. 

4) Type the Converted DCA file name. The extension RF is automat
icallyassigned. 

5) Press Enter. 

6) Answer Y to the question "Do you want to continue?" 

To convert an Office Writer document into DCA, follow these steps: 

1) Select Convert from the main menu. 

2) Select Office Writer to DCA from the Convert menu. 

3) Type the Office Writer document name. 

4) Type the DCA file name. The extension DCA is automatically 
assigned. 

5) Press Enter. 

Note: only Office Writer version 4.0 and above support DCA. 

To convert a Wordstar 2000 document into DCA, follow these steps: 

1) Select A-Additional Features from the main menu. 

2) Select Convert from the Additional Features Menu. 

3) Type the Wordstar 2000 document file name. 

4) Type the DCA file name. The extension RFT is automatically 
assigned. 
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5) Press Enter. 

Samna Word To convert a Samna Word document into DCA, follow these steps: 

1) Press F9 from the Samna main screen. 

2) Press T (translate) from the Do What? prompt. 

3) Press D (Samna to DCA) from the Translate prompt. 

4) Press S (Samna to DCA Revisable Form). 

5) Type the name of the Samna document. 

6) Type the name of the DCA document. Type the file extension. 

7) Press Enter. 

Microsoft Word 
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Xerox Ventura Publisher can read and write standard Microsoft Word 
version 3.1 files and Windows Write. Other versions of Word may also 
work. Microsoft Word style sheets are not usable by Xerox Ventura 
Publisher. 

Xerox Ventura Publisher automatically converts standard Word text 
attributes to Xerox Ventura Publisher text attributes. 

Attribute 
Begin/End Bold 
Begin/End Superscript 
Begin/End Subscript 
Begin/End Strikethrough 
Underline 
Discretionary Hyphen 
Non Break Space 

MSWord 
Alt b 
Alt + 
Alt
Alts 
Alt u 
Ctrl -
Ctrl Spacebar 

All other attributes, attribute combinations, footnotes, index refer
ences, and text characters must be entered into Microsoft Word using 
the < > commands outlined earlier in this chapter. 
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Multimate 

Xerox Ventura Publisher can read and write standard Multimate ver
sion 3.31 files. Other versions of Multimate may also work. 

Xerox Ventura Publisher automatically converts standard Multimate 
text attributes to Xerox Ventura Publisher text attributes. 

Attribute 
BeginlEnd Bold 
BeginlEnd Superscript 
BeginlEnd Subscript 
BeginlEnd Strikethrough 
Underline 
Discretionary Hyphen 
Non Break Space 

Multimate 
AltZ 
AltQ 
AltW 
AltQ 
Shift 
Shift F7 
Alt S 

All other attributes, attribute combinations, footnotes, index refer
ences, and text characters must be entered into Multimate using the < 
> commands outlined earlier in this chapter. 

WordPerfect 

Xerox Ventura Publisher can read and write WordPerfect version 4.1 
or 4.2 files using the WordPerfect option in the Load TextlPicture 
menu. Use the WordPerfect 5.0 to load version 5.0 files. 

Xerox Ventura Publisher automatically converts standard WordPerfect 
text attributes to Publisher text attributes. 

Attribute 
BeginlEnd Bold 
BeginlEnd Superscript 
BeginlEnd Subscript 
BeginlEnd Strikethrough 
Underline 
Discretionary Hyphen 
Non Break Space 

WordPerfect 
F6 
Shift FI, 1 
Shift FI, 2 
Alt F5, 4 
F8 
Ctrl, -
Home, Space bar 
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All other attributes, attribute combinations, footnotes, index refer
ences, and text characters must be entered into WordPerfect using the 
< > commands outlined earlier in this chapter. 

Xerox Ventura Publisher can read and write standard Wordstar 3.3, 
3.4,4.0 and 5.0 files. Other versions of Wordstar may also work. 

Xerox Ventura Publisher automatically converts standard Wordstar 
attributes to Xerox Ventura Publisher text attributes. 

Attribute 
start/Stop Bold 
Start/Stop Superscript 
Start/Stop Subscript 
Start/Stop Strikethrough 
Start/Stop Underline 
Discretionary Hyphen 
Non Break Space 

Wordstar 
AB 
AT 
AV 
AX 
AS 
Soft hyphen 
AO 

All other attributes, attribute combinations, footnotes, index refer
ences, and text characters must be entered into Wordstar using the < > 
commands outlined earlier in this chapter. 

Foreign characters entered in Wordstar 3.4 which are not available in 
both the Xerox Ventura Publisher and the IBM character set will not 
display or print 

Wordstar tabs When you press the tab key, Wordstar does not always place a tab 
character into the text, but instead inserts multiple spaces. As 
described earlier in this chapter, Xerox Ventura Publisher requires the 
actual tab character in order to correctly format tabular information. 
To assure that Wordstar inserts real tab characters, tum the Vari-Tab 
feature within Wordstar Off. 
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Xerox Writer 

Xywrite 

Xerox Ventura Publisher can read and write standard Xerox Writer 
version 2.0 files. 

Xerox Ventura Publisher automatically converts standard Writer text 
attributes to Xerox Ventura Publisher text attributes. 

All other attributes, attribute combinations, footnotes, index refer
ences, and text characters must be entered into Xerox Writer using the 
< > commands outlined earlier in this chapter. 

Xerox Ventura Publisher can read and write standard Xywrite II and 
Xywrite III files. 

Xerox Ventura Publisher automatically converts standard Xywrite text 
attributes to Xerox Ventura Publisher text attributes. 

All other attributes, attribute combinations, footnotes, index refer
ences, and text characters must be entered into Xywrite using the < > 
commands outlined earlier in this chapter. 
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APPENDIX E 
CHARACTER SETS AND CODES 

Xerox Ventura Publisher includes two character sets: 

• An international character set which includes characters for many 
languages, including English, Spanish, French, and Italian 

• A symbol character set which includes mathematics and greek 
characters which can be used for simple formulas and equations. 

Not all of these characters can be typed directly from the keyboard. 
Characters not available on your keyboard can be entered by holding 
down the ALT key and then typing the Decimal equivalent for that 
character on the numeric keypad. The tables on the following pages 
show these decimal equivalents. 

When using your wordprocessor to enter foreign characters and other 
characters above decimal 127, you must enter these characters by 
using the < > codes, as explained in Appendix D. For wordprocessors 
which support foreign characters, Xerox Ventura Publisher will accept 
these characters without placing numbers inside of < >. However, the 
decimal equivalent of these characters must be less than 169, and the 
foreign characters in your wordprocessor must have the same decimal 
equivalents as those shown on the following pages. For characters 
above 169, use the decimal code inside of brackets, e.g., <185> for §. 

For users of the Apple Laserwriter and other advanced PostScript 
printers, dingbat characters are shown in the following table. Dingbats 
do not display on the screen unless you purchase matching screen fonts 
from Adobe Systems. The international character set displays instead. 
Dingbats will print, however, if you own an advanced PostScript 
printer. 
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Xerox Ventura Publisher Character Set 

Inter- Inter-
Decimal national S:imbol Dingbat Decimal national S:imbol Dingbat 

32 space space space 56 8 8 K 

33 ~ 57 9 9 + 
34 " V ~ 58 + 
35 # # ~ 59 + 
36 $ :3 t« 60 < < -:-
37 0/0 % 1J' 61 = = t 

38 & & ({) 62 > > '1i' 

39 3 @ 63 ? ? t 

40 ( + 64 @ - ffi 

41 ) ~ 65 A A (& 

42 * * ... 66 B B· + 
43 + + ~ 67 C X + 
44 ~ 68 D .1 .. 
45 {h 69 E E + 
46 ~ 70 F <I> .. 
47 / / ~ 71 G r -¢-

48 0 0 tC? 72 H H * 49 1 1 c» 73 I I * 
50 2 2 eO- 74 J t} 0 

51 3 3 ./ 75 K K * 52 4 4 II 76 L A '* 53 5 5 X 77 M M * 54 6 6 X 78 N N .. 
55 7 7 ~ 79 0 0 * 
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Xerox Ventura Publisher Character Set 

Inter- Inter-
Decimal national S:tmbol Dingbat Decimal national S:tmbol Dingbat 

80 p II * 104 h 11 * "" 

81 Q e * 105 t * 82 R P * 106 <p 
,I, 

* 
83 S L * 107 k K * 84 T T * 108 A • 
85 U y * 109 m )l 0 

86 V <; * 110 n v • 
87 W n * 111 0 0 0 

88 X ..... • 112 P 1t 0 1-4 
~ 

89 y '¥ • 113 q e 0 

90 Z Z • 114 r p 0 

91 [ [ ... ' .. ;:; 115 s a • 
92 \ .. * 116 t t T 

93 ] ] * 117 u u • 
94 A 1. * 118 v rn .:. 
95 0 119 w 0) t 

96 ~ 120 x ~ 
97 a a 0 121 Y 'I' I 

98 b ~ 0 122 z ~ I 

99 c it: * 123 { { i 

100 d 0 * 124 I I ~ 

101 e E 3$ 125 } } " 
102 f <I> * 126 " 
103 9 y ~!~ 

.fl' 127 
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Inter- Inter-
Decimal national S:lmbol Dingbat Decimal national S:tmbol Dingbat 

128 C 152 Y + e 
129 0 r !Y 153 0 * 0 

130 e • 154 0 6) • -
131 a ::; • 155 ¢ = <D • 
132 a / • 156 £ 8 

133 a 00 • 157 ¥ f3 

134 a f ~ 158 D @) 

135 g 4- n, 159 f .J fIV 

136 e • tit 160 a ~ CD 

137 e • • 161 3 ® 

138 e It • 162 6 9\ @ 

139 "i H ~ 163 U f.J @ 

140 i f- CD 164 n ® @ 

141 i @ 165 N Et> ® 

142 A ~ @ 166 S! 0 (J) 

143 A J. @ 167 Q n ® 

144 E 0 ® 168 i u ® 

145 ca ± ® 169 " :::) @) 

146 JE " ® 170 " :::) 0 

147 6 ~ @ 171 a:. f) 

148 0 x ® 172 c D 

149 0 oc @ 173 c e 
150 0 a " 174 « E 0 

151 U • @ 175 » ~ 0 
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Xerox Ventura Publisher Character Set 

Inter- Inter-
Decimal national S:tmbol Dingbat Decimal national sytol Dingbat 
176 a L fj 200 A .-
177 6 V (;) 201 E r c) 

178 0 ® 0 202 E I ¢ 

179 " © (ID 203 E L ~ 

180 re TM -+ 204 r ~ 

181 CE IT --)- 205 ~ '" 182 A ~ ~ 206 i l L) 

183 A t 207 "i I c> 

184 6 -, , 208 6 • 
185 § /\ -. 209 6 ) 0 

186 =1= v ~ 210 6 J ~ 

187 t ¢=> ~ 211 S ( ]JH 

188 1f ¢:: ... 212 S I ..~ 

189 © 11' -+ 213 0 J :+ 

190 ® ::::) -+ 214 0 1 -i' 

191 TM ~ " .. 215 0 I ~ 

192 
" 

0 II'" 216 Y ) » 

193 ( - 217 B 1 ~ 

194 %0 ® > 218 Z I -> 

195 • © :> 219 Z J ... 
196 TM > 220 / 1 .. 
197 L '- 221 ~ .. 
198 ( ,.. 222 J ~> 

199 A I • 223 
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Text codes 

A complete description of the text codes is provided in Appendix D. 

Text attributes Codes 
Box (Hollow) (Filled) <$BO> <Bl> 
Base Line Jump <Jnnn> 
Begin Kerning <B%n> 
Bold weight type <B> 
Color index <Cnnn> 
Double underline <=> 
Italics <I> 
Line Break <R> 
Medium weight type <M> 
Overscore <0> 
Point Size <Pnnn> 
Resume Normal <D> 
Small <S> 
Strikethrough <x> 
Subscript <v> 
Superscript <A> 
Typeface <Fnnn> 
Underline <U> 
Spaces 
Em space <-> 
En space < ..... > 
Figure Space <+> 
Non-Breaking Space <N> 
Thin Space <I> 
Inserted text 
Discretionary Hyphen <-> 
Footnote <$Ftext> 
Fractions <$E 1/2 > or <$E lover 2 > 
Hidden text <$ ! text> 
Index <$Iprimary[sort];secondary[sort]> 
Page number (chapter number C#) <$R[P#]> 
Picture anchor (below) <$&anchor name[ v]> 
Picture anchor (same page) <$&anchor name> 
Picture anchor (above) <$&anchor name[A]> 
Picture anchor (automatic) <$&anchor name[ -]> 
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APPENDIX F 
PRINTER INFORMATION 

This appendix provides important set up, configuration, and opera
tional information about your printer. Information on how to add 
additional fonts to your printer is provided in Appendix K. 

The following paragraphs apply to all printers. Read these paragraphs 
first and then tum to the section which contains specific information 
for your printer. 

Printer limitations 

~ YOUR PRINTER MAY NOT BE CAPABLE OF PRINTING 
EVERYTHING YOU SEE ON THE COMPUTER SCREEN. 

REFERENCE GUIDE 

Speed, resolution, maximum picture size, character set, and unprint
able space at the edge of the page are different for each printer. Also, 
the document may not be centered on the page due to manufacturing 
tolerances. You can avoid disappearing headers & footers which result 
from the blank space at the edge of the page by changing the above 
and below space for the header and footer tags. You can compensate 
for the offset by adjusting the left and right margins. 

To see the limitations of your printer, print the chapter called 
CAPABILI (contained in the TYPESET directory, if you installed the 
example files). 

On printers which do not use a page description language (e.g., 
PostScript), the fonts which appear in line art can only be the discrete 
sizes. Therefore, when the picture is scaled, the fonts may be slightly 
too large or too small for the picture. Solution: 

1) Make the picture slightly larger or smaller. 
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2) Better yet, don't put text in pictures. Instead, attach box text to the 
frame which contains the illustration and use the considerable 
typographic power of Xerox Ventura Publisher to produce annota
tions for your pictures. 

Printer problems 

F-2 

The following general troubleshooting guidelines apply to all printers. 

If you can't get anything to print, first try pressing the self test button 
on the printer, if your printer has one, to see if the basic printer 
mechanism is working. This causes the printer to print one or more 
pages. If nothing happens in this self-print mode, consult your printer 
manufacturer or dealer for further help. 

If the printer has just been installed, and doesn't print correctly 
using other software, the problem may very well be the printer cable. 
Disconnect the cable from the printer and count the number of pins. If 
the connector has 36 pins, it is a parallel cable, and the cable is 
probably not the cause of your problems (although cables over 10 feet 
can cause problems with high speed computers). If the connector has 
25 pins, it is a serial cable, and you may not have the correct cable. 
Many people try to connect the laser printers to their computer with a 
standard serial cable that has the right set of connectors, but is not 
wired as required by a laser printer. Most printers which use a serial 
cable use one which is wired similarly to a null modem cable. The 
correct wiring diagrams for HP LaserJet and Apple LaserWriter cables 
are shown in the section for each printer, along with manufacturer's 
part numbers. 

Also, check the printer configuration switch settings. 

If the printer prints correctly from other programs, but does not 
print from Xerox Ventura Publisher, you have probably specified the 
wrong printer or wrong printer port during installation. Select the 
Printer Info option in the Options menu, and try a different printer or 
printer port. The printer selection is shown at the top of the dialog box. 
The printer port is shown on the Output To: line. If, in the test above, 
you found a 25 pin cable, you can select between printer ports COM1: 
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and COM2:. If, in the test above, you found a 36 pin cable, you can 
select between LPTl:, LPT2:, and LPT3:. Try printing one page with 
each of these options until the page prints correctly. The configuration 
switch settings within the printer should also be examined. Different 
programs work with different switch settings from those required for 
Xerox Ventura Publisher. Check the section within this chapter that 
pertains to your printer for information on the correct switch settings. 
Also, check the CONFIG.syS file. Certain device drivers such as 
GEMPRINT.SYS will keep Xerox Ventura Publisher from printing 
correctly. These must be removed. You should also check to make sure 
you have more than 500K space available on your hard disk. Xerox 
Ventura Publisher places files temporarily on your hard disk during 
printing and if your disk is almost out of space, this can cause a 
problem. 

Xerox Ventura Publisher includes the following fonts for each printer 
installed, unless otherwise noted: 

Courier (fixed pitch) 

• 10, 12 point (10 characters to the inch) medium 

Swiss (Helvetica) san-serif 

• 6,8,9, 10, 11, 12 point medium 

• 9, 10, 11, 12 point italic 

• 8, 10, 12, 14, 18,24,36 bold 

Dutch (Times Roman) serif 

• 6,8,9, 10, 11, 12 point medium 

• 9, 10, 11, 12 point italic 

• 8, 10, 12, 14, 18,24,36 bold 

Symbol (greek, mathematics) 

• 10 point medium 
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Xerox 4045 laser printer 
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Paper Size 

The 4045, when driven by Xerox Ventura Publisher, handles 8.5 X 11 
inch, 8.5 X 14 inch, and A4 (21.0 X 29.7 centimeters) paper. You can 
always print a smaller page on a larger paper size by changing the 
page's Frame Width and Height in the Sizing & Scaling option. 

Like all laser printers, the 4045 cannot print to the edge of the page. 
This means that text and pictures placed near the edge of the page will 
show correctly on the computer screen, but may not print as displayed. 
Remember, therefore, to set a large enough margin using the Margins 
& Columns option in the Frame menu. To see the amount of blank 
space around the edge of the page, print the CAPABILI.CHP chapter 
in the TYPESET directory. 

Configuration switches 

The 4045 configuration switches are found on the 101S04200 Car
tridge. The settings for various configurations are shown in Figures 
F-l through F-4. The switch settings to use depend upon: 

• Whether your printer is connected with a parallel or serial cable 

• Amount of memory installed (450K or 1.5 megabytes) 

• 4045 ROM revision 

The Bytes Available (memory installed) and ROM revision # is 
printed on the 4045 Configuration Sheet shortly after the machine is 
first turned on. 

At least 450K bytes of DRAM and ROM revision 2.X or above must 
be installed in the 4045 in order to print Xerox Ventura Publisher 
documents. Installing even more DRAM allows larger pictures to be 
printed. At least 1.0 megabytes of DRAM and revision 3.1 must be 
installed to use the 300 dpi driver. 
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1··.& .... 1 I·· .. ····, ,·· ...... 1 

, ........ , 
87654321 87654321 87654321 87654321 

B A OFF 

0 C t 
ON 

B A OFF 

0 C t 
ON 

I·· ...... , I.·······, , ........ , I········, 
87654321 8 76 5 4 3 2 1 87654321 8 7 6 5 4 3 2 1 

Figure F-1 Xerox 4045 switch settings for Figure F-2 Xerox 4045 switch settings for 
version 3.1.1, 15M RAM, parallel inteiface version 2.0, 450K RAM, parallel inteiface. Turn 

D8 OFF for version 2.1 ROM. 

, ........ , I·· .. ···., I·· ...... , I·· .. ···., 
87654321 87654321 87654321 87654321 

B A OFF B A OFF 

0 C t 0 c t 
ON ON 

, ........ , ,··· .. ··.1 1··.·· .. ·1 , ........ , 

87654321 87654321 87654321 87654321 

Figure F-3 Xerox 4045 switch settings for Figure F-4 Xerox 4045 switch settings for 
version 2.0, 450K RAM, serial interface version 3.1.1, 15M RAM, serial inteiface 

The Xerox 4045 Laser Printer can be set up as either a parallel or serial 
printer. To use it as a serial printer, consult your 4045 manual, and set 
the 4045 cartridge switches as shown in either Figure F-3 or F-4, 
depending on which ROM version and memory is installed. 

Resolution 
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Xerox Ventura Publisher allows you to print both text and pictures on 
your 4045. Text prints with a resolution of 300 dots per inch, and 
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Memory 

pictures print with a resolution of 150 or 300 dots per inch, depending 
on which driver is installed. 

Fonts are loaded by Xerox Ventura Publisher into the 4045 as needed 
for each page. The space taken by these fonts decreases the space 
available for pictures. If a page contains many big pictures, and a large 
number of different fonts, especially larger size fonts, the 4045 runs 
out of memory and prints an error page. The remaining pages should 
print correctly, unless a similar problem exists on those pages. 

To correct the problem, do one of the following: 

1) Select the 150 dpi driver instead of the 300 dpi driver. (If the 150 
dpi driver is not already installed, use VPPREP, as described in the 
Setup and Installation section.) 

2) If this doesn't work, reduce the size or number of fonts used on the 
problem page. 

3) If this doesn't work, reduce the number or size of pictures on the 
problem page. 

Limitations 

• Pictures which contain text which is rotated at an angle to the text 
on the page will not print. 

• The 4045 cannot print white text on a black background. 

• A maximum of 64 bit images is allowed per page, although memory 
will usually limit the number to fewer than 64. Only 8 bit images 
are allowed on any single scan line. 

• The 4045 prints text, or lines drawn in the Graphic mode, in 100% 
black only. It cannot print these, objects in shades of gray. 

• The maximum memory available for fonts is 447K bytes (the 
amount actually available is printed on the Configuration Sheet 
when the printer is first turned on). This limits the maximum font 
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size to approximately 40 points, depending on the typeface and 
weight. 

• The Titan typeface is used in place of Courier. 

Xerox 4020 color ink jet printer 

Xerox Ventura Publisher can print color documents directly on the 
Xerox 4020 Color Ink Jet Printer. Up to eight colors can be printed. 

Paper size 

Xerox Ventura Publisher can print to a Xerox 4020 Color Ink Jet 
Printer only on 81;2 inch width paper. 

Switch setti ngs 

The 4020 switch settings required for proper operation are shown in 
Figure F-S. 

/····1 OFF 

t 
ON 

7654321 4 3 2 1 

B A 

Figure F-5 Xerox 4020 switch settings. Settings are for parallel inteiface. 
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Resolution 

Xerox Ventura Publisher allows you to print both text and pictures on 
your Xerox 4020 Color Ink Jet Printer. Both text and pictures print at 
a resolution of 120 dots per inch. 

Limitations 

• You cannot create new colors by overlapping two transparent 
graphics or by defining new colors in the Define Color option. The 
colors will not mix. 

• The 4020 prints text, or lines drawn in the Graphic mode, in 100% 
of any color. It cannot print these objects in shades of gray or light 
shades of the selected color. 

• A maximum of 64 bit images is allowed per page, although memory 
will usually limit the number to fewer than 64. Only 8 bit images 
are allowed on any single scan line. 

HP LaserJet, LaserJet Plus, LaserJet II, LaserJet 2000 

Cabling 

F-8 

The first part ofthis section refers to all LaserJet printers. The last parts 
refer to the LaserJet only, or the LaserJet Plus/LaserJet Series 
II/LaserJet 2000 only. The LaserJet Series II functions identically to 
the LaserJet Plus, although it is capable of printing font sizes larger 
than 36 points. Neither the HP PaintJet color printer nor the DeskJet 
printer are supported by Xerox Ventura Publisher. 

The HP LaserJet is sold by Hewlett-Packard with a serial (25 pin) 
interface. The HP LaserJet Plus is sold with a serial or parallel (36 pin) 
interface. The cable required for the parallel interface is HP part 
number 24542D. The HP part number for the RS-232C serial cable is 
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Computer 25 pin to 25 pin 
Adaptor Cable 

Female Connector Male Connector 

Female Connector 

1 -

2-

3-

:-~--

Male Connector 

1 Chassis Gnd 

3 RO 

2 TO 

20 OTR 

Chassis Gnd 

TO 

RO 

CTS 

OSR 

OTR 20- - - - - - - - C-: ~:! 
Signal Gnd 7 - - 7 Signal Gnd 

Figure F-6 HP Laserjet 25 pin to 25 pin cable 

Computer 

Female Male Female Male 

9 pin to 25 pin 25 pin to 25 pin 
Adaptor Cable Printer Cable 

Female Male Female Male 

Chassis Gnd NC- 1 1 - 1 Chassis 

TO 3- 2 2 - 3 RO 

RO 2- 3 3 -- 2 TO 

CTS 8 -- 5 

:~ 
20 OTR 

OSR 6 6 

Gnd 

Signal Gnd 5- 7 7- 7 Signal Gnd 

Figure F-7 HP Laserjet 9 pin to 25 pin cable 
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part number 92219J (5 .0 meters) or 17255D (1.0 meter.) Connection 
of this serial cable to the IBM AT (9 pin) requires the IBM Serial 
Device Adapter Cable (IBM part number 6450217 or 6450242.) For 
the IBM AT (9 pin) you can alternatively purchase a single cable from 
Hewlett-Packard, part number 245420. 

If you want to build your own cables, Figures F-6 and F-7 show the 
correct wiring diagram for both PC (25 pin connectors) and AT (9 pin) 
machines 

Paper size 

Xerox Ventura Publisher and the HP LaserJet handles 8V2 X 11 inch, 
81/2 X 14 inch, and A4 (21.0 X 29.7 centimeters) paper. The LaserJet 
2000 supports B5 and double size. However, the LaserJet cannot print 
to the edge of the page. This means that text and pictures placed near 
the edge of the page will show correctly on the computer screen, but 
may not print as displayed. Also, the document may not be centered 
on the page due to manufacturing tolerances. To see the amount of 
blank space around the edge of the page on your printer, as well as the 
offset from center, print the CAPABILI.CHP chapter in the TYPE
SET directory. You can compensate for the offset by adjusting the left 
and right margins. You can avoid disappearing headers & footers by 
changing the above and below space for the header and footer tags. 

Resolution 

With all LaserJet models, text prints with a resolution of 300 dots per 
inch. With the standard LaserJet, pictures and graphics print with a 
resolution of75 dots per inch. With the LaserJetPlus or LaserJet Series 
II, pictures print with a resolution of either 150 or 300 dots per inch, 
depending on which Xerox Ventura Publisher option you installed. 
Text within line art pictures print at either 300 dots per inch, depending 
on the text size. 
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Standard HP LaserJet 

The standard HP LaserJet only prints Xerox Ventura Publisher docu
ments with the HP 92286F font cartridge installed. It does not accept 
the downloaded fonts that are included with Xerox Ventura Publisher 
for the LaserJet Plus or LaserJet Series II. The characters available 
with this cartridge are a subset of the standard Xerox Ventura Publisher 
font set shown in Appendix E. The actual characters available can be 
shown by printing the CHARSET chapter located in the TYPESET 
directory. The math symbol set is not included in this cartridge. 

HP LaserJet Plus/Series II 
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Fonts are loaded by Xerox Ventura Publisher into the HP LaserJet Plus 
as needed for each page. The space taken by these fonts decreases the 
space available for pictures. If a page contains many big pictures, and 
a large number of different fonts-especially larger size fonts-the 
LaserJet runs out of memory and displays error 20 in the status display. 
To continue printing, press the CONTINUE button on the front of the 
LaserJet, and place the printer back on-line, if necessary. The LaserJet 
attempts to print at least a portion of the page. Unless a similar problem 
exists on the following pages, the remaining pages should print cor
rectly. 

Once an error 20 has occurred, you must simplify the page that caused 
the problem in order to print the problem page. To simplify the page, 
do one or more of the following: 

1) Reduce the size or number of fonts used on the problem page 

2) Reduce the number or size of pictures on the problem page 

3) Add more memory to your printer. 

4) Make sure that no other program, run prior to Xerox Ventura 
Publisher, downloaded fonts and made them "permanent". If this is 
the case, these fonts, which are not used by Xerox Ventura Pub
lisher, reduce the LaserJet memory space available to print each 
page. To remove permanent fonts, tum off the LaserJet and then 
tum it back on again. 
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If you installed for 300 dots per inch, and you frequently encounter the 
error 20 message, you may want to install both the 150 and 300 dot per 
inch drivers (to install both drivers, run VPPREP-see Setup and 
Installation.) You can then choose the 150 dot per inch HP LaserJet 
Plus option in the Set Printer Info option and print the problem pages. 
This doubles the size of the graphic that can be placed on any given 
page before an error 20 message will occur. When the page has printed, 
you can go back to the Set Printer Info menu and choose the 300 dot 
per inch HP LaserJet driver. 

Permanent fonts 

You can choose to download fonts to the HP LaserJet Plus prior to 
running Xerox Ventura Publisher. This reduces printing time by elim
inating the need to transfer font files to the printer during the print 
operation. However, it does increase the chance of getting an out of 
memory error message. 

To make fonts reside permanently in the HP LaserJet Plus follow the 
instructions given for the LaserJet in Appendix K. 

LaserJet CNF file 

The HPLJPLUS.CNF file located in the VENTURA directory lets 
you customize font management for the HP LaserJet printers in the 
following ways: 

• You can place printer fonts in a directory other than VENTURA. 

• You can specify which fonts are to be downloaded by the 
HPDOWN utility (see Appendix K). 

• You can specify which fonts to use when using the LaserJet as a 
draft printer. 

A typical CNF file looks like this: 

downpath(D:\HPFONTS\) 
permfont(lHLVB3024.SFP) 
permfont (2 TMSB3012. SFP) 
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Fonts in other 
directories 

Download fonts 

Draft printing 

REFERENCE GUIDE 

permfont(3TMSB3014.SFP) 
permfont (4 TMSB3018. SFP) 
fontspec(HELVTINY,2,2,O,O) 
fontspec(HLVN3006,2,6,O,O) 
fontspec(HLVN3008,2,8,O,O) 
fontspec(HLVB3008,2,8,1,O) 
fontspec(HLVN3010,2,lO,O,O) 
fontspec(HLVB3010,2,lO,1,O) 
fontspec(HLVI3010,2,lO,4,O) 

Do not place any spaces within the CNF file. 

The down path command lets you place all fonts for your printer in 
any directory. The example above shows the syntax you should use to 
place fonts in the D:\HPFONTS directory. All fonts must be placed in 
the directory you specify (any fonts in the VENTURA directory are 
ignored). 

You can "permanently" download fonts (until the printer is turned off) 
to improve printing speed. The fonts which you download must be 
placed in the CNF file following the permfont command. This proce
dure is described in more detail in Appendix K under the Adding New 
Fonts to the HPLaserJet heading. 

You can use the LaserJet printer to produce draft copy of documents 
which will ultimately be printed on a typesetter or other printer. If you 
use the width table for the ultimate device but print directly to the 
LaserJet, each line will end at the correct location and the amount of 
text on each page will match the ultimate printout. However, Swiss 
(Helvetica) and Dutch (Times Roman) typefaces will be substituted 
for the fonts used on the ultimate printer/typesetter. 

If you have purchased fonts for the LaserJet which are similar to those 
used on your ultimate printer/typesetter, you can use your fonts to 
provide draft copy which more closely matches the appearance of the 
final copy. Follow the steps provided in Appendix K for adding fonts 
to your HP LaserJet printer. Then, modify the CNF file by adding a line 
similar to the following, for each font: 

fontspec(fontfile,ID,size,attrb,O) 

where: 
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fontfile is replaced with the name of the HP LaserJet font file. 

ID is replaced with the typeface ID used for the font you are trying to 
match. You must know the font ID for the font on your ultimate printer. 
For many common fonts, the ID numbers shown in the table near the 
end of Appendix K will work. 

size is replaced with the point size of the font you are trying to match. 

attrb is replaced with the attribute number as follows: l=medium; 
2=bold; 5=italic; 6=bold italic. 

The example given on the previous page shows the typical format. 

Limitations 

The LaserJet printers all have the following limitations: 

• They cannot print both portrait and landscape fonts on the same 
page. Therefore, the rotated text feature (Alignment option) cannot 
be used with LaserJet printers. 

• They cannot print white text on a black background. 

• A maximum of 64 bit images is allowed per page, although memory 
will usually limit the number to fewer than 64. Only 8 bit images 
are allowed on any single scan line. 

• The LaserJet Plus cannot print text larger than 36 points. The 
LaserJet Series II does not have this limitation. 

• The LaserJet printers cannot print opaque images which obscure 
the text or pictures below. 

• The LaserJet prints text, or lines drawn in the Graphic mode, in 
100% black only. It cannot print these objects in shades of gray. 

• More than 512K memory may be required to print pages which 
contain a large number of fonts. 
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JLaser 

The Tall Tree System's JLaser board plugs into your computer and 
allows you to print Xerox Ventura Publisher documents on laser 
printers not specifically supported by Xerox Ventura Publisher. You 
must place the !E=O switch in the VPPROEBAT file if you use the 
Jlaser card with the Professional Extension to Xerox Ventura 
Publisher. See the last page of Appendix A for more details. 

Paper size 

The JLaser can print on paper up to 8V2 X 14 inches. 

Resolution 

Fonts 

Text and pictures print with a resolution of 300 dots per inch. 

Additional type sizes and type faces can be added by using fonts for 
the HP LaserJet. See Appendix K. 

If you add more than ten fonts to the JLaser, increase the buffers 
statement in the CONFIG.SYS file to BUFFERS=30. 

JLaser limitations 
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• The JLaser cannot print fonts larger than 30 points. 

• The JLaser card creates each page in an un-compressed, bitmap 
format. This means that each page is represented by a one megabyte 
file which is transferred directly from the JLaser card to the printer 
at extremely fast, video speeds. While this results in very fast 
printing, the fact that each page takes up one megabyte makes 
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storage of each page on disk impractical. Therefore, no Print To File 
option is available for the JLaser card. 

• The JLaser prints text, or lines drawn in the Graphic mode, in 100% 
black only. It cannot print these objects in shades of gray. 

• The JLaser card requires that certain jumpers on the card be in
stalled correctly. Contact Tall Tree Systems in Palo Alto, California 
for more infonnation on how to reconfigure the JLaser card to 
avoid these problems. 

Dot matrix printers 

F-16 

Xerox Ventura Publisher supports the Epson MX-80, FX-80, and 
RX-80 dot matrix printers, IBM Proprinter, Epson LQ 1500, and 
Toshiba dot matrix printers, plus other printers which can emulate 
these 9 and 24 pin printers. 

Paper size 

Xerox Ventura Publisher can print to a dot matrix printer on 8 V2 X 11 
inch paper. Dot matrix printers having a larger width paper capacity 
can also be used. 

Resolution 

Xerox Ventura Publisher allows you to print both text and pictures on 
your dot matrix printer at a resolution of 120 X 144 dots per inch for 
the 9 pin printers and 180 x 180 dots per inch for the 24 pin printers. 

Limitations 

• Fewer fonts are available for dot matrix printers than laser printers. 
The Paragraph Font menu shows you the fonts available. 
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• For Epson MX and compatible printers (120 x 144 dpi) he font 
height is different when text is printed in landscape rather than 
portrait. 

• Dot matrix printers print text, or lines drawn in the Graphic mode, 
in 100% black only. They cannot print these objects in shades of 
gray. 

• A maxim um of 64 bit images is allowed per page, although memory 
will usually limit the number to fewer than 64. Only 8 bit images 
are allowed on any single scan line. 

Interpress 2.0 printers include the Xerox 4050, 8700 and 9700 printers. 
To print to these printers, print your document to a file, then send them 
via Ethernet or XC-80 to the printer using your network software. 
XC-80 is also known as XNS. The exact instructions are as follows: 

1) Print the chapter to a file name. Give the print file the same name 
as the chapter and give it the extension IP. 

2) Quit from Xerox Ventura Publisher. 

3) Copy the Interpress print file to the location and disk which 
XPRINT uses for its print files. Normally XPRINT looks for the 
interpress master print file to be named XPRINT.IP, located in the 
root directory of the drive on which the network is installed. Thus 
you may need to rename to XPRINT.IP after the file is copied. 

4) Print the file by issuing the command: 

XPRINT -M Enter 

You should install the maximum graphic memory available for your 
Interpress printer if you plan to print large image files from Xerox 
Ventura Publisher. 

Interpress printers can print virtually to the edge of the page. 

Networked version of the 4050, 8700, and 9700 printers require 
Formatting Print Service (FPS). 
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If your Interpress printer produces a Page Too Complex message, you 
must simplify the page by turning off letterspacing, kerning, and 
tracking for Body Text and all other tags used frequently throughout 
your document. 

Limitations 

Interpress printers have the following limitations: 

• They cannot print white text on a black background 

• Interpress printers print text, or lines drawn in the Graphic mode, in 
100% black only. They cannot print these objects in shades of gray. 

• They cannot print opaque images which obscure the text or picture 
underneath. 

PostScript 
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Xerox Ventura Publisher can print on various PostScript printers and 
typesetters. PostScript printers include the Apple LaserWriter, 
LaserWriter Plus, and LaserWriter NT; TI Omnilaser; DEC 
PrintServer40, IBM 4216 printer; QMS PS 800,1200, and 2400 laser 
printers; and the Linotype Linotronic 100,300 typesetters. Many other 
PostScript printers and typesetters are available. 

Resolution 

Text and graphics print at different resolutions, depending on the 
capability of the specific device. For instance, you will get 300 dots 
per inch resolution with the laser printers listed above, 1270 dots per 
inch for the Linotronic 100, and 2540 dots per inch for the Linotronic 
300. 
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Only the fonts which are stored permanently in your printer can 
initially be printed by Xerox Ventura Publisher. For most PostScript 
printers this includes: 

• Helvetica 

• Times Roman 

• Symbol 

• Courier 

• Avant Garde 

• Bookman 

• Century Schoolbook 

• Helvetica Narrow 

• Palatino 

• Zapf Chancery 

• Zapf Dingbats 

However, the font menu for PostScript shows a much larger selection. 
You can print other fonts shown in the PostScript font menu if you 
purchase new fonts from Adobe Systems. These fonts are then 
downloaded to the printer as described in Appendix K. 

Whenever possible, connect your PostScript printer or typesetter using 
a Centronics-type parallel cable. 

The IBM 4216 uses its own special cable. 

If your PostScript printer or typesetter must be connected using an 
RS-232C cable, you should use the same cable used for HP LaserJet. 
This cable can be purchased from Hewlett-Packard. The HP part 
number for the RS-232C serial cable is part number 92219J or 
17255D. Connection of this serial cable to the IBM AT (9 pin) requires 
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the IBM Serial Device Adapter Cable (IBM part number 6450217 or 
6450242.) Some devices (such as the Linotronic typesetters) may 
require a different sex connector at the printer end than provided with 
the HP cable. In this case you must build your own cable. 

If you want to build your own cables, Figures F-6 and F-7 show the 
correct wiring diagram for both PC (25 pin connectors) and AT (9 pin) 
machines. 

If the cable is not wired correctly, you will get an error message on 
your computer screen when you attempt to print. 

The LaserWri ter contains a mode switch on the side of the printer. This 
should be set to 9600 baud if you connect this printer using an 
RS-232C serial cable. 

Printing to a file 

You may find it useful to print to a disk file and then later send this disk 
to the printer or typesetter. The method for doing this is covered in the 
Set Printer Info section of the Menu Commands chapter. 

PostScript CNF file 

The POSTSCPT.CNF file located in the VENTURA directory lets 
you customize PostScript printer operation in the following ways: 

• You can place downloadable fonts in a directory other than 
PSFONTS. 

• You can change the end of file marker to make PostScript files 
compatible with various Apple networks. 

• You can trade off printing speed for PostScript file size if you plan 
to print to a file and then send these files to an outside typesetting 
service. 

• You can specify which fonts to use when using your PostScript 
printer as a draft printer. 
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A typical PostScript CNF file looks like this: 

psfonts(C:\PSFONTS\) 
eoftype(PC) 
imgtype(FAST) 
font (AvantGarde-Book,51,M,TEXT,RES) 
font(AvantGarde-BookOblique,51,I,TEXT,RES) 
font (AvantGarde-Demi,51,B,TEXT,RES) 
font (AvantGarde-DemiOblique,51,BI,TEXT,RES) 
font (Bookman-Light, 23,M,TEXT,RES) 
font (Bookman-LightItalic,23,I,TEXT,RES) 
font (Bookman-Demi,23,B,TEXT,RES) 
font (Bookman-DemiItalic,23,BI,TEXT,RES) 
font (ZapfChancery-MediumItalic,29,I,TEXT,RES) 
font (ZapfDingbats, 129,M,PI,RES) 

Do not place any spaces within the CNF file. 

Fonts in other 
directories 

Standard fonts, such as Helvetica and Times Roman are resident in all 
PostScript printers. However, Xerox Ventura Publisher allows you to 
use additional fonts which are stored on the computer hard disk. (See 
Appendix K, and see the Add/Remove Fonts option.) These fonts 
should be stored in a directory called PSFONTS (for PostScript.) If 
you want to place these fonts in a different directory, use the ASCII 
text function of your word processor to modify the POSTSCPT.CNF 
file in the VENTURA subdirectory. 

For instance to place PostScript fonts in a directory called 
MYFONTS, modify the POSTSCPT.CNF file to read: 

psfonts(C: \MYFONTS\) 

~ If your printer has enough memory, download the fonts before running 
Xerox Ventura Publisher, and then use the Add/Remove Fonts option 
to change the width table for each of these fonts from Download to 
Resident. This will dramatically improve print speed. See Appendix K 
for more details. 
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All fonts must be placed in the directory you specify (any fonts in the 
VENTURA directory are ignored). 

F-21 



APPENDIX F-PRINTER INFORMATION PostScript 

Printing over an 
Apple network 

Reducing 
PostScript file 
size 

Draft printing 
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If the PostScript file is to be printed via an Apple network, use the 
ASCII function in your word processor to modify the 
POSTSCPT.CNF file, located in the VENTURA directory. Change the 
line which says: 

eoftype(PC) 

to: 

eoftype(MAC) 

This suppresses the printing of AD characters which are read by Apple 
network software as an end of file character. The POSTSCPT.CNF file 
must be modified prior to printing the PostScript file. 

PostScript files can become quite large when printing pages which 
contain images. To reduce the size of this type of PostScript file, use 
the ASCII function of your word processor to replace the line which 
reads: 

imgtype(FAST) 

with 

imgtype(COMPACT) 

It may take much longer to print this file, but the file will usually be 
smaller. 

You can use your PostScript printer to produce draft copy of docu
ments which will ultimately be printed on a non-PostScript typesetter 
or other printer. If you use the width table for the ultimate device but 
print directly to your PostScript printer, each line will end at the correct 
location and the amount of text on each page will match the ultimate 
printout. However, Helvetica and Times Roman typefaces will be 
substituted for the fonts used on the ultimate printer/typesetter. 

If you have purchased PostScript fonts which are similar to those used 
on your ultimate printer/typesetter, you can use your fonts to provide 
draft copy which more closely matches the appearance of the final 
copy. Follow the steps provided in Appendix K for adding fonts to 
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your PostScript printer. Then, modify the CNF file by adding a line 
similar to the following, for each font: 

font(fontname,ID,style,char,res) 

where: 

fontname is replaced with the downloadable PostScript font name. 
You can find this name in the PFA or PFB font file near the beginning. 
Use the DOS TYPE command to type this file to the computer screen. 
You will find the name of the font directly following the word 
FontName. 

ID is replaced with the typeface ID used for the font you are trying to 
match. You must know the font ID for the font on your ultimate printer. 
For many common fonts, the ID numbers shown in the table near the 
end of Appendix K will work. 

style is replaced with the style as follows: M=medium; B=bold; 
I=italic; BI=bold italic. 

char is replaced with either the word TEXT or PI. Use PI only for 
typefaces which do not use the standard international character set 
(e.g., Dingbats). Use TEXT for all other fonts. 

res is replaced with either the word RES or DOWN:fontfile. If the 
font is residend in the printer, enter RES. If the font resides on your 
computer's hard disk, type DOWN:fontfile and replace fontfile with 
the DOS file name of the font file you want Xerox Ventura Publisher 
to download. 

The example given on the page K-21 shows the typical format. 

OTR handshaking 
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When copying files from DOS to PostScript printers or typesetters, 
you must first insert the Utilities Disk into the A drive and then type 
the following command directly from the DOS prompt: 

COPY A: \POSTSCPT\DTR . TXT LPT1: Enter 
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DTR.TXT is a file contained on the Xerox Ventura Publisher Utilities 
disk in the POSTS CPT directory. Once this file is transmitted, it does 
not ever need to be re-transmitted unless another program resets your 
printer. It remains in the printer, even when power is turned off. 
Sending this file to the printer or typesetter does not affect the opera
tion of Xerox Ventura Publisher. 

PostScript prologue 

At the beginning of every PostScript print operation, Xerox Ventura 
Publisher sends subroutines (prologue) to the printer. These subrou
tines are contained in the file called PS2.PRE. Advanced users may 
want to load these subroutines permanently into the printer or typeset
ter and thus avoid the time required to load the prologue at the 
beginning of each print job. To do this: 

1) Copy the file called PERMVP.PS (which contains the permanent 
version of these subroutines) from the POSTSCPT directory on the 
Utility Disk to the VENTURA directory. 

2) Download this file to your printer by using the DOS COPY com
mand as described in the Set Printer Info option for the DTR. TXT 
file. Unlike DTR.TXT, however, this file must be downloaded each 
time your printer is turned on. 

3) Delete the PS2.PRE file from the VENTURA directory, or rename 
it to any other name. 

~ When creating PostScript files (by printing to a file) to be printed on 
another printer or typesetter, always include the prologue (i.e., do not 
delete the PS2.PRE file.) 

Special effects 

You can create special effects such as outline fonts by replacing the 
PS2.PRE file with a different PS2.PRE file located on the Utilities 
disk. To install the special effects file: 

1) Locate the Utilities Disk. 

2) Delete the PS2.PRE file 
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3) Copy the file PS2.EFF to the VENTURA directory and rename it 
at the same time as follows (assuming Xerox Ventura Publisher is 
installed on the C drive): 

COPY A:\POSTSCPT\PS2.EFF C:\VENTURA\PS2.PRE 

Once installed, select color #7 (the color at the bottom of the Color 
setting in the font options) for any font to create an outline. Other color 
settings may produce other special effects. 

The colors defined in the Define Colors option do not change the 
special effect. Also, special effects do not display on the screen. 

If you are familiar with the PostScript language, you may modify the 
PS2.EFF file to create your own special effects. 

A version of PS2.EFF which can be downloaded to the printer perma
nently is contained in the file called PERMVP.EFF. Copy this file to 
the printer as described prev'iously for PERMVP.PS and then delete the 
PS2.PRE file. Like PERMVP.PS, the PERMVP.EFF file stays in the 
printer only until the printer's power is turned off. 

Limitations 

Ruling line 
around images 

Transparent 
graphics 

IBM 4216 

PostScript bug 
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PostScript cannot print transparent overlapping graphics. This means 
that if one graphic overlaps another, the graphic on the bottom will 
always be completely obscured. 

Because PostScript cannot print transparent overlapping graphics, a 
ruling box around an image will not print. The solution is to set the 
frame margins equal to the overall ruling box height. 

The IBM 4216 laser printer requires DOS version 3.3 or above. 

Version 23 of PostScript implemented for the Apple LaserWriter 
below version 2 had a communications handling error described by 
Adobe Systems Incorporated as follows: 

"During serial input, if the input buffer becomes full and the Apple 
LaserWriter sends XOFF to stop transmission from the host, it occa-
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sionally fails to send XON to restart transmission ... This bug occurs 
only under unusual circumstances that are difficult to describe ... " 

This bug does not generally manifest itself on small jobs consisting of 
several pages. However, when more than twenty pages are printed as 
a single job, the computer may lock up. Reason: the PC will be waiting 
for the LaserWriter to indicate that it is ready for input, but the 
LaserWriter will believe it has already made that indication. 

Adobe Systems, Incorporated has released a downloadable patch 
which fixes this bug. The patch is provided in the file called PSt.PRE. 
This file is contained in the Utilities Disk in the POSTSCPT directory. 
To use this patch, simply copy this file from the Utilities Disk to the 
VENTURA directory. Xerox Ventura Publisher automatically sends 
this patch to the printer each time you print a chapter. 
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PICTURES 

This appendix describes limitations inherent in the process of convert
ing from a variety of different graphic formats into Xerox Ventura 
Publisher's internal graphic format. This chapter also includes other 
important information about pictures. 

AutoCAD pictures 

CGM 

DXF 
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Xerox Ventura Publisher converts slide files from AutoCAD. 
AutoCAD SLD files are created using the AutoCAD ADE-2 (Ad
vanced Drafting Extension) package. The AutoCAD MSLIDE com
mand is used. The use of this command is covered in the AutoCAD 
User Reference manual. Look in the AutoCAD Reference Manual 
index under Slides. Better resolution can be obtained by converting 
AutoCAD files to HPGL. 

Xerox Ventura Publisher converts CGM files. Key features and limita
tions include: 

• All typefaces are converted to Helvetica 

• Color is converted 

• Pattern fills are converted based on the GSS CGI definition. 

AutoCAD and other CAD programs store files in DXF format (Draw
ing Interchange Format.) To convert these files to GEM format, which 
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EPS 
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can be read by Xerox Ventura Publisher, use the DXFTOGEM utility. 
This utility is contained in the Utilities Disk. To convert a file, insert 
the Utilities Disk into the A drive and type the following: 

A: DXFTOGEM filename Enter 

If the filename has no extension, the extension DXF is assumed. 

A file with the same name but with the extension GEM is created. This 
file can then be loaded as a line art GEM file using Xerox Ventura 
Publisher's Load Text/Picture option. 

The following DXF attributes are not converted: 

• Shape entity 

• Text mirroring 

• Tapering widths in polylines 

• Underscore and overscore in text strings 

• Text expansion factors 

• Backward text obliquing and arbitrary forward obliquing 

Symbol characters (e.g., plus/minus, circle dimension) in text 
strings 

• Curve fitting 

• 3D rendering 

• Ellipses which are not X-Y aligned 

Xerox Ventura Publisher converts EPS files. Key features and limita
tions include: 

• EPS files will display on screen if the EPS file includes either a 
TIFF image or Windows metafile description of the PostScript 

image. Otherwise, a large X is placed in the frame. 

• EPS files can only be printed to PostScript printers. However, if the 
EPS file includes either a TIFF image or Windows metafile de scrip-
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HPGL 
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tion of the PostScript image, then this image will print to non-Post
Script printers. The resolution of this image depends on the quality 
of the TIFF or Windows representation. 

• Any single page printed to a disk by Xerox Ventura Publisher using 
the PostScript printer driver can be read back into a frame using the 
Load Text/picture EPS option. However, this file is not a true EPS 
file and therefore cannot be read by other programs which read EPS 
files. Files printed with the Page Size & Layout option set to 
Landscape cannot be read back into a frame within a chapter with 
the Page Size & Layout option set to Portrait. 

• When generating print files from Xerox Ventura Publisher to be 
read by the EPS converter, you can create smaller files if you 
temporarily rename or remove the PS2.PRE file contained in the 
\ VENTURA directory. Remember to put this file back before print
ing to the printer. 

A PostScript file must be specifically made into an Encapsulated 
PostScript file. The rules for converting PostScript files can be ob
tained from Adobe Systems Technical Support. Write: 

Technical Support 
Adobe Systems 
1870 Embarcadero Road 
Palo Alto, CA 94303 
USA 

Xerox Ventura Publisher converts HP 7470 and HP7475 HPGL files. 
Other plotter files may not work. 

HPGL files are generated in most applications by choosing to print to 
an HP plotter and then printing to a file. Key features and limitations 
include: 

• Arcs, lines, and text are converted 

• Text size is converted 
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• If you don't want an HPGL picture rotated, select a different 
orientation from within the graphics program before generating the 
HPGL file. Page rotation is not supported. 

• Color is not converted. 

• Fonts are all converted to Helvetica. 

• Filled areas are made up of vectors, so it is possible that gaps will 
appear in the fill patterns. You may also see rounded ends on lines 
if you enlarge the picture. Therefore, if at all possible, enlarge the 
picture within your external graphics program before saving as an 
HPGLfile. 

Lotus 1·2·3 pictures 

Lotus 1-2-3 .PIC files are created using the 1-2-3 SAVE option, which 
is found in the 1-2-3 Print menu. Within 1-2-3, the keystrokes required 
once a graph has been created on the screen, are: 

/GS filename 

Filename is replaced by the name of the 1-2-3 picture file you wish to 
create. 

Macintosh Paint 

Xerox Ventura Publisher converts Macintosh Paint files. Transfer files 
from the Macintosh to the PC using a network or communication 
program. Features and limitations include: 

• Pictures always transfer as a full 8 x 10 page. Therefore, a small 
image on a white page must be enlarged considerably within the 
frame. 
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Macintosh PICT 

Xerox Ventura Publisher converts Macintosh PICT files. Transfer files 
from the Macintosh to the PC using a network or communication 
program. Features and limitations include: 

• Bit images within PICT files do not convert 

• Text fonts are usually converted into Times Roman. They some
times convert into Helvetica. 

PC Paintbrush pictures 

PC Paintbrush files are created using the Save as option in PC 
Paintbrush. These files are stored with the extension PCX. 

• Color is not converted from PC Paintbrush pictures. 

Video Show 

Xerox Ventura Publisher converts General Parametric Video Show 
files. Key features and limitations include: 

• Only 7-bit (not 8-bit) pictures are converted. 

• Color is not converted. Color is instead turned into shades of gray. 

• The 3D bar function is not implemented. 

Text to PCX conversion 
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Any text file of up to twenty-five lines or less can be converted to a 
graphic PC Paintbrush file. This file can then be loaded as a PC 
Paintbrush image file and placed in a frame. This utility is used to print 
the computer screen as you see it, complete with ruling lines and other 
text effects which don't normally print when importing text data from 
the screen into programs like Sidekick. 
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To convert a text file that has been captured from the screen using 
Sidekick or some other background utility, and save to a file, type the 
following: 

TXTTOPCX filename /% Enter 

where filename is replaced with the name of the file to convert, and % 
is replaced with the type of display in use 

EGA with Enhanced Monitor use: . . . 
EGA with Monochrome Monitor use: 
Color Card or EGA with Color Monitor use: 
AT&T 6300 or Xerox 6065 use: 

A file with the same name but an extension of PCX is converted. 

This utility does not work with a Hercules card. 

~ Reverse video and boldface text are not converted by this utility. 

Windows Clipboard Converter 

.c 

.M 
o 
A 

Many Windows applications can create a WMF metafile which Xerox 
Ventura Publisher can read directly using the Windows selection in 
the Load Text/Picture option. 

If your Windows program cannot create WMF metafiles, Xerox Ven
tura Publisher includes a Windows Clipboard converter which saves 

n .... nUi.''3U!I_ii .. 
File Uie" Special 
A~UIIICIIID~ E~ F~ G~ U~ W~ X~ 
Y~Z~ 
C:TEST SYSTEM \WINDOWS 
PIF MODERIf.FOIf 
ABC. TXT MSDOS.EXE 
CALC .EXE NOTEPAD .EXE 
CALElfDAR .EXE PAllfT .EXE 
CHART. DP PRACTI CL WR I 

'~IW~IN~ :~m~i ~~~E 
CLOCK. EKE ROMAN. FOIf 
COlfTROL.EXE SCRIPT .FON 
COURA.FOIf SYMBOLS.DP 
COURB .FOIf TMSRA .FOIf 
DOTHIS. TXT TMSRB .FOIf 
FLOWCHRT .DP WIIf.COM 
HELPMLDOC WIIf.Ilfl 
HELUA.FOIf Wltl11l1l.BIIf 

~~~~~N~~lfm ~m~~~.;gu~QR 

Figure G-J Run the CLJP2VP program from the Windows screen. 
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INSTINCT • 
File Edit Draw Text 

CLIPBOARD FORMAT 
II • 

1~~~~~h~~~~aGitmap ~ 
¥~~t?~CT Format 

Figure G-2 Select the Windows Metafile Format, if your program provides 
an option. 

o 

Figure G-3 Cut or copy the drawing to the clipboard 

Figure G-4 Expand the CLIP2VP icon. 
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Installation 

Operation 
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Figure G-5 Save the file. 

to disk any metafile which has been Cut or Copied to the Windows 
clipboard. (Note: neither Windows Paint nor any other image files can 
be brought into Xerox Ventura Publisher). 

To install the Windows clipboard converter: 

1) Copy the CLIP2VP.EXE program from the Utilities disk to the 
WINDOWS directory. For example, to copy to the WINDOWS 
directory on the C: drive type: 

2) COpy A: CLIP2VP . EXE C: \ WINDOWS 

The following steps show how to bring pictures into Xerox Ventura 
Publisher from any Windows application which can cut line art 
metafiles to the Windows clipboard. These instructions assume you 
are familiar with Microsoft Windows, and that Windows is installed in 
the WINDOWS directory. 

1) Start Windows. 

2) Run the CLIP2VP program from the Windows screen (see Figure 
G-l). 

3) Shrink the CLIP2VP program into an ICON at the bottom of the 
screen. 

4) Run the Windows application from which you will obtain the 
picture to be used in Xerox Ventura Publisher. If your application 
allows different clipboard formats, make sure that the Windows 
Metafile format is selected (see Figure G-2). 
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5) Create the drawing. Then select a portion (or all) of the drawing and 
Cut or Copy the drawing to the clipboard (see Figure G-3). 

6) Expand the CLIP2VP icon (see Figure G-4). 

7) Choose the Command Save As .•.. Type the name of the file under 
which you wish to save this file. The extension WMF will automat
ically be appended to the file name (see Figure G-5). 

8) Close the Windows drawing application and close the CLIP2VP 
application. 

When you are finished creating pictures, Run Xerox Ventura Publish
er, either from Windows (the PIF file must be installed) or from the 
DOS prompt. Load the Windows Metafile (WMF file) you just 
created. Follow the procedures for loading Line Art given in the Menu 
Commands section of this manual. 
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APPENDIX H 
APPLICATION NOTES 

Publishing a database 

This application note describes how to extract, pre-format, and ul
timately publish information from a database program. 

Example: phone directory 

Example 
database 
structure 
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This example assumes some knowledge of dBase III, although the 
concepts apply to any database program. 

Suppose you want to publish a phone directory using information from 
a dBase III database. This simple directory contains last name, first 
name, and phone number. A typical structure for such a database is 
shown below. 

Field Field name T~12e Width 

1 DATE Date 08 
2 COMP_NAME Character 31 
3 MISTER Chara<;:ter 04 
4 FIRST_NAME Character 12 
5 LAST_NAME Character 12 
6 TITLE Character 25 
7 ADDRESS Character 34 
8 CITY Character 20 
9 STATE Character 02 

10 ZIP Character 06 
11 PHONE Character 12 
13 COMP_TYPE Character 15 
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To publish a directory from the data in this database, create a style 
sheet with three tag names: Body Text, FN, and Phone. Set page 
layout to single sided. The relevant settings for each of these three tags 
is shown below: 

Bod~ Text Font 10 ~oint, bold 

Alignment Left, Hyphen off 
Spacing Inter-line and Inter-

paragraph: I pica 
Break Line Break Before 

FN Font 10 ~oint, normal 

Alignment Left, Hyphen off 
Spacing Inter-line and Inter-

paragraph: 1 pica 
In From Left: 1 inch 

Break No Line Break 

Phone Font 1 0 ~oint, normal 

Alignment Right, Hyphen off 
Spacing Interline and Inter-

paragraph: 1 pica 
Break Line Break After 

Extracting the data 

The dBase III LABEL command can be used to: 

• Extract the information from this database 

• Insert the FN and PHONE tags 

• Save the resulting information into an ASCII text file 

You can also create your own custom program file as shown later in 
this section. 
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The following assumes some familiarity with dBase III, and assumes 
that the database has already been created with the structure shown 
above. 

First, generate a dBase label file called PHONEGEN by typing: 

modi label phonegen 

On the first page of the label form, enter the following values: 

Width of label: 80 
Height of label: 3 
Left margin: 0 
Lines between labels: 0 
Spaces between labels: 0 
Number of labels across: 1 

On the second page of the label form, enter the following values: 

1 trim (last_name) +' " 
2 '@FN = '+trim (first_name) 
3 '@PHONE = '+trim (phone) 

Save the label by pressing and holding the Ctrl key and then pressing 
W. 

Next, either index or sort the database on the field last_name. 

Finally, to create an ASCII text file called PHONEl.TXT that can be 
read directly by Xerox Ventura Publisher, type the following com
mand: 

. label form phonegen to phonel 

Read the file PHONE1.TXT into Xerox Ventura Publisher as a 
Wordstar file. Load the style sheet you created earlier. The phone list 
will already be formatted and ready to print. 

H-3 



APPENDIX H-APPLICATION NOTES Custom dBase code 

Custom dBase code 

The following is an example of custom dBase code which extracts text 
from the same database structure given in the previous example. The 
purpose of this code is to generate a mailing label list. Each mailing 
label is one paragraph, with separate lines separated by line breaks, 
i.e., <R>. Excess spaces are trimmed, and blank fields are taken out. 

USE TEMP 
SET ECHO OFF 
SET TALK OFF 

One unique feature of this program is that it places a null paragraph 
tagged with a tag called LBL HEIGHT in front of each label. The 
purpose of this tag is to control the height of the label independent of 
the number of lines in the label. This is very useful when you print to 

INDEX ON COMP NAME+LAST NAME TO TEMP 
- -

GO TOP 
SET ALTERNATE TO TEMP 
DO WHILE. NOT. EOF () 

X=' , 
SET ALTERNATE ON 

? ' @LBL HEIGHT = ' 
SET ALTERNATE OFF 
IF LAST NAME<>' , 
X=TRIM(MISTER)+' , +TRIM(FIRST_NAME) +' '+TRIM(LAST_NAME)+'<R>' 

ENDIF 
IF TITLE<>' , 
X=X+TRIM(TITLE)+'<R>' 

ENDIF 
IF COMP NAME<>' , 
X=X+TRIM(COMP_NAME)+'<R>' 

ENDIF 
X=X+TRIM(ADDRESS)+'<R>'+TRIM(CITY)+', , +TRIM(STATE) +' '+TRIM(ZIP) 
IF COUNTRY<>' , 
X=X+' <R>' +TRIM(COUNTRY) 

ENDIF 
SET ALTERNATE ON 
?X 
SET ALTERNATE OFF 

SKIP 
ENDDO 
CLOSE ALTERNATE 
SET TALK ON 

Figure H-i Custom dBase ill code to print data in Xerox Ventura Publisher format. 
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self-adhesive label sheets. You can purchase, for instance, 8 1/2 x 11 
label sheets with three columns of one inch labels. If you want to start 
the printing on each label starting 0.1 inch from the top of the label, 
create a style sheet as follows: 

1) Select Frame mode. 

2) Select the Margins & Columns menu. 

3) Set one columns, and 0.00 for top, bottom, left, and right margins. 

4) Select Paragraph mode. 

5) Use the Add New Tag function to create a tag called 
LBLHEIGHT. 

6) Set this tag's Above space to 0.1 inch and set its below space to 0.9 
inch (Spacing option). 

7) Set Line Break Before, Keep With Next Yes (Breaks option). 

8) Select a Body Text paragraph. 

9) Set Body Text Line Break to After. 

10) Set a small amount (e.g., 6 points) for Body Text In From Left and 
In From Right spacing (Spacing option). This will move the text 
away from the edge of the label. 

11) Set Body Text Font and Interline spacing so that 4-5 lines of text 
can be placed on the label. 

The text created by this program and formatted by this style sheet will 
always begin each label 0.1 inch from the top of that label, regardless 
of whether the previous label contained 1, 2,3,4, or 5 lines. 

Printing large databases 

Large databases may cause Xerox Ventura Publisher to reach its 
paragraph or line element limitations. To increase the size of the 
document which can be produced without reaching these limits and to 
decrease loading time, you should use line breaks (created with the 
<R> code) to separate fields which appear on different lines, but which 
are formatted with the same typeface. 

~ When publishing a database, use line breaks instead of paragraphs to 
create new lines whenever possible. 
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Tabs 

Note, however, that a paragraph can be no longer than 8,000 bytes, and 
the practical limit is closer to 4,000 bytes, so you will need to place a 
carriage return-line feed combination at frequent intervals. 

The &LSTG-P2.CHP example in Appendix L provides a simple 
example of a product listing which uses line breaks instead of carriage 
return-line feeds to separate paragraphs. 

The general rule of thumb is that a line break should be used, when 
publishing a database, between any two lines which are typo
graphically identical. 

Another technique for separating fields in a database is to use tab 
characters between fields. This is especially useful for inserting 
leaders between fields, for example: 

Smith, John 
Turner, Fred 

(408) 555-1234 
.(408) 555-1111 

Tabs should be used sparingly, however, because they consume 
memory. If too many tab characters are used, you may encounter the 
following error message: 

This frame is too complex to completely format. Try 
splitting it into two frames or reducing the number of 
columns, tabs, leaders, and lines of text. 

If you cannot create the document with fewer leadered tabs and if you 
cannot increase the space between lines, then: 

1) Draw frames on the page on top of each but the first column. If your 
document is only one column then draw a frame across the bottom 
half of the page. 

2) Place text onto the page. 

3) Select the first frame you drew. 
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4) Select the same file name that you placed into the page. This will 
continue the text from the page into this frame. 

5) Make the selected frame a repeating frame. 

6) Select the next frame, and repeat steps 4 and 5 for each frame that 
you drew in step 1. 

These frames will automatically repeat on each page until the entire 
text file has been placed in the document. Some text must still flow 
into the page in order to force Xerox Ventura Publisher to automat
ically create new pages. 

The Professional Extension to Xerox Ventura Publisher uses EMS 
memory to increase dramatically the size and complexity of the docu
ment that can be created with being restricted by these limits. 
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GLOSSARY 

ASCII Text Files. American Standard Code For Information Inter
change. ASCII text is stored in exactly the same order as you see it on 
a printed page, with no additional characters added or deleted. ASCII 
files are often called "print" files. 

Ascender. The part of a lower case character which rises above the 
height of the lower case "x." 

Assignment List. The list of files, tags, or attributes that can be 
transferred to the selected frame, paragraph, or selected text. Shown in 
the Side-Bar on the left side of the screen. 

Attribute. Any style used to enhance readability of text. Typical 
attributes include boldface, underline, and italic. Font changes as
signed to selected text are also considered attributes. Examples of 
these font attributes include 14 point, blue, and kern. 

Baseline. An imaginary line on which type rests. Descending charac
ters hang below the baseline. 

Binding Margin. The additional space added to the side of the page 
that will be drilled or punched prior to insertion into a binder. Use 
different margins for left and right pages to create binding margins. 

Body Text. The text of the main part of the document. 

Box Text. Box created using the Graphic mode which contains text. 
Box text does not flow around frames, and can have graphics (e.g., 
arrows) directly attached to it. Use box text for tables and callouts. Use 
frames containing text files for newspaper-type make-up. 

Break. An interruption in the flow of text from one paragraph to the 
next. Normally each paragraph continues directly below the previous 
paragraph or, if no more room is left on this column or page, it 
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continues at the top of the next column or page. This is called a line 
break. If a paragraph always begins at the top of a new column, this is 
called a column break. If a paragraph always begins at the top of a new 
page, this is called a page break. 

Chapter. A combination of text and picture files, formatted with a 
style sheet. A chapter file consists of pointers to each of these files, 
along with instructions on how to combine them together on the 
computer screen or on the printer. 

Clipboard. A temporary, invisible holding place for text, pictures, 
and graphics. Any text block or picture placed on the clipboard using 
a cut or copy operation can be placed anywhere else in the chapter. The 
clipboard can independently hold one text block, one picture, and one 
graphic. 

Crop. Eliminate unwanted portions of a picture. The portions not 
displayed in the document are still stored in the original picture file. 

Crop Marks. Alignment marks which delineate the outside edges of 
the printed page. Also sometimes called trim marks or register marks. 
Crop marks can be automatically added at print time or you can draw 
your own using the Graphic mode. 

Descender. The portion of a letter which extends below the baseline. 
The tail on the lower case y is a good example of a descender. 

Dialog Box. The set of choices presented on the screen for each menu 
option selected. 

Discretionary Hyphen. A hyphen, placed in a word, which only 
prints if the word appears at the end of a line. Used to add hyphens 
beyond those produced by the hyphenation algorithm. Discretionary 
hyphens always take precedence over any hyphens inserted by Xerox 
Ventura Publisher. 

Em. A unit of measure which equals the point size of the paragraph's 
font. Em units are often used to specify the width of a column or the 
amount of indentation. 

Em Dash. An em dash is one em long and is used to separate paren
thetical statements-such as this one-from the surrounding text. 
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Em Space. An em space equals the width of the letter m in current 
point size. An em space is created by pressing and holding both the 
CtrI and Shift keys and then pressing M. Xerox Ventura Publisher 
actually uses the width of the @ character. 

En. A unit of measure which equals one half the width of an em. 

En Dash. An en dash (decimal 196) is used between numbers. For 
example: Figure 5-35. 

En Space. An en space equals one half the width of an em space. Its 
width is equal to the letter n in the current font. An en space is created 
by pressing and holding both the Ctrl and Shift keys and then pressing 
N. 

Extension. The part of the file name to the right of the period. For 
instance, the extension in the file name "DOC2.WPI" is WPI. Exten
sions are used by Xerox Ventura Publisher to differentiate between 
files of different types. 

Figure Space. A figure space equals the width of a number in the 
current point size. Use figure spaces between numbers in tables to 
keep tabular information aligned properly. A figure space is created by 
pressing and holding both the Ctrl and Shift keys and then pressing F. 

File. A unit of information stored on hard disk. Different types of 
information are stored in files with different extensions, and are treated 
differently. The different file types recognized by Xerox Ventura 
Publisher are Style Sheet (STY), Chapter (CHP), Publication (PUB), 
Width Table (WID), Caption (CAP), Graphic (VGR), text, image, and 
line art. 

Filter. The specification on the Directory line in the Item Selector 
that determines which files are displayed. The character "*,, indicates 
that any set of characters can be displayed; the character "?" indicates 
that any single character can be displayed in that position. For in
stance, *.STY will display any file name with the extension STY. 
GRAB????.IMG will display all eight character file names starting 
with the letters GRAB having the extension IMG. 
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Font. A unique combination of typeface, type size, type style, and 
type weight. For instance, Swiss (typeface), 12 point (type size), bold 
(type weight) is one font; Swiss, 14 point, bold is another. 

Font Metric. The width and height information for each character in 
each font. This information is stored in a width table. 

Footer. Text which appears at the bottom of every page in the docu
ment. 

Footnote. Explanatory information at the bottom of the page which 
is referenced on the same pages. 

Frame. A rectangular box used to hold text or pictures. Each page is 
also a frame. Pages are automatically created as needed to accom
modate all text in a file. 

Greeking. The act of representing text by dummy type having no 
meaning, or by a series of straight lines. Within Xerox Ventura Pub
lisher, greeking is used to increase screen drawing speed when the text 
is too small to be legible. Does not affect what gets printed. 

Gutter. The blank space between columns, or the blank space be
tween two pages in a bound document. 

Halftone. The process of representing a shade of gray by a series of 
black dots of different size. The bigger the dots, the darker the shade 
of gray. On printers which cannot print different sizes of dots (e.g., a 
laser printer), the halftone is produced by printing different numbers 
of dots in a given area. 

Image. A picture which is composed of individual dots created with 
a "paint" program or with a scanner. See also Line Art. 

Indent. The blank space at the beginning of the first line of a para
graph. 

Inter-line Spacing. The space between lines in a paragraph. See 
Leading. 

Interpress. A language used to describe how to print a page which 
consists of both text and pictures. This description is completely 
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independent of the printing device. This means that the page can be 
printed on printers which use Interpress, and the page will be printed 
at the full resolution that each printer or typesetter can produce. 

Justification. Text aligns evenly with both the right and left margins. 

Kerning. Space reduction between specific letter pairs. Even when 
proportionally spaced, certain letter pairs should be placed more close
ly together eliminate excessive white space. This space is especially 
noticeable with larger type sizes. For instance, an upper case V which 
follows an upper case A should be placed closer to the A. For example: 

This is not kemed: A V. 

This is kemed: AV. 
Landscape. A page printed so that as you read it, the width of the 
page is greater than its height. 

Layout. The arrangement of text and pictures on any given page. 

Leaders. Characters placed in the blank space between items in a list. 
For example: 

Table Item 1 .... .Item 2 .... .Item 3 .... .Item 4 

t t 
Leading. The distance in points from the baseline of one line of type 
to the next. 

Line art. A picture which is produced on the computer and stored as 
mathematically defined objects. In traditional typesetting, line art 
refers to illustrations containing only black or white, with no shades of 
gray. 

Line Break. The blank line which separates two paragraphs. If no 
line break is set between two paragraphs, the second paragraph will 
begin at the same vertical point as the first line in the first paragraph 

1-5 



APPENDIX I - GLOSSARY Line Length. - Point. 

1-6 

(Next Y Position: Normal); or at the same vertical point as the last line 
in the first paragraph (Next Y Position: Beside Last Line of Previous 
Paragraph. ) 

Line Length. The length of a line of type. Usually expressed in picas 
and points. 

Mechanical. A finished "camera ready" piece of artwork, generally 
one or two pages. 

Monospaced. An equal amount of character width for each character. 
Most typewriters and printers are monospaced, whereas most typeset 
material is proportionally spaced. Also called monopitch. See 
Proportional Spacing. 

Orphan. One or more lines of text left at the bottom of a column or 
page. Also, see Widow. 

Outdent. Text on the first line of a paragraph which prints to the left 
of the paragraph margin. 

Page. The frame defined by the Page Layout option. Additional 
frames are placed on top of this page. The page counter on the screen 
shows the number of pages in the document. 

Paste. The act of moving text or a picture from the clipboard to the 
page. 

Paragraph. Any line or lines of text ended by pressing the Enter 
key. A single letter, word, or line is considered a paragraph if the Enter 
key is pressed at the end of the letter, word, or line. 

Pica. Typographic unit of measurement equal to V6 inch. Twelve 
points equals one pica. 

Picture. Any drawing or illustration placed in a frame. A picture can 
be either image or line art. 

Point. Typographic unit of measurement equal to Vn inch. 
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Proportional Spacing. Different space is given to each character in 
a font. When proportionally spaced, the letter i gets less space than the 
letter w. 

Port. The connection point in the computer for peripherals such as a 
printer or mouse. 

Portrait. A page printed so that, as you read it, the width of the page 
is less than its height. 

PostScript. A language used to describe how to print a page which 
consists of both text and pictures. This description is completely 
independent of the printing device. This means that the page can be 
printed on any printer or typesetter that uses PostScript, and the page 
will be printed at the full resolution that each printer or typesetter can 
produce. 

Publication. A combination of chapter files. Each chapter file can 
have its own set of text, picture, and style sheet files. 

Reflect. Reflected settings place a mirror image of that setting on 
alternating pages. For example, if a picture is placed at the left side of 
a left page and then reflected using the For All Pages Left & Right in 
the Repeating Frame option, the picture will then be placed on the right 
side of right pages. 

Ruling Line. Any horizontal or vertical line used to separate text or 
frames from the surrounding layout. 

Run around. Text which follows the outline of a picture. 

Sans serif. Type style which does not have small horizontal strokes 
at the top of each letter. This is sans serif type. 

Scale. Increasing or decreasing the size of a picture. 

Scanner. A device which converts a paper drawing into a computer 
image. 

Select. Point to something on the screen and press the mouse button. 
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Style Sheet. A file which is stored separately from text, but which 
controls the typographic format of that text. 

Tag. The format applied to a particular paragraph. 

Thin Space. A thin space is the width of a period. 

Typeface. The style of type e.g., Bookman, Palatino, Avant Garde, 
Zapf Chancery. 

Typeset. The act of producing a document on a typesetting machine. 
Xerox Ventura Publisher can produce documents on a laser printer that 
have near typeset quality. 

Widow. One or more lines of text left at the top of a column or page. 
Note: a widow also refers to a single word on the last line of a 
paragraph. While this is considered poor form, Xerox Ventura Publish
er does not attempt to prevent this kind of widow. Also, see Orphan. 

Width Table. A file which contains font metric information. 

WYSIWYG. What You See Is What You Get (printed.) Refers to the 
ability to display on the computer screen a close representation of what 
is printed. A word processor which uses special characters to mark the 
beginning and end of underlined text, rather than showing text with an 
underline is an example of a program which does not have 
WYSIWYG. 

The lead-ins for each glossary entry in this chapter were created as 
separate paragraphs. The Putting It Together chapter shows how to 
create these. 

The lead-in paragraph was tagged with a tag called Lead-In. To 
automatically transfer the first and last entry on the page to the header, 
the following was typed in the Header & Footer dialog box on the 
Right line for Left Page Header: 

[<Lead-In] <197> [>Lead-In] 

The [<Lead-In] code copies the first occurrence of a lead in to the 
header. The <197> code produce and Em dash. The [>Lead-In] code 
copies the last occurrence on the page of a lead in to the header. 
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Document formats 

Up to eight columns per page or frame. Multiple frames on same page 
can create more than eight columns. Columns can be unequal width. 
Different column widths and indents for left and right pages. 

Text flows automatically across page boundaries if placed in the page. 

Vertical rules between columns, plus two vertical rules per frame. 

Portrait or landscape format. Set globally for entire chapter. 

Ruling lines (up to three) of different widths can be placed above, 
below, or around each frame. 

Document content 

Views 
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Multiple, non-contiguous articles per document. 

Up to 128 chapters can be combined for printing, generating a table of 
contents or index. Documents up to 9,999 pages can be handled. 

• Facing (Two full pages.) 

• Reduced (Full page.) 

• 100% (Normal size.) 

• 200% (Enlarged view.) 
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Style-sheet Format Control 

Style sheets control each paragraph's fonnat through paragraph tags. 
Each style sheet can contain up to 128 tags. 

Style sheets control the following on a paragraph by paragraph basis: 

• Typeface and font 

- Fonts available depends on printer 

- Any half point size between 1 and 254 point 

• Text alignment horizontally and vertically within column, includ
ing automatic decimal alignment 

• Text rotation to 90, 180, and 270 degrees. 

• Hyphenation (two different languages can be hyphenated within 
the same document) 

• Justification 

• Indent/outdent for any number of lines 

• Line to line spacing (leading) 

• Paragraph spacing 

• Temporary margins (using spacing in from left, in from right) 

• Page, line, or column breaks. Used to control pagination, create 
outdented headings, and vertical tabs 

• Automatic large first letter of paragraph 

• Automatic bullets 

• Tabs 

- Sixteen horizontal tabs per paragraph 

- Left, center, right, decimal point aligned 

- Leaders 

• Automatic kerning (ifkeming infonnation is in printer width table) 

• Automatic letterspacing (flags loose lines) 

- Nonnal, minimum and maximum spaceband settings 
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• Both typesetter and word processor control for base of first line of 
text on a page. 

• Letter space adjustment 

• Make leading automatically increase/not increase for larger fonts in 
paragraph. 

• Single/double underline, overscore, and strikethrough thickness 
and position settable 

• Superscript, subscript, and small text size and position settable for 
each paragraph. 

• Define any color using CMYK mixture. Over 125 million possible 
colors. 

• Horizontal ruling lines 

- Up to three ruling lines, each of different thickness and 
spacing above, below, or around text 

- Pre-set options: rule length equal to text, margin, column or 
frame 

Customized options: rule length and indent settable 

- Eight textures and colors available 

Text within ruling line allowed 

Ruling lines the width of text, margin, column, or custom 
width 

• Margins & Columns 

• Portrait, landscape, paper size 

• Vertical tabs 

• Automatic section numbering 

Up to ten levels 

Can be used for manuals, outlines, lists 

Page controls 

Automatic headers/footers. 
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• Separate headers/footers for left and right pages 

• Left, center, right aligned text in each header. Two lines each 

• Automatic page numbering and section headings in header or 
footer 

Page numbering in choice of: 

• Arabic numbers (1,2,3) 

• Upper or lower case roman numerals 

• Upper or lower case letters (A,B,C) (A-Z only) 

• Alphabetic (One, Two, Three) 

Page counter: 1-9999. 

Automatic page, chapter, table, and figure numbering across chapters. 

Automatic footnotes (footnote text appears at the bottom of the page) 

Column balance on last page of chapter. 

Chapter headings forced to same page as next paragraph. Also, widow 
& orphan controls. 

Automatic conversion to quotes and em dashes from inch marks and 
multiple hyphens. 

Accepts text from and stores text (and formatting information) back to 
standard word processors: 

• Displaywrite III and IV (DCA) 

• Microsoft Word 

• Multimate 

• WordPerfect (4.2 and 5.0) 

• Wordstar 

REFERENCE GUIDE 



Editing 

REFERENCE GUIDE 

APPENDIX J - FEATURES 

• Xerox Writer 

• Xywrite 

• Any word processor or other program that generates a standard 
ASCII file 

Real-time re-form at during editing. 

Files from different word processors can be mixed in same document. 

Text insert or delete at any point. 

Concatenate text from several files into one file. 

Text blocks can be deleted, moved, or copied. 

Any letter, word or group of words can be changed to: 

• Boldface 

• Italic 

• Small caps 

• Strikethrough 

• Subscript 

• Superscript 

• Underline 

• Double underline 

• Overscore 

• All lower case 

• All upper case 

• All initial caps 

• Any available font 

Automatic fraction creation 

Interactive font change, tracking, and kerning for any selected text. 
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Selected text can be moved: 

• Horizontally (manual kerning.) 

• Vertically (base line jump) 

Accepts pictures generated by: 

• AutoCAD SLD 

• GEM Draw, GEM Graph 

• Lotus 1-2-3 

• Mentor Graphics 

• PC Paintbrush, GEM Paint 

• Any program that can save files in General Parametric's Video 
Show format (e.g., Lotus Freelance) 

• Any program that can save files in CGM format 

• Macintosh PICT files 

• Macintosh Paint files 

• Encapsulated PostScript files 

• HPGL 

• Microsoft Windows 

• TIFF 

• Images scanned from Microtek, Dest, Datacopy, or other scanner 
which saves files in PC Paintbrush PCX, GEM, or TIFF format 

• CAD pictures stored in DXF format 

Handles text around irregular pictures using text flow around and 
multiple frames. 

Any picture can be automatically repeated throughout the document. 
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Picture scaling: stretch to fit picture frame, maintain original aspect 
ratio, or scale by factors. 

Picture cropping: pictures larger than frame can be cropped as desired. 

Captions. 

• Attached to pictures 

• Abovelbelow /left/right of picture 

• Automatic figure or table numbering 

• Rules above, below, around each caption 

Anchored Pictures. 

• Same position on new page 

• Relative above text 

• Relative below text 

• Automatically within text. This allows you to create pictures which 
move within a line of text, just like any character on the keyboard. 

Five graphic tools available 

• Ellipse/circle 

• Rectangle/square 

• Rounded rectangle/square 

• Line 

• Box text 

Graphics can be attached to any page or frame 
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Printing 

Single- or Double-sided fonnatting (start on left or right side.) 

Print left pages or right pages only (for manual duplex printing) 

Paper type: 

• 8112 X 5112 

• 8112 X 11 

• 8112 X 14 

• 11X17 

- Shingle feature allows you to print mUltiple 8112 x 11 pages 
to achieve one 11 x 17 page 

- Shrink feature allows you to print an 11 x 17 page on 8112 x 
11 paper (PostScript only) 

• 18 x 24 (Broadsheet) 

- Shrink 

- Strips output for typesetters 

• A4 

• B5 

Collating and printing order control. 

Multiple paper trays. 

Color separations. 

Front/back matter 

Automatic table of contents, table of figures, table of tables, generation 
by searching for paragraph tags. 

Automatic index generation by searching for index entries. 
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2M bytes, reduced by 
Greater of 4 M bytes 

or total EMS, reduced 
Total amount of text per chapter 16K bytes for each 

by 16K bytes for each 
1,000 paragraphs 

1,000 paragraphs 

Maximum paragraph size 7,990 bytes 7,990 bytes 

1,024/frame minimum 
Up to 16,000 if EMS 

Line elements per frame* 725 memory is available 
(32 bytes EMS per 

line element) 

Number of paragraphs/per chapter 
1,000 per 16K of 1,000 per 16K of 

memory up to 64,000 memory up to 64,000 
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* Each line of text creates two line elements. Each paragraph font 
change (where one paragraph has a different font than the previous 
paragraph) creates one line element. Each attribute (e.g., bold, italic) 
in the text creates three line elements. Each tab takes two line ele
ments. Thus the maximum number of lines of text per frame without 

EMS memory and the Professional Extension is 7~5 = 362 lines. 
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APPENDIX K 
FONT UTILITIES 

New fonts can be added by following the installation directions given 
in the Add/Remove Fonts section of this Reference Guide. This 
installation requires that you install a Width Table which provides 
Xerox Ventura Publisher with information about the spacing, height, 
and kerning for each character in each font. When this width table is 
not provided by the font vendor, or when you want to modify an 
existing width table, you will need to use the utilities described in this 
chapter. 
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A set of characters that are designed to look similar constitute a 
typeface. A collection of characters-such as A, B, C-fonns a char
acter set. Xerox Ventura Publisher contains two character sets: 

• An international character set 

• A symbol character set 

It provides three typefaces for the international character set: 

• Helvetica (or equivalent, i.e. Swiss) 

• Times Roman (or equivalent, i.e., Dutch) 

• Courier 

and one typeface for the symbol character set. 

1) Within a typeface, each character can be printed in different sizes. 
The size of a character is measured in points, where one point 
equals 1/72 inch. 

Each character can also have a different style, where a style can be: 

• Normal 

• Bold 

• Normal italic 

• Bold italic 

Finally, each character can be printed in one of two orientations: 

• Portrait 

• Landscape. 

Each combination of typeface, size, style, and orientation defines a 
font. Many people use the word font when they really mean typeface. 
However, throughout this manual, font means the unique combination 
of typeface and size, style, and orientation. 
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Within a laser printer or typesetter, each character in a font is drawn 
on the paper as a series of individual dots. The printer creates these 
dot-by-dot drawings from information contained in font files. Font 
files are either stored in your computer or printer, or are created in 
real-time, as you print, from mathematical outlines. Most printers use 
the first approach, while PostScript uses the second approach. 

If you want to add new printer fonts to Xerox Ventura Publisher, you 
must purchase new font files (or font outlines for PostScript) from a 
font supplier. You then store these fonts or outlines on your computer's 
hard disk or within the printer's memory, depending on the printer 
type. As described at the beginning of this chapter, the font vendor 
should also supply a Xerox Ventura Publisher width table. The width 
table provides concise information about all the new fonts you are 
adding. If the width table is not provided by the font vendor, you must 
create it using the utilities described later in this chapter. 

Adding new printer fonts 
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To add new printer fonts, follow these instructions. 

1) For non-PostScript printers, copy all font files from the distribution 
disk to the VENTURA directory on your computer hard disk. Copy 
PostScript fonts to a directory which you create called PSFONTS. 
(Note: you can copy HP LaserJet fonts to a directory other than 
VENTURA. See the HP LaserJet section later in this chapter.) 

2) Copy the width table for these fonts to the VENTURA directory. If 
the font vendor did not supply a width table for these new fonts, you 
must create one. Width Table creation is different for each printer 
and is described later in this chapter. 

3) Use the Add/Remove Font option to merge the width table for these 
new fonts into a width table already in use. 
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'Screen fonts 

Because the display on your computer has a much lower resolution and 
different aspect ratio from your printer, the fonts you purchase for your 
printer cannot be used to show new fonts on your computer display. 
You can, however, purchase new screen fonts (which are separate files 
from the printer fonts). If purchased with the printer fonts as part of a 
matched set, these screen fonts will match the printer font widths and 
styles. 

Since matching screen fonts are not always available, Xerox Ventura 
Publisher allows you to add printer fonts while still using the screen 
fonts already installed. When a printer font is used which does not 
match the existing screen fonts, the program adjusts the space between 
words on the screen as necessary to compensate for the differences in 
widths between the new printer font and the generic screen font 
(Figures K-l and K-2). This assures that each line and paragraph ends 
at the correct location. While this may make each word appear either 
too close or too far from its neighbor on the computer screen, the line 
and paragraph endings will be correct, and each page will look correct 
when it is printed. 

If you add printer fonts for characters other than those shown in 
Appendix E, Xerox Ventura Publisher will not display the correspond
ing fonts on the screen unless you add the appropriate screen fonts. 

Adding new screen fonts 

K-4 

Screen fonts must be provided by the font vendor in Xerox Ventura 
Publisher format. Ideally these fonts should match the resolution of 
your computer display. However, screen fonts for the IBM Enhanced 
Graphics Display (91 x 72 dpi resolution) will work with all displays 
shown in the VPPREP installation menus (except the IBM Color 
Display). 

To add new screen fonts: 

1) Copy the fonts to the VENTURA or the VENTURA\VPFONTS 
directory. All screen fonts must be in one directory or the other. 
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T his trip really began in. September last year 
when Gerry won first prize in a raffle at the 

fashion show which Rush-Presbyterian-St. Luke's 
Medical Center holds every year. The prize was two 
round trip tickets to Hong Kong on United Airlines, 
and ten nights in the Ho ng: Ko ng: Hyatt Ho tel. 
Analyzing our good fortune, we concluded thiit we 

Figure K-J Screen display showing a document where screen fonts match 
the printer fonts. 

T his trip really began in September last 
year when Gerry won first prize in a 

raffle at the fashion show which Rush-Pres
byterian-St. Luke's Medical Center holds every 
year. The prize was two round trip tickets 
to Hong Kong on United Airlines, and ten 
nights in the Hong Kong Hyatt Hotel. Analyz-

Figure K-2 Screen display showing document where screen fonts don't 
match the new printer font. Note how extra space is added between words to 
make the line endings correct for the new font (the new font is wider than the 
screen font). 

2) Run Xerox Ventura Publisher. 

3) Type this three letter file extension (e.g, VGA) for the new fonts on 
the Screen Fonts line in the Set Printer Info dialog box. 

The new screen fonts are loaded and immediately displayed. If the 
fonts take more than a few seconds to load, set BUFFERS=30 in the 
CONFIG.SYS file. Better still, if your computer contains more than 
640K, install a disk cache (available from your computer dealer). 

If the fonts will completely replace the fonts which VPPREP installed, 
the new fonts must contain both Helvetica and Times Roman 
typefaces. The maximum file size for anyone screen font is 35K bytes. 
You can add up to 700 screen fonts. 

K-5 



APPENDIX K-ADDING FONTS Screen fonts 

Full Page 
Displays 

K-6 

PostScript screen fonts from Adobe Systems can be purchased in 
Xerox Ventura Publisher form. However, if you can only find standard 
Adobe format fonts (ABF format) these can be converted to Xerox 
Ventura Publisher format. You must include both Helvetica and Times 
Roman fonts in the following conversion. To convert these fonts: 

1) Copy the font files to the VENTURA directory. 

2) Rename the font files, if necessary so that they all have the exten
sion ABF. 

3) Copy the ABFTOFNT.EXE converter from the POSTSCPT direc
tory on the Utilities Disk to the VENTURA directory by typing the 
following: 

COpy A: \POSTSCPT\ABF* . * C: \ VENTURA Enter 

4) Convert the fonts by typing the following: 

ABFTOFNT *. ABF Enter 

The fonts are all converted to Xerox Ventura Publisher format, and the 
file extensions are all changed to PSF. 

If you have several different printers installed and each has its own set 
of matching screen fonts, make the extension for each printer's match
ing screen fonts unique. 

Xerox Ventura Publisher automatically installs high resolution (VGA) 
fonts for full screen displays such as the Wyse 700, MDS Genius, and 
Xerox Full Page Display. If you can only obtain additional fonts in 
EGA format but want to use these new fonts along with the higher 
resolution VGA fonts, you can copy the new fonts to the VENTURA 
or the VENTURA \ VPFONTS directory and then rename the extension 
for these fonts from EGA to VGA. 

When adding new screen fonts, take care not to add fonts which 
duplicate those you already have, but in a different file name. Xerox 
Ventura Publisher may not know which font file to use. 
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Adding new fonts to the HP LaserJet Plus 

To add new fonts to the HP LaserJet Plus, follow the general directions 
for adding new printer fonts. 

Creating an HP LaserJet Plus width table 

REFERENCE GUIDE 

If the font vendor did not supply a Xerox Ventura Publisher width table 
for your HP LaserJet Plus, you must create one. To create a width table 
for new fonts which have already been copied to your computer hard 
disk: 

1) Use the DOS RENAME command to rename all new portrait font 
files to have the extension SFP, and all new landscape fonts to the 
extension SFL. 

2) Optional: If landscape fonts are not supplied by the font vendor, 
create landscape fonts from portrait fonts (skip this step if you don't 
need landscape fonts.) 

- Insert the UTILITIES DISK into drive A 

- Type the following command: 

A:PORTOLAN C:\VENTURA\*.SFP Enter 

3) Copy the HPLTOVFM.EXE utility from the UTILITIES DISK to 
the VENTURA directory by typing the following command: 

COpy A:\HPLJPLUS\*.* C:\VENTURA Enter 

4) For each portrait font file, you must create a Ventura Font Metric 
(VFM) file. This is a readable text file which provides Xerox 
Ventura Publisher with important information about your new 
fonts. The VFM file is described in more detail near the end of this 
chapter. To create this file, type the following command for each 
new font file: 

HPLTOVFM fontname. SFP [switches] Enter 

where [switches] is replaced with the following: 
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• IF=Typeface name (15 characters maximum) 

• IN=Typeface ID (15-65,554; See ID table starting on page K-18) 

• IP=Point size (always 2 characters) 

• IW=Weight (style) (1 character: N=normal; B=bold; I=normal 
italic; T=bold italic) 

You must specify all switches for each font file. 

Example: You purchase six new portrait fonts: Century Schoolbook 8 
point normal; 10 point normal; 10 point bold; 10 point italic; 12 point 
normal; and 12 point bold. You copy these to your computer's hard 
disk and rename the files so they have the extension SFP. The file 
names are: 

CENT08NP.SFP 
CENTIONP.SFP 
CENTIOIP.SFP 
CENTIOBP.SFP 
CENT12NP.SFP 
CENT12BP.SFP 

To create VFM files for each of these fonts, type these commands 
(executing these commands from a batch file is less prone to error): 

HPLTOVFM CENT08NP. SFP /F=Century/N=20/P=08/W=N Enter 

HPLTOVFM CENTIONP. SFP /F=Century/N=20/P=lO/W=N Enter 

HPLTOVFM CENTIOIP. SFP /F=Century/N=20/P=lO/W=I Enter 

HPLTOVFM CENTIOBP. SFP /F=Century/N=20/P=lO/W=B Enter 

HPLTOVFM CENT12NP. SFP /F=Century/N=20/P=12/W=N Enter 

HPLTOVFM CENT12BP. SFP /F=Century/N=20/P=12/W=B Enter 

Once all the VFM files have been created, you next create a list of all 
VFM files. This list must contain the name of every VFM file just 
produced. Create the list with any word processor, and save as an 
ASCII text file. The name of this file should be the same as the name 
of the ultimate width table file, and the extension should be LST. 

The VFM file names should be placed in the LST file with all fonts for 
a given typeface together, starting with the smallest point size and then 
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going to larger point sizes. Within a given size, the order should be 
normal, italic, bold, and then bold italic. 

Example: The LST file for the seven fonts whose VFM files were 
created in the example above should look like this: 

CENT08NP.VFM 
CENT10NP.VFM 
CENT10IP.VFM 
CENT10BP.VFM 
CENT12NP.VFM 
CENT12BP.VFM 

As the last step in the width table generation process, the 
VFMTOWID.EXE utility uses the LST file to create a new width 
table. The syntax for this conversion is: 

VFMTOWID filename.LST Enter 

where filename is replaced with the name of the list file you wish to 
convert. The VFMTOWID.EXE file must be copied from the Utilities 
Disk to the VENTURA directory by placing the Utilities Disk in the A 
drive and typing the following: 

COpy A: \ VFMTOWI D . EXE C : \ VENTURA Enter 

Example: To create a width table from the list file created in the 
previous example, assuming this file is saved under the name CEN
TURY.LST, type the following: 

VFMTOWID CENTURY.LST Enter 

This will create a width table called CENTURY. WID. This width 
table can be merged into an existing width table using the 
Add/Remove Fonts option within Xerox Ventura Publisher. 

When you are finished generating new width tables, you can save the 
VFM and LST files onto a floppy disk and then erase them from your 
computer's hard disk. They are not used by Xerox Ventura Publisher 
except when generating a new width table. 
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Downloading fonts 

If you own a LaserJet Plus, LaserJet Series II, HP 2000 or compatible 
printer, Xerox Ventura Publisher automatically copies fonts from the 
computer to the printer as needed during the To Print operation. This 
feature makes Xerox Ventura Publisher simple to use, but it can result 
in long print times if each page in your document uses different fonts 
than the pervious page. 

If your printer contains at least 1 megabyte of memory, you can 
improve performance dramatically by copying fonts to the printer 
before running Xerox Ventura Publisher. The HPDOWN program 
contained on the Utilities disk automatically copies fonts to the printer. 
The following directions show you how to download fonts before 
running Xerox Ventura Publisher and how to then stop the automatic 
downloading of these fonts during printing. 

1) Use your word processor's ASCII text function to create a file 
called HPLJPLUS.CNF. Place this file in the VENTURA subdirec
tory. (See Appendix F for more information on the CNF file.) 

2) On the first line of this file, place the name of the disk drive and 
directory where all fonts are stored. Use the format shown in the 
example which follows. 

3) On each remaining line, place the font ID number and the file name 
of the font to be downloaded. 

The font ID number is a number which you provide. It gives Xerox 
Ventura Publisher the information necessary to select fonts within the 
printer. You must assign ID numbers in the order that fonts are 
downloaded. Thus, the first font downloaded must have ID number 1, 
the second ID number 2, and so on. For example, to download five HP 
LaserJet fonts, where all fonts are contained in the C:\FONTS direc
tory, the HPLJPLUS.CNF file should contain the following: 

DOWNPATH(C:\FONTS) 
PERMFONT(l TMSN3010.SFL) 
PERMFONT(2 TMSN3012.SFL) 
PERMFONT(3 TMSB3010.SFP) 
PERMFONT(4 
PERMFONT(5 

TMSB3012.SFP) 
TMSB3014.SFP) 
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~ The only spaces allowed in the above are between the font ID number 
and font file name. No spaces should be placed between the command 
(Le., HPFONTS, PERMFONT) and the left parenthesis. All fonts must 
reside in the directory specified after the HPFONTS command. 
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1) Once the HPLJPLUS.CNF file is saved, copy the HPDOWN.EXE 
utility from the Utilities disk to the VENTURA directory. 

2) Type: HPDOWN. The fonts will be copied permanently to the 
LaserJet printer connected to LPTl:. To copy fonts to LPT2: type: 
HPDOWN LPT2: To copy fonts to COMl: type HPDOWN COM1:, 

etc. 

3) Run Xerox Ventura Publisher. 

4) Select the Add/Remove Fonts option. For each font you have 
downloaded, select the Face, Size, and Style for that font and then 
select the word Download at the bottom of the Style menu. The 
word Download will change to Resident indicating that Xerox 
Ventura Publisher now knows that this font is resident in the printer 
and does not need to be downloaded. If you make a mistake, select 
the word Resident and it will change back to Download. 

5) Select Save As New Width Table at the bottom ofthe Add/Remove 
Fonts Dialog Box. Save the width table under the existing width 
table name if you are always going to download the fonts before 
running Xerox Ventura Publisher. Save under a different name if 
you will only be pre-downloading some of the time. 

If you always plan to download the fonts before running Xerox 
Ventura Publisher, then you should put the HPDOWN statement in the 
AUTOEXEC.BAT file. 

Font downloading takes 10-30 seconds per font depending on speed of 
your computer and speed of the connection to your computer. 
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Adding new fonts for the Xerox 4045 Laser Printer 
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To use new fonts with the Xerox 4045, follow the general directions 
for adding new printer fonts, earlier in this chapter. 

Creating a width table 

If the font vendor did not supply a Xerox Ventura Publisher width table 
file for your 4045 printer, you must create one. This is done as follows: 

1) Copy the XRXTOVFM.EXE utility from the UTILITIES DISK to 
the VENTURA directory by typing the following command: 

COpy A: \XRX 4045\*. * C: \VENTURA Enter 

2) Rename each font file according the following conventions: 

The file extension must be .XFN 
The file name must be in the following format. 

X450FPPW.XFN 

where: 

o is replaced with the orientation (portrait = P; landscape = L) 

F is replaced by one of the following typefaces: 

A AvanCgarde 
B Bookman 
C Century 
D Dingbats 
F Friz_quadrata 
G Garamond 
H Helvetica 
L Lubalin 
N N ar _helvetica 
0 Optima 
P Palatino 
S Souvenir 

REFERENCE GUIDE 



Adding new fonts for the Xerox 4045 Laser Printer APPENDIX K-ADDING FONTS 

REFERENCE GUIDE 

M Symbol 
T Times 
Z Zapf_chancery 

PP is replaced with the type size (e.g., 08 for 8 point, 10 for 10 
point etc.) 

W is replaced with one of the following type weights (styles): 

B Bold 
I Italic 
N Normal 
T Bold Italic 

Example: The file name for 14 point, italic, Lubalin, portrait, 
should be X45PL14I.XFN. 

3) Convert each font to a Xerox Ventura Publisher VFM file using the 
XRXTOVFM.EXE converter. The resulting VFM file is an ASCII 
text file that can be edited. (See end of this chapter.) Each file must 
be converted individually. 

Example: To convert the font file in the previous example, type the 
following: 

XRXTOVFM X45PL14I.XFN Enter 

4) Create a list of all VFM files that should be included in a new width 
table. Create this list with any word processor, and save as an ASCII 
text file. The name of this file should be the same as the name of 
the ultimate width table file, and the extension should be LST. The 
VFM file names should be placed in the LST file with all fonts for 
a given typeface together, starting with the smallest size and then 
going to larger sizes. Within a given size, the order should be 
normal, italic, bold, and then bold italic. 

Example: The 4045 LST file which created the fonts provided with 
Xerox Ventura Publisher is: 

X45PH06N.VFM 
X45PH08N.VFM 
X45PH10N.VFM 
X45PH10I.VFM 
X45PH10B.VFM 
X45PH12N.VFM 
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X45PH12I.VFM 
X45PH12B.VFM 
X45PH14B.VFM 
X45PH18B.VFM 
X45PH24B.VFM 
X45PT08N.VFM 
X45PTION.VFM 
X45PTIOI.VFM 
X45PTIOB.VFM 
X45PT12N.VFM 
X45PT12I.VFM 
X45PT12B.VFM 
X45PT14B.VFM 
X45PT18B.VFM 
X45PT24B.VFM 
X45PC12N.VFM 
X45PMION.VFM 

5) Finally, convert the LST file to a width table using the 
VFMTOWID.EXE program as follows: 

VFMTOWID filename.LST Enter 

where filename is replaced with the name of the list file you wish 
to convert. 

This width table can be merged into an existing width table using the 
AddlRemove Fonts option within Xerox Ventura Publisher. When you 
are finished generating new width tables, you can save the VFM and 
LST files onto a floppy disk and then erase them from your computer's 
hard disk. They are not used by Xerox Ventura Publisher except when 
generating a new width table. 
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Adding fonts to JLaser 

REFERENCE GUIDE 

Some font vendors supply printer fonts in Xerox Ventura Publisher 
format. These fonts are intended for use with AST TurboLaser, Cor
data, JLaser and other printers. Follow the general directions for 
adding printer fonts given earlier in this chapter. For the AST Turbo
Laser printer, the extension for these fonts should be renamed to W30. 
For the other printers the extension should be renamed to B30. 

You can also use fonts intended for the HP LaserJet printer. These fonts 
can be converted for use with the AST Turbo Laser, Cordata Laser 
Printer, and JLaser board. To generate a width table for these fonts, 
follow the procedure described in the Adding new fonts for the HP 
Laser Jet Plus section, with the following changes: 

• Only portrait fonts are required. 

• During the VFMTOWID operation, specify the printer name as 
follows: 

VFMTOWID CENTURY. LST /N=printer Enter 

where printer is replaced with the name of the printer exactly as it 
appears in the Set Printer Info dialog box. 

After the width table has been generated, convert the fonts themselves 
from HP format to Xerox Ventura Publisher's format by using the 
HPLTOFNT.EXE utility contained on the UTILITIES DISK To con
vert the fonts: 

1) Copy the HPLTOFNT.EXE utility from the UTILITIES DISK to 
the VENTURA directory by typing the following command: 

COPY A: \HPLTOFNT . EXE C: \ VENTURA Enter 

2) For each portrait font file type the following command: 

HPLTOFNT fontname. SFP [switches] Enter 

where [switches] is replaced with the following: 
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3) /F=Typeface name (15 characters maximum) 

/N=Typeface ID (See ID table later in this chapter 

/P=Point size (always 2 characters) 

!W=Weight (style) (1 character: N=normal; B=bold; I=normal 
italic; T=bold italic) 

For instance, to convert a 10 point, Century Schoolbook, normal, 
portrait font from HP LaserJet Plus to Xerox Ventura Publisher format, 
type the following: 

HPLTOFNT CENTIONP.SFP/F=Century/N=20/P=lO/W=N 
Enter 
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Adding new PostScript fonts 

To add new fonts for PostScript printers, copy the font files to the 
PSFONTS directory on your computer hard disk. (Create this direc
tory, if necessary.) Re-name the font file name, so that it matches 
exactly one of those shown in the Typeface subsection which follows, 
and with the extension PFB (or PFA if your font files are ASCII). 

If you wish to save fonts in a different directory, use the ASCII text 
editing function of your word processor to edit the POSTSCPT.CNF 
file located in the VENTURA directory. For instance, if all fonts are 
saved in a directory called NEWFONTS, change the line in the 
POSTSCPT.CNF file which reads: 

psfonts(C:\PSFONTS\) 

to: 

psfor:ts(C:\NEWFONTS\) 

If the font is not contained in the PostScript width table, use the 
AddIRemove Font option in the Options menu to merge the width 
table for these new fonts into the existing PostScript width table. Then, 
for each font added, use the Add/Remove Font option to change the 
state of each new font to Download. 

~ Remember to change the download/resident switch for each Face, 
Size, and Style combination. 
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Because of the way PostScript operates, Xerox Ventura Publisher must 
download the entire font file each time the font on a page changes. 
Therefore, for best performance, you should copy the fonts to the 
printer before you run Xerox Ventura Publisher. Then set each font to 
resident using the AddIRemove Fonts option. 

See Appendix F for more information on the POSTSCPT.CNF file and 
its use with downloadable fonts. 
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Typefaces 

The following is a list of industry standard typefaces and their as
sociated ID's and weights (styles.) Ifthe typeface you are adding is not 
on this list, assign the largest number available for the class of typeface 
you are adding. For example, the first sans serif typeface not on the 
list, should be assigned number 49, and the first serifed typeface 
number 99. The PostScript file name is shown for reference. For file 
names which contain the underline character you must type enough 
underline characters to make the file name exactly eight characters 
long. 

System Faces (International Character Set) 

PostScript Weight 
Typeface File Name Face Id (Style) 
Courier-Bold COURIB 1 1 
Courier-Bold Oblique COURIBO 1 5 
Courier COURI 1 0 
Helvetica-Oblique HELVEO 2 4 
Helvetica-Bold HELVEB 2 1 
Helvetica HELVE 2 0 
Helvetica-Bold Oblique HELVEBO 2 5 
Times-Bold Italic TIMESBI 14 5 
Times-Italic TIMESI 14 4 
Times-Bold TIMESB 14 1 
Times-Roman TIMESR 14 0 

Serifed Faces (International Character Set) 

PostScript Weight 
Typeface File Name Face Id (Style) 
New Century Schlbk-Itahc NCI 20 4 
New Century Schlbk-Roman NCR 20 0 
New Century Schlbk-Bold Italic NCBI -- 20 5 
New Century Schlbk-Bold NCB 

--
20 1 

Palatino-Italic POI 21 4 
Palatino-Bold Italic POBI 21 5 
Palatino-Bold POB 21 1 --
Palatino-Roman POR 21 0 
Garamond-Bold GAB 22 1 --
Garamond-Bold Italic GAB I 22 5 
Garamond-Light GAL -- 22 0 
Garamond-Light Italic GALl 22 4 
Bookman-Demi BKD 23 1 --
Bookman-Light Italic BKLI 23 4 
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PostScript Weight 
Typeface File Name Face.Id (Style) 
Bookman-Demlltahc BKDI 23 5 
Bookman-Light BKL 23 0 
Lubalin Graph-Demi Oblique LUDO 24 5 
Lubalin Graph-Book LUW --- 24 0 
Lubalin Graph-Book Oblique LUWO 

--
24 4 

Lubalin Graph-Demi LUD --- 24 1 
Souvenir-Light SUL --- 25 0 
Souvenir-Light Italic SULI 25 4 
Souvenir-Demi SUD 25 1 
Souvenir-Demi Italic SUDI 25 5 --
Benguiat-Book BGW 26 0 
Benguiat -Bold BGB --- 26 1 
Glypha-Bold GYB --- 27 1 
Glypha GYR 27 0 
Glypha-Oblique GYO --- 27 4 
Glypha-Bold Oblique GYBO 27 5 
Friz Quadrata FQRG __ 28 0 
Friz Quadrata-Bold FQB 28 1 ---
Zapf Chancery-Medium Italic ZCMI 29 4 
Trump Mediaeval-Italic TMI 30 4 
Trump Mediaeval-Bold Italic TMBI 30 5 
Trump Mediaeval-Roman TMR 30 0 
Trump Mediaeval-Bold TMB --- 30 1 
Melior-Bold Italic MEBI 31 5 
Melior-Bold MEB 31 1 ---
Melior-Italic MEl 31 4 
Melior MER 31 0 
Galliard-Bold Italic GLBI 32 5 
Galliard-Bold GLB 32 1 ---
Galliard-Italic GLI 32 4 
Galliard-Roman GLR 32 0 
New Baskerville-Bold Italic NBBI 33 5 
New Baskerville-Bold NBB 33 1 ---
New Baskerville-Italic NBI 33 4 
New Baskerville-Roman NBR 33 0 
Goudy-Bold Italic GOBI 34 5 
Goudy-Bold GOB --- 34 1 
Goudy-Italic GOI 34 4 
Goudy GOR 34 0 
Park Avenue PAM 35 0 
Bodoni-Bold Italic BDBI 36 5 
Bodoni-Bold BDB 36 1 
Bodoni-Italic BDI 36 4 
Bodoni BDR 36 0 
Bodoni-Poster BDPS 37 0 
Century Old Style-Bold COB --- 38 1 
Century Old Style-Italic COl 38 4 
Century Old Style-Regular CORG 38 0 
Cheltenham-Bold Italic CHBI 39 5 
Cheltenham-Bold CHB 39 1 ---
Cheltenham-Book Italic CHWI 39 4 
Chel tenham-Book CHW 39 0 ---
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Sans Serifed Faces (International Character Set) 

PostScript 
Typeface FileName Face Id 
Helvetica-N arrow-Bold HELVENB 50 
Helvetica-Narrow-Bold Oblique HELVENBO 50 
Helvetica-Narrow-Oblique HELVENO 50 
Helvetica-Narrow HELVEN 50 
Avant Garde-Book AGW 51 
Avant Garde-Demi Oblique AGDO 51 
Avant Garde-Demi AGD 51 ---
Avant Garde-Book Oblique AGWO 51 
Optima-Bold Oblique OPBO 52 

--
Optima-Bold OPB --- 52 
Optima-Oblique OPO --- 52 
Optima OPR 52 
Korinna-Kursiv Bold KRKB 53 
Korinna-Bold KRB 53 
Korinna-Kursiv Regular KRKX 53 
Korinna-Regular KRRG 53 
Helvetica-Light HVL 54 
Helvetica-Light Oblique HVLO 54 
Helvetica-Black HVBL 55 
Helvetica-Black Oblique HVBLO 55 
Franklin Gothic-Demi FRD 56 
Franklin Gothic-Book FRW 56 
Franklin Gothic-Demi Oblique FRDO 56 
Franklin Gothic-Book Oblique FRWO 56 
Franklin Gothic-Heavy FRH 57 ---
Franklin Gothic-Heavy Oblique FRHO 57 
Helvetica-Cndnsd-Light Oblique HVCLO 58 
Helvetica-Condensed-Light HVCL -- 58 
Helvetica-Cndnsd-Bold Oblique HVCBO 59 
Helvetica-Condensed-Oblique HVCDO 59 
Helvetica-Condensed HVC 59 ---
Helvetica-Condensed-Bold HVCB 59 
Helvetica-Cndnsd-Black Oblique HVCO 60 
Helvetica-Condensed-Black HVCBL 60 

Typewriter (mono-spaced) faces (International Character Set) 

PostScript 
Typeface FileName Face Id 
Amencan Typewnter-Bold ATB 100 
American Typewriter-Medium ATM 100 
Machine MAM 101 
Courier-Oblique COURIO 102 
Prestige Elite PERG 103 --
Prestige Elite-Bold PEB 103 
Prestige Elite-Bold Slanted PEBSL 103 
Prestige Elite-Slanted PESL 103 
Orator-Slanted ORSL 104 
Orator ORRG 104 
Letter Gothic-Bold LGB 105 ---
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Typefaces 

Weight 
(Style) 

la 
5 
4 
o 
o 
5 
1 
4 
5 
1 
4 
o 
5 
1 
4 
o 
o 
4 
o 
4 
1 
o 
5 
4 
o 
4 
4 
o 
5 
4 
o 
1 
4 
o 

Weight 
(Style) 

1 
0 
0 
4 
0 
1 
5 
4 
4 
0 
1 
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Typeface 
Letter GothIc-Slanted 
Letter Gothic 

PostScript 
FileName 
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Face Id 
Weight 
(Style) 

Letter Gothic-Bold Slanted 

LGSL 
LGRG 
LGBSL 

105 
105 
105 

4 
o 
5 

PI Fonts (Different Character Sets) 

Typeface 
Symbol 
Zapf Dingbats 
Sonata 
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PostScript Weight 
File Name Face Id (Style) 
SYMBOL 128 0 
ZDM 129 0 
MUSO 130 0 

Since Xerox Ventura Publisher allows font ID numbers up to 65,535, 
you can also assign any font ID number above 256 if your font does 
not appear on this list. 
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VFM file format 

K-22 

The VFM file created during the width table generation process 
describes the font characteristics for each font file. It has the same 
fonnat, regardless of what font file type (e.g., HP LaserJet Plus, 
PostScript) was used as the source. While most readers of this note will 
not need to edit the VFM file, the following infonnation is provided 
for those who have the need to make changes to the font infonnation. 
Remember, after you edit any VFM files, you must then generate a 
new width table using the VFMTOWID utility, and then merge this 
new width table using the AddlRemove Fonts option in the Options 
menu. Otherwise, changes made to the VFM table will not affect 
Xerox Ventura Publisher's output. 

A sample VFM file is shown on the following page. 

In this file, each field has the following function: 

DEVICE-This specifies the printer or typesetter on which this font 
will be printed. The name is determined by the VFM converter you 
use. For example, if you use the HPLTOVFM converter, the DEVICE 
name will be automatically set to HP LJ+. This string is used to 
determine whether Xerox Ventura Publisher is currently set for draft 
or ultimate printing (as shown in the Set Printer Info dialog box.) 
Key Note: draft printing is done on a different printer than the one for 
which you added fonts. Only the system fonts will be used when draft 
printing, and space between words will be adjusted as necessary in 
order to make lines and paragraphs end at the correct place. 

TYPEFACE-This specifies the typeface name. The name is set by 
the IF option during VFM generation. It can be a maximum of 15 
characters, and must be unique for each type family. 

FACEID-This number is the typeface ID. This number is set by the 
IN option during VFM generation. It must also be unique for each 
typeface. The valid range is 15-65,554 decimal. Basic Serifed fonts are 
20-49. Sans serifed fonts are 50-99. Mono-spaced fonts are 100-127. 
PI fonts (i.e., character sets other than the international character set 
shown in figures E-l and E-2) are 128-255. Fonts not shown in the 
typeface tables on the previous pages can be any number up to 65,554. 
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DEVICE HP LJ+ 
TYPEFACE Swiss 
FACEID 2 
SIZES 18 
ATTRTYPE 2 
UFACEID 2 
USTYLE 1 
SFACEID 2 
SSTYLE 1 
TOP 288 
BOT 68 
YMPY 1 
YDIV 18 
XMPY 1 
XDIV 18 
DEVSPEC NONE 
WIDTHS 192 

Width for the letter P. ( 
Character widths, starting 
with the space character 
(decimal 32) 

84100 100 232 1 562127611211214830084100 84 96 
168168168 1681681681681681689292300300300168 
30020 12224216196180232224 92164212176264224236 

(2(iO) 36216200180212196280192 188180116152116300148 
'76i68 184 164 184 172 96 184 180 80 80 168 80 264 180 184 
18418411616496180160228160160152148148 1483004 
224 180 172 168168168 168 164 172 172 172 80 80 80 204 204 
196264300 i84 184184180180160236212168168180180168 
1688018418018022411612816813213272 72 100 136 136 
168184236184284340204204236148148148148248248260 
132300384300148300100204204 19619619692 92 92 92 
236236236200 164 212 212212 188 180 0 0 0 0 0 0 
KERN268 ~ 

:; ~ ~ = ~ ~ 268 kerning pairs in this font. (not all shown here) 
4584-12 \ 

45 88 -12 

4589 -24 First pair is: 
65444 
65464 
65584 
65594 
65 84 -12 
6585 -4 
6586 -4 
6587 -4 
6589 -16 
65 118-4 
65 119-4 

- T 

Figure K-3 Example HP LaserJet VFM file for Swiss 18 point bold. 
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SIZES-This is the point size. It can range from 1-255 points. This 
number is set by the /P option during VFM generation. The number 
255 is used to set continuous font scaling (this enables the Custom font 
setting in the font dialog boxes.) 

ATTRTYPE-This number specifies the weight of the font, where 
1=medium; 2=bold; 5=medium italic; 6=bold italic. This field along 
with sizes and face ID are used by Xerox Ventura Publisher to uniquely 
identify a font. 

UFACEID-This number is always the same as FACEID. It is an 
abbreviation of ultimate face ID. It is used to select the typeface on the 
printer when it is the ultimate device. 

USTYLE-This number is used to select the weight of the font on the 
ultimate device. The numbering convention is different than AT
TRTYPE: O=medium, 1=bold, 4=medium italic; 5=bold italic. 

SFACEID-This is no longer used in this version. 

SSTYLE-This is no longer used in this version. 

TOP-This defines the distance from the baseline to the top of the cell 
of the font, using a normalized measurement system. To convert this 

n(~~~~)into(~~~e)s, use the following formula: 

YMPY * 1200 

BOT-This defines the distance from the baseline to the bottom of the 
cell of the font, using a normalized measurement system. To convert 

U~~)~t :~~rhes, use ilie following fonnula: 

XMPY,XDIV-Xerox Ventura Publisher's coordinate system is 
based upon a 111200 inch grid. The ratio of these two numbers provides 
the conversion between the normalized internal measurement system, 
and inches. 

YMPY,YDIV-Xerox Ventura Publisher's coordinate system is 
based upon a 111200 inch grid. The ratio of these two numbers provides 

REFERENCE GUIDE 



VFM file format 

REFERENCE GUIDE 

APPENDIX K-ADDING FONTS 

the conversion between the nonnalized internal measurement system, 
and inches. 

DEVSPEC-This string is used to pass infonnation to the output 
device at print time, and is associated with a particular face, size and 
weight. The format of the string must be: 

JUNK/pfilename/lfilename 

/p must be placed in front of the portrait font's name, and /1 in front of 
the landscape font's name. 

WIDTHS-This specifies the number of characters in the width table. 

WIDTH TABLE ENTRIES-For any given Font Size (measured in 
points) you can convert from the VFM file width entries (shown below 
the word WIDTHS) into the width of the character (measured in 
points) using the following fonnula: 

Width = (~J (XMPYJ (Font Size) (VFM width) 
1200 XDrv 

Example: 

From the sample VFM file, XMPY=1 and XDIV=18. The width 
measurement for an 18 point letter Pis: 

(~J (~J (18) (200) = 12 points. 
1200 18 

Thus an 18 point letter P is 12 points wide. 

Note: when using this fonnula to compute the VFM width, you must 
round to integer widths. The VFM file fonnat only allows integers. 

It is interesting to compute the width of the capital M in Figure K-3 
and note that it is 18 points, equal to the point size. This verifies that 
the width of an M, which is the basis of the unit of measurement called 
an em, is indeed equal to the point size. 
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Kerning pairs 
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The last part of the VFM file provides information which tells Xerox 
Ventura Publisher how much space to subtract (or add) between 
specified pairs of letters. Up to 1000 kerning pairs are allowed. The 
number of kerning pairs is entered at the beginning of the kerning pair 
section of the VFM file by typing the word KERN followed by the 
number of kerning pairs. The VFM example file contains 268 kerning 
pairs. 

Kerning information for each character pair is entered as follows: 

Char#l Char#2 Kerning 

where Char#l is replaced with the decimal equivalent for the first 
character, Char#2 is replaced with the decimal equivalent for the 
second character, and Kerning is replaced with the amount of kerning 
desired. A negative number moves the second character to the left; a 
positive number moves the second character to the right. The units of 
measurement for kerning are the same as described on the previous 
page for VFM widths. 

Example: 

For the example VFM table, create a kerning pair which will move the 
capital V (decimal 86) 1.20 points closer to the capital A (decimal 65). 

From the VFM table, XMPY=l, XDIV=18, and the font size is 18 
points. Therefore the VFM measurement needed for 1.20 points is 

(1.20)(127020J (118J (118J -- 20 (Rounded to the nearest in-

teger. ) 

The entry in the VFM table under the word KERN looks like this: 

65 86 -20 
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The VFMTOWID utility creates width tables from VFM files. The 
WIDTOVFM utility does just the opposite: it allows you to create 
VFM files from an existing width table. This lets you easily modify or 
update existing width tables. This utility also creates an LST file which 
can be used directly by the VFMTOWID program to regenerate the 
width table once you have modified the VFM files. 

To run the WIDTOVFM utility: 

1) Copy the WIDTOVFM utility from the Utilities disk into the same 
subdirectory as the width table you wish modify. Xerox Ventura 
Publisher must be installed on the same disk drive as this subdirec
tory. 

2) Type: WIDTOVFM widthfile.WID 

where widthfile. WID is the name of the width file. 

Depending on the speed of your computer and the size of the width 
table, the utility will run for at least a few seconds, possibly as long as 
a few minutes. 

When the utility is finished, type DIR *.VFM to display a directory of 
all the new VFM files. Type DIR * .LST to display the file which 
contains a listing of all these VFM files. 

Helpful hint: when you modify VFM files, do not rename or delete any 
of them. If you follow this hint, then all you have to do to regenerate 
the width table when you are finished modifying the VFM files is type: 

VFMTOWID widthfile.LST 

The widthfile.LST file created by the WIDTOVFM utility contains all 
the VFM file names in the correct order. If you want to delete a font 
from a width table, load the width table into Xerox Ventura Publisher 
using the Load Different Width Table command in the Printer Info 
option, and then delete the font using the Add/Remove Fonts option. 
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APPENDIX L STYLE SHEETS 

Xerox Ventura Publisher includes 20 different style sheets. Each style 
sheet is named according to the following formula: 

• &-identifies an original style sheet supplied with the software 

• P or L-identifies the printing orientation as portrait (vertical) or 
landscape (horizontal) 

• Digit-number of columns in the style sheet 

• STY-file extension for a style sheet 

Thus, a book sty Ie which is printed portrait mode in two columns is 
&BOOK-P2.STY. Below is a complete list of style sheet titles with a 
brief description: 

&BOOK-PI.STY 
&BOOK-P2.STY 
&BRO-L2.STY 
&BRO-P3.STY 
&INV-Pl.STY 
&LSTG-P2.STY 
&LTRI-P1.STY 
&MAG-P3.STY 
&NEWS-P2.STY 
&NEWS-P3.STY 
&PHON-P2.STY 
&PREL-Pl.STY 
&PRPT-Pl.STY 
&PRPT-P2.STY 
&TBL-Pl.STY 
&TBL2-Ll.STY 
&TCHD-Pl.STY 
&TDOC-Pl.STY 
&VWGF-L1.STY 
&VWGF-Pl.STY 

Book, 1 column 
Book, 2 column 
Brochure, landscape, 2 column 
Brochure, portrait, 3 column 
Invoice form with line items 
Product listing 
Letter 
Magazine 
Newsletter, 2 column 
Newsletter, 3 column 
Phone listing 
Press Release 
Proposal/report, 1 column 
Proposal/report, 2 column 
Tabular financial table 
Columnar table 
Technic~l manual 
Technical manual 
Viewgraph, landscape 
Viewgraph, portrait 
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CAPABILI.STY 

SAMPLE1.STY 

CHARSET.STY 

SCOOP.STY 

L-2 

The style sheets provided with Xerox Ventura Publisher represent 
common publishing applications. Any style sheet can be modified to 
fit your exact needs. Just remember to make a copy of the style sheet 
before editing so the original remains intact. Any changes made to a 
style sheet affect all chapters which use it. To make a copy of a style 
sheet, use Save As New Style in the File menu. 

Xerox Ventura Publisher also provides a chapter file (on the Examples 
Disk) for each of the style sheets. The chapter file provides a text and 
frame Template for the style sheet to format. 

To look at an example of each style sheet: 

1) Select the Open Chapter option in the File menu. 

2) Select the chapter name which corresponds to the sty Ie sheet you 
want to see (Le., &BOOK-Pl.CHP uses &BOOK-Pl.STY.) 

Xerox Ventura Publisher also contains several other style sheets: 

Used by the CAPABILI chapter to visually show you the limitations 
of your printer. Open this chapter and then print it to see whether your 
printer can print white text on a black background or transparent 
graphics. This chapter also shows you what font sizes your printer can 
print, and how much space it leaves around the edge of the page. The 
CAPABILI chapter is shown on the next page. 

U sed for training exercises 

U sed by the CHARSET chapter to display and print the Xerox Ventura 
Publisher character set. Printing this chapter will show you what 
characters your printer can print. 

U sed by the SCOOP chapter to display an example of a typo
graphically sophisticated page. You should open this chapter, then 
select individual frames to see how to create a complex document. 

To see an example of each style sheet:, open the chapter which has the 
same name as the style sheet, e.g., to see an example of the &PHON
P2 style sheet, open the chapter &PHON-P2.CHP. 
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VENTURA PUBLISHER PRINTER 
CAPABILITY PAGE 

RCVCI se Text 

White text. The box to the left should be black with the words "Reverse Text" 
printed in white on top of it. If your printer cannot print white text on a black 
background (e.g., LaserJet), you will see only a black box. 

Opaque graphics. The word 
"Under" from the phrase "Text 
Under Graphics" should be com
pletely obscured by the opaque oval. 
If your printer can't print opaque 
graphics, the text partially shows 
through the oval. 

Transparent graphics. The word 
"Under" from the phrase "Text 
Under Graphics" should be partially 
obscured by the transparent oval. If 
your printer can't print transparent 
graphics (e.g., PostScript), the text 
will be totally obscured. 

Rotated text. The words 
"Rotated Text" below should ap
pear at right angles to the words 
"Normal Text" if your printer can 
print rotated text. Otherwise, the 
words "Rotated Text" will not ap
pear at all. 

>< 
~ 

1 
o 
~ 

Nannal Text 

Font sizes. The numbers below represent a range of point sizes between 
6 and 72 point Times (or Dutch). If the size is not currently available for 
your printer, the number will print in the nearest available size. 

Colored text_ If your printer 
maps colors to shades of gray, 
you should see different shades 
for the following words: red, 

blue, 

,,',"12.14.243648.72 
Ruling lines. This 3 ruling 
lines around this box 
should be obscured by an 
opaque circle. On some 
printers, the rules show 
through. 

Kern: 
No Kern: 

VA 
VA 

Automatic kerning. Some 
printer width tables contain kern
ing information. If your printer 
width table contains kerning in
formation, the letters V A will be 
closer together in the first line 
than in the second line above. 
Otherwise, the V A in both lines 
will be identical. 

CAPABILI.CHP Print this file to your printer to visually see your printer's capabilities. 
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STYLE SHEET: &BOOK·Pl.STY 

Description: Single column book layout 

Comment: For any document with multiple chapters or sections. 

Special Characteristic: Menu: Option 

One 36-pica column Frame Margins & Columns 

Column-wide rules above Paragraph Ruling Line Above 
and below Chapter :# Ruling Line Below 

Chapter #, Chapter Title Paragraph Alignment 
centered on page 

Big first character Paragraph Special Effects 
in Firstpar 

Body Text indented 1.5 Paragraph Spacing 
inches in from left margin 

Bullet indented 10 picas Paragraph Spacing 
from left margin and begin Special Effects 
with • 

Ruling line separating Page Footnote Setting 
footnotes from text 

Page Break has page break Paragraph Breaks 
after set so that following 
paragraph starts new page. 

Change Bar is created with Paragraph Ruling Box Around 
a custom ruling box around 
where the width of the rule 
and the height of the rule are 
the same. 

Tags and Function Keys 
F1 Firstpar F2 Major Heading 
F3 Minor Heading F4 Bullet 
F5 Chapter Head F6 Chapter # 
F7 F8 Page Break 
F9 Change Bar FlO Body Text 
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Chapter # 
I 

~ 

== ~ 
C'1 
~ 

~ 
Firstpar 

• 
~ 
0 ~ 0 0 

~I 
~ 0 
~ = Body Text 

w 
I 
CfJ 
W 
.....J 
>- ~ I-
CfJ 

~ ~ 
Z_LABEL FIG E-4 as x 

~ -is c: Z_FOOTER z 
~ w 

a.. 
~ a.. U E-4 « 

~Chapterl 

The Adventure Begins 

__ +1 tI.~ThiS lnp rcally ocg-:m in ~cp~mber last year 
when Gerry won fIrst pnze m a raffle at the 

faslllon show which Rush-Prcsbytcrian-St. Luke's 
MedIcal Ccnlcr holds every year. The prize was two 
round LIip tickets to Hong Kong on United Airlincs. 
and k'll nights in lhe Hong Kong Hyatt Hotel. 
AnalY/.ing our good fOrLunc.wcconc1udcdtharwe 
W:HllL'd III do more than spend (Cn days in Hong 
Kllng ;llld return, hut at the same time, Uniled, 
kl\ ill~ju~l !c!llllcn ilsroulcsandcquipmcnlfrom Pan 
Anh.'riL"an. h:ld not yet r.:...·civcdauthority to fly to 
(lUII.'r d':-SlJn.ltlOns or hclwecn points in thc Far East 

--+I.~~ On Febru;lr)' 10th. UmlcdacquircdthisaulhorilY, 
~nd 011 Fdmlacy II th Debbie ocean putting our tri 

Flaure l-l)Place your own plclure inthis 
frame 

-_+1 tI.~The Adventure Begins 

together. We left on March 2nd and returned on 
March 261h. We enLCred seven countries. traveled 
over 25.000 miles on four airlines. made over 500 
Kodachromc@ slides. almost 200 Kodacolor~ 
prints. and 5 1(2 hours of color and sound videotape. 

Chicago to Tokyo 

II :03 P.M. Chicago Lime. 39,000 feet somewhere 
over the Western Pacific. we are 8 hours and 42 
minutes out of Los Angeles with about 2 more hour 
to go to TOKYO. We were about an hour and ten 
minutes IUIC out of Los Angclcs, 

Travel Log 
So far. it'sbeen a long and interesting day and 1 

guess it's just about half over. We did the follow· 
mg: 

• Aroscat5:30A.M 
• Left the house at 7:00 A.M. 
• Arrived in Los Angeiesat 12:35 P.M ........ _+ __ 
• Arrived in Tokyo at 11:46P.M. 

Chapter Title 

Major Heading 

Minor Heading 

Bullet 
Z_CAPTION 

UJ 
o 
::; 
~ 
UJ 
o z 
w 
a:: 
w 
LL 
UJ 
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STYLE SHEET: &BOOK-P2.STY 

Description: Two column book layout 

Comment: For any document with multiple chapters or sections. 
Note how frame-wide Chapter headings keep text from flowing to top 
of second column on page one. 

Special Characteristic: Menu: 

Rule around entire frame Frame 

Two 17-pica columns Frame 
with a 2-pica gutter 

Chapter #, Chapter Title Paragraph 
flush left on page, extends 
across columns 

Big first character Paragraph 
in Firstpar 

Major Heading flush left Paragraph 
in column 

Ruling line below Paragraph 
major Heading 

Bullet indented 10 picas Paragraph 
from left margin and begin 
with • 

Page Break has page break Paragraph 
after set so that following 
paragraph starts new page. 

Change Bar is created with Paragraph 
a custom ruling box around 
where the width of the rule 
and the height of the rule are 
the same. 

Option: 

Ruling Box Around 

Margins & Columns 

Alignment 

Special Effects 

Alignment 

Ruling Line Below 

Spacing 
Special Effects 

Breaks 

Ruling Box Around 

Tags and Function Keys 
Fl Firstpar F2 Major Heading 
F3 Minor Heading F4 Bullet 
F5 Chapter Title F6 Chapter # 
F7 F8 Page Break 
F9 Change Bar FlO Body Text 
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Body Text 

Position 

The Title of The Seminar --
A Short Description of the Seminar .......... ----------~~ 

fJ'J,i~~~%?:, ~ ............ -------------+-
Detroit, Michigan ~ 

~ Some sales blurb that makes a person want to attend your seminar. 
~ Highlights of last ~ear's seminar. How many people showed up. What 

you can expect this year. 

7:30-8:00 A.M First event. ~ Event 
-+-----t.~~:;;-o;,:.r;;;~~t 

XYZCorp. 

A brief description of what Mr. Smith will talk about. 

10:00-10:15 Break 

10:15-12:00 Exhibits 
All kinds of interesting exhibits 

12:00-1 :00 P.M. Lunch 

1:OQ-2:30P.M Next talk 

Time ~8:OQ-10:00A.M. Second Event 
Ms. Jane Schwartz 

Mr.J. Poiuyt 
Director of Sales 
RTY Industnes 

What he plans to talk about 

Treasurer 
NBCo.Ltd. 

Ms. Schwartz will talk about all kinds of interesting things. 

2:30-5:00 Cocktail hour 

Title 

Subtitle 

Setting 
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STYLE SHEET: &BRO-L2.STY 

Description: Two-column landscape brochure 

Comment: Use to describe meeting agenda 

Special Characteristic: Menu: Option: 

Two 26.5 pica columns Frame Margins & Columns 
with a 6-pica gutter 

Title, Subtitle and Setting Paragraph 
centered on page 

Alignment (frame-wide) 

Ruling line below Setting Paragraph 
(To use Setting tag 
without ruling line, press 
Ctrl + Enter after text to 
create a line break. July 
23,1987 and Mariott 
Hotel are examples.) 

No line break after Time Paragraph 
(Line Break=Before. This 
means another tag, i.e., 
Event, can be on the 
same line, since it is in-
dented from left margin) 

Event and Position Paragraph 
are indented 1.5 inches in 
from left margin 

Page Break has page break Paragraph 
after set so that following 
paragraph starts new page. 

Ruling Line Below 

Breaks 

Spacing 

Breaks 

Tags and Function Keys 
F1 Title 
F3 Setting 
F5 Event 
F7 Time 
F9 Position 
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F4 
F6 
F8 Page Break 

F10 Body Text 
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ACME PUBLISHER 
Professional Publishing For Your Desktop 

ur favorite word proces
sor. and graphics from 
popular graphics programs 
or scanners. and create 
professional. typeset quality 
documents. Without being a 
professional layout artist. 
typesetter or graphic desig
ner. You don't even have to 
think like one. 

You can compose any docu
ment that you desire in a 
fraction of the time it would 
take to send it to a typeset
ter. proof it. and print it. 

Sl!!!cificatlons 

Feature Mult. Mod. Rel.1 

Text Yes Yes Yes 

Picture Yes No Yes 

Yes Yes 

With the Acme Publisher™. 
all you need to know is how 
to point. The mouse driven 
software contains dozens of 
professionally designed 
style-sheets-for newslet
ters. flyers. technical docu
ments. catalogs. proposals. 
and magazines. Plus. you 

can design your own. or 
modify ours. 

~ choose your design by 
selecting a style-sheet. 
Click. Load text from your 
word processor. Click. And 
watch it flow. instantly. into 
your format. 

You want three columns. not 
two? Click. Done. The whole 
chapter. up to 100 pages. is 
now three column format 
with proportional spacing. 
justification. hyphenation. 
multiple type styles and 
sizes. Just like you get from 
the typesetter. 

Headline 

Oeckhead 

Table Item 
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STYLE SHEET: &BRO-P3.STY 

Description: Three-column portrait brochure 

Comment: Use for sales brochures. 

Special Characteristic: Menu: Option: 

Three 13-pica columns Frame Margins & Columns 
with a 1.5-pica gutter 

Headline automatically Paragraph Typographic controls 
kerned and tracked 

Headline, Deck Head Paragraph Alignment (frame 
centered on page wide) 

Major Head flush left Paragraph Alignment (column 
over column wide) 

Table Header centered Paragraph Alignment 
over column 

Custom 1 point underline Paragraph Typographic controls 
used on first line of Table 
Item 

Ruling line below Paragraph Ruling Line Below 
Table Header 

Table Item tab settings: Paragraph Tab Setting 
tab1=left (4 picas) 
tab2=right (10 picas) 
tab 3=right (13 picas) 

Body Text flush left Paragraph Alignment 

Page Break has page break Paragraph Breaks 
after set so that following 
paragraph starts new page. 

Tags and Function Keys 
F1 
F3 
F5 
F7 
F9 

Headline 
Major Head 
Table Header 
Address 
List Item 

REFERENCE GUIDE 

F2 Deckhead 
F4 
F6 Table I tern 
F8 Page Break 

FlO Body Text 
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Logo 

Address 

Date 

Customer 

Invoice 

Column heads 

Total 

microPublishing Report 
Small Computer Solutions for Publications Professionals 

2004 Curtis Ave. #A 

March 1, 1986 

Quantity Description 
Subscription 
Seminar fee including 

late charges 

Redondo Beach, CA 90278 

INVOICE 

Price 
$175.00 
$575.00 

(213) 376·5724 

Subtotal 
. $175.00 

................ $2,875.00 

Total now due: ....................................................................................... $3,050.00 

Line item 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &INV·Pl.STY 

Description: Single column invoice 

Comment: Mixed type sizes in Logo. (Set tag attributes, then go to 
Text mode. Select the word to be in a different font and use Set Font 
to change it. Note: Paragraph Tag does not override Set Font at
tributes) 

Special Characteristic: Menu: Option: 

One 42-pica column Frame 

Address tab settings: Paragraph 

Margins & Columns 

Tab Setting 
tab l=center (21 picas) 
tab 2=right (42 picas) 

Invoice in shaded box Paragraph 
(use an 18-pt. rule with 
pattern 1. Select a nega-
tive value (-) for Space 
Below Rule 3. This has 
the effect of moving the 
line below 18 points 
higher and creates dark 
words on a shaded band.) 

Column Head tab settings: Paragraph 
tab 1 =left (6 picas) 
tab 2=left (20 picas) 
tab 3=right (42 picas) 

Ruling Line Above 

Tab Setting 

Line Item tab settings: Paragraph 
tab 1 =left (6 picas) 

Tab Setting (leaders 
turned on for tab 3) 

tab 2=left (20 picas) 
tab 3=decimal (40 picas) 

Ruling line above Paragraph Ruling Line Above 
Total 

Total tab settings: Paragraph Tab Setting 
tab 1 =decimal (40 picas) 

Fl 
F3 
F5 
F7 
F9 

Headline 
Major Head 
Table Header 
Address 
List Item 

REFERENCE GUIDE 

Tags and Function Keys 
F2 Deckhead 
F4 
F6 Table Item 
F8 Page Break 

FlO Body Text 
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Z_HEADER 

Category 

Comp 
Model 

Body Text 

Digitizers 

~ Digitizers DeclslonWare, Inc •..........•. (555) 3836059 
RightWriter 
Document and style proofreader for IBM PC 
75.00 

Chorus Data Systems.. . . .. . .. (555) 424 2900 IBM PC 96K. DOS 2.0 
PC-Eye 

~ 
Video capture image digitizer 
450.00 
IBM PC 256K. long slot 

Emerging Technology ..... . .. (555) 447 9495 
Professional Writers Package 
Word processing and document development 
software 

Datacopy ..... __ . _ . . . ... (555) 965 7900 490.00 
Model 900 Imaging System 192K 
35-mm digitizing camera with computer interface 
11945.00 Living Vldoetext, Inc __ ......... (555) 9646300 
IBM XT/AT. Thinktank 
Hercules card Outlining software 

195.00 
Koala Technologies, Inc .. _ ..... (555) 676 5655 IBM PC or Macintosh 
MacVision 
Image digitizer for Macintosh computer Reference Software ........... (555) 826 2222 
349.95 Reference Set 
Macintosh On-line thesaurus 

89.00 
Mlcrovision Co. ... _ . _ ... (555) 438 5520 IBM PC 
MacV,z 
Image digitizer for Macintosh 
299.00 
Macinlosh 

ScenlcSoft Inc. 
ScenicWriter 

(555) 742 6677 

Text editing, correcting, and compos'llion software 
for IBM 

Quad ram Corp. . .. 
Palette Capture 
Video input digitizer 
795.00 

. ... _ .(555) 923 6666 PC 

IBM PC 360K, DOS 2.1 

Editorial Software 

Arrlx Logic Systems Inc. . _ ..... (555) 292 6425 
APSImicroDCF 
IBM-based text processing system 
695.00 
IBM XT 

995.00 
MSDOS 

TCI Software Research 
T3 
Scientific word processing system 
595.00 
IBM PC, 512K. graphics 

(555) 522 4600 

Writing Consultants 
Word Finder 

...... (555) 377 0130 

On-line thesaurus 
124.95 
IBM PC 

page 1 liliiii Z_FOOTER 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &LSTG-P2.STY 

Description: Two column product listing 

Comment: Line breaks are used to separate different entries in 
Body Text. In long directory listing, this dramatically increases the 
size of the chapter that can be created compared to using paragraphs 
between each line. 

Special Characteristic: Menu: Option: 

Two 19-pica columns Frame Margins & Columns 
with a I-pica gutter 

"Live" headers automatically Page 
place, in the header, the first 
occurrence of text which is 
tagged as Category. This is 
stored in chapter, not style 
sheet. 

Text attributes in the footer Page 
(the word page is subscripted) 

Headers & Footers 

Headers & Footers 

Comp uses one tab, with 
with dot leaders to create 
the phone number. 

Paragraph Tab Settings 

tab=right 19 picas 

Fl Category 
F3 Model 
F5 
F7 
F9 

REFERENCE GUIDE 

Tags and Function Keys 
F2 Comp 2 
F4 
F6 
F8 

FI0 Body Text 
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-"----------tl~~ Ajax Corp. 
Leaders in Industrial Innovation 

[ 

123 Sapporro Road 

-+----------.~~ paIO(5~~;d;:i~~~027 ... 4 ....... ----------_+-
Mr.J.Smilh 
123 Main St. 
Delroit, MI 98989 

Dear Mr. Smith, 

November 15.1987 ...... -+--

It has been called to our attention that you have been having a difficult time with our new 

widget Upon reviewing your case, we have found that you have failed to plug your widget into 

an electrical outlet. As may know, our widget does require power to operate properly. 

Thank you for buying our widgets, and we look forward to your continued business 

~ 
Sincerely, 

John L. Smi,h 
Customer Service Manager 

Motto 
Phone 

Date 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &LTR-Pl.STY 

Description: One column standard business letter 

Comment: 

Special Characteristic: Menu: 

Company Name centered Paragraph 
with rule below it 

Body Text double spaced Paragraph 
(use Inter-line spacing option; 
Spacing Above is one-half 
the amount entered for 
Inter-line) 
Change inter-line spacing 
to 13.98 points for single 
line spacing. 

Date has line break after Paragraph 
with Beside Last Line of 
Previous Paragraph 
This, combined with 
right alignment places the 
date on the same line as 
the last line of the previous 
paragraph 

Page Break has page break Paragraph 
after set so that following 
paragraph starts new page. 

Change Bar is created with Paragraph 
a custom ruling box around 
where the width of the rule 
and the height of the rule are 
the same. 

Option: 

Alignment 
Ruling Line Below 

Spacing 

Break 

Alignment 

Breaks 

Ruling Box Around 

Tags and Function Keys 
F1 
F3 
F5 
F7 
F9 

Name 
Address 
Recipient 

Change Bar 

REFERENCE GUIDE 

F2 Motto 
F4 Date 
F6 
F8 Page Break 

F10 Body Text 

L-17 



~ 

= 0 
ct$ 
~ • 

~ 
~I ~ 
W 
J: 
C/) 

W 
.J 
>- .. 
r- et: C/) 

J ~ 
x E-t 
Ci 

~ z 
w 
a.. 
a.. 0 « 

E-4 

~~ 
~~ 
t-4~ 

~~ 
~~ 

~ ...... 
a= 
~ 
~ 

E-4 

Oeckhead 

Byline 

Creditline 

Z_LABEL FIG 
Z_CAPTION 

First par 

Body Text 

Z_FOOTER 

Laser Printers Arrive 

~~~~~[, kre:sC~~~~ln~ar~~ I fmm 

Computer Business 
Competing Technologies 

byJosC{JhSmilh • D<lisyWhcc1 

Dot Matrix 

• Laser printers 

Figure-II
The Author 

The laser printer provides sharper 
graphic Images, Jones nOled, and the 
laser now has the wealth of software 
sUpportdol-matrixprimcrshavcalways 
enjoyed. So, ifauscr moves to a laser 
prinlcrfromadol-maLIixprimcr"hccun 
run much of his graphics software and 
get bener graphics resolution," Jones 
said. 

"The nCxlstcp isdcycloping generic 
graphics drivers which support lasers at 
300-by-300 resolution. That's when 

~ I Bullet 

+ 
you will sec a huge impact on dOl
matrix printers, both in price and the 
numbcrofunitsshipping,"hcsaid,ad
ding that it will bc a year to 18 months 
bcforc Ihis happens_ 

.A. 5 laser pri~ters g~in more altention 
wlLh lower pnces, higher speeds and 
quality output, high-end dot-mauix 
printers are slarling 10 losc some ofLheir 
appeal. 

Though PC users are still buying dot
matrix printers, the laser printer is 
giving them an alternative to think 
about, according to indusuy observers 

Laser printers, Lhough relatively ex
pensive, are being used more in net
worked environments where the dis
uibuted use of the printer justifies the 
expcnse,severaJ analysts said. The non
impaclprimcrsaisocatchuserimerest 
because they arelcss noisy, offer shar
per graphics (commonly 300-by-300 

November 15, 1988 

Laser primers with write-white 
engines and copier options. using 
dry powder toner. 

Laser printers still have a few areas 
that could be improved. according to 
George Jones, a key industry analyst. 
He noted Lhat Lhere are no standards in 

Joncs was quick to point out that hc 
never sees dOl-malrix printers disap
pearing_ "Multiplc-part forms arc still 
imponam, and an impact printer is 
needed for that." He also noted that 
people will always want hard copies for 
their files or interoffice memos, and the 
quickest, most cost-efficient way of 
doing thaI is through a low-cost dot
matrix printer-without having to wait 

This is a liftout. It in line for a share laser printer. Current 

highlights a key quote or les figu,es seem 10 bca, Jones OUI. In 

statement in the article. markel-research rum Las" Compuling 

controllers for laser primers and but the 
cost of using a laser is now less than a 
dot matrix on a cost-per-copy per 
minute basis. 

of Alamo, Texas, polled over 600 com
puterspccialtyslorcs finding Lhat, while 
lascr-printersalesareup.lheyhavenol 
cclipscd dOl-matrix printers. 

Laser Computing analyst Todd Wig
gins said he expccts dOl-mauix printers 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &MAG-P3.STY 

Description: Three column magazine 

Comments: Note automatic figure numbering in frame captions. 
This is saved. in the chapter. Also, note that text in the Liftout box is 
from a different text file. 

Special Characteristic: 

Three 13-pica columns 
with a 1.5-pica gutter 

Body Text first line indent 
of6 points 

Letterspacing on for Body 
Text 

Vertical rules between 
columns 
(Inter-column=on) 

Headline centered 
across page, frame-wide 

Firstpar not indented 
(Relative indent=O) 
Big first character in 
Firstpar 

Bullet has l.l-pica 
fixed indent 
each Bullet item begins 
with • 

Larger type size 
for text in liftout box 

Ruling lines above and 
below Liftout 

Menu: Option: 

Frame Margins & Columns 

Paragraph Alignment 

Paragraph Typographic Controls 

Frame Vertical Rules 

Paragraph Alignment 

Paragraph Alignment 

Paragraph Special Effects 

Paragraph Alignment 

Paragraph Special Effects 

Paragraph Font 

Paragraph Ruling Line Above 
Ruling Line Below 

Tags and Function Keys 
FI Headline 
F3 Firstpar 
F5 Creditline 
F7 Byline 
F9 

REFERENCE GUIDE 

F2 Subhead 
F4 Deckhead 
F6 
F8 Bullet 

FlO Body Text 
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Widget World News ----Views and News of Widget Manufacturing in the 80s 

Headline ~Software Salaries: How do you stack up? 

Byline ~bYJoesm'th I 

Subhead 

Body Text 

TOC Title 

How much your soflware professionals are paid is a func
tion of many variables. and a subject of considerable interest 
toyourorganizalion. 

~soltware salary pay scales 
Because of the dynamic growth of the software industry 

over the last decade, the demand for experienced. qualified 
programmers has greatly increased. thus leading to a spiraJing 
ofsaJarics. 

But what causes managers to pay one programmer more 
than anOlher? Does the type of organization, its size. or loca
tion make a difference? What career path or programming 

~
PCCialtYICadslothcmostrcmunCraliOn? 

To answer these questions. Acme Magazine recenLly con
ductcd its third annual compcnsation survey for softwarc pro
fcssionuls. This newsletter article prescnts the results of this 
study and explores what the findings may mean to you. 

Acme Magazine asked Joe Smith, a compensation consult
ing specialist for the software indusUy,LO design and conduct 
the survey. Twenty-four positions, representing four program· 
mer job families plus management, were included. 

Data was collccted for base pay, bonus and incentive pay
ments, and whether nor not incumbents received stock options 
or other forms of equity. 

Questionnaires were sent to the data processing heads of 
2,400 organizations throughout the United States. 

-of----!o-.... ~ Table of Contents 

Second story. .............. . .. ...... 2 

TOC Entry ~ Next comes the /ounh .............. 5 
A Long article breaks to the next line without 

running into the page number ............... '.d .•........ 6 

Note that this TOC could have been generated 
from the newstetter CHP file ............................... 9 

CD-ROM Breaks New • Ground 
Compact Disk Read Only 

Memory (CD-ROM) is a rap
idly emerging new technol
ogy for the retrieval of vast 
amounts of infonnation from 
an optical disk. This new 
peripheral device allows a to
tally new level of func· 
tionality in the use of 
microcomputers. 

Physically. the CD·ROM 
device has a laser disk drive 
(or "player") thc same size as 
atraditional51/4"drive. The 
removablediskis43/4",and 
has a capacity of 550M bytes 
(equivalent to 1500 360K 
floppy disks). 

Theory 01 Operallon 
Information stored on a 

CD-ROM can be loaded into 
memory (RAM), displayed 
and printed, as with other 
media. While that data in 
RAM may be altered and 
stored to a conventional mag
nelie disk.lheoriginai infor
mation on the CD-ROM is 

unalterable. always ensuring 
the original copy is intact. 
making arehiving easy. 

The storage capacity, low 
cost, and read only feature of 
CD-ROM bring an enonnous 
new capability to microcom
puterusers-lhatis,infor
mation retrieval of very large 
reference publications. How 
people receive and use infor. 
mationintheimmediateand 
longtenn future will bedra
matically changed by CD· 
ROM. 

In addition to the huge ca· 
pacity of raw information 
storage, specialized software 
for the search of that inform a
tion is currently being intro· 
duced. This software allows 
searching the infonnation in 
areas, methods and spceds not 
previously feasible. 

It now bccomespossible to 
electronically publish refer· 
ence material more economi· 
cally than to print the same 
material in book form. That 

Caption ........ __________ --1~_ 
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Credo 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &NEWS-P2.STY 

Description: Two column newsletter 

Comment: Frames placed on top of underlying page frame allow 
multiple text files to be placed in document. Each frame can have its 
own set of columns. Text flows from frame to frame. The order of flow
ing is determined by what order the frames were created. 

Special Characteristic: Menu: Option: 

Two 20.5-pica columns Frame Margins & Columns 
with a I-pica gutter 

First line of Body Text Paragraph Alignment 
indent ofl pica 

Table of Contents frame has Frame 
ruling box around and shaded 
background 

Ruling Box Around 
Frame Background 

Table of Contents entries Paragraph Spacing 
indented I pica from left 
and right frame margin 

TOC tab settings: 
Tab I=right (19 picas) 
leader=periods 

Successive hyphens 
in Body Text restricted to 
2 in a row 

Paragraph Alignment 

Tags and Function Keys 
FI Deckhead 
F3 Bullet 
F5 TOC Entry 
F7 
F9 

REFERENCE GUIDE 

F2 
F4 Credo 
F6 
F8 Subhead 

FlO Body Text 
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Byline 

Subhead 
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142 Guitrep Pkwy 

Software Salaries: How 
do you stack up? 

hyJocSmith 

Software salary pay scales 
Bcc:Juse ofthc dynamic growlhof 

the software industry over the last 
decade, the demand for ex~rienced, 
quallfll:-d programmers has greatly in
rreased, thus leading toa spLraling of 
salaries. 

But what causes man:lgcrs 10 pay 
onc programmer more than another"? 

Z_CAPTION 

+ FIgure 1 C~ph<>n Inf<>rmatloo. 

Docs the typcoforganiz:ltion, its sizc. 
or loc:ltion make a difference? What 
carccr path or programnung spccialty 
lcads to the most remuneration? 

To answer these questions, Acme 
MagazincreccntJyconductcd its third 
annual compensation survey for 
software professionals. This newslet
terarticle prescntsthe results of this 
study and explores what the findings 
may mean to you 

Aeme Magazine asked Joe Smith. a 
compcnsaLionconsullingspcciaJistfor 
the software industry. to design and 
conduct the survey. Twenty-fourposi
lions, representing four programmer 
job families plus management. were 
included. 

November.J987 

Detroit. Mt 98987 

Data was collected for base pay. 
bonus and incentive payments, and 
whcthcrnornolincumbcnlSrcccivcd 
slock oplions Of Olhcr formsofcquilY 

QucsLionnaircswcrCSCnllOlhedala 
processing heads of 2.400 organi7..a
tionsrnroughoutthcUnilcdStalcs 

CD-ROM Breaks New 
Ground 

Compact Disk Read Only Memory 
(CD-ROM) is a rapidly emerging new 
technology for the rClfievaJ of vast 
amoums of infonnation from an opti
cal disk. This new peripheral device 
allows a towlly new level of fune
tionalityinthcuscofmicrocompulcrs 

Physically, the CD-ROM device 
has a laser disk drive (or "player") the 

same size as a traditional 5 1/4" drive. 
The removable disk is4 3/4",andhas 
a capacity of 550M bytes (equivalent 
10 1500360K floppy disks). 

Theory of Operation 
Information stored on a CD-ROM 

can be loaded into memory (RAM), 
displayed and printed. as with other 
media. While that data in RAM may 
bealleredandstoredtoaconventional 
magnetic disk, the original infonnaLion 
on the CD-ROM is unalterable,always 
ensuring the original copy is intact, 
making archiving easy. 

The storage capacity ,low cost, and 
read only feature of CD-ROM bring an 
enormous new capability to 

(413) 567-9888 

microcomputer users - that is, infor
malion rClIieval of very large reference 
publications. How pcople receive and 
use infonnation in the immediate and 
long term future will be dramatically 
changed by CD· ROM. 

lnaddilion to the huge capacity of 
raw infonnation storage. specialized 
software for the search of that informa
tioniscurrentlybeingintroduced 
This soflware allows searching the in
formation in areas, methods and 
speeds not previously fcasible 

It now becomes possible to 
electronically publish reference 
material more economically than 10 

print the same material in book form. 
That cost benefit, coupled with search 
and retrieval software, make an 
astonishing price/pcrfonnance ratio. 

Table of Contents 
First story.... .. .. __ .... 1 

Second story..... .. ............. 2 
Thelhirdarticfe ... _ .. _ ........ 3 

Next comes the fourth ....... 5 
A Long article breaks /0 the 
next line without running into 
Ihe palle numbQr .... __ .. _ ...... 6 
Nolelhallhis TOC coufd 
have been generaled from 

Ihe newsletter CHP lile • ..... 9 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &NEWS-P3.STY 

Description: Three column newsletter 

Comments: Unlike text in &NEWS-P2.CHP, the text in this 
chapter flows directly into the underling page. The table of contents 
frame has a ruling box around and a shaded background. These ef
fects are part of the chapter, not the style sheet 

Special Characteristic: Menu: Option: 

Three 12.5-pica columns 
with a 2-pica gutter 

Page Margins & Columns 

Inter-column vertical rules 
between columns 

Headline has ruling line 
above 

Firstpar has no indent 
(Fixed indent=O) 

Body Text has I-pica 
fixed indent 

Table of Contents entries 
indented 1 pica from left 
frame margin 

TOC tab settings: 
Tab l=right (19 picas) 
leader=periods 

Frame Vertical Rules 

Paragraph Ruling Line Above 

Paragraph Alignment 

Paragraph Alignment 

Paragraph Spacing 

Generated caption line Paragraph Breaks 
break before. Free-form 
caption line break after and 
indent relative to length of Alignment 
previous line plus 12 points 

Tags and Function Keys 
Fl Deckhead 
F3 Bullet 
F5 TOC Entry 
F7 
F9 

REFERENCE GUIDE 

F2 
F4 Credo 
F6 
F8 Subhead 

FlO Body Text 
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AST Research Inc. Xerox ~ Z _H EAD E R 
(555)8631333 

AbatonTechnology (555)9059399 
Addison.Wesley Publishing Co (555)9443700 
Adobe Systems Inc (555)8520271 
AdserveMedlaSystems, Inc (555)2135700 
AdvancedTechnologleslnt'l (555)7481688 
AFIPS (555)6208926 
Airus (555)6843000 
AlhedLlnotype (555)4342000 

~
AllotypeTYPOgraPhiCS (555)5773035 
AlphaSottwareCorp. (555)2292924 
AlphaGraphlcs (555)8824100 Body Text 
Altertex! (555)4260009 
American 8usiness Press (555)6616360 
Amgraf.lnc (555)4744797 
AmrronDataServices (555)8598333 
Apple Computer. Inc (555)996 1010 
Applied Publishing Technologies (555)872 "90 

Phone tmt2!,Csystemsinc l1li ~~;~~~~~~~~ 
Ashton-Tate (555)3298000 
ASTAesearchlnc (555)8631333 
Autographix (555)8908558 
Autologic (555)4989611 
Automallc Fulfillment Services (555)3668722 
Autospeclnc (555)6490890 
Award Software Inc (555)3952773 
Beach Media Inc (555)2266726 
Bell & Howell Company (555)2621600 
BPAA (555)6610222 
Business Systems International (555)9987227 
Bunonwarelnc (555)7464296 
CanonUSAlnc, PrinterDiv (555)4886700 
Capital Equipment Co (555)8296220 
CauzinSystems, Inc (555)5730150 
Centfam Systems West, Inc (555) 644 8244 
CFlnc (555)8294990 
Chorus Data Systems (555)4242900 
Comm Type Interface Typesetting (555)9388973 
Composition Technology Inti (555)8481010 
CompugraphicCorp (555)9446555 
CompuNews, Inc (555)8261110 
CompuScan,lnc (555)2886001 
CompuServe (555) 4578600 
Computer EdlTypeSyslems (555)2228148 
Computing Software Services Inc (555) 43260n 
Concept Technologies, Inc (555)6843314 
CreativeSlralegies Resrch Inler (555)2497550 
CybenextCorp (555)8227079 
Data Transforms (555)8321501 

DataChange, Inc 
Data Fronliers, Inc 
Data Recording Systems, Inc 
Data Sytemsof Connecticut Inc 
Datacopy 

g::~~~~s ~~c 
Dataquestlnc 
Oatek Information SerVlC9s, Inc 
OayFlolnc 
DeastonWare, Inc 
DsasionResources 
Desktop Graphics 
DestCorporalion 
DicomedCorp 
Oiconixlnc 
Digllal Equipment Corp 

g~~~II::t:~:~~: International 

~~~t"m:~~::SY Inc 

EikonixCorporation 

~:C~~en:r!~i~r;~:I~Sn~~chnOIOgy 
Emerging Technology Consultants 
Epsilon 
EpsonAmenca,lnc 
Ericsson Inlormation Systems 
Esgraphlncorporated 

~I~::~i~:~:~~~es 
~~~~ ~~~~I~V~~~re, Inc 

FTlSystems 
FUjitsu America Inc 
Future Compuling Inc 
GeneratBindlngCorporation 
GenesysSystems 
GenicomCorp 
Genoa Systems Corp 
Gnostic Concepts, Inc 
Graphic Connections 
Graphic Arts Technical Foundation 

~~amSoftwarecOfP 

HammermiliPapersGroup 

~::~:t~~~:puter Graphics 

Hewlett-Packard 

(555)4411332 
(555)4673125 
(555)2932400 
(555)8775451 
(555)9657900 
(555)2664444 
(555)2627276 
(555)9719000 
(555)8939130 
(555)4763044 
(555)3836059 
(555)2221974 
(555)7369098 
(555)9467100 
(555)8853000 
(555)2593100 
(555)8845111 
(555)2262984 
(555)9571600 
(555)7589460 
(555)4456325 
(555)2755070 
(555)2271447 
(555)6377233 
(55514479495 
(555)2730250 
(555)5344500 
(555)8953962 
(555) 524 03n 
(555)6210818 
(555)8414503 
(555)6333676 
(555)2331080 
(555)4872142 
(555)9468777 
(555)4372400 
(555)2723700 
(555)5643636 
(555)9491188 
(555)9459720 
(555) 8544672 
(555)2519750 
(555)6216941 
(555)3591024 
(555)6412200 
(555)4568811 
(555)3295076 
(555)9691642 
(55513233869 
(214)4362616 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &PHON·P2.STY 

Description: Two column portrait style for phone books or other 
directories 

Comment: The break and alignment settings in the Body Text and 
Phone tags allow a directory to be created without tab settings. 
However, dot leaders cannot be used. Text was automatically tagged 
by database report generator. By making the company name a 
separate tag from the phone number, the company name can 
automatically be placed into the header. 

Special Characteristic: Menu: Option: 

Two 20.5 pica columns Frame Margins & Columns 
with a I-pica gutter 

"Live" header on odd and Page 
even pages. First and last 
occurrence of text tagged 
with Body Text are placed 
in the header. 

Ruling line below Header Paragraph 

Body Text has line Paragraph 
break before, but not after 

Phone has line break after Paragraph 
and right alignment. This 
makes the phone numbers 
appear on the same line with 
the company names. 

Phone flusn right Paragraph 
in column 

Headers & Footers 

Ruling Line Below 

Breaks 

Breaks 
Alignment 

Alignment 

Tags and Function Keys 
FI Phone 
F3 
F5 
F7 
F9 

REFERENCE GUIDE 

F2 
F4 
F6 
F8 

FlO Body Text 
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Name • Ajax Corp. 
Leaders in Industrial Innovation ........ --------_t-

[ 

123 Sapporro Road 

Address • palO;5~~~;:i~~~02 .. 7 .. 1lIIIIIII1_----------_t-

For Release • FORIMMEDlATERELEASE 

Motto 

Phone 

Fornwreinformation: ~ ~ Contact 
Mr. Joe Flack ...........,... 

(212) 555·1212 

-XYZ Corp. Ships 1000th Product -
Date line ---t.. LOS ANGELES, CA, July 17 XYZ Corp .. the leading manufacturer of widgets for the automated 

WI get supp y In ustry, announced that it has shipped its 1000th Model 123-X enhanced widget. ...... _-+-
The customer is ABC Inc. of Livonia Hills, MI. 

Body Text 
"This is an important step for XYZ Corp., and the emerging widget industry," said Fred Smith, 

~ president of XYZ Corp. "We have now shipped more widgets than the other ten companies com
bined. We believe our technology is second to none," 

Marketing plans. availability, and pricing for the new widget line will be announced later this fall. 

XYZ Corp .. Inc. was formed in 1975. Headquarters are in Los Angeles California . 

Headline 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &PREL·Pl.STY 

Description: One column press release 

Comment: The letterhead is placed in a separate frame. 

Special Characteristic: 

One 39-pica column 

Contact is flush right 

Menu: 

Frame 

Paragraph 

Option: 

Margins & Columns 

Alignment 

Dateline has line break Paragraph Breaks 
before, but not after 
(another tag can be placed on the same line) 

Firstpar has line break 
after 

Firstpar is indented 
relative to previous line 

Paragraph 

Paragraph 

Breaks 

Alignment 

The combination of Dateline and Firstpar attributes create an 
automatic lead-in. The first paragraph is always placed exactly after 
the Dateline, regardless of the Dateline length. Also, the Dateline is a 
different font from Firstpar. 

Fl 
F3 
F5 
F7 
F9 

Headline 
For Release 

Firstpar 

REFERENCE GUIDE 

Tags and Function Keys 
F2 Dateline 
F4 Contact 
F6 
F8 Page Break 

FlO Body Text 
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Title of Report 

PROPOSAL TO ACME INSURANCE CORPORATION 

Head level 1 ~ ~C!::!or~p!::!or~at!::e...,;T!!ra:.:.:in~in~9L...-_-:--,..,..-,..".....,_,..,..-,.....---:,....,....--:,-::-__ 
The Corporate Training department has identified an objective to redesign and refonnat over 
9000 pages of textual and graphic information which constitutes the company's training 
documentation elements. In addition to redesigning this substantial amount of information, 
the department will also add new sections to the current training cuniculum. The training 
documentation is currently available in a variety of media, mostly on much copied papers. 
The documentation is somewhat out of date '1 -------------, 
since the collection of materials dates back 

Body Text --- ten years. According 10 the Corporate 
Director of Training, there is no orderly 
fashion or design for this infonnation. The 

------
Z_HEADER 

Title 

corporation has hired a consultant, Ms. Joan 

Belden who has designed a specific format ~ Z_LABEL FIG 
and process for the training documentation. 
Ms. Belden will become a member of the 
Acme Insurance staff to coordinate the 

Bullet 

Head level 2 

processes of rewriting the documentation··~Fjg""'U""'re":'l_"!"l r"T':':'h-. c""'a""'pti""'on~lo""'rt~hi""'S l""'igu""'re""' . ...,. ..-
Currently, there is an in-house printing and 
type-setting shop. Because of delays and priorities, the training department does not have 
ready access to this facility. Due to the size and nature of Ihis project, a decision has been 
made to evaluate departmental or work-group desk-top publishing Solulions specifically for 
the training facility. Having an departmental facility for documentation will give the train
ing operation the following benefits: 

---
• Fast tum-around time without having to depend on another corporate department 

to print documentation. 

• Ability to make immediate changes and update training modules. 

• Ability to use already installed Personal Computers and Word Processing equip
ment in association with the new publishing equipment. 

• Ability to incorporate the new machinery directly into the day-Io-day operations 
of the department. 

-+--tl~ .. The TXN Solution 
It is the recommendation of TXN Corporation that Acme Insurance consider the 3544 
graphic workstation as the input tenninal for the redesign/refonnat processes in the training 
facility. TXN was the first company to offer this unique type of workstation. In 1976, we 
introduced the 9967 professional computer which had the power of combining textual and 
graphic elements on the same screen. Now, ten years later, after many modifications and 
refinements of our original technology, we are proud to introduce the 3544 Professional 
Workstation for publishing applications. 

Page 1 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &PRPT-Pl.STY 

Description: One column proposal/report. 

Comment: Header and Footers are contained in chapter. Chapter 
has different headers on left and right pages. 

Special Characteristic: Menu: Option: 

One 36-pica column Frame 

Horizontal padding of Frame 

Margins & Columns 

Sizing & Scaling 
3 points for caption 
frame. This keeps the text 
on the left of the frame from 
touching the frame, yet the 
right side of the frame snaps 
to the right column guide. 

Ruling line below Head Paragraph 
Levell 

Bullet items indented 3 picas Paragraph 
in from left margin 

Extra space above and below Paragraph 
Bullet items (gives the effect 
of double spacing) 

Space between Body Text Paragraph 
paragraphs set with inter-
paragraph space This lets 
Head Levell be closer to 
Body Text than Body Text 
paragraphs are to each other. 

Ruling Line Below 

Spacing 

Spacing 

Spacing 

Tags and Function Keys 
Fl Title F2 Head Levell 
F3 Head Level 2 F4 Bullet 
F5 F6 
F7 F8 Page Break 
F9 Change Bar FlO Body Text 
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-- PROPOSAL TO ACME INSURANCE 
CORPORATION 

-+---11." Corporate Training 
The Corporate Training deparlment has iden~ 
tilied an objective to redesign and reformat 
over 9(XIO pages of textual and graphic infor
mation whiL'h l'onstillites the company's tr;lin
ing documentation elements. In addition to 

fed('signing this substantial amount of infor
mation. the department will also add new sec
tions to the current training curricululll. The 
training documentation is currently available 
in a variety of media. mostly on much copied 
papers. The documentation is somewhat out -+-.... ~ofdate since the collection of materials dates 
back ten years. According to the Corporate 
Director of Training. there is no orderly 
fashion or design for this infom1ation. The 
corporation has hired a consultant, Ms. Joan 
Belden who has designed a specific format 
and process for the training documentation. 
~1s. Belden will become a member of the 
Acme Insurance staff to coordinate the 
processes of rewriting the documentation. 

Currently. there is an in-house printing and 
type-setting shop. Because of delays and 
priorities. the training department does not 
have ready access to this facility. Due to the 
size and nature of this project, a decision has 
been made to evaluate departmental or work
group desk-top publishing solutions specifi
cally for the training facility. Having an 
departmental facility for documentation will 
give the training operation the following 
benefits: 

... - • Fast turn-around time without 
having to depend on another cor
porate department to print 
documentation. 

• Ability to make immediate chan
ges and update training modules. 

• Ability to use already installed 
Personal Computers and Word 
Processing equipment in associa
tion with the new publishing 
equipment. 

• Ability to incorporate the new 
machinery directly into the day
to-day operations of the depart-

The TXN Solution .... --------+
It is the recommendation of TXN Corpora-
tion that Acme Insurance consider the 3544 
graphic workstation as the input tenninal 
for the redesign/refonna! processes in the 
training facility. TXN was the first com-
pany to offer this unique type of worksta-
tion. In 1976. we introduced the 9967 
professional computer which had the power 
of combining textual and graphic elements 
on the same screen. Now. ten years later, 
after many modifications and refinements 

-+--..... Title 01 Report 1-1 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &PRPT-P2.STY 

Description: Two column proposal/report. 

Comment: Header and footers are in chapter, not style sheet. 
Ruling line around caption (store in chapter) has 3 points space above 
the rule. 

Special Characteristic: Menu: Option: 

One I8-pica column, one Frame Margins & Columns 
I7-pica column with a 
2-pica gutter 

Ruling lines above and below Paragraph Ruling Line Above 
Title Ruling Line Below 

Head Levell centered Paragraph Alignment (column 
in column wide) 

Bullet items indented 3 picas Paragraph Spacing 
in from left margin 

Extra space above and below Paragraph Spacing 
Bullet items (gives the 
effect of double spacing) 

Ruling line below footer Paragraph Ruling Line Below 

Different font for generated Paragraph Font 
caption than for free-form 
caption 

Tags and Function Keys 
FI Title F2 Head Levell 
F3 Head Level 2 F4 Bullet 
F5 F6 
F7 F8 Page Break 
F9 Change Bar FI0 Body Text 
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APPENDIX L-STYLE SHEETS 

CHAPTER: &TBL-Pl.CHP 

Text file: TABLE.TXT 

L-32 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &TBL-Pl.STY 

Description: One column table. 

Comment: Use for financial statements. 

Special Characteristic: Menu: Option: 

One 39-pica column Frame Margins & Columns 

Column Heads tabs: 
Tab 1 =center (14 picas) 
Tab 2=center (30 picas) 

Ruling line below Column 
Heads 

Paragraph Ruling Line Below 

Body Text has fixed indent Paragraph Alignment 
of 3 picas from left margin 

Body Text and Total tabs: Paragraph Tab Setting 
Tab 1 = decimal (18 picas) 
(has dot leader) 
Tab 2 =decimal (35 picas) 

Ruling lines above and below Paragraph Ruling Line Above 
Total Ruling Line Below 

Tags and Function Keys 
Fl Column Heads F2 
F3 Category F4 
F5 Total F6 
F7 F8 
F9 FI0 Body Text 
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Next Column Third Col. Price 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &TBL2-Ll.STY 

Description: One column table in landscape mode 

Comment: This table style sheet uses tags to create vertical tabs. 
The ruling lines below Table Header is part of its tag. The other 
ruling lines are a separate tag attached to a paragraph with no text 
in it. 
Note: When adding text to vertical tab, you may have to push the 
ESC key to get the page to reformat. 

Special Characteristic: Menu: Option: 

One 54-pica column Frame Margins & Columns 

Title centered on page Paragraph Alignment 

ColI has line break before, Paragraph Breaks 
no line break after 

Col 2 has no line breaks Paragraph Breaks 

Col 2 justified Paragraph Alignment 

Col 2 indented 12 picas in Paragraph Spacing 
from left margin; 28picas 
from right 

Col 3 has no line breaks Paragraph Breaks 

Col 3 indented 30 picas in Paragraph Spacing 
from left margin; 10 picas 
from right 

Col 4 has line break after Paragraph Breaks 
no line break before 

Col 4 flush right Paragraph Alignment 

Col 4 indented 36 picas in Paragraph Spacing 
from left 

Tags and Function Keys 
FI Title 
F3 ColI 
F5 Col 3 
F7 Rule 
F9 

REFERENCE GUIDE 

F2 Table Header 
F4 Col2 
F6 Col4 
F8 

FlO Body Text 
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I MENU COMMANDS PUBLISHING C~APTE~--J. 

• PUBLISHING CHAPTER 

• MENU COMMANDS 

I "~. ,,-, ~,-, -"' ~ _roo. through the menus al the top of the screen. This section 

__ ~~~~~~~It~i~ ~~::.t~;e~fee:~~~~~:~~~~~~ea~~~~~ 
the order in which they appear on the screen. Use the 
index for an alphabetical reference to these commands. 

Menu Conventions 

I Olten, a menu option will be shown in gray and cannot 
be highlighted. This usually indicates that the proper 
function has not been selected. The table below mdl-
cales these dependencies 

DESK 

I Publisher Info Always available I • 
FtLE 

New Must first Open chapter or Load file 
Open Always available 
Save File name must be in title bar 
Save As .. Always available 

FILE MENU 

Descrlptlon/Appllcatton 

Ventura Publisher 
I The File Menu controls information flow into and out of 

Z_HEADER 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &TCHD·Pl.STY 

Description: One column in portrait mode 

Comments: Use for technical documentation. This style sheet was 
derived from the one used to format this reference guide. The equa
tion on page 2 illustrates the use of centered tabs to create equations. 
The text TECHDOC.TXT contains index references. Also, this style 
sheet contains both index and table of contents tags. Therefore if you 
generate either a table of contents or index, this style sheet will for
mat them automatically. This is the most sophisticated style sheet in 
the TYPESET directory. 

Special Characteristic: Menu: Option: 

One 27-pica column Frame Margins & Columns 

Ruling line below header Paragraph Ruling Line Below 

Ruling line above footer Paragraph Ruling Line Above 

Chapter Head flush right Paragraph Alignment 
with ruling line below Ruling Line Below 

18 points of space below Paragraph Spacing 
Chapter Head 

Heading 1 flush left with Paragraph Alignment 
ruling lines above and below Ruling Lines Above 

Ruling Lines Below 
2 picas above and below Paragraph Spacing 
Headingl 

Body Text indented 7 picas Paragraph Spacing 
in from left margin 

Ruling line below Heading 2 Paragraph Ruling Line Below 

Ruling line above Table Paragraph Ruling Line Above 
Headl 

List 1 indented 8 picas Paragraph Spacing 
in from left margin 

Tags and Function Keys 
Fl Chapter Head F2 Heading 1 
F3 Heading 2 F4 Computer Text 
F5 Key Note Text F6 List 1 
F7 List 2 F8 Page Break 
F9 Table 1 FI0 Body Text 
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Z_SEC 1 

Z_SEC 2 
Z_LABEL FIG 

Z_CAPTION 

II] USER INTERFACE ..... 4-------

[ill WYSIWYG :4 

--] 
Ventura Publisher is designed to provide What You See (on the screen) Is What You Get 
primed (WYSIWYG). This means that the computer display should match as closely as 

~~~i:~'t~tcrut!:~~~~~:rh~~::~ ~~~p: ~np~g:~~~ ~;!~:::: a~! ::::h~:.!~~~:r:: .... __ +--
to prim a page on a laser printer or typesetter. do create some unavoidable differences. In 
particular. because the computer CRT screen cannot produce anywhere near the same resolu
tion of a prin.tec or lypeseuer. and because what is displayed is shown in a different aspect 
ralio (height to width ratio), the space between words and between lines may appear to be 
bigger or smaller than the printed page under certain circumstances. Several thin ruling 
lines, with little space between, may show on lhe screen as one lhick line . 

Z_SEC 3 ~ BKeybOardKeys .......... ----------+-

Z_FOOTER 

Various keys on the keyboard perfonn special functions: 

o The keyboard Cursor keys conlrollhe Text Cursor (The text cursor is displayed 
asathin vcnical line.) 

• The Home key goes to the first page of the document. 

• The End key goes to the last page of the document. ....... ~ ______ +-_ 
o The Pg Up key goes to the previous page. 

o The Pg Dn key goes to the next page. 

1.2. ITEM SELECTOR 

l-A 

1.2.1 Description 

The display shown in Figure 10-2 is called an Item Selector. The Item Selector is used for 
savingandrclricvingfilcs. 

WYSIWYG 

Chapter Head 

Major Heading 

Body Text 

Minor Heading 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &TDOC-Pl.STY 

Description: One column in portrait mode. 

Comment: Use for technical documentation. Note: the frame is 
anchored below the first Major Heading. Also note, the text con
tains many index points. Show Tabs & Returns to see where they are. 

Special Characteristic: Menu: Option: 

One 39-pica column Frame Margins & Columns 

Auto-numbering used for Page Auto-Numbering 
Chapter Head, Major 
Heading, Minor Heading 

Generated tags for auto- Paragraph Breaks 
numbers have line break 
before, and not after 
(permits other tags 
on same line) 

Chapter Head, Major Paragraph Alignment 
Heading, and Minor 
Heading are indented 
relative to previous line 
plus 12 points 

Chapter Head, Major Paragraph Breaks 
Heading, and Minor 
Heading have line break 
after and not before 

Body Text, Table Head, Paragraph Spacing 
Table Item indented 9 picas 

Bullet, System Prompt Paragraph Spacing 
indented 11 picas in from left 
margin. Each Bullet item Paragraph Special Effects 
begins with • 

Ruling box around Warning Paragraph Ruling Box Around 

Tags and Function Keys 
Fl Chapter Head F2 Major Heading 
F3 Minor Heading F4 Warning 
F5 Table Head F6 Table Item 
F7 System Prompt F8 Page Break 
F9 Bullet FI0 Body Text 
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Presentation Title --
Presenter's Name ~ -Presenter's Organization .. 

~Main To~ic is the Most Im~ortant 

Use line breaks to add space vertically - · Use the special function keys as you type to tag the 
~ 

paragraphs you are typing - - For instance, this paragraph was tagged by pressing ... 
function key F5 

Another subtopic 

· Still another subtopic 

Another Main To~ic 

· Subtopic 
- Subsubtopic 
- Subsubtopic 

Subtopic 

Title 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &VWGF-Ll.STY 

Description: One column in landscape mode. 

Comment: Use for horizontal viewgraphs 

Special Characteristic: Menu: Option: 

One 54-pica column Frame Margins & Columns 

Title, Presenter centered Paragraph Alignment 

Ruling line below Paragraph Ruling Line Below 
Topic Levell 

Topic Level 2 indented Paragraph Spacing 
6 picas in from left margin 

Topic Level 2 begins 
with bullet ( .), followed by 

Paragraph Special Effects 

O.5-inch indent 

Topic Level 3 indented 
12 picas in from left margin 

Paragraph Spacing 

Topic Level 3 begins Paragraph Special Effects 
with and en dash (-) 
followed by O.5-inch indent 

Tags and Function Keys 
F1 Topic Levell F2 
F3 Topic Level 3 F4 Table Item 
F5 Presenter F6 Title 
F7 F8 
F9 FlO Body Text 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &VWGF-Pl.STY 

Description: One column in portrait mode. 

Comment: Use for vertical viewgraphs. 

Special Characteristic: Menu: Option: 

One 39-pica column Frame Margins & Columns 

Title, Presenter centered Paragraph Alignment 

Ruling lines above and Paragraph Ruling Line Above 
below Topic Levell Ruling Line Below 

Topic Level 2 indented Paragraph Spacing 
6 picas in from left margin 

Topic Level 2 begins Paragraph Special Effects 
with bullet ( .), followed by 
O.5-inch indent 

Topic Level 3 indented Paragraph Spacing 
12 picas in from left margin 

Topic Level 3 begins Paragraph Special Effects 
with en dash (-) followed 
by O.5-inch indent 

Tags and Function Keys 
F1 Topic Levell F2 
F3 Topic Level 3 F4 Table Item 
F5 Presenter F6 Title 
F7 F8 
F9 FlO Body Text 
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fA=, C-20 
@ 

First column of text, D-2 
- character, 3-1 7 

A 

Abandon, 5-12 
Abort 

Go to page, 3-8, 5-96 
Print, 3-8 

Add new frame, 4-4 - 4-5 
Keep enabled, 3-8 

Add new tag, 4-17 - 4-18 
Adding non-keyboard characters, 
4-25 . 
Alignment, 5-133 - 5-137 

See also Set rulers 
Alt key, 3-10 
Anchors & captions, 5-110 - 5-113 

See also InsertJedit anchors 
Apple LaserWriter 

See LaserWriter 
Arabic numbering 

Defined, 5-71 
Arrow keys 

See Cursor keys, 3-8 
Art 

See Pictures 
Ascender, 1-1 
ASCII text, D-12 

Characters not used, D-12 
Defined, 1-1 
From mainframes, D-12 

Aspect ratio, 3-22 

REFERENCE GUIDE 

Index 

Assign function keys, 4-31, 5-174 -
5-183 
Assignment list, 3-4 

Defined, 3-4, 1-1 
Attribute 

Defined, 1-1 
See also Text attributes 

Attribute overrides, 5-154 - 5-155 
Auto adjust styles, 5-132, 5-194 
Auto-numbering, 5-74 - 5-80 

See also Section numbering 
Auto CAD , G-l 

Creating slide files, G-l 
DXF files, G-l 
Slide files, G-l 

B 

Backspace key, 3-8, 4-25 
Backup files, 5-9 
Bad break 

See Widow 
Baseline, 1-1 
Beep 

What it means, 3-19 
Beginning the program, 2-8 - 2-10 
Big first character, 5-152 - 5-153 

Reversed, 6-24 - 6-26 
Binding margins, 5-100 

Defined, 1-1 
Blowup 

See Sizing & scaling 
Body text, 5-129 

Cannot remove, 6-22 
Defined, 1-1 
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Body type 
See Body text 

Bold 
See Text attributes 

Book publishing 
Page numbering across chapters, 

5-71 - 5-73 
Borders 

See Ruling box around 
See Ruling line abovelbelow 

Box 
See Ruling box around 
See Ruling line abovelbelow 

Box character, 5-39 
Box text, 4-38 - 4-39 

Compared to frames, C-7 
Breaks, 5-145 - 5-148 

Defined, 1-1 
Bring to front, 5-181 - 5-182 
Broadsheet, 5-25, 5-63 - 5-65 
Buffer 

Print, 6-44 
Bullet, 5-152 - 5-153 

See also Special effects 
Button on mouse 

See Mouse 

c 
Cabling 

Printer, F-19 
CAD conversion, G-1 
Callouts, 4-38 - 4-39 
Camera guides, 5-23 
Cancel a menu, 3-16 
CAP files, 5-8, 5-10 
Capitalize, 4-21 
Caption files, 5-112 
Captions 

Adding to pictures, 5-110 - 5-113 

INDEX-2 

Auto-numbering for, 5-111 
Caption margins, 5-100 
Converting to text file, 5-57 
Placing both on same line, 5-112 
Tags, 5-112, 6-22 

Carriage return 
See Enter 

Center 
See Alignment 

Center text 
See Alignment, 5-133 

Centimeter, 3-16 
CGM, G-1 
Change bars, 5-165 
Chapter 

Defined, 1-2 
Typography, 5-65 - 5-70 

Chapter counter, 5-71 - 5-73 
Chapter files 

Combining into publications, 5-216 
Printing, 5-21 - 5-25, 5-217 
See files associated with, 5-21 7 

Chapter menu, 5-61 - 5-97 
Chapter numbering across 
chapters, 5-71 - 5-73 
Chapter typography, 5-65 - 5-70 
Character formatting 

See Style sheet 
Character set, E-1 
Character space 

Changing, 4-22 - 4-24 
Characters 

See Alt key 
See Fonts 
See Foreign character 
Hidden, 5-211 

CHP extension, 5-6 
CIF files, 5-8, 5-10 
Circles 

Drawing, 4-36 
Clear menu, 3-2 
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Clipboard 
Defined, 1-2 
Frame, 5-35 
Graphic, 5-36 
Text, 5-34 

Close chapter 
See Quit, 5-28, 5-30 - 5-31 

CNF file, F-12 
PostScript, F -20 

Color, D-6 
Printing, 5-168 - 5-171 
Separations, 5-169 

Color display 
Installing, A-3 

Color displays, 3-22 
Column balance, 5-68 - 5-69 

Columns don't balance exactly, 5-69 
Column break, 5-145 - 5-148 
Column guides, 5-208 

Page used as grid, 6-10 - 6-12 
Column snap, 5-213 
Columns 

Aligning text within, 5-213 
Changing to equal width, 5-99 
Changing to unequal column 

width, 5-99 
Different left/right page, 5-100 
Margin & column option, 5-98 -

5-101 
See also Margins & Columns 
More than eight, 5-116 - 5-124 
Rules, 5-118 - 5-119 

Comments, D-9 
Concatenation, 5-14 
CONFIG.SYS, 2-6 
Contents of Ventura Publisher, 1-3 
Conversion 

DXF to GEM, G-l 
Text to PCX, G-5 

Copy, 5-32 - 5-36 
Chapter, C-4, 5-222 - 5-223 
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Frame, 5-34 
Graphic, 5-35 
Publication, 5-222 - 5-223 
Text, 5-33 
Text attributes, 5-34 

Copy-fitting, 6-47 
Copyright symbol, 4-26 

See Keyboard keys 
Creating new tags, 4-1 7 - 4-18 
Crop, 5-104 

Defined, 1-2 
See Sizing & scaling 

Crop marks, 5-23, 5-177, 1-2 
Crosshairs, 5-197 
Ctrl key, 3-9 

INDEX 

Current Selection Indicator, 4-6, 
4-30 
Cursor 

Mouse, 3-6 
Text, 1-5 

Cursor keys, 3-8 
Cut, 5-32 - 5-36 

Text attributes, 5-34 
Cut/copy/paste, 5-32 - 5-36 
Cutlines 

See Callouts, 4-38 - 4-39 

D 

Database publishing, H-l 
Dbase III, D-l, D-14, H-1 
DCA, D-15 - D-16 
DEC PrintServer 40, F-18 - F-26 
Default settings, 5-28 
Define colors, 5-166 - 5-170 
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Definition, 1-1 
Arabic numbering, 5-71 
Assignment list, 3-4 
Images, 4-8 
Line art, 4-8 
Line break, 4-27 
Orphan, 5-66 
Pictures, 4-8 
Tag, 5-129 
Text cursor, 1-5 
Typographic conventions, 1-5 
Widow, 5-66 

Delete 
Character, 4-25 
Directory, 5-26 - 5-32 
Extra carriage returns, D-10 - D-11 
Files, 5-26 - 5-27 
Frame, 5-34 
Graphic, 5-35 
Page, 5-93 - 5-94 
Repeating frame, 5-116 
Text, 4-25, 5-33 

Delete key, 3-8 
Desk menu, 5-3 
Destination, 5-14 
Dialog box 

Defined, 1-2 
Use of, 3-14 - 3-17 

Dictionary 
See Hyphenation dictionary 

Direction keys 
See Keyboard keys 

Directory 
Changing, 3-19 
Creating new, 5-27 
Delete, 5-26 - 5-32 
Make new, 5-26 
See also Subdirectory 

Discretionary hyphen, 3-10, D-9 
Defined, 1-2 

Disk cache, 6-40 

INDEX-4 

Disk drives 
Changing, 3-20 
Not initially displayed, 3-20 

Disk full, 5-26 
Displaywrite, D-15 - D-16 
Document 

See Chapter 
Documentation 

How to use, 1-1 
DOS COpy command, C-4 
DOS file operations, 5-26 - 5-27 
Dot leader 

See Tabs 
Dot matrix printers, F-16 

Paper size, F -16 
Resolution, F-16 

Double spaces 
Eliminating, 5-15 

Double underline 
Change defaults, 5-154 - 5-156 

Drawing 
See Graphic mode 
See Graphics 

Drives 
Changing the active, 3-20 

Drop-down menu, 5-195 
Dropped capital, 5-152 - 5-153 
Duplex printing, 5-22 
DXF file, G-l 

E 

Edit menu, 5-30 - 5-56, 5-58 
Edit special code, 5-38 
Editing 

See Graphic mode 
See Text editing 

Editing text to fit 
See Copy-fitting, 6-47 
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Em dash, 3-10, 4-26, 6-49, 1-2 
Auto conversion, 5-194 

Em space, 3-10, 4-27, 1-3 
EMS memory, A-6, 2-9, 6-40 
EN dash, 3-10, 1-3 
En space, 3-10, 4-27, 1-3 
End key, 3-8 
End of file 

Finding, 6-13 
End of file symbol, 5-211 
End session 

See Quit, 5-28, 5-30 - 5-31 
Enlarging a picture 

See Sizing & scaling 
Enter key, 1-5, 3-16, 4-31 
Epson LQ 1500, F-16 
Epson MXlFXIRX-880, F-16 
Equations, 4-27, 5-151 
Erase 

See Backspace key 
See Delete 

Error messages, C-9 - C-22 
Escape (ESC) key, 3-8 
Exit 

See Quit, 5-28, 5-30 - 5-31 
Extension 

Default names, 3-20 - 3-21 
Defined, 1-3 

F 

Features 
List, 1-4 

Figure counter, 5-35 
Figure numbering across chapters, 
5-71 - 5-73 
Figure space, 3-10, 1-3 
File 

Creating new text, 4-29 
Defined, 1-3 
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Delete, 5-27 
Filters, changing, 3-18 
Graphics files created, 5-16 
Management, 6-41 

INDEX 

N arne conventions, 3-20 - 3-21 
Print to file, C-4, 5-199 
Removing, 4-8, 5-54 - 5-55 
Removing excess, 5-55 
Renaming, 5-56, 5-58 
Within chapter, 5-217 
Write protected, 5-27 

File menu, 5-4 - 5-28, 5-30 - 5-31 
File not found, 3-20 
File type/rename, 5-56, 5-58 
Files 

Backup, 5-9 
CAP, 5-8,5-10 
CIF, 5-8, 5-10 
VGR, 5-8, 5-10 

Fill attributes, 5-185 
Filter 

Defined, 1-3 
First line indent, 5-136 
Floppy disks 

Don't read from directly, 3-20, 5-14 
Font Metric 

Defined, 1-4 
Fonts, 5-131 - 5-132, F-3 

Adding new, C-1, 5-203 - 5-205, K-1 
Changing, D-6, 4-21 
Character set, E-1 
Defined, 1-4, K-2 
Disable downloading, 5-205 - 5-215 
Downloading, C-2 
Downloading to printer, 6-39 -

6-45, K-10 - K-11 
HP LaserJet, F-11, K-7 - K-11 
Interactive changing, 4-21 
Interactive size change, 4-22 - 4-24 
JLaser, F-15, K-15 - K-16 
Kerning, 4-22 - 4-24 
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File (continued) 
Modifying automatic kerning, K-26 
Paragraph tag doesn't change, 

5-132 
PostScript, F-19, K-17 
Printing, won't print font, 5-132 
Screen fonts, K-4 - K-6 
Selected text, 4-21 
Size limitations, 5-132 
VFM file format, K-22 - K-25 
Width tables, 5-201 
Wrong size in line art, F-1 
Xerox 4045, K-12 - K-14 

Footer 
Defined, 1-4 
See also Headers & Footers 

Footnotes, 5-89 - 5-92 
Changing placement, 5-91 
Copying/moving, 5-34 
Defined, 1-4 
Deleting, 5-41 
Editing, 5-40 
Inserting, D-9, 5-40 - 5-41 
Length limitation, 5-41 
Margins & Columns, 5-101 
Superscript footnote number, 5-92, 

6-27 - 6-28 
Turn on/off, 5-40 

Foreign characters, D-3, 4-25 
Foreign language 

Hyphenation, B-2 
Format 

See Style sheet 
See Tag 

Forms, 4-39 
Formulas, 5-151 

Mathematical, 4-27 
Fractions, 5-47 - 5-48 
Frame 

Typography, 5-108 - 5-109 
Frame menu, 5-108 - 5-109 

INDEX-6 

Frame mode, 3-4,4-3 - 4-12 
Frame too complex, C-19 

How to fix, H-6 
Frame typography, 5-108 - 5-109 
Frames 

Adding, 4-4 - 4-5 
Anchoring, D-9, 5-49 - 5-51 
Background, 5-122 - 5-123 
Captions, 5-112 
Changing size, 4-10 
Column snap, 5-213 
Create multiple, 6-46 
Creating multiple, 4-5, 5-54 
Cut, copy, paste, 5-34 
Defined, 4-3 - 4-12, 1-4 
Delete, 5-34 
Gray selection lines, 5-115 
Line snap, 5-214 
Margins, 5-210 
Menu, 5-97 - 5-128 
Moving, 4-9 
Placement, 5-103, 6-46 
Placing files in, 4-6 - 4-7 
Re-anchor, 5-82 
Removing file from, 4-8, 5-54 
Repeating, 5-114 - 5-117 
Ruling lines around, 5-120 - 5-121 
Selecting frame on bottom, 4-11 -

4-14 
Selecting multiple, 4-10, 6-47 
Selecting underneath, 6-46 
Selection borders, 6-47 
Sizing & Scaling, 5-102 - 5-107 
Text fit, 6-48 
Text flow around, 5-102 
Text in, 6-10 - 6-14 
Wordwrap around, D-5 

Full box, 3-2 

REFERENCE GUIDE 



Function keys 
Assigning, 5-174 - 5-183 
See also Assign function keys, 4-31, 

5-174 - 5-183 

G 

Gl characters 
See Foreign characters 

GEMPRINT.SYS, F-3 
Generated numbers 

See Auto-numbering 
See Section numbering 

Generated tags, 5-192, 6-22 - 6-23 
Glossary, 1-1 
Go to page, 5-95 - 5-97 

Keyboard shortcuts, 5-96 
Relative to file, 5-96 

Graphic menu, 5-176 - 5-185, 
5-187 - 5-191 
Graphic mode, 3-4, 4-33 - 4-39 
Graphics 

Circles, 4-36 
Constraints, 4-36 
Cut, copy, paste, 5-35 
De-selecting, 5-187 
Drawing multiple, 4-36 
How to use, 4-34 
Keep tool enabled, 3-8 
Load from, 5-184, 5-186 
PostScript, 5-1 7 
Repeating, 4-35, 5-177 
Save attributes, 5-184 - 5-192 
Saving/loading line and fill 

attributes, 6-50 
Select all, 5-187 
Selecting graphic on bottom, 4-37 
Selecting multiple, 6-47 
Squares, 4-36 
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Graphs 
See Graphics 
See Pictures 

Gray 
Shades of, 5-168 

Gray display 
Installing, A-3 

Greek characters, 4-26 
Greeking, 5-59, 5-193 

Defined, 1-4 

INDEX 

Grid settings, 4-36, 5-189 - 5-191 
Gutter 

See Columns 
Gutter rule 

See Vertical rules 
Gutters, 5-99, 1-4 

H 

Halftoning, 5-124 - 5-128 
Halt, 2-10 
Hanging indent, 1-6 

See also Outdent 
Hard disk 

Space requirement, 2-3 
Space taken on, A-I 

Head margin 
See Spacing 

Headers & Footers, 5-83 - 5-87 
Custom, 5-53 
Don't print, C-3 
Example, generated, 1-8 
Generated, 5-85 
Large, 5-116 
Margins & Columns, 5-101 
Multi-column, 5-116 
Tags, 6-22 
Text attributes in, C-6 
Turn on/off, 5-88 
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Headings 
Outdented, 6-29 

Help,1-2 
See Appendix C 
See relevant topic in index 

Hidden text, D-9 
Hide column guides, 5-208 
Hide pictures, 5-209 - 5-210 
Hide rulers, 5-207 
Hide side-bar, 5-206 
Highligh t text, 4-19 
Highlighting 

See Text attributes 
Home key, 3-8 
Horizontal scroll bar, 3-3 
Horizontal tabs, 5-149 - 5-151 
HP DeskJet, F-8 
HP LaserJet, A-4, F-8 - F-14 

Cabling, F-8 
Disable font downloading, 5-205 -

5-215 
Error 20, F-11 
Font cartridge, A-4, F-11 
Font size limits, F-14 
Fonts, F-11 
New fonts for, K-7 - K-11 
Out of memory, F-11 
Paper size, F-10 
Resolution, F-10 
Rotated text, F -14 
White text, F-14 

HP LaserJ et II, A-4 
HP PaintJet, F-8 
HPDOWN, K-10 - K-11 
HPGL, G-3 
HPLJPLUS.CNF, F-12 
Hyphenation 

Dictionary, B-1 
Foreign languages, B-2 
Overriding for specific words, 4-29 
Turning on/off, 5-134 

INDEX-8 

Hyphens 
Discretionary, D-9, 4-29 
Non-breaking, 4-28 
Removing, D-~, 4-28 

I 

IBM 4216 
Installing, A-4 

IBM 4216 laser printer, F-18 - F-26 
DOS version required, F-25 

Image 
EPS screen display, G-2 

Images 
Cropping, 3-10, 5-104 
Defined, 4-8, 1-4 
Half toning, 5-124 - 5-128 
Scaling, 5-104 
Scanned, 5-107 - 5-110 

Inch, 3-16 
Indent, 5-136 

Defined, 1-4 
First line, 5-136 
From both margins, 5-144 

IndentslOutdents, 6-29 - 6-31 
Index 

Copying/moving, 5-34 
Creating, 5-42 - 5-46 
Creating within word processor, 

D-10 
Deleting, 5-44 
Generating, 5-220 - 5-221 
Repeat automatically throughout 

section, 5-86 
Tags, 6-22 

INF files, A-5 
Insert 

See Text editing 
Insert cross reference, 5-52 - 5-53 
Insert key, 3-8 
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Insert special code, 5-37 
InsertJedit anchor, 5-49 - 5-51 

See also Anchors & captions 
InsertJedit index, 5-42 - 5-46 
InsertJremove page, 5-93 - 5-94 

Installation, 2-1 - 2-10 
Begin, 2-4 
Hard disk space required, 2-3 
Modify existing, 2-5 
Modify existing, shortcut, A-5 - A-6 
Software, 2-3 - 2-7 
Updating from version 1.0, A-2 

Inter-line spacing 
Defined, 1-4 

Inter-Paragraph spacing, 5-140 
Inter-Line spacing 

Setting, 5-142 
Interpress, F-17 

Defined, 1-4 
Page too complex, F-18 
Print files, 5-200 

Italics 
See Text attributes 

Item selector 
Beep, 3-19 
Drive names, adding, A-5 
Filter, 1-3 
Operation, 3-18 - 3-21 
Too many files, 3-19 

J 

JLaser, A-4, F-15 
Font size limits, F-15 
Fonts, F-15 
New fonts for, K-15 - K-16 
Paper size, F-15 
Print to file, F-15 
Printing problems, F-16 

REFERENCE GUIDE 

Resolution, F-15 
Justification 

See also Alignment 
Defined, 1-5 

Justify 
See Alignment 

K 

Kerning, 4-22 - 4-24 
Automatic, 5-156 
Defined, 1-5 
Global On/Off, 5-67 
Interactive, 4-24 

INDEX 

Interactive on-screen kerning, 4-22 
-4-24 

Manual, D-7 
Modifying automatic, K-26 
On-screen, 4-24, 5-194 

Keyboard 
Characters not on, D-3, 4-25 
Keys, 3-7 - 3-13 
Shortcuts, 3-11 

L 

Labels 
Printing mailing labels, H-4 
See Call outs, 4-38 - 4-39 

Landscape, 5-63 
Defined, 1-5 

Large documents 
Creating, 5-216 

Laser printer 
See name of printer 

LaserJet 
See HP LaserJ et 
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LaserWriter, A-4, F-18 - F-26 
Cabling, F-19 
Connection to PC, F-19 
Error message, F -20 
New fonts for, K-17 
Switches, F -20 

Layout 
Defined, 1-5 

Lead-ins, 5-146 - 5-149 
Creating, 6-30 
Example, 1-8 

Leaders 
Defined, 1-5 
See also Tabs 

Leading 
Defined, 1-5 
See also Inter-line spacing 
See also Spacing 

Left justify text 
See Alignment, 5-133 

Letterspacing, 5-156, 5-212 
Interactive, 4-24 

Line art 
Cropping, 5.;104 
Defined, 4-8, 1-5 
Scaling, 5-104 

Line attributes, 5-183 - 5-184 
Line break, 3-9, D-8, 5-145 - 5-148 

Defined, 4-27, 1-5 
Use in a database, H-5 

Line length, 1-6 
Line snap, 5-214 
Lines 

Drawing straight lines, 4-36 
Horizontal or vertical, 4-36 

Linotronic 
100, 300, F-18 - F-26 
Cabling, F-19 

Lists 
See Section numbering, 

Auto-numbering 

INDEX-10 

Load different style, 5-19 
Load from, 5-186 - 5-192 
Load text/picture, 3-18, 5-13 - 5-18 

Changes to text, 5-15 
Destination, 5-14 
Several files, 5-14 

Loading a style sheet, 6-19 
Logitech mouse, A-3 
Logoff 

See Quit, 5-28, 5-30 - 5-31 
Loose lines, 5-212 
Lotus 1-2-3, D-1 

Creating pictures, G-4 
Printing spreadsheet text, D-13 

Lotus Manuscript, D-15 

M 

Macintosh 
Paint, G-4 
PICT, G-5 

Mainframe 
Text files from, D-12 

Maintain aspect ratio, 5-104 
Make directory, 5-26 - 5-27 
Manuscript, D-15 
Margins 

Binding, 5-100 
Left/right page, 5-100 
Temporary text margins, 5-144 

Margins & Columns, 5-98 - 5-101 
Match coprocessor, 6-44 
Math characters, 4-26 
Measurement units 

Changing, 3-16 
Rulers, 5-196 

Mechanical, 1-6 
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Memory 
Increasing, A-6 
Out of memory, C-ll, C-14, C-18, 

C-21, H-5 - H-6 
Printer out of memory, A-4, 5-205 -

5-215, F-6, F-ll 
Menu 

Can't select, 5-1 
Clear, 3-2 
Gray text, 5-1 
Pull-down, 5-195 
Pulling down, 3-2 

Menu commands, 5-1 
Microsoft Windows, 2-9 
Microsoft Word, D-17 

Style Sheets, D-17 
Minimum space width, 5-158 
Mode Selector, 4-1 - 4-39 
Monospaced, 1-6 
Mouse, A-3 

Cursor, 3-6 
Double click, 3-19, 5-193 
Installation, A-3 
Middle and right buttons, 3-6 
Operation, 3-6 
Operation without, 3-12 - 3-14 
Problems with, A-3 

MOUSE.COM, A-3, 2-6 
Move, 5-32 - 5-36 

Frame, 5-34 
Graphic, 5-35 
Text, 5-33 

Multi-chapter, 5-215 - 5-225 
Multi-sync monitors, A-3 
Multimate, D-18 
Multiple article chapters, 6-10 -
6-14 
Multiple copy printing, 5-22 
Multiple file loading, 5-14 
Multiple frames, 4-5,4-10, 6-47 
Multiple graphics, 4-36 
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Multiple paragraph tagging, 4-15, 
4-32 

N 

Network operation, 2-3, C-8 
New, 5-5 
New Index 

Index Entry, L-l 
New page, 6-13 
Newsletter layout, 6-10 - 6-14 

Re-using, 6-14 - 6-20 
Non-breaking space, 3-10, D-9, 4-27 
Normal space width, 5-160 
Numbering 

Automatic section numbering, 5-74 
- 5-80 

Chapter, 5-71 - 5-73, 5-222 
Lists, 5-79 
Page, 5-71 - 5-73, 5-222 

o 
Office Writer, D-16 
Open chapter, 5-6 - 5-7 
Options menu, 5-191 - 5-225 
Orientation, 5-63 
Orphan 

Defined, 5-66, 1-6 
Outdent, 5-136 

Defined, 1-6 
Outdents 

See also Indents/Outdents 
Outlines, 5-74 - 5-80 
Output 

See Printing 
OUTPUT. WID , 5-202 
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Overscore 
Change defaults, 5-154 - 5-156 

p 

Packing list, 1-3 
Padding, 5-106 
Page 

Create new, 6-13 
Creating new automatically, 6-13 
Custom size, 5-106 
Defined, 1-6 
Go to, 5-95 - 5-97 
InsertiRemove, 5-93 - 5-94 

Page break, 5-145 - 5-148, 6-49 
Page counter, 5-71 - 5-73, 5-222 
Page down, 3-8 
Page layout, 5-62 - 5-64 
Page menu, 5-93 - 5-94 
Page number indicator, 3-5 
Page numbering 

Anywhere on page, 5-52 - 5-53 
,,, Page numbering across chapters, 
5-71 - 5-73 
Page numbers 

See Headers & Footers 
See Numbering 
See Page counter 

Page up, 3-8 
Paper size, 5-63 
Paper tray 

Selection, 5-23 
PARAFILTR, D-10 - D-11, 5-142 
Paragraph 

Adding and deleting, 4-31 
Defined, 1-6 
Line break, 4-27 
Numbering automatically, 5-74 -

5-80 
Spacing, 5-142 
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Paragraph menu, 5-129 - 5-171, 
5-173 - 5-183 
Paragraph mode, 3-4,4-13 - 4-18 
Paste, 5-32 - 5-36 

Defined, 1-6 
PC Paint 

Can't load files, C-8 
PC Paintbrush 

Color, G-5 
Creating, G-5 
No color, C-7, G-5 
Text to PCX conversion, G-5 

Performance, 2-8 - 2-10 
Degrades suddenly, 6-45 
Improvements, 6-39 - 6-45 

Phone directory, H-1 
Picas, 3-16 

Defined, 3-17, 1-6 
Picture anchor, D-9 
Pictures, 4-9, 5-13 - 5-18 

Defined, 4-8, 1-6 
Obscures text, F-25 

Points, 3-16 
Defined, 3-17, 1-6 

Port 
Defined, 1-7 

Portrait, 5-63 
Defined, 1-7 

POSTSCPT.CNF, F-20, F-22 
PostScript, F-18 - F-26 

Bug, F-25 
Defined, 1-7 
Encapsulated, G-2 
EPS screen display, G-2 
Files, 5-17 
Files don't display, 5-17 
Fonts, F-19 
See also LaserWriter 
Printing via Apple network, F -22 
Prologue, F-24 
Resolution, F -18 
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Special effects, F-24 
Prin t buffer, 6-44 
Print file 

JLaser, F -15 
LaserWriter, F-20 

Print spooler, 6-44 
Print Style Sheet, 5-171, 5-173 -
5-176 
Printer 

Capabilities, 5-186 
Configuration, 5-21 
Determining limitations of, F-l 

Printer troubleshooting, C-8, F-2, 
F-16 
Printing 

Blank near edge of page, F-4 
Changing ports, 5-199 
Changing printers, 5-199 
Chapter, 5-21 - 5-25 
Disable font downloading, 5-205 -

5-215 
Disk files, 5-199 
Double sided, 5-63 
Duplex, 5-22 
Fonts won't print, 5-132 
Large format, 5-25 
Matching width tables, 5-201 
Multi-Chapter, 5-21 7 
Multiple copies, 5-22 
Portrait or landscape, 5-63 
Printer won't print, C-3 
Publication, 5-21 7 
Selected pages, 5-22 
Space between word incorrect, 

5-201 
Speed, improving, 6-39 - 6-45 
Stopping, 5-21 
To a file, C-4, 5-24, 5-199, F-15 
To file, multi-chapter, 5-217 

Problem 
- character in dialog box, 3-1 7 
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Assignment list, can't select, 3-5 
Blank columns, 5-136 
Blank near edge of page, F-4, F-I0 
Bullet overlaps text, 5-153 
Caption doesn't appear, 5-112 
Chapter different than saved, 5-20, 

5-172 - 5-1 73, 6-19 
Character doesn't print, 4-26 
Columns don't balance, 5-69 
Copy, all files not copied, 5-224 
Cursor keys, 3-13 
Disk drive change wrecks display, 

3-20 
Disk drives, changing, 3-20 
Disks not used during installation, 

2-6 
Enter doesn't end dialog, 5-223 
Facing page format inoperative, 

5-63 
Facing pages view not available, 

C-6 
File, can't find, 3-21 
Font selection gray, 5-132 
Font, won't change, 5-132 
Fonts won't print, 5-132 
Footer spacing too large, 5-86 
Footnote space above, 5-91 
Footnotes don't appear, 5-40, 5-90 
Frame moves instead of changing 

size, 4-10 
Graphic repeats on every page, 4-35 
Header not displayed, 5-88 
Header spacing too large, 5-86 
Header/footer doesn't display, 5-84 
Menu option gray, 5-1 
Menu options gray, 5-129 
Numbers in dialog box change, 

5-164 
Open chapter is slow, 5-6 
Page doesn't print completely, F-6, 

F-11 
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Problem (continued) 
Paragraph overwrites other text, 

5-136 
Paragraph selection lost, 4-17 
Performance degrades, 6-45 
Picture not in frame, C-6 
Picture obscures text, F -25 
PostScript bug, F-25 
Print doesn't match screen, 3-22 
Print, page edges blank, 3-22 
Print, page numbers wrong, 5-22 
Printer won't print, C-S 
Printing, wrong space between 

words, 5-201 
Ruling box doesn't print, F-25, 6-47 
Ruling box stops at column/page, 

5-164 
Ruling line dashes don't print, 

5-121, 5-163 
Spacing changed, 5-132 
Spreadsheet columns don't align, 

D-13 
Style sheet changed, 5-20 
Tab doesn't take effect, 5-150 
Tab, first line indent, 5-151 
Tabbed text beyond margin, 5-151 
Tabs don't work, 5-151 
Tags added to style sheet, 6-22 
Text attributes change, 4-31 
Text disappears, 4-30 
Text disappears during editing, 

5-122 
Text doesn't appear in frame, C-4 -

C-5 
Text doesn't match Appendix L 

styles, 6-21 
Text flow around irregular shape, 

C-S 
Text format changed in word 

processor, D-2 
Text formatting speed, 5-6S 
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Text in wrong frame, 6-13 
Text into right margin, 5-136 
Text moves to next column/page, 

6-4S 
Text on top of text, 5-79 
Text, can't place where 1 want, C-7 
Text, can't read, 5-193 
Vertical rule doesn't show, 5-119 

Problems 
Error messages, C-9 - C-22 

Prologue 
PostScript, F -24 

Publication 
Creating, 5-216 
Defined, 1-7 

Publisher info, 5-3 
Pull-down menu preference, 5-195 

Q 
QMS 

PS SOO, 1200, 2400, F-18 - F-26 
Quit, 2-10, 5-2S, 5-30 - 5-31 
Quotes 

Auto conversion, 5-194 
True typographic, 3-10, 4-26, 6-49 

R 

RAM disk, 6-41 - 6-42 
Re-anchor frames, 5-S2 
Rearrange 

Chapters within publication, 5-21 7 
Redraw screen, 4-30 
Reducing a picture 

See Sizing & scaling 
Reformat page, 3-S 
Register marks, 5-23, 1-2 
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Remove 
Directory, 5-27 - 5-32 
File, 5-54 - 5-55 
Page, 5-93 - 5-94 
Tag, 5-171, 5-173 - 5-176 

Rename tag, 5-171, 5-173 - 5-176 
Renumber chapter, 5-81 
Renumber chapters, 5-222 
Repeating frames, 5-114 - 5-117 

Text in, 4-8 
Requirements 

System, 2-1 
Reset section number, 5-79 
Return 

See Enter 
Reverse type, 5-164, 6-32 - 6-33 
Right justify text 

See Alignment, 5-133 
Rulers 

Measurement units, 5-196 
Show/hide, 5-207 

Ruling lines 
Custom width, 5-163 
Dashes, 5-121, 5-163 
Defined, 1-7 
Frames, 5-120 - 5-121 
Paragraph, 5-162 - 5-165 
Vertical, 5-118 - 5-119 

Runarounds, C-8, 4-12, 5-106 
Defined, 1-7 

Running head 
See Headers & Footers 

Running the program, 2-8 - 2-10 

s 
Samna Word, D-17 
Sans serif, 1-7 
Save, 5-8 - 5-9 

Files, 3-18 - 3-21 
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Publication, 5-21 7 
Save as, 5-10 - 5-11 
Save as new style, 5-20 
Scale 

Defined, 1-7 
Scaling, 5-104 

INDEX 

Scanned images, 5-107 - 5-110, 
5-124 - 5-128 
Scanner, 5-17 

Compatibility, C-7 
Defined, 1-7 
Printing images from, 5-107 - 5-110 

Screen controls, 3-1 
Screen fonts, K-4 - K-6 

PostScript, K-6 
Screen snapshot, G-5 
Scroll down one line, 3-3 
Scroll left one character, 3-3 
Scroll right one character, 3-3 
Scroll up one line, 3-2 
Scrolling 

Difference from go to page, 5-96 
Search and replace, D-l 
Secondary leading 

See Inter-Paragraph spacing, 5-140 
Section numbering, 5-74 - 5-80 

See also Auto-numbering 
In frames, 5-76 
Tags, 5-78 

Select 
Defined, 1-5, 1-7 
Menu option, 3-2 
Text, 4-19 

Select all, 4-35, 5-187 - 5-188 
Send to back, 5-179 - 5-180 
Set preferences, 5-192 - 5-195 
Set rulers, 5-196 - 5-197 
Shaded type, 6-33 
Shading 

See Frames, background, 5-122 
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Shift 
Font, D-6, 4-25 

Shift keys, 3-8 
Shortcut, 3-11 

Keyboard, go to page, 5-96 - 5-98 
Mouse, 3-19 

Show on all pages, 5-177 - 5-178 
Show on this page, 5-177 - 5-178 
ShowlHide column guides, 5-208 
Showlhide loose lines, 5-212 
ShowlHide pictures, 5-209 - 5-210 
ShowlHide rulers, 5-207 
ShowlHide side-bar, 5-206 
ShowlHide tabs & returns, 5-211 
Side-Bar, 3-4 - 3-5, 5-206 
Sidekick, A-1, G-5 
Size box, 3-3 
Sizing & scaling, 4-9, 5-102 -
5-107, 6-46 
Soft hyphen 

See Discretionary hyphen 
See Hyphenation 

Space, 4-27 
Em, 3-10, 1-3 
En, 3-10, 1-3 
Figure, 3-10, 1-3 
Non-breaking, 3-10, D-9, 4-27 
Thin, 3-10, 1-8 

Space character 
See Character space 

Spaceband, 5-158 
Spacing, 5-138 - 5-144 

Adding additional between 
paragraphs, 4-12 

After period, colon, 5-16 
Between lines, 5-142 
Between paragraphs, 5-15, 5-142 
Between words, 5-158 
Inter-Line, 5-140 
Inter-Paragraph, 5-140 
Total paragraph space, 5-143 
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Special characters 
See Alt key 
See Fonts 
See Foreign characters 

Special code 
Delete, 5-38 
Edit, 5-38 
Paste, 5-38 

Special code:lnsert, 5-37 
Special effects, 5-152 - 5-153 
Special function keys, 3-9 
Speed 

Improving screen drawing speed, 
5-209 

Printing, 5-23, 6-39 - 6-45 
Slow loading due to excess files, 

5-55 
Spelling check, D-1 
Spooler 

Print, 6-44 
Spreadsheets 

Publishing, D-13 
Square box, 5-39 
Squares 

Drawing, 4-36 
Starting the program, 2-8 - 2-10 
Store 

See Save 
Stretch to fit, 5-104 
Strikethrough 

Change defaults, 5-154 - 5-156 
Style sheet 

Attributes stored in, 5-61 
Changed unexpectedly, 5-20 
Creating, 6-18 - 6-19 
Defined, 6-18, 1-8 
Examples, Appendix L, L-1 
How to create, 6-19 - 6-23 
Loading, 5-19, 6-19 
Margins & Columns stored in, 5-97 
Menu options affecting, 6-21 
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Style sheet (continued) 
Modifying, 4-18 - 4-20, 6-18 
Print, 5-171, 5-173 - 5-176 
Saving, 5-20, 6-19 
Unwanted changes in, 5-8 
Width table stored with, 5-201 

Subdirectory 
Selection, 3-19 

Subscripts, 4-19, 5-155 - 5-156 
Superscripts, 4-19, 5-155 - 5-156 
Support, 1-2 
Suppress previous level, 5-76 - 5-77 
Symbols, 4-25 - 4-26, E-1 
System requirements, 2-1 

T 

T-Square, 5-197 
Tab in 

See Indent 
Tab key, 3-9 
Tabbed out 

See Outdent 
See Outdent, 5-136 

Table COUll ter, 5-35 
Table numbering across chapters, 
5-71 - 5-73 
Table of contents 

Generating, 5-218 - 5-219 
Tags, 6-22 

Tables 
Aligning numbers (figure space), 1-3 
Creating, 4-39, 6-34 - 6-38 

Tabs, 5-149 - 5-151 
Changing decimal, 5-195 
From word processor, D-4 
Show/hide, 5-211 
Text right margin, 5-151 
U sed to create tables, 6-34 - 6-38 
Versus spaces, D-5 
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Vertical, 6-35 
Wordstar, D-19 

INDEX 

Tag multiple paragraphs, 4-15,4-32 
Tags 

Adding new, 4-1 7 - 4-18 
Assigning to text, 4-13 - 4-18 
Auto-numbering, 5-78 
Captions, 5-112 
Choosing names, 6-21 
Defined, 5-129, 1-8 
Extracting tagged text, 5-85 
Font, 5-131 
Frame-wide, 5-136 
Function keys, 3-9 
Generated, 4-17, 6-22 - 6-23 
Headers & Footers, 5-86 
Hidden, 5-192 
In a word processor, D-2 
Modifying, 4-18 - 4-20 
Removing, 4-18, 5-171, 5-173 -

5-176 
Renaming, 5-171, 5-173 - 5-176 
Spacing automatically changed, 

5-132 
Unexpected new names, 6-22 
Z-tags, 6-22 

Tall orientation 
See Portrait 

Technical support, 1-2 
Template, 6-14 - 6-20 
Text 

Adding and deleting, 4-25 
Alignment, 5-133 - 5-137 
Automatic text insertion, 5-80 
Beyond right margin, 5-151 
Changes during loading, 5-15 
Copy-fitting, 6-47 
Hidden, D-9 
In frames, 6-10 - 6-14 
Keep away from frames, 5-106 
Overlapping frames, 6-13 
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Text (continued) 
Reverse, 5-164 
See also ASCII text, D-12 
White on black, 5-122, 5-164 

Text attributes 
Canceling, D-7 
Changing, 4-19 - 4-24 
Cuticopy, 5-34 
Deleting, 4-30 
End of paragraph, D-7 
Precedence over tags, 4-21 
Word processor, D-5 - D-7 

Text cursor 
Defined, 1-5 

Text editing, 4-25 
Across page boundaries, 5-96 
Adding non-keyboard characters, 

3-10 
Adding/deleting text, 4-25 
Alt key, 3-10 
Backspace key, 3-8 
Blank frame/page, 4-29 
Copy text between chapters, 5-36 
Ctrl key, 3-9 
Cursor keys, 3-8 
Cut, copy, paste, 5-33 
Delete key, 3-8 
End key, 3-8 
Enter key, 1-5 
Escape (ESC) key, 3-8 
Hidden characters, 5-211 
Insert key, 3-8 
Line break, 3-9, 4-27 
Move, 5-33 
Non-breaking space, 4-27 
Non-keyboard symbols, 4-25 
Page down key, 3-8 
Page up key, 3-8 
Paragraphs, adding/deleting, 4-31 
Section numbers, 5-76 
Select text, 4-19 
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See also Shift font 
Shift keys, 3-8 
ShowlHide tabs & returns, 5-211 
Special function keys, 3-9 
Tab key, 3-9 

Text flow around, 5-102 
Text mode, 3-4, 3-8, 4-19 - 4-32 

Changing typeface, 4-21 
Kerning, 4-22 - 4-24 

Thin space, 3-10, 1-8 
Thumb tab, 5-114 
Tilde character ( ..... ), 3-17 
Tints 

Defining, 5-168 
Title bar, 3-2, 5-8 
To print, 5-21 - 5-25 
Tracking 

Interactive, 4-22 - 4-24 
Trademark symbols, 4-26 
Trailer 

See Headers & footers 
Trim marks 

See Register marks 
Trim pictures 

See Scaling, 5-104 
Turn column snap on/off, 5-213 
Turn footers off/on, 5-88 . 
Turn headers off/on, 5-88 
Turn line snap on/off, 5-214 
Typeface 

Defined, 1-8 
See Fonts 

Typeset 
Defined, 1-8 

Typographic controls, 5-154 - 5-161 
Automatic, 6-49 

Typographic conventions, 1-5 
Typography 

Kerning, interactive, 4-22 - 4-24 
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u 
Underline 

Change defaults, 5-154 - 5-156 
Undo 

Attribute delete, 4-31 
See Abandon, 5-12 
Text delete, 4-31 

UNTITLED.CHP, 5-8 
Update from version 1.0, A-2 
User interface, 3-1 - 3-22 

Pull-down menu preference, 5-195 

v 
Version information, 5-3 
Vertical justification, 5-68 - 5-70 
Vertical rules, 5-118 - 5-119 
Vertical scroll bar, 3-2 
Vertical shift 

See Shift font 
Vertical tab, 6-35 
VFM file, K-22 - K-25 
VGR files, 5-8, 5-10 
Video show, G-5 
View menu, 5-58 - 5-60 
Volkswriter 3, D-16 
VP.BAT, A-5 - A-6 
VP.INF file, 5-28 

w 
White letters on a black background 

See Reverse type 
Wide orientation 

See Landscape 
Widow 

Defined, 5-66, 1-8 

REFERENCE GUIDE 

Widows & Orphans, 5-66 
Width table 

Not in standard format, C-15 
Won't load, C-16 

Width tables, 3-21 
Adding kerning to, 5-157 
Changing, 5-201 
Creating new, 5-204 
Defined', 1-8 
Load new width table, 5-204 
OUTPUT.WID, 5-202 
Stored with style sheet, 5-20 
Use, 5-19, 5-198 
VFM creation, K-27 

WIDTOVFM, K-27 
Wildcard, 1-3 
Windows 

INDEX 

Clipboard converter, G-6 - G-9 
Running from, 2-9 

Windows Write, D-17 
Word processor, D-1 

Attributes, E-1 
Converting between different, 5-56 
Developing index in, D-10 
Information deleted, D-1 
Text attributes, D-5 - D-7 
Writing custom converter, D-1 

WordPerfect, D-18 
Wordstar, D-19 

Tabs, D-5, D-19 
Wordstar 2000, D-16 
Wrapping text around picture 

See Runarounds 
WYSIWYG 

Defined, 3-22, 1-8 
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x 
Xerox 4020, F-7 

Resolution, F-8 
Switch settings, F-7 

Xerox 4045, F-4 - F-6 
Configuration switches, F-4 
DRAM option, F-4 
New fonts for, K-12 - K-14 
Out of memory, F-6 
Paper size, F-4 
Resolution, F-5 
300 DPI driver, A-3, F-4 

Xerox writer, D-20 
Xywrite, D-20 

z 
Z-tags, 6-22 

See also Tags,generated 
Zoom in, 5-59 
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